
 

[1] Agile Product Lifecycle Management 
Product Collaboration User Guide 
Release  9.3.6 
E71143-08

September 2023



Agile Product Lifecycle Management Product Collaboration User Guide, Release  9.3.6 

E71143-08

Copyright © 2010, 2022, Oracle and/or its affiliates. All rights reserved.

Primary Author: Oracle Corporation

This software and related documentation are provided under a license agreement containing restrictions on use and 
disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or 
allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, 
perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or 
decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find 
any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of 
the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any 
programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are "commercial 
computer software" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental 
regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any 
operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject 
to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not 
developed or intended for use in any inherently dangerous applications, including applications that may create a risk of 
personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all 
appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its 
affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their 
respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used 
under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, 
and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered 
trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products, and 
services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all 
warranties of any kind with respect to third-party content, products, and services unless otherwise set forth in an 
applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible for any loss, 
costs, or damages incurred due to your access to or use of third-party content, products, or services, except as set forth 
in an applicable agreement between you and Oracle.



iii

Contents

Preface ...............................................................................................................................................................    xv

Audience.......................................................................................................................................................     xv
Documentation Accessibility .......................................................................................................................     xv
Related Documents ......................................................................................................................................     xv
Conventions..................................................................................................................................................     xv

1 Introduction
Product Collaboration Use Cases .............................................................................................................   1-1
What’s New in 9.3.6....................................................................................................................................   1-2
What’s New in 9.3.5....................................................................................................................................   1-2
What's New in 9.3.4....................................................................................................................................   1-2
What's New in 9.3.3....................................................................................................................................   1-2
What's New in 9.3.2....................................................................................................................................   1-3

2 Items
Item Objects................................................................................................................................................   2-1

Lifecycle Phase .....................................................................................................................................   2-2
Title Block Tab .....................................................................................................................................   2-3

Fields on the Title Block Tab ........................................................................................................   2-3
Changes Tab..........................................................................................................................................   2-4
BOM Tab ..............................................................................................................................................   2-5

Creating a Common BOM.............................................................................................................   2-5
Creating a Site-Specific BOM .......................................................................................................   2-6

Manufacturers Tab ................................................................................................................................   2-6
Viewing a Manufacturer Part from the Manufacturers Tab ..........................................................   2-6

Sites Tab................................................................................................................................................   2-6
Prices Tab..............................................................................................................................................   2-7
Quality Tab ...........................................................................................................................................   2-7
Compliance Tab ....................................................................................................................................   2-7
Suppliers Tab ........................................................................................................................................   2-7
Relationships Tab..................................................................................................................................   2-7
Attachments Tab ...................................................................................................................................   2-8

Working with Thumbnails on Item Objects ..................................................................................   2-9
History Tab ...........................................................................................................................................   2-9

Working with Item Revisions ....................................................................................................................   2-9



iv

Viewing a Different Revision ............................................................................................................    2-10
Introductory Revisions .......................................................................................................................    2-10
Blank Revisions .................................................................................................................................    2-10
How the Revision List Works ............................................................................................................    2-11
Revisions and Attachment Capabilities .............................................................................................    2-11
How Rev and Site Lists are Determined............................................................................................    2-12
Working with Pending Revisions ......................................................................................................    2-12
Attachments on Pending Revisions....................................................................................................    2-13

Effects of CopyFilesToRev SmartRule ......................................................................................    2-13
Creating a Pending Revision.......................................................................................................    2-14
Modifying Pending Revisions ....................................................................................................    2-14

Creating Agile Items ...............................................................................................................................    2-14
Creating Items in Web Client.............................................................................................................    2-15
Creating an Item Using Save As ........................................................................................................    2-16
Creating Items in Java Client .............................................................................................................    2-17
Creating an Item Using Add ..............................................................................................................    2-17

Creating a Pending Revision.......................................................................................................    2-18
Modifying Pending Revisions ....................................................................................................    2-18

Editing Agile Items ..................................................................................................................................    2-18
Editing an Unreleased Item................................................................................................................    2-18
Editing a Released Item .....................................................................................................................    2-19

Editing a Released Item's Description Field ...............................................................................    2-19
Changing an Item's Subclass..............................................................................................................    2-20

Releasing an Agile Item to Production ..................................................................................................    2-20
Unreleasing an Item ...........................................................................................................................    2-21

Incorporating and Unincorporating Items ...........................................................................................    2-22
Overview of File Folders and Item Attachments ...............................................................................    2-22
Overview of Incorporation.................................................................................................................    2-22
Pre-incorporating an Item ..................................................................................................................    2-23
Incorporating an Item.........................................................................................................................    2-23
Unincorporating an Item ....................................................................................................................    2-24

Attribute History Report ........................................................................................................................    2-24
Where Used Tab ......................................................................................................................................    2-25

Sites and the Where Used Tab ...........................................................................................................    2-25
Viewing Site-specific Where Used ....................................................................................................    2-26

Deleting Items ..........................................................................................................................................    2-26
Printing Item Tabs ..................................................................................................................................    2-26

3 Sites and Distributed Manufacturing
What is Agile Distributed Manufacturing? .............................................................................................   3-1
What Are Sites? ..........................................................................................................................................   3-2
How Sites Can Be Used ..............................................................................................................................   3-3

Different AMLs at Each Site ................................................................................................................   3-4
Different BOMs at Each Site ................................................................................................................   3-4
Different Effectivity Dates and Dispositions at Each Site ....................................................................   3-4

How Sites Work ..........................................................................................................................................   3-4
Site Information on BOMs and AMLs .................................................................................................   3-4



v

Sites Tab of Items .................................................................................................................................   3-5
Changes and Sites .................................................................................................................................   3-5
Controlling Access to Sites ...................................................................................................................   3-5
Common BOM/AML Sections .............................................................................................................   3-5

Where Sites Are Documented ...................................................................................................................   3-6
Site Objects .................................................................................................................................................   3-6

General Info Tab - Sites ........................................................................................................................   3-7
General Info Tab Fields - Sites ......................................................................................................   3-7
Site Lifecycle Phase.......................................................................................................................   3-8
AML Required on Buy Field .........................................................................................................   3-8
Site AML Allowed Field ...............................................................................................................   3-8

Attachments Tab ...................................................................................................................................   3-9
History Tab ...........................................................................................................................................   3-9

Creating Sites...........................................................................................................................................    3-10
Creating a Site Using the Save As Feature ........................................................................................    3-10

Associating a Site with an Item ..............................................................................................................    3-10
Fields on the Sites Tab .......................................................................................................................    3-11

Modifying the Make/Buy Field on the Item Sites Tab ...............................................................    3-11
Adding Sites to the Sites Tab.............................................................................................................    3-12
Removing Sites from the Sites Tab....................................................................................................    3-13

Deleting Site Objects ...............................................................................................................................    3-13
Editing Sites .............................................................................................................................................    3-13
Printing Sites............................................................................................................................................    3-14

4 Manufacturing Objects
What Is Agile AML? ..................................................................................................................................   4-1

What Does Agile AML Do? .................................................................................................................   4-1
About Manufacturing Objects...............................................................................................................   4-1
Many-to-One Relationships in Agile AML ..........................................................................................   4-2
Sites and AML Data..............................................................................................................................   4-2

Setting Up Manufacturing Data................................................................................................................   4-3
Manufacturing Objects: Manufacturers and Manufacturer Parts .......................................................   4-3

Manufacturing Object Tabs ..................................................................................................................   4-3
Where Used Tab ............................................................................................................................   4-5
Sites and the Manufacturer Part Where Used Tab.........................................................................   4-6
Manufacturer Part Prices Tab ........................................................................................................   4-6
Where Used Tab and the Discovery Privilege...............................................................................   4-6
Read Privilege................................................................................................................................   4-7

About Manufacturers ............................................................................................................................   4-7
Lifecycle Phase of a Manufacturer ................................................................................................   4-7
D-U-N-S Number ..........................................................................................................................   4-7

About Manufacturer Parts .....................................................................................................................   4-7
Lifecycle Phase of a Manufacturer Part.........................................................................................   4-8

Creating and Managing Manufacturing Objects ....................................................................................   4-8
Creating Manufacturers.........................................................................................................................   4-8
Creating a Manufacturer Using the Save As Feature............................................................................   4-9
Creating Manufacturer Parts ..............................................................................................................    4-10



vi

Creating a Manufacturer Part in Web Client ..............................................................................    4-11
Creating a Manufacturer Part in Java Client...............................................................................    4-11
Java Client Manufacturer Name Automatic Validation .............................................................    4-12
Where is Java Client Manufacturer Name Automatic Validation Used? ...................................    4-13
How to Use Java Client Manufacturer Name Automatic Validation .........................................    4-13
Creating a Manufacturer Part Using the Save As Feature ..........................................................    4-14

Modifying Manufacturing Objects.....................................................................................................    4-16
Deleting Manufacturing Objects............................................................................................................    4-16
Manufacturers Tab of an Item...............................................................................................................    4-16

Manufacturers Tab Buttons................................................................................................................    4-16
Manufacturers Tab Fields ..................................................................................................................    4-17

Viewing AML Information by Site ........................................................................................................    4-18
Associating a Manufacturer Part with Its Corresponding Item.........................................................    4-18
Important Considerations When Working with Manufacturing Objects .........................................    4-19
Working with Manufacturing Data on Preliminary Items .................................................................    4-19

Adding a Manufacturer Part to the Manufacturers Tab .....................................................................    4-19
Deleting a Manufacturer Part from the Manufacturers Tab...............................................................    4-21
Modifying a Manufacturer Part on the Manufacturers Tab ...............................................................    4-21

Modifying Manufacturing Data from the Redlines Tab......................................................................    4-22
Overview of Redlining Manufacturing Data .....................................................................................    4-22
Redline Manufacturers Tab................................................................................................................    4-22
Adding a Manufacturer Part on the Redline Manufacturers Tab.......................................................    4-24
Adding Nonexistent Manufacturer Parts on the Redlines Tab ..........................................................    4-24
Deleting a Manufacturer Part from the Redlines Tab ........................................................................    4-24
Editing Manufacturer Part Information on the Redline Manufacturers Tab......................................    4-25
Undoing Changes to the Redline Manufacturers Tab ........................................................................    4-26
Conflict AML Validation When Releasing Changes.........................................................................    4-26

Conflict AML Validation on Sites..............................................................................................    4-28
Duplicate AML Validation When Releasing Changes ......................................................................    4-28

Duplicate AML Validation on Sites ...........................................................................................    4-29
Printing Manufacturing Objects and AMLs ........................................................................................    4-29

5 Bills of Material
About Bills of Material ..............................................................................................................................   5-1
BOM Tab ....................................................................................................................................................   5-1

How the Agile Administrator Controls What You See.........................................................................   5-1
BOM Tab Buttons.................................................................................................................................   5-2

Web Client BOM Tab Buttons ......................................................................................................   5-2
Java Client BOM Tab Buttons.......................................................................................................   5-3

BOM Table Fields.................................................................................................................................   5-4
Web Client BOM Table Fields ......................................................................................................   5-4
Java Client BOM Table Fields.......................................................................................................   5-6

Common and Site-specific Portions of the BOM .................................................................................   5-6
Viewing BOMs by Site .........................................................................................................................   5-7

Opening Items on a BOM ..........................................................................................................................   5-7
Opening a Part, Assembly, or Document from the BOM Tab..............................................................   5-8
Expanding and Collapsing an Assembly ..............................................................................................   5-8



vii

Using BOM Go To................................................................................................................................   5-9
Expanded BOM Display Window, Web Client .................................................................................    5-11

Revisions Listed on BOMs......................................................................................................................    5-11
BOMs of Items Affected by an ECO .................................................................................................    5-12

About Modifying the BOM Table..........................................................................................................    5-12
Modifying Site-Specific Portions of the BOM of a Preliminary Item...............................................    5-13
Web Client, Adding Items to the BOM Table of a Preliminary Item................................................    5-13

Web Client, Type in the Number of an Item to Add to the BOM Table ....................................    5-14
Web Client, Quick Search to Add Items to the BOM Table ......................................................    5-15
Web Client, Create New to Add Items to the BOM Table .........................................................    5-16
Web Client, Saved Search to Add Items to the BOM Table ......................................................    5-16
Web Client, Custom Search to Add Items to the BOM Table....................................................    5-17
Web Client, Adding a Place-holder Row to the BOM Table .....................................................    5-18
Web Client, Editing a Place-holder Row....................................................................................    5-19
Web Client, Completing a Place-holder Row in the BOM Table ..............................................    5-19

Java Client, Adding Items to the BOM Table of a Preliminary Item ................................................    5-20
Java Client, Type in the Number of an Item to Add to the BOM Table.....................................    5-20
Java Client, Search for Items to Add to the BOM Table ............................................................    5-21
Java Client, Adding a Blank Row to the BOM Table ................................................................    5-22
Java Client, Editing a Blank Row...............................................................................................    5-22
Java Client, Completing a Blank Row in the BOM Table..........................................................    5-23
Java Client, Adding Nonexistent Items to the BOM Table ........................................................    5-24

Modifying the BOM Table of a Preliminary Item .............................................................................    5-25
Removing Items from the BOM Table ..............................................................................................    5-25
Conflict BOM Validation When Releasing Changes ........................................................................    5-26

Conflict BOM Validation on Sites..............................................................................................    5-27
Duplicate BOM Validation When Releasing Changes ......................................................................    5-28

Duplicate BOM Validation on Sites ...........................................................................................    5-29
Working with Reference Designators....................................................................................................    5-30

Viewing Reference Designators.........................................................................................................    5-30
Reference Designators Allow Range Expand Collapse Preference Setting ...............................    5-31
Viewing Reference Designators in Web Client ..........................................................................    5-31
Viewing Reference Designators in Java Client ..........................................................................    5-31

Adding Reference Designators ..........................................................................................................    5-32
Reference Designator Entry Format Guidelines .........................................................................    5-33
Leading Zeros in Reference Designators....................................................................................    5-33
Multi-segmented Reference Designator Entry Format Guidelines.............................................    5-34
Entering Multi-segmented Reference Designator Ranges..........................................................    5-34
Editing the Reference Designator Field......................................................................................    5-35
Duplicate Reference Designators and Sites ................................................................................    5-36

Deleting Reference Designators.........................................................................................................    5-36
Modifying Reference Designators .....................................................................................................    5-37

Redlining the BOM of a Released Item .................................................................................................    5-38
Overview of BOM Redlining.............................................................................................................    5-39
Redline BOM Tab..............................................................................................................................    5-39

Redline BOM Tab Buttons .........................................................................................................    5-41
Adding an Item to a Redline BOM Table ..........................................................................................    5-42



viii

Removing an Item from a Redline BOM Table.................................................................................    5-43
Editing Item Information on a Redline BOM Table ..........................................................................    5-43
Undoing Changes to a Redline BOM Table ......................................................................................    5-44

Printing BOM Data .................................................................................................................................    5-45

6 Variant Management
About Agile PLM Variant Management..................................................................................................   6-1
Configuring Agile PLM Variant Management .......................................................................................   6-1

How Agile PLM Variant Management Works .....................................................................................   6-2
Description of the BOM Items..............................................................................................................   6-2
Possible Combinations..........................................................................................................................   6-3

Mandatory......................................................................................................................................   6-6
Optional .........................................................................................................................................   6-6
Minimum/Maximum Quantity.......................................................................................................   6-6
Mutually Exclusive ........................................................................................................................   6-7

Combination Rules................................................................................................................................   6-7
Valid Options of an Option Class ..................................................................................................   6-7
Mutually Exclusive BOM Items ....................................................................................................   6-8
Mandatory BOM Items..................................................................................................................   6-9
Quantities of BOM Items...............................................................................................................   6-9
Selecting BOM Items..................................................................................................................    6-10
Documents as BOM Items..........................................................................................................    6-10

Model Option BOM ...........................................................................................................................    6-10
Quantities ...........................................................................................................................................    6-11

Alphanumeric Quantity Values ..................................................................................................    6-12
Reference Designator..................................................................................................................    6-12

Instances Tab......................................................................................................................................    6-12
Instance .......................................................................................................................................    6-13
Propagate Instance Revision .......................................................................................................    6-13
Instance Manager ........................................................................................................................    6-14
Configuration Graph ...................................................................................................................    6-16

Derive Instance BOM ........................................................................................................................    6-16
Instance BOM ....................................................................................................................................    6-17
Revisions............................................................................................................................................    6-17
Import / Export...................................................................................................................................    6-18

Import Objects into Instances Table ...........................................................................................    6-18
Import Configuration Graph into Instances Table ......................................................................    6-18

Working with Agile PLM Variant Management .................................................................................    6-19
Creating a Model Option BOM .........................................................................................................    6-19

Creating a Model ........................................................................................................................    6-19
Creating a BOM Entry with Min/Max Value .............................................................................    6-19
Creating an Optional BOM Entry ...............................................................................................    6-20
Creating a Mutually Exclusive BOM Entry ...............................................................................    6-20
Creating an Optional Mutually Exclusive BOM Entry ..............................................................    6-21
Adding Manufacturer Sites to a Model Option BOM ................................................................    6-21
Checking the Model Option BOM..............................................................................................    6-21

Deriving an Instance BOM with the Internal Configurator ...............................................................    6-22



ix

Creating an Instance....................................................................................................................    6-22
Configuring One Instance ...........................................................................................................    6-22
Validating the Instance ...............................................................................................................    6-24
Comparing and Modifying Instances..........................................................................................    6-25
Creating the Instance BOM ........................................................................................................    6-26

Propagating the Configuration of One Instance to Another ..............................................................    6-27
Importing / Exporting Variant Management Information..................................................................    6-27

Exporting into aXML Files.........................................................................................................    6-27
Importing aXML Files ................................................................................................................    6-28
Importing/Exporting PDX Files..................................................................................................    6-28
Exporting into Text (csv) or Excel (xls) Files ............................................................................    6-28
Importing Text (csv) or Excel (xls) Files....................................................................................    6-29

Working with Agile PLM Variant Management - External Configurator........................................    6-29
Deriving an Instance BOM with the External Configurator ..............................................................    6-29

Creating an Instance BOM with the External Configurator .......................................................    6-30

7 Changes
Change Classes ...........................................................................................................................................   7-1
Change Objects...........................................................................................................................................   7-3

Cover Page Tab .....................................................................................................................................   7-4
Fields on the Cover Page Tab ........................................................................................................   7-4
Status on the Cover Page Tab ........................................................................................................   7-6

Affected Items Tab................................................................................................................................   7-7
Affected Files Tab.................................................................................................................................   7-8
Workflow Tab .......................................................................................................................................   7-8

Workflow Overview Section .........................................................................................................   7-9
Web Client Workflow Tab, Base View .........................................................................................   7-9
Web Client Current Signoff Status View ...................................................................................    7-10
Java Client Workflow Tab Summary Table ...............................................................................    7-11
Java Client Workflow Tab Signoff History Table......................................................................    7-11
Signoff Duration .........................................................................................................................    7-12
User Action Timestamp ..............................................................................................................    7-12

Relationships Tab...............................................................................................................................    7-13
Attachments Tab ................................................................................................................................    7-13
History Tab ........................................................................................................................................    7-14

Workflow Routings Inbox ......................................................................................................................    7-16
Changes and Manufacturing Sites.........................................................................................................    7-16

Site Information Affected by Changes...............................................................................................    7-17
Sites and ECOs...................................................................................................................................    7-17
Sites and MCOs .................................................................................................................................    7-18
Site Change Orders ............................................................................................................................    7-18

Site-Specific Effectivity and Obsolete Dates..............................................................................    7-18
The Relationship of Changes to Item Revisions ...................................................................................    7-18
Creating Changes ....................................................................................................................................    7-19

Site Change Order Save As Limitations ............................................................................................    7-19
Modifying Changes .................................................................................................................................    7-20
Agile Change Control Workflows..........................................................................................................    7-20



x

Redlining through ECOs, DFCOs, MCOs, and SCOs.........................................................................    7-20
Redlining through ECOs....................................................................................................................    7-21
Redlining through DFCOs .................................................................................................................    7-21
Redlining through MCOs...................................................................................................................    7-21
Redlining through SCOs ....................................................................................................................    7-21

Routing Managers: Change Analyst and Component Engineer ........................................................    7-22
Deleting Changes .....................................................................................................................................    7-23
Printing Change Tabs .............................................................................................................................    7-23

8 Affected Items of Changes
Affected Items Tab .....................................................................................................................................   8-1

Buttons on the Affected Items Tab .......................................................................................................   8-2
Fields on the Affected Items Tab ..........................................................................................................   8-4

Sites Field in Affected Items Table ...............................................................................................   8-5
Old Item Description and Item Description...................................................................................   8-5
Revision .........................................................................................................................................   8-6
Obsolete Date and Effective Date..................................................................................................   8-7
Lifecycle Phase and Old Lifecycle Phase......................................................................................   8-7

Affected Items by Manufacturing Site .....................................................................................................   8-7
Fields That Allow Site-Specific Values................................................................................................   8-8
Site-Specific Effectivity and Obsolete Dates........................................................................................   8-8

Viewing the Disposition of Parts in an ECO or SCO..............................................................................   8-8
Adding an Item to the Affected Items Tab ..............................................................................................   8-8

Web Client, Adding Items to the Affected Items Table .......................................................................   8-9
Web Client, Type in the Number of an Item to Add to the Affected Items Table ........................   8-9
Web Client, Quick Search to Add Items to the Affected Items Table........................................    8-10
Web Client, Create New to Add Items to the Affected Items Table ..........................................    8-11
Web Client, Saved Search to Add Items to the Affected Items Table........................................    8-11
Web Client, Custom Search to Add Items to the Affected Items Table .....................................    8-12

Java Client, Using the Add Affected Items Wizard...........................................................................    8-13
Performing Bulk Changes..................................................................................................................    8-13

BOM Bulk Changes Overview ...................................................................................................    8-14
Web Client BOM Bulk Change Wizard .....................................................................................    8-14
Java Client BOM Bulk Change Wizard......................................................................................    8-16
Manufacturer Part (AML) Bulk Changes Overview ..................................................................    8-17
Web Client Manufacturer Part Bulk Change Wizard .................................................................    8-18
Java Client Manufacturer Part Bulk Change Wizard..................................................................    8-19

Working with the Affected Items Table ................................................................................................    8-20
Title Block Redline Tab of ECOs and MCOs....................................................................................    8-21

Change Controlled Attributes .....................................................................................................    8-21
Special Considerations for ECOs.......................................................................................................    8-21

Fields Required to Release an ECO............................................................................................    8-22
Special Considerations for MCOs......................................................................................................    8-23
Special Considerations for SCOs.......................................................................................................    8-23
Special Considerations for ECRs.......................................................................................................    8-24
Special Considerations for Deviations ...............................................................................................    8-25
Special Considerations for Stop Ships ...............................................................................................    8-25



xi

Removing an Item from the Affected Items Tab..................................................................................    8-26
Editing Rows in the Affected Items Tab ...............................................................................................    8-26

Editing Affected Items Tab Rows in Web Client ..............................................................................    8-27
Using Fill-Up and Fill-Down in Web Client Tables...................................................................    8-27

Editing Affected Items Tab Rows in Java Client...............................................................................    8-28
Fill Up Rows and Fill Down Rows Buttons in Java Client ........................................................    8-28

Viewing the Redlines of an Affected Item .............................................................................................    8-29

9 Working with Product Reports and Process Reports
About Agile Reports...................................................................................................................................   9-1
About Product Reports and Process Reports ..........................................................................................   9-1

Accessing Product Reports and Process Reports ..................................................................................   9-2
Agile Products Reports Summary.........................................................................................................   9-2
Agile Process Reports Summary...........................................................................................................   9-3

Products Reports ........................................................................................................................................   9-3
Assembly Cost (Item Master) Report ...................................................................................................   9-4
BOM Explosion Report ........................................................................................................................   9-5
Consolidated BOM Report....................................................................................................................   9-6
Effective BOM Explosion Report.........................................................................................................   9-7
Item Activity Report .............................................................................................................................   9-8
Compare Item Attributes Report...........................................................................................................   9-9
Manufacturer BOM Report ................................................................................................................    9-10
Where Used Report ............................................................................................................................    9-11
BOM Comparison Report ..................................................................................................................    9-12
Legacy BOM Comparison Report - Single Level Only.....................................................................    9-13
Item Attribute History Report ............................................................................................................    9-15
Item Manufacturers Report ................................................................................................................    9-16

Process Reports .......................................................................................................................................    9-17
Change Activity Report .....................................................................................................................    9-17
Change Backlog Report .....................................................................................................................    9-18
Change Cycle Time Report................................................................................................................    9-20
User Signoff Duration Report ............................................................................................................    9-22
Change Package Report .....................................................................................................................    9-23
IP Transfer Report..............................................................................................................................    9-24
Change Metrics Report ......................................................................................................................    9-25

10 Help for Power Users
Details about Discovery and Read Privileges .......................................................................................    10-1

Displaying Non-viewable Fields........................................................................................................    10-2
Part or Document? ..................................................................................................................................    10-2
Changing an Item's Subclass..................................................................................................................    10-4
About Matching Criteria in Workflows ................................................................................................    10-5
Details About Revision Display on BOMs.............................................................................................    10-6
Searching for Orphan Items That Do Not Have Parents ....................................................................    10-7
Quick Access to Agile Objects using Smart URLs ...............................................................................    10-8



xii

A Deleting Agile Objects
Soft Delete and Hard Delete Defined .......................................................................................................    A-1
Soft-Deleting an Object.............................................................................................................................    A-2
Undeleting an Object ................................................................................................................................    A-2
Hard-Deleting an Object ..........................................................................................................................    A-2
Notes about Deleting Specific Agile Object Types .................................................................................    A-3

Notes about Deleting Item Objects ......................................................................................................    A-3
Notes about Deleting Change Objects .................................................................................................    A-4
Notes about Deleting Transfer Order Objects......................................................................................    A-4
Notes about Deleting PSR or QCR Objects.........................................................................................    A-4
Notes about Deleting Sourcing Project, RFQ and RFQ Response Objects .........................................    A-5
Notes about Deleting Package Objects ................................................................................................    A-6
Notes about Deleting Manufacturer Objects........................................................................................    A-6
Notes about Deleting Site Objects .......................................................................................................    A-6
Notes about Deleting User Objects ......................................................................................................    A-7
Notes about Deleting User Group Objects...........................................................................................    A-7
Notes about Deleting PG&C Objects...................................................................................................    A-8

B Configuring Product Collaboration in Agile Administrator
Reference Designator Preferences ...........................................................................................................    B-1

Reference Designators Allow Range Expand Collapse.......................................................................    B-1
Edit Mode - How editing reference designators is affected by the Expand/Collapse setting.......    B-2

Reference Designator Range Indicator ................................................................................................    B-2
Why Select a Non-default Reference Designator Range Indicator?.............................................    B-2

Reference Designators with Leading Zeros .........................................................................................    B-3
Multi-segmented Reference Designators .............................................................................................    B-3

Revising Item Descriptions .......................................................................................................................    B-3
Setting up the Change Order Object ....................................................................................................    B-4
Setting up the Appropriate Modify Privilege Masks for each Method................................................    B-5

Item Object Description Field Modification.................................................................................    B-5
Revision Controlled, All Items .....................................................................................................    B-5
Revision Controlled, All Items .....................................................................................................    B-6

Notes on Configuring Product Collaboration Object Tabs...................................................................    B-7
Notes on Configuring Agile PLM Settings that Affect Product Collaboration ...................................    B-7
Configuring Sites - Distributed Manufacturing .....................................................................................    B-7
What are Change Controlled Attributes?...............................................................................................    B-9

Configuring Change Controlled Attributes........................................................................................    B-10
Display Type for Lists in Web Client ....................................................................................................    B-10

C Configuring Variant Management
Administrative Settings for Variant Management.................................................................................    C-1

Privileges for Variant Management User.............................................................................................    C-1
Activating 'Internal Configurator' - Instance Manager ........................................................................    C-2
External Configurator - Oracle Generic Configurator User Interface................................................    C-2

Activating 'External Configurator' - Generic Configurator User Interface..........................................    C-2
Admin Settings for the External Configurator .....................................................................................    C-3



xiii

Event Management in Variant Management .........................................................................................    C-3
Variant Management Event Types.......................................................................................................    C-3
Examples of Variant Management Events...........................................................................................    C-3

Create Variant Instance.................................................................................................................    C-3
Derive Variant Model Option BOM.............................................................................................    C-4
Update Variant Configuration ......................................................................................................    C-4
Validate Variant Configuration ....................................................................................................    C-5
Validate Variant Instance Selections ............................................................................................    C-5
Validate Variant Model Option BOM ..........................................................................................    C-5

Glossary



xiv



xv

Preface

Agile PLM is a comprehensive enterprise PLM solution for managing your product value 
chain. 

Audience
This document is intended for administrators and users of the Agile PLM products.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My 
Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle 
Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html contains 
the latest versions of the Agile PLM PDF files. You can view or download these manuals from 
the website, or you can ask your Agile administrator if there is an Agile PLM Documentation 
folder available on your network from which you can access the Agile PLM documentation 
(PDF) files. 

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an 
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which 
you supply particular values.
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monospace Monospace type indicates commands within a paragraph, URLs, code in 
examples, text that appears on the screen, or text that you enter.

Convention Meaning
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This section provides links or information about where to find details about performing the 
following Product Collaboration.

Product Collaboration Use Cases
The following are Product Collaboration Use Cases:

Search for Items

– Agile PLM provides a Quick Search, a Custom Search with a list of items attributes 
the Agile administrator configures, and an Advanced Search, that lets you to define 
complex searches including Where-used searches.

– In the Web Client navigation pane toolbar, click the Help button and choose Quick 
Tours to view a short video about search features.

– See Getting Started with Agile PLM, chapter "Finding Agile Data with Searches" for 
detailed information about defining, saving, and executing searches in Web Client and 
in Java Client.

Create Item

– "Creating Items in Web Client" on page 2-15

– "Creating Items in Java Client" on page 2-17

– "Creating an Item Using Add" on page 2-17

– "Creating an Item Using Save As" on page 2-16

Add Item to Preliminary BOM

– "Web Client, Adding Items to the BOM Table of a Preliminary Item" on page 5-13

– "Java Client, Adding Items to the BOM Table of a Preliminary Item" on page 5-20

– "Modifying the BOM Table of a Preliminary Item" on page 5-25

Viewing expanded view of a BOM

– "Expanding and Collapsing an Assembly" on page 5-8

– "Expanded BOM Display Window, Web Client" on page 5-11

– "Using BOM Go To" on page 5-9

Create a Change against an item

– "Expanding and Collapsing an Assembly" on page 5-8

– "Expanded BOM Display Window, Web Client" on page 5-11
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– "Creating Changes" on page 7-19

Route a Change Order

– See Getting Started with Agile PLM, chapter "Routing Objects with Workflows."

Release a Change Order

– "Releasing an Agile Item to Production" on page 2-20

– See Getting Started with Agile PLM, chapter "Routing Objects with Workflows."

Add Affected Items to Changes

– "Adding an Item to the Affected Items Tab" on page 8-8

– "Web Client, Adding Items to the Affected Items Table" on page 8-9

– "Java Client, Using the Add Affected Items Wizard" on page 8-13

Add Manufacturer Parts to Preliminary Items

– "Adding a Manufacturer Part to the Manufacturers Tab" on page 4-19

Redline BOMs and AML

– "Redlining the BOM of a Released Item" on page 5-38

– "Redline Manufacturers Tab" on page 4-22

Redline item attributes

– "Title Block Redline Tab of ECOs and MCOs" on page 8-21

– "What are Change Controlled Attributes?" on page B-9

Checkout/Checkin Attachments against Items/Changes/Manufacturer Parts/Manufacturers

– See Getting Started with Agile PLM, chapter "Working with Attachments."

What’s New in 9.3.6
For information about new features and functions available in Agile PLM 9.3.6, see Agile PLM 
Readme v9.3.6, available on the Oracle Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html.

What’s New in 9.3.5
For information about new features and functions available in Agile PLM 9.3.5, see Agile PLM 
Readme v9.3.5, available on the Oracle Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html.

What's New in 9.3.4
For information about new features and functions available in Agile PLM 9.3.4, see Agile PLM 
Readme v9.3.4, available on the Oracle Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html.

What's New in 9.3.3
For information about new features and functions available in Agile PLM 9.3.3, see Agile PLM 
Readme v9.3.3, available on the Oracle Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html.
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What's New in 9.3.2
For information about new features and functions available in Agile PLM 9.3.2, see Agile PLM 
Readme v9.3.2, available on the Oracle Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html.
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Items can be parts or documents. In general, if the document is shipped as part of a product, or 
if it has costs associated with it, then create it as a part object. If the document is an internal 
document, procedure, or reference, then create it as a document object. (In some cases, you 
may want to create a document as a part. For examples, see "Part or Document?" on page 10-2.)

Item Objects
This section includes the following topics:

"Lifecycle Phase" on page 2-2

"Title Block Tab" on page 2-3

"Changes Tab" on page 2-4

"BOM Tab" on page 2-5

"Manufacturers Tab" on page 2-6

"Sites Tab" on page 2-6

"Prices Tab" on page 2-7

"Quality Tab" on page 2-7

"Compliance Tab" on page 2-7

"Suppliers Tab" on page 2-7

"Relationships Tab" on page 2-7

"Where Used Tab" on page 2-25

"Attachments Tab" on page 2-8

"History Tab" on page 2-9

To locate and open an item, follow the instructions in Getting Started with Agile PLM.

When you view an item in Web Client, information about it is displayed on tabs in the right 
content pane.

When you view an item in Java Client, information about it is displayed on tabs in an item 
window.

The following table lists the items tabs.

The Agile administrator may have added additional tabs or sections, called Page Two and Page 
Three by default. These tabs or sections contain custom fields defined by the administrator.
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Lifecycle Phase
A lifecycle phase name at the top right of the object window of an item indicates the production 
lifecycle phase of the item. (The names that you see may differ if the Agile administrator has 
customized the lifecycle names for your organization.)

The lifecycle phase name also appears in the Lifecycle Phase field on the item Title Block tab. 
See "Title Block Tab" on page 2-3.

Table 2–1 Item object tabs

Item tab name Tab information includes

Title Block Tab General information about the item, unique class and subclass fields 
defined by the Agile administrator

Changes Tab Any pending changes or released changes against the item

BOM Tab The item's bill of material

Manufacturers Tab Manufacturer and manufacturer parts information about sources for 
that part

Sites Tab The manufacturing sites that use the item

Prices Tab Prices associated with the item.

For more information about Product Cost Management (PCM), see the 
Product Cost Management User Guide.

Quality Tab Information about Product Quality Management (PQM) objects 
associated with this item. Product Service Requests (PSRs) are 
problem reports or non-conformance reports about this item.

For more information about PQM, see the Agile Product Quality 
Management User Guide.

Compliance Tab Information about the compliance to material regulations related to the 
item.

For more information about Product Governance & Compliance 
(PG&C), see the Agile Product Governance & Compliance User 
Guide.

Note: The Compliance tab is visible in Web Client only. Agile PG&C 
is a Web Client-based solution.

Suppliers Tab Information about the approved suppliers for the item. This tab is used 
in both the PG&C and PCM solutions.

For more information about PG&C, see the Agile Product Governance 
and Compliance User Guide.

For more information about PCM, see the Product Cost Management 
User Guide.

Note: The Supplier tab is visible in Web Client only. Agile PG&C and 
Agile PCM are Web Client-based solutions.

Relationships Tab The Relationships tab lets you create relationships with other Agile 
objects and to create dependencies between the current item object and 
other routable objects.

For more information about relationships, see the chapters about 
working with business objects in Getting Started with Agile PLM.

Where Used Tab Where the item is used

Attachments Tab Attached drawings and files

History Tab Actions taken on the item, for example, when attachments were added 
and removed



Item Objects

Items 2-3

The following table shows the default lifecycle phases.

Title Block Tab
The Title Block tab has fields that contain the information found on a typical paper-based title 
block. Some fields are filled in automatically and then you complete the rest. You may not be 
able to edit the contents of some fields. Your assigned roles and privileges determine which 
entries you are allowed to edit.

For more information about editing items, see "Editing an Unreleased Item" on page 2-18 and 
"Editing a Released Item" on page 2-19.

For more information about Title Block fields, see "Fields on the Title Block Tab" on page 2-3.

Fields on the Title Block Tab
By default, the item object Title Block tab contains the fields listed in the following table. 
Agile administrators determine which fields are enabled and visible on the Title Block tab.

In Web Client, the Title Block can contain two additional sections, called Page Two and Page 
Three by default. In Java Client, these are separate tabs. Agile administrators can add custom 
class fields to Page Two section and customer subclass fields to the Page Three section. The 
Agile administrator determines whether these sections are enabled, and what they are called.

Table 2–2 Default Item Lifecycles

Lifecycle phase 
name Lifecycle definition

Preliminary The item has never been released. It may have a pending change against it.

Prototype The item has been released to be built in very limited quantities for testing.

Pilot The item has been released to be built in limited initial quantities.

Production The item has been released for regular production.

Inactive The item is temporarily not in use but may be reactivated.

Obsolete This item is no longer in use.

Table 2–3 Title Block Tab fields

Field Definition

Number The item's number. The item number is completed when the item is created. 
Depending on Agile system settings, the number may be automatically 
generated or the user may enter a number.

Description Text that describes the item. By default, descriptions can be up to 240 
characters, counting spaces and carriage returns (carriage returns count as 
two spaces).

Size Drawing size - select from the list.

Product Line(s) The product group or groups that include this item - select from the list.

Lifecycle Phase The lifecycle phase of the item for the displayed revision, for example, 
Prototype or Production. See "Lifecycle Phase" on page 2-2 for more 
information.

Rev Incorp Date The date an item is incorporated - automatically completed when the item is 
incorporated.

Rev Release Date The date an item is released - automatically completed when the item is 
released.
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Changes Tab
The item object Changes tab displays a list of changes related to the item you are viewing. The 
changes are displayed in two tables. The information on this tab is filled in automatically. You 
can sort the tables by clicking the heading of the column by which you want to sort. For 
example, to sort by description, click the Description column heading.

The upper table, Pending Changes, shows pending changes, including changes on hold. The 
lower table, Change History, shows released and canceled changes.

The Site column displays the site entered on the Affected Items tab of the change. If more than 
one site is listed on the Affected Items tab, then the change is listed once for each site.

To open a change listed on the Changes tab:

In Web Client, click the change number.

In Java Client, double-click the change row.

The change opens with the Cover Page tab on top.

Part Type The subclass of this item - completed when the item is created. Depending on 
Agile system settings, the part type field may be automatically completed or 
the user may select a part type. See "Changing an Item's Subclass" on 
page 2-20 for more information.

Part Category The category that includes the item - select from the list.

Effectivity Date Displays the date the revision becomes effective. This date is specified on the 
Affected Items tab of the change that released the revision. See also 
"Site-Specific Effectivity and Obsolete Dates" on page 7-18.

Item Group(s) If this field has been enabled, then it displays the item groups of which the 
current item is a member.

Shippable Item

Exclude from Rollup

Compliance 
Calculated Date

Part Family

Mass

Overall Compliance

These fields are associated with Agile PG&C. For more information about 
Product Governance & Compliance (PG&C), see the Agile Product 
Governance & Compliance User Guide.

See also Agile PLM Administrator Guide and Getting Started with Agile 
PLM.

Note: If you do not have Discovery privilege for a change, then the change 
does not appear on the Changes tab. You may see a message telling you how 
many changes are not displayed. For more information, see "Details about 
Discovery and Read Privileges" on page 10-1. If you have questions about 
your Discovery or Read privileges, see the Agile administrator.

Note: Although its name is similar, the History tab shows actions made 
against an item, while the Change History table on the Changes tab lists 
released and canceled changes for the item.

Table 2–3 (Cont.) Title Block Tab fields

Field Definition
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BOM Tab
The BOM tab lists all the items on an item's bill of material (BOM). For details on the BOM 
tab, see Chapter 5, "Bills of Material."

If there are site-specific items on the BOM tab, then common items and site-specific items are 
grouped together. The common items are listed first. The Sites column is blank for common 
items. The Sites column of site-specific items displays the associated site name.

The common section of the BOM lists items that are associated with all the sites where the 
parent item is associated. The common section of a BOM can be modified through a revision 
change only.

The site section of the BOM lists items specific to the selected site. The site section of the 
BOM can be modified through a revision change or an SCO (site change order). For a site to be 
listed in a section of the BOM, the site must also be associated with the parent item.

To view all the components for all sites, then select ALL from the Site drop-down list.

To open an item listed on the BOM tab:

In Web Client, click the item number. The item opens with the Title Block tab on top.

In Java Client, double-click the item row. The item opens with the Title Block tab on top.

Or, right-click the item row, choose Open, and then choose a tab. The item opens with the 
selected tab on top.

Creating a Common BOM
You can directly edit the item object BOM table when an item is initially created and before it 
is added to the Affected Items table of a change.

For detailed instructions about adding items to the BOM tab, see:

"Web Client, Adding Items to the BOM Table of a Preliminary Item" on page 5-13

"Java Client, Adding Items to the BOM Table of a Preliminary Item" on page 5-20

When you add an item to the common portion of the BOM table, the Sites column is blank to 
indicate that the item is associated with all the sites assigned to the BOM.

Note: If you do not have Discovery privilege for an item, then the item 
does not appear on the BOM tab. You may see a message telling you how 
many items are not displayed. For more information, see "Details about 
Discovery and Read Privileges" on page 10-1.

Note: You can directly edit the BOM table when an item is initially created 
and before it is added to the Affected Items table of a change. See "Creating a 
Common BOM" on page 2-5 and "Creating a Site-Specific BOM" on 
page 2-6.

Note: By assigning a color to each site, you can color code the site section 
of the BOM tab.
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Creating a Site-Specific BOM
You can directly edit the item object BOM table when an item is initially created and before it 
is added to the Affected Items table of a change.

If the site for which you want to create a site-specific BOM is not on the Site list, then you 
must associate the item with that site through the item's Site tab. See "Associating a Site with 
an Item" on page 3-10.

For detailed instructions about adding items to the BOM tab, see:

"Web Client, Adding Items to the BOM Table of a Preliminary Item" on page 5-13

"Java Client, Adding Items to the BOM Table of a Preliminary Item" on page 5-20

When you add an item to a site-specific portion of the BOM table, the Site column is 
automatically completed with the site selected from the Site list as the associated site.

Manufacturers Tab
The Manufacturers tab displays the manufacturer parts used for the item, including 
site-specific manufacturer parts. The information on the tab is derived from associated 
manufacturing objects. If your company is using Agile AML features, and you have the 
appropriate privileges, then you can use this tab to construct an approved manufacturers list 
(AML) for the item.

The Manufacturers tab displays, in a sortable table, information about:

The manufacturers that produce the part

The manufacturer parts that they supply, including:

– Whether the manufacturer part is the preferred or an alternate part.

– Whether they are currently an active manufacturer of that part.

– The manufacturer's part number corresponding to the part in Agile PLM.

The manufacturing site to which the manufacturer part applies (manufacturer parts are 
listed once per applicable site). The AML Split column on the Manufacturers tab enables 
you to define the percent (%) allocated for the AML for the selected site.

Viewing a Manufacturer Part from the Manufacturers Tab
To open a manufacturer part from the item object Manufacturers tab:

In Web Client, click the manufacturer part number.

In Java Client, double-click the manufacturer part row.

Or, right-click the manufacturer part row, choose Open, and then choose a tab. The 
manufacturer part opens with the selected tab on top.

Sites Tab
The Sites tab of an item lists all the manufacturing sites that use the item or that have 
site-specific information that pertains to the item.

Note: If you do not have Discovery privilege for a manufacturer, then it 
does not appear on the Manufacturers tab. You may see a message telling 
you how many manufacturers are not displayed. For more information, see 
"Details about Discovery and Read Privileges" on page 10-1.
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To make an item available to site-specific BOMs and AMLs, you must add the appropriate sites 
to the item's Sites tab. For example, to enable users at the India site to add site-specific 
information for a part, then add India to the part's Sites tab. With the necessary privileges, you 
can add, edit, and remove information on the Sites tab.

For more information about manufacturing sites, including how to work with the Sites tab, see 
"Associating a Site with an Item" on page 3-10.

Prices Tab
The item object Prices tab shows information about the prices associated with the item.

For more information about pricing and the Prices tab, see Getting Started with Agile PLM or 
the Product Cost Management User Guide.

Quality Tab
The Quality tab of an item (part or document) lists the product service requests (PSRs) that 
reference the item. PSRs may include non-conformance reports (NCRs) and problem reports 
(PRs). The Agile administrator may have defined additional PSR types for your company. This 
tab is filled in automatically. For more information about the Quality tab and PQM features, 
see the Product Quality Management User Guide.

Compliance Tab
The item object Compliance tab relates to Agile PG&C and lists the compliance declarations 
associated with the item. For more information, see Agile Product Governance & Compliance 
User Guide.

Suppliers Tab
This item object Suppliers tab relates to Agile PG&C and lets you associate suppliers with the 
item. For more information, see Agile Product Governance & Compliance User Guide.

Relationships Tab
The item object Relationships tab lets you create relationships between the item object and 
other business objects, both lifecycle objects and routable objects. You can create dependencies 
(rules) between the item object and routable objects.

The Rule column displays the rule that defines how the lifecycle phase of a related lifecycle 
object affects the workflow progression of a routable object. In a relationship where both 

Note: The Compliance tab is visible in Web Client only. Agile PG&C is a 
Web Client-based solution.

Note: The Supplier tab is visible in Web Client only. Agile PG&C is a 
Web Client-based solution.

Note: You can create a relationship between two lifecycle objects (for 
example, two items). However, you cannot add a rule to a relationship 
between two lifecycle objects. In any rule, at least one of the objects must be 
a routable object. For more information, see Getting Started with Agile PLM.
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related objects are routable objects, the rule defines how the workflow progression of one 
routable object affects the workflow progression of the other routable object.

A relationship without a specified rule does not limit or affect the workflow progression or 
lifecycle status of either related object. You can use non-rule relationships to record objects that 
are somehow related to the current item object, but do not have any dependencies with the 
current item object.

Revision-specific relationships are available to you only if the Agile administrator has 
configured Agile PLM to enable revision-specific relationship capabilities. Revision-specific 
relationships allow you to select a specific revision for a Part object, Document object, or 
Published Price object in a relationship 

If Agile PLM has been configured for the use of reference objects, then you can add, on the 
Relationships tab, a reference, or link, to an object in an external application.

For more information about relationships, revision-specific relationships, reference objects, and 
how to use this tab, see the chapters about working with business objects in Getting Started 
with Agile PLM.

For information about all change object tabs, see Chapter 7, "Changes."

Attachments Tab
All objects have an Attachments tab. On the Attachments tab, you can attach files and URLs 
to the object by referencing those files and URLs in a file folder object. On the Attachments 
tab, you can view, copy (get), or print attached files if you have the appropriate privileges.

Individual attached files are stored in file folder objects and can be attached to multiple objects. 
The files in a file folder object can be drawings or scanned images, documents, non-viewable 
files, compressed files, and so on.

For detailed information about working with file folder objects and the Attachments tab, see 
Getting Started with Agile PLM.

You cannot make modifications to the Attachments tab of incorporated items. For more 
information about incorporated items, see "Incorporating and Unincorporating Items" on 
page 2-22.

Attachment tab operations (add, remove, edit) for items are revision-based. Attachments are 
added to or deleted from a specific ECO-created revision of the item, such as Rev A, Rev B, 
and so on. ECO-created item revisions have attachment capabilities. MCOs and SCOs are 
based on a particular item revision, but have no revision of their own, and therefore do not have 
attachment capabilities. For more information about item revisions and attachments, see 
"Revisions and Attachment Capabilities" on page 2-11.

Common Attachments tab operations in Web Client include:

View file in AutoVue for Agile - click its filename link. If the attached file is not viewable 
with AutoVue for Agile, then it opens in the native application, if it is installed on your 
computer.

Get a local copy of a file - select one or more rows and click the Get button.

Common Attachments tab operations in Java Client include:

Note: Attachments apply to all manufacturing sites of an item. That is, 
there are no site-specific attachments.
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View a file in AutoVue for Agile - select a row in the Attachments table and click the View 
Files button.

View a file in its native application - select a row in the Attachments table and click the 
Open Files button.

Get a local copy of a file - select a row in the Attachments table and click the Get Files 
button.

Working with Thumbnails on Item Objects
For information about working with thumbnails (small depictions of attachments), see Getting 
Started with Agile PLM.

History Tab
The History tab shows a summary of actions taken against an object, including a description of 
the action, which user took the action, the date of the action, and other details.

The types of actions recorded for items are:

Creation of the item

Attachment actions: view, open, add, delete, get, check in, check out, cancel checkout, 
incorporate, unincorporate, and field modifications on the Attachments tab.

Save As

Send

Print

Modification of the subclass or any field of a released item

Subscription modification and sharing

Field modifications for preliminary items that have not been released are recorded for 
modifications to the Relationships tab and Attachments tab only. Other field modifications to 
preliminary items are not recorded.

For modifications to released items, the revision information is included in the history table row 
in the Rev column.

Working with Item Revisions
The Site and Rev fields above the item tabs let you display item information based on 
manufacturing site and revision.

When you open an item, the Rev field displays the latest released version.

This section includes the following topics

Note: If you do not have the appropriate Read privilege for an object, then 
you cannot see the contents of the fields on the History tab. See "Details 
about Discovery and Read Privileges" on page 10-1.

Note: When you open the item from the Affected Items tab of a change 
order, the revision associated with that change order is displayed.
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"Viewing a Different Revision" on page 2-10

"Introductory Revisions" on page 2-10

"Blank Revisions" on page 2-10

"How the Revision List Works" on page 2-11

"How Rev and Site Lists are Determined" on page 2-12

"Working with Pending Revisions" on page 2-12

"Attachments on Pending Revisions" on page 2-13

Viewing a Different Revision
To view a different revision:

1. To see a revision that pertains to a specific manufacturing site, then select that site from the 
Site drop-down list.

2. Select a revision from the Rev drop-down list above the tabs. When you select a revision, 
the corresponding effectivity date is displayed.

When you select a different revision, all the tabs display information from the selected 
revision. For example, if the BOM tab is displayed, and you switch from revision C to 
revision B, then the other tabs also show revision B.

Introductory Revisions
The initial revision of an item-that is, the revision of a newly created, unreleased item-is labeled 
Introductory. Introductory revisions have no changes against them, and they are not assigned a 
revision letter. When an item is in the Introductory stage, it is not under change control and can 
therefore be modified directly.

Introductory revisions are treated the same as released revisions. That is, they are considered 
the base revision by Where Used and Object searches, the Where Used tab, changes, and the 
Save As feature.

Introductory appears in the Rev drop-down list at the bottom of the list because it is the earliest 
revision. It is the only revision on the list that is not associated with a change.

See also: "How the Revision List Works" on page 2-11.

Blank Revisions
You may see revisions in the list that are not Introductory and that do not have an assigned 
revision letter. These are referred to as blank revisions.

Blank revisions occur when an MCO is released against an item before an ECO releases the 
item. That releasing MCO creates a blank revision, as do any subsequent changes that occur 
before a new ECO revision is created. The Rev list displays the number of the MCO instead of 

Note: When you select ALL from the Site drop-down list, the default value 
in the Rev list is the latest released change for that item.

Note: Not all tabs are revision-specific, for example, the Where Used tab 
and the History tab are not revision-specific. When you view tabs that are not 
revision-specific, the Rev drop-down list is disabled.
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a revision letter. The following is an example of a Rev list that includes a blank revision created 
by MCO M00001.

(A) C00004
M00001

Introductory

How the Revision List Works
As stated above, a revision labeled Introductory in the Rev list indicates the initial revision of 
the object, with no pending changes. Once the object is listed on a change, a letter sequence of 
revisions is started.

For released revisions, the number of the releasing ECO is displayed next to its corresponding 
revision. (Remember, an item can be revised only by an ECO.) For example, for a part, if ECO 
E54321 resulted in the release of revision C, then revision C in the Rev drop-down list reads

C E54321

A revision number or letter inside parentheses indicates that the revision is pending, not yet 
released:

(A) C00004

You may see revisions in the list that are not Introductory and that do not have an assigned 
revision letter. These are referred to as blank revisions.

Blank revisions occur when an MCO is released against an item before an ECO releases the 
item. That releasing MCO creates a blank revision, as do any subsequent changes that occur 
before a new ECO revision is created. The Rev list displays the number of the MCO instead of 
a revision letter:

M00001

MCOs and SCOs are based on item revisions, but neither can create a new revision of a part, 
and, therefore, neither has attachment capabilities. MCO and SCO modifications, which you 
can select in the Rev drop-down list, inherit the attachments of the ECO-created revision or the 
Introductory revision upon which they are based.

The MCO or SCO number is displayed next to the corresponding revision on the Rev 
drop-down list. For example, if there is a pending MCO M12345 against Rev B of a part, then 
on the Rev drop-down list, that revision is listed as "(B) M12345."

Revisions and Attachment Capabilities
Item attachment operations (add, remove, edit) are revision-based. Attachments can be added to 
or deleted from only an ECO-created revision or an Introductory revision. MCOs and SCOs are 
based on an item revision, but have no revision of their own, and therefore do not have 
attachment capabilities. MCO and SCO modifications, which you can select in the Rev 
drop-down list, inherit the attachments of the ECO-created revision or the Introductory revision 
upon which they are based.

Note: If the ECO-created revision or the Introductory revision is 
incorporated, then you will not be able to add or remove attachments and you 
will not be able to edit the attachments table. For more information about 
item incorporation, see "Incorporating and Unincorporating Items" on 
page 2-22.
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See also "Attachments Tab" on page 2-8. For detailed information about attachments and file 
folders, see the chapter about working with attachment files in Getting Started with Agile PLM. 
For information about ECO-redlining attachment files, see Agile PLM Viewer Addendum.

The following tables illustrate attachment capabilities (add, remove, edit) for different entries 
on the item Rev drop-down list.

How Rev and Site Lists are Determined
All revisions are shown to all users regardless of their default site or site access. However, 
when you open an item, the Rev drop-down list is set to the last change for your default site.

The default revision of an item that is shown is based on your default site. Even if you select a 
different site from the Site drop-down list, then the default revision still reflects what you see 
from your default site.

Working with Pending Revisions
You can create a pending revision of an item. When you create an ECO against an item, the 
ECO creates a pending revision of that item. Pending revisions let you modify the item under 

Table 2–4 Rev list example, item released by ECO, and attachment capabilities

Rev list entry Attachment capabilities

(C) ECO -356 Yes, has attachment capabilities, because it is a pending ECO-created 
Rev.

B SCO-444 No attachment capabilities; it is based on Rev B and inherits Rev B's 
attachments.

B ECO-233 Yes, has attachment capabilities, because it is an ECO-created Rev.

A MCO-888 No attachment capabilities; it is based on Rev A and inherits Rev A's 
attachments.

A ECO-222 Yes, has attachment capabilities, because it is an ECO-created Rev.

INTRODUCTORY Yes, has attachment capabilities, because it is an introductory revision. 
Introductory revisions have the same features as an ECO-created 
revision.

Table 2–5 Rev list example, item released by MCO, and attachment capabilities

Rev list entry Attachment capabilities

(B) MCO-934 No attachment capabilities; pending MCO based on Rev B and inherits 
Rev B's attachments.

B ECO-572 Has attachment capabilities, because it is an ECO-created Rev.

A SCO-444 No attachment capabilities; it is based on Rev A and inherits Rev A's 
attachments.

A MCO-788 No attachment capabilities; it is based on Rev A and inherits Rev A's 
attachments.

A ECO-333 Has attachment capabilities, because it is an ECO-created Rev.

MCO-766 No attachment capabilities; it is based on the Introductory revision and 
inherits the Introductory revision's attachments.

INTRODUCTORY Has attachment capabilities, because it is an introductory revision. 
Introductory revisions have the same features as an ECO-created 
revision.
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change control, including redline modifying its BOM table and its Manufacturers table. You 
can also create pending revision attachment markups.

A pending revision can be identified by the parentheses around the revision number in the Rev 
field, for example, (A).

For information about incorporating pending revisions of items, see "Incorporating and 
Unincorporating Items" on page 2-22.

Attachments on Pending Revisions
By default, when a pending revision is created, it inherits the same list of attached files that are 
attached to the current default revision. If any files are then either added to or removed from the 
current default revision, then those modifications are not reflected on the Attachments tab of 
the pending revision. For additional information about attachments and item revision levels, see 
Getting Started with Agile PLM.

See also: "Removing an Item from the Affected Items Tab" on page 8-26.

Effects of CopyFilesToRev SmartRule
The CopyFilesToRev (Copy Files to Rev) SmartRule setting determines how pending revision 
item attachments are created or referenced. The Agile administrator sets the Agile PLM system 
to either copy, copy with warning, reference, reference with warning or disallow the list of 
attachments to be copied to a new pending revision. There are two "Copy File to Rev" 
SmartRules, one for File folders class and the other for Designs class, which have different 
options and which can be set independently.

When you add an item to the Affected Items table of a pending ECO, you create a pending 
revision of an item. Depending on the Agile PLM Copy Files to Rev SmartRule setting, 
pending revision attachments are processed as followed:

Copy (available for File folders only) - For the item's new pending revision, Agile PLM 
creates a new file folder and creates a new copy of the attachment file, which is placed in 
the new file folder.

Reference - Agile PLM uses the existing file folder and creates a new reference to it on the 
item's new pending revision Attachments tab.

Disallow - The new item pending revision is created with no attachments.

Copy with Warning (available for File folders class only) - The same as the Copy setting, 
with the option of choosing no attachments for the new pending revision.

When you add items to the pending ECO, you are presented with a warning dialog that includes 
a row for each item you are adding.

To add the item and to copy the attachments, check both the Add check box and the 
Attachments check box.

To add the item with no attachments, check only the Add check box.

Reference with Warning - The same as the Reference setting, with the option of choosing 
no attachments for the new pending revision.

When you add items to the pending ECO, you are presented with a warning dialog that includes 
a row for each item you are adding.

To add the item and to reference the existing attachments, check both the Add check box 
and the Attachments check box.

To add the item with no attachments, check only the Add check box.
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When this SmartRule is set to Reference or Reference with Warning, if there are multiple 
versions of any attachment file, then only the reference to the latest version is used for the new 
reference on the pending revision.

For example, if you create an ECO against Part 456, Rev C (thus creating a pending Rev D), 
then all the attachment files that are attached to Rev C are also attached to pending Rev D. (The 
file and file folder references on the Attachments tab of released Rev C are duplicated on the 
Attachments tab of pending Rev D.) Any attachment files that are added to the Attachments 
tab of Rev C, or any other Rev C Attachments tab modifications (for example, modifying the 
file folder version numbers) after the creation of the ECO are not copied to pending Rev D.

Creating a Pending Revision
Writing a pending ECO against an item creates a pending revision of the item. A pending 
revision can be identified by the parentheses around the revision number in the Rev field, for 
example, (A).

To create a pending revision:

1. Create the item.

2. Create an ECO.

3. Place the item on the Affected Items tab of the change.

4. Give the affected item a revision number.

For information about creating changes, see Chapter 7, "Changes."

Modifying Pending Revisions
You modify pending revisions the same way you modify other objects. Because modifying a 
pending revision could affect a released revision, you must have the appropriate privileges to 
modify the Title Block, Page Two, and Page Three fields. If you have privileges to modify 
preliminary items, then you can modify fields on the pending revisions of items. If you have 
privileges to modify released items only (and you do not have privileges to modify preliminary 
items), then you cannot modify fields on the pending revisions of items. If you have questions 
about your assigned modify privileges, see the Agile administrator.

See also: "Editing a Released Item" on page 2-19.

Creating Agile Items
To create an item, you must have the appropriate create Item privilege.

In Web Client, you can create an item with the Create New > Items command or the Actions > 
Save As command.

Note: Attachment files that are added to the Introductory revision after the 
object is associated with a change (that will result in released Rev A) will not 
be copied to subsequent revs. This SmartRule does not affect MCO or SCO 
revisions because MCOs and SCOs do not create separate new revisions.

Note: SCOs are for site-specific changes only. They do not affect common 
site information, and they do not increment the revision number. SCOs 
cannot be used to create a pending revision of a newly created item that has 
never been released.
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In Java Client, you can create an item with the File > New > Item command, the New Object 
button, or the Save As command, on the More Actions menu (click the More button at the top 
of the object window) and on the right-click shortcut menu.

You can also create an item as you add it to the BOM tab of a parent item or the Affected 
Items tab of a change.

This section contains the following topics:

"Creating Items in Web Client" on page 2-15

"Creating an Item Using Save As" on page 2-16

"Creating Items in Java Client" on page 2-17

"Creating an Item Using Add" on page 2-17

The initial revision of an item-that is, the revision of a newly created, unreleased item-is labeled 
Introductory. For more information about Introductory revisions, see "Introductory Revisions" 
on page 2-10.

Once you create an item, that item exists until you delete it. If you create a new item, and you 
then decide that you do not want to keep it, be sure to delete the item. Otherwise, the new item 
is still in the database, and the number cannot be reused. See Appendix A, "Deleting Agile 
Objects."

Creating Items in Web Client
A wizard leads you through the process of creating an item and specifying the BOM, 
manufacturing sites, manufacturers, and attachments.

To create and complete an item in Web Client:

1. Using the Create New menu button, choose the object class you want to create. For 
example:

Create New > Items > Parts

Create New > Items > Documents

2. In the Create New dialog, use the Type drop-down list to select the type (subclass) of item 
you want to create.

3. Assign a number to the item. To do so, either accept the number that appears, click the 
AutoNumber button (123) to use the next autonumber, or type a number.

When you click the AutoNumber button (123) to enter the item number, you might see a 
list of autonumber choices. The autonumber format and sequence are determined by the 
Agile administrator. The Agile administrator also determines whether using autonumbers is 
required or optional.

4. Complete any required fields.

5. Click Save.

The item is displayed in the right content pane with the Title Page tab in edit mode.

6. Edit the title page fields as desired, and click Save.

Or, click any other tab to automatically save the title page and view the tab you selected.

You do not enter information on the Changes, Where Used, or History tabs. Those tabs 
are completed automatically.

See also: "Creating Items in Java Client" on page 2-17, "Creating an Item Using Save As" 
on page 2-16, "Creating an Item Using Add" on page 2-17.
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Creating an Item Using Save As
Using the Save As feature is a quick way to create an item that is similar to an existing item.

For site-specific items, the original item's manufacturing sites are copied to the new item, as are 
all components and manufacturer parts on the common and site-specific portions of the BOM 
and Manufacturers tabs. (Sites for which you do not have privileges are not copied.) If you 
select a specific site in the Site drop-down list and Save As, then only the selected site's data 
will be copied to the newly created item.

For example, parts generally have a BOM tab. By default, documents do not. When you save a 
part as a document, you cannot view the part's BOM in the resulting document unless the Agile 
administrator has configured your system to permit documents to have BOMs.

If the Agile administrator has set the appropriate attributes, then fields in the optional Page 
Two and Page Three sections are copied to the new item. For information about the behavior 
of Page Two and Page Three fields in your Agile PLM system, see the Agile administrator.

If the item has one or more attachments, then the attachments for the new item are created 
using the method specified by the Agile administrator in Agile system preferences:

Create new copy of file(s) - Agile PLM creates a new file folder and creates a new copy 
of the attachment file, which is placed in the new file folder.

Reference existing file(s) - Agile PLM uses the existing file folder and creates a new 
reference to it on the new item's Attachments tab.

Do not copy file(s) - The new item is created with no attachments.

Prompt - You are prompted to select one of the above three methods. If the item has no 
attachments, then no prompt appears.

Save As copies data from a field in the existing object to the same field in the new object. If a 
field or list value in the existing object is not available in the new object, then that field or list 
value is not copied to the new object.

For items using sites:

The new item has only the default site associated with it (that is, the site selected in the 
Sites drop-down list when you performed the Save As action), even if the original item had 
multiple sites. If the new item needs additional sites, then you must add sites to the new 
item manually.

If you select All from the Site drop-down list of the original item and then perform a Save 
As action, then all the sites from the original item are copied to the new item.

If the original item does not have a default site then, after the Save As action, the resulting 
new item also does not have a default site.

Caution: In general, you should not use Save As to create an object in a 
different class or subclass (type) from the original object. The different 
classes or subclasses may not have the same tabs or defined fields, and you 
may lose access to some data in the newly created object.

Note: If you do not have Discovery privilege for any of the items on the 
BOM list of the existing item, then you can use Save As to create a new item, 
which includes the BOM list items that you cannot discover. You also will 
not be able to discover those BOM list items on the newly created item.
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In Java Client, you can create an item using the File > Save As command or the Save As 
command on the More Actions menu (click the More button at the top of the object window) 
and on the right-click shortcut menu.

In Web Client, you can create an item using the Actions > Save As command.

For more information about creating items or other objects using Save As, see Getting Started 
with Agile PLM.

See also: "Creating Items in Java Client" on page 2-17, "Creating Items in Web Client" on 
page 2-15, "Creating an Item Using Add" on page 2-17.

Creating Items in Java Client
The process for creating new objects involves two main steps: creating an empty object, and 
then filling in the object tabs with information specific to the object.

To create and complete an item in Java Client:

1. Using the File menu, choose the object class you want to create. For example:

File > New > Items > Parts

File > New > Items > Documents

2. In the New dialog, use the Type drop-down list to select the type (subclass) of item you 
want to create.

3. Assign a number to the item. To do so, either accept the number that appears, click the 
Autonumber button to use the next autonumber, or type a number.

If more than one autonumber format can be used, then the available autonumber formats 
appear in a list when you click the Autonumber button. Select the autonumber format you 
want.

The autonumber format and sequence are determined by the Agile administrator. The Agile 
administrator also determines whether using autonumbers is required or optional.

4. Complete any required fields.

5. Click OK.

The new item appears with the Title Block tab showing.

6. Fill in information on the item tabs, as desired.

You do not enter information on the Changes, Where Used, or History tabs. Those tabs 
are completed automatically.

See also: "Creating Items in Web Client" on page 2-15, "Creating an Item Using Save As" 
on page 2-16, "Creating an Item Using Add" on page 2-17.

Creating an Item Using Add
When you click the Add button on certain tabs of items and changes, such as the Affected 
Items or BOM tab, you can create a new item to add to the tab.

To add an item to the BOM table by creating a new item, see:

"Web Client, Create New to Add Items to the BOM Table" on page 5-16.

"Java Client, Adding Nonexistent Items to the BOM Table" on page 5-24.

See also: "Creating Items in Java Client" on page 2-17, "Creating Items in Web Client" on 
page 2-15, "Creating an Item Using Save As" on page 2-16.
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Creating a Pending Revision
Writing a pending ECO against an item creates a pending revision of the item. A pending 
revision can be identified by the parentheses around the revision number in the Rev field, for 
example, (A).

To create a pending revision:

1. Create the item.

2. Create an ECO.

3. Place the item on the Affected Items tab of the change.

4. Give the affected item a revision number.

For information about creating changes, see Chapter 7, "Changes."

Modifying Pending Revisions
You modify pending revisions the same way you modify other objects. Because modifying a 
pending revision could affect a released revision, you must have the appropriate privileges to 
modify the Title Block, Page Two, and Page Three fields. If you have privileges to modify 
preliminary items, then you can modify fields on the pending revisions of items. If you have 
privileges to modify released items only (and you do not have privileges to modify preliminary 
items), then you cannot modify fields on the pending revisions of items. If you have questions 
about your assigned modify privileges, see the Agile administrator.

See also: "Editing a Released Item" on page 2-19.

Editing Agile Items
You can edit preliminary and released items in different ways. Preliminary items can be edited 
directly, but released items must be edited with a change order.

This section contains the following topics:

"Editing an Unreleased Item" on page 2-18

"Editing a Released Item" on page 2-19

"Changing an Item's Subclass" on page 2-20

Editing an Unreleased Item
You can edit numbers and much of the other information about an item on the Title Block tab if 
the item has not been released. For additional information about editing an item that has not 
been released, see "Working with Item Revisions" on page 2-9 and "About Modifying the BOM 
Table" on page 5-12.

Note: SCOs are for site-specific changes only. They do not affect common 
site information, and they do not increment the revision number. SCOs 
cannot be used to create a pending revision of a newly created item that has 
never been released.

Note: When you renumber a part that is a child of another item, the 
connection between the parent and child is maintained. If the parent item has 
been released, then you will see a warning asking you whether to continue.
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Whether the item is released or unreleased, you cannot edit item tabs that are completed 
automatically, such as the Where Used tab, the Changes tab and the History tab.

For example, to renumber an unreleased item using Web Client:

1. Open the item.

2. Click Edit.

3. Select the number in the Number field, and type a new number.

Or click the 123 button to assign a new autonumber automatically.

4. When your modifications are complete, click Save to keep them, or click Cancel to close 
the Edit page without saving the changes.

Other fields can be modified in a similar way. For more information about editing object fields, 
see the chapter "Navigating in Agile Web Client" in Getting Started with Agile PLM.

For example, to renumber an unreleased item using Java Client:

1. Open the item.

2. Select the number in the Number field, and type a new number.

Or click to assign a new autonumber automatically.

3. When your modifications are complete, click Save to keep them, or click Close to close 
the object window without saving the changes.

Other fields can be modified in a similar way.

For more information about editing object fields, see the chapter "Navigating in Agile Java 
Client" in Getting Started with Agile PLM.

Editing a Released Item
If you have sufficient privileges, then you can edit most fields on the item object Title Block 
tab even after an item is released, including:

The Number field.

See "Editing an Unreleased Item" on page 2-18.

The Description field.

See "Editing a Released Item's Description Field" on page 2-19.

For more information about editing a released item, see "Redlining the BOM of a Released 
Item" on page 5-38.

With sufficient privileges, you can also add or modify attachments (on the Attachments tab) 
after an item is released.

Editing a Released Item's Description Field

Note: If you have questions about your privileges, ask the Agile 
administrator.

Note: The Agile administrator may have configured Agile PLM so that the 
Description field of a released item can be changed only by using the 
Affected Items tab of a change order.
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If you have sufficient privileges, then you can edit the Description field of the latest released 
revision of an item or of a pending ECO revision.

When you edit a released item's Description field, the new description appears only on the 
latest released revision of the item.

If the Description field has been modified several times, then only the most recent 
modification appears in the Description field of the item.

If the item has pending revisions, then a warning message appears that lets you choose 
whether to copy the new description to the pending revisions as well.

To modify the Description field of a pending revision, use one or both of the following 
methods. The methods available on your Agile system depend upon how the Agile 
administrator has configured the Agile system and which privileges you have.

– Open the item, and then select the pending revision in the Revision drop-down list. 
Then edit the Description field and save your edits. (You must have the appropriate 
privileges.)

– Use the Affected Items tab of the change order. Select the appropriate item row on the 
Affected Items table and click Edit. Edit the (new) item description field, and save 
your edits. (Requires the appropriate privileges.)

Description field modifications on the item are recorded on the History tab of the item 
after the item is released.

Description field modifications from Affected Items tab of a change order are recorded 
on the History tab of the change after the change moves out of the Pending status. Please 
note when the change is released, description field modifications will not be recorded to 
the History tab of the item.

Changing an Item's Subclass
If your administrator has created additional subclasses, and you have the appropriate privileges, 
then you can change the subclass of an item. For example, you can change the subclass of a 
particular document from Specification to Data Sheet.

For information about how to change the subclass of an item, see "Changing an Item's 
Subclass" on page 10-4.

Releasing an Agile Item to Production
Items are not released to production directly. Rather, a change (an ECO) is created against the 
item, and that change is released through the change control process, described in Getting 

Note: If the change order Affected Items tab of the pending revision 
displays both the Old Item Description (latest released revision) and the New 
Item Description (pending revision), then the Old Item Description field on 
the Affected Items table will be updated to reflect the actual item description 
of the latest released revision. The Affected Items table New Item 
Description (pending revision) remains unchanged.

Important: The item Description field cannot be modified through an 
MCO because an MCO does not create a new item revision. The MCO uses 
the Description field information from the ECO revision or Introductory 
revision on which it is based.
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Started with Agile PLM. For more information about ECOs and other Agile changes, see 
Chapter 7, "Changes."

To release an item to production:

1. Follow the steps in "Creating Changes" on page 7-19 to create an ECO that releases the 
item.

2. Route the ECO as described in Chapter 7, "Changes."

3. When the change has progressed through the required statuses, then it is ready for release. 
Usually, this includes at least one Review status type, when users sign off the change.

If AutoPromote is set, then the change is released automatically when the change has been 
signed off and all required values to enable release have been filled in.

If AutoPromote is not set, then click the Next Status button to release the change.

When the change is released, the item is also released.

For more information about working with workflows, see Getting Started with Agile PLM.

Unreleasing an Item
If you have sufficient privileges, and the workflow allows it, then you can unrelease a released 
item.

To unrelease an item:

1. Open the item.

2. Click the Changes tab.

3. Open the change that released the item.

(If there are subsequent changes to the item, then you must first unrelease those changes in 
the reverse order from which they were made.)

4. On the Workflow tab, click the Pending status type in the status chart.

Note: If you have the appropriate privileges, then you can use the 
Workflow tab to move the change directly to the Released status type in the 
workflow.

Caution: Do not unrelease items if you use Agile ChangeCAST or Agile 
Content Service (ACS).

Note: Switching a change to any status in the workflow that occurs before 
the first Released status type unreleases the change and, therefore, unreleases 
the item. If there is no such status displayed as an available status to select in 
the change status flowchart (Pending, Submit, Review, or Hold type), then 
either you do not have the necessary privileges to select that status to 
unrelease the change, or the workflow assigned to the change does not allow 
unreleasing the change. (For information about how to view the sequential 
list of statuses in a workflow, see the chapter "Routing Objects with 
Workflows" in Getting Started with Agile PLM.)

The Change Status dialog opens.
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5. Fill in the Notify field.

6. Enter any comments in the Comments field.

7. Click Finish (Web Client) or OK (Java Client).

Incorporating and Unincorporating Items
If you have sufficient privileges, then you can incorporate an item. When you incorporate an 
item, you lock its attachments so no unauthorized modifications can be made. If you 
incorporate an item with no attachments, then none can be added to it.

This section includes the following topics:

"Overview of File Folders and Item Attachments" on page 2-22

"Overview of Incorporation" on page 2-22

"Pre-incorporating an Item" on page 2-23

"Incorporating an Item" on page 2-23

"Unincorporating an Item" on page 2-24

Overview of File Folders and Item Attachments

All objects have an Attachments tab. On the Attachments tab, you can attach files and URLs 
to the item by referencing those files and URLs in a file folder object. Individual attached files 
are stored in file folder objects and can be attached to multiple objects. On an item's 
Attachments tab, the file folder Version is listed in the attachments table. Each time you check 
out and check in an attachment from the item's Attachments tab, the file folder Version is 
advanced by one number. If you have the appropriate privileges, then you can also edit the 
attachments table and select a specific Version of the file folder.

Because multiple objects, including items, can reference the same file folder, it is possible for 
different items to reference different Versions of the same file folder. Item 123 can reference 
Version 3 of file folder FF444, and Item 987 can reference Version 6 of file folder FF444.

Overview of Incorporation
When you incorporate an item revision, you lock the item's attachments to the specific file 
folder Version currently displayed on the item's Attachments tab. Incorporation is an action 
that applies to item objects only. Non-item business objects, including file folder objects, 
cannot be incorporated.

For example, if the item's attachment is file SPEC.doc, and it is stored in FF004, and the file 
folder Version on the item's Attachments tab is Version 3, then when you incorporate the item, 

Note: For detailed information about attachments and file folder objects, 
see Getting Started with Agile PLM, "Working with Attachments" and 
"Working with File Folders." See also "Attachments Tab" on page 2-8 and 
"Revisions and Attachment Capabilities" on page 2-11.

Note: Only ECO-created revisions and Introductory revisions can be 
incorporated. For more information about attachments and item revisions, see 
"Revisions and Attachment Capabilities" on page 2-11.
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the item's attachments are now locked to Version 3 of FF004. In a similar manner, if the Version 
selected on the item's Attachments tab is Latest-4, then when you incorporate the item 
revision, the file folder Version reverts to Version 4, and is now locked on that Version for the 
incorporated item. If the item has multiple attachments in multiple file folders, then all the file 
folder Versions are locked when you incorporate.

Due to checkout and checkin actions that can be performed from the Attachments tabs of any 
objects that reference the same file folder, and also checkout and checkin actions on the Files 
tab of the file folder object itself, it is possible for the file folder to be modified and additional 
file folder Versions to be created.

Once an item is incorporated, you can no longer check out its attachments from the item's 
Attachments tab. Copies can be taken of attachments to view the attachment copy and to work 
with the attachment copy, but the attachments cannot be amended on that revision of the item 
without unincorporating. (Amending an item's attachments includes adding or deleting 
attachments and changing the file folder Version number shown in the attachments table.) 
Likewise, you cannot incorporate an item that has any files checked out.

Before you can add or edit the attachment files of an incorporated item or the file folder 
Versions referenced by an incorporated item, the item must first be unincorporated. Once the 
changes are made, the item can be incorporated again. Appropriate privileges are required to 
either incorporate or unincorporate items.

The Incorporated/Unincorporated status refers to all the attachments to the item for a specific 
revision. When you incorporate an item, only that revision with its attachments is incorporated. 
For example, if you have three unincorporated revisions of an item (revisions C, D, and E), 
then when you incorporate revision D, revisions C and E remain unincorporated.

For information about working with attachments and file folder objects, see Getting Started 
with Agile PLM.

See also: "Incorporating and Unincorporating Items" on page 2-22.

Pre-incorporating an Item
An item with a pending change can be incorporated before it is released, in which case it is 
referred to as pre-incorporated. Pre-incorporating an item provides a way to mark a revision as 
tentatively complete, and to freeze attachments to prevent checkout. (It is still possible to get a 
copy of an attachment, but the files attached to an incorporated item revision cannot be 
modified.)

Pre-incorporation is performed the same way as incorporation, except that it is performed on an 
unreleased item. For instructions, see "Incorporating an Item" on page 2-23.

See also: "Incorporating and Unincorporating Items" on page 2-22.

Incorporating an Item
You cannot incorporate an item that has any attachment files checked out.

To incorporate an item using Web Client:

1. Open the item.

2. Choose Actions > Incorporate.

To incorporate an item using Java Client:

Important: Regardless of how many Versions a file folder has, once you 
incorporate an item revision, it always refers to the locked file folder Version.
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1. Open the item.

2. Click the More button at the top of the object window to display the More Actions menu 
and choose Incorporate.

Or, right-click in the window, and choose Incorporate from the shortcut menu.

If an item is incorporated before it is released, then the incorporation process is performed in 
the same manner, but it is known as pre-incorporation. See "Pre-incorporating an Item" on 
page 2-23.

See also: "Incorporating and Unincorporating Items" on page 2-22.

Unincorporating an Item
When you unincorporate an item, only that particular revision is unincorporated.

To unincorporate an item using Web Client:

1. Open the item.

2. Choose Actions > Unincorporate.

To unincorporate an item using Java Client:

1. Open the item.

2. Click the More button at the top of the object window to display the More Actions menu 
and choose Unincorporate.

Or, right click in the window, and choose Unincorporate from the shortcut menu.

See also: "Incorporating and Unincorporating Items" on page 2-22.

Attribute History Report
In Web Client, you can use the Actions menu to execute the Item Attribute History report for 
the item you are viewing. For more information, see also:

"Item Attribute History Report" on page 9-15

"Compare Item Attributes Report" on page 9-9

"What are Change Controlled Attributes?" on page B-9

To execute the Item Attribute History report:

1. In the Actions menu, choose Attribute History Report. The Run Item Attribute History 
Report wizard appears.

2. In the Select Layout and Configuration wizard step, select the layout you want from the 
drop-down list, or use the Edit button to edit an existing layout or use the Create button to 
create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

3. Select a report output format: PDF, WORD, EXCEL, or HTML.

4. Click Next. The Select Item wizard step appears.

5. The currently viewed item is pre-selected for you.

You can either accept the pre-selected item or you can remove the pre-selected item and 
choose a different item. Type in the text field or click to execute a quick search.
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6. In the Change Type field, use the drop-down list to select the changes you want to include 
in the report: Changer Orders, Manufacturing Orders, or Both.

7. Click finish to run and display the report.

You are prompted to download the report in the format you selected.

Where Used Tab
The item object Where Used tab lists all the assemblies that use the item. The information on 
this tab is filled in automatically.

The Where Used tab includes two tables:

Where Used - displays the latest released revision of the assemblies where the item is 
used. If the assembly has never been released, then the Introductory revision is displayed. 
For more information, see "Introductory Revisions" on page 2-10.

Pending Change Where Used - displays the pending revisions of the assemblies where 
the item is used, including the associated change order number.

To view or hide the Pending Where Used table in Web Client:

On the Web Client Where Used tab, click the sub-tab you want to view:

Pending Changes Where Used

Where Used

To view an item from the Where Used tab using Web Client:

Click the item number.

To view or hide the Pending Change Where Used table in Java Client:

Use the View drop-down list to select either Show Pending or Hide Pending.

To view an item from the Where Used tab using Java Client:

Double-click the item row in the where-used table.

For information about site information displayed in the Where Used tables, see Sites and the 
"Where Used Tab" on page 2-25.

Sites and the Where Used Tab
The item object Where Used table displays all the assemblies where the item is used. 
Assemblies can be listed multiple times, once per site. The Sites column in the Where Used 
table shows common (blank) and site-specific portions of the BOM that include the item.

For more information about the where used tables, see "Where Used Tab" on page 2-25.

Note: When you first view the Where Used tab, the Pending Change 
Where Used table is hidden by default.

Note: If you do not have Discovery privilege for an item, then it does not 
appear on the Where Used tab. You may see a message telling you how 
many items are not displayed. For more information, see "Details about 
Discovery and Read Privileges" on page 10-1.
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Viewing Site-specific Where Used
You can filter the Where Used tab to display assemblies where the item is used from specific 
manufacturing site.

To view a site-specific where used:

1. From the title block tab, select specific site from the Site drop-down list.

2. Go to Where Used tab. Where Used table displays the combination of common items and 
site-specific items. 

The Sites column of site-specific items displays the associated site name while the Sites 
column is blank for common items.

Deleting Items
For information about deleting items, see Appendix A, "Deleting Agile Objects."

Printing Item Tabs
You can print object tabs and other data from your Agile PLM system. You can print the current 
tab or all tabs. Attachments are printed from their native applications or from the AutoVue for 
Agile viewer.

In Web Client, with the object open, choose Actions > Print.

In Java Client, with the object open, use the Print button.

For additional information about printing objects, see Getting Started with Agile PLM.

Note: Pending Changes Where Used Tab always display items from ALL 
manufacturing site. The table contains common items and site-specific items 
from ALL sites associated with the item.
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What is Agile Distributed Manufacturing?
When the Agile administrator enables the Agile PLM Sites license, the Agile Site object is 
available and Agile PLM multi-site manufacturing functions become available. Agile multi-site 
manufacturing capabilities are used to assist a company that builds its products in multiple 
locations (distributed manufacturing). Before taking this step, you must determine and plan 
how Agile PLM multi-site manufacturing will be integrated with your ERP system.

Agile multi-site manufacturing helps a company that builds its products in multiple locations to 
do so by enabling parts and documents in those locations that are specific to the manufacturing 
process. In Agile PLM, revisions are global item attributes. If a part is used in two 
manufacturing sites, then it must share the revision level, although the effectivity dates and 
disposition settings can be different.

The Agile multi-site manufacturing features allow you to annotate product data with three types 
of site relationships:

Item object-to-Site relationship

An item can be associated with one or more sites by adding the site object to the sites table 
on the item Sites tab. Item-site relationships are similar, but not identical to ERP item-site 
relationships. You can see if an Agile part is enabled in any sites by viewing its Sites tab.

– Parts that are not released in any site have only global item effectivity dates and 
dispositions.

– Parts released in sites can have both site-specific item effectivity dates and 
dispositions and global item effectivity dates and dispositions.

BOM row-to-Site relationship

Note: For information about implementing and configuring Agile multi-site 
manufacturing, see Administrator Guide.

Caution: Agile PLM multi-site manufacturing functionality is built 
differently than ERP sites or organizations. Agile Site objects and ERP sites 
or organizations are similar, but they are not identical. You should work with 
an Oracle Consulting - Agile practice representative to plan your Agile PLM 
to ERP integration before you enable the Agile Sites license. The type of 
information that you want to track in Agile PLM and how you choose record 
that information in Agile PLM may depend on how product information is 
stored in your ERP system.
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BOM row-site relationships are unique to Agile PLM. A child part can relate to its parent 
with no site relationship or through one or more specific sites. Each BOM row has either 
no site relationship or one site relationship. Use multiple rows, one for each site, to 
represent more than one site relationship for the same child part.

– A child part that reports to its parent without a specific BOM row-site relationship is 
considered a common part, that is, a part common to all manufacturing sites.

– A child part that reports to its parent with a BOM row-site relationship is a 
site-specific part, that is, a part that is specific to the related manufacturing site.

AML table row-to-Site relationship

On the Manufacturers tab of a part, you can specify site-specific AMLs (Approved 
Manufacturer List). Rows on the part manufacturer table can be common (specify no site) 
or a site-specific (associated with a site listed on the Sites tab of the part). BOM row-site 
relationships and AML row-site relationships are independent of one another.

– A manufacturer part without a specific AML row-to-site relationship is a common 
manufacturer part and can be used at any manufacturing site.

– A manufacturer part with an AML row-to-site relationship is a site-specific 
manufacturer part, which enables the manufacturer part to be used at the specified 
manufacturing site.

Other important Agile PLM sites and ERP sites differences to keep in mind:

In many ERP systems, a part can appear in different sites and have independent revisions. 
Agile PLM considers the revision to be a global attribute of the part. Therefore, site-based 
revisions are not supported in Agile PLM. To accommodate this need, simply prefix or 
suffix the part number with a unique string, for example SJC-P1000 and NYC-P100. These 
are unique parts which have global revision, but because these parts are not used in other 
sites their revisions appear to be site-specific.

The item-site relationship and the BOM row-site relationship are independent of one 
another in that you can add a part to a BOM as a site-specific BOM row without first 
adding the site to the part. Unlike typical ERP systems, Agile does not require that a part 
must first be released in a site before it can be added to a site-specific BOM row.

When adding a row to a BOM where the parent has sites that are not on the child, Agile 
PLM prompts the user to add the sites to the child. This occurs only on the initial add of 
the BOM row - either in authoring mode (direct editing of a part) or in redlining mode 
(modifying a part through change redline). The user can choose only to Copy the sites onto 
the child to add the row to the BOM. Choosing Close will not add the BOM row. If 
additional sites are subsequently added to the parent, then the newly added sites are not 
automatically copied to the child. If sites are removed from the child, then no check is 
made on whether there is inconsistency between sites on the parent and the child.

The SmartRule Child Released First is enforced by the Release Audit when a part is 
released. When a parent part is released, this rule checks the BOM components for site 
association and whether the BOM components are also released. The Release Audit 
verifies whether the item has been released by a Change or Manufacturer Change after a 
site was added. To correctly pass this SmartRule, then the item must be released after 
adding a site.

What Are Sites?
In Agile PLM, site objects represent manufacturing sites. Companies that practice distributed 
manufacturing use several different manufacturing sites for their products. For example, Widget 
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Corporation manufactures its products at the corporate location in Austin, Texas, but also at 
manufacturing plants in Taiwan, Singapore, Mexico City, and Milpitas, California.

Site objects ensure that each ERP has only the relevant information for its production needs. 
For example, companies can manage what is sent to each internal ERP site or contractor in a 
Make or Buy site association.

Site objects help ease the production transfer from one manufacturing site to another. For 
example, the Widget Corporation can transfer an entire product from their Taiwan prototype 
site to their Mexico City production site by adding the production site association to all the 
parts in the Taiwan BOM that are not in the Mexico City BOM, and then send the BOM to 
Mexico City through an engineering change order (ECO) or a site change order (SCO).

Site objects also help formalize the site effectivity process by allowing a user to create a 
proposed effectivity date change (SCO) against a part revision. For example, if a site 
production date has to be changed to a later date, then an SCO against the part provides a 
simple record of approvals and reasons for changing the effective date.

The following diagram illustrates how sites can be used in Agile PLM. The three sites in this 
diagram vary in ERP system, effectivity date, and manufacturer. Also, Site 3 has added 
site-specific build instructions.

Figure 3–1 Example of Manufacturing Sites in use

How Sites Can Be Used
You can use sites to record and manage site-specific AMLs, BOMs, and effectivity dates.

This section includes the topics:

"Different AMLs at Each Site" on page 3-4.

"Different BOMs at Each Site" on page 3-4

"Different Effectivity Dates and Dispositions at Each Site" on page 3-4
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Different AMLs at Each Site
Often, different sites use different manufacturers and manufacturer parts to build the same 
products. Reasons for the differences could be cost (for example, it may be more cost-effective 
for a site to use a nearby manufacturer) or status of a manufacturer, to name two examples. The 
AML for an assembly can include different manufacturer parts for the various manufacturing 
sites.

See also: "How Sites Work" on page 3-4.

Different BOMs at Each Site
The BOM of an assembly can include items that pertain only to specific sites. The common 
BOM lists all items that constitute the core assembly, and that BOM is the same for all sites. 
However, the appropriate users assigned to each manufacturing site can add site-specific items 
to the BOM (thus creating a site-specific portion of the BOM). Often, these additional items are 
documents, such as assembly instructions specific to how something is built at a site.

See also: "How Sites Work" on page 3-4.

Different Effectivity Dates and Dispositions at Each Site
Items may have different effectivity dates and dispositions at each site. This enables, for 
example, the Austin site to begin using revision B of an item while Singapore continues to use 
revision A until stock has run out.

Effectivity dates and dispositions are specified on the Affected Items tab of an ECO or an 
SCO. To create a new revision when you assign the new effectivity date or disposition, then use 
an ECO. To assign site-specific effectivity dates and dispositions without incrementing the 
revision, use an SCO.

See also: "How Sites Work" on page 3-4.

How Sites Work
Site objects, similar to manufacturer objects, hold information about each site. Users with 
appropriate privileges can create additional sites.

This section includes the topics:

"Site Information on BOMs and AMLs" on page 3-4

"Sites Tab of Items" on page 3-5

"Changes and Sites" on page 3-5

"Controlling Access to Sites" on page 3-5

"Common BOM/AML Sections" on page 3-5

Site Information on BOMs and AMLs
When you view an item's BOM or AML (Manufacturers tab), you can choose to view it for all 
sites or for a specific site. When you view the BOM or AML for a specific site, the common 
BOM or AML is included in the list.

See also: "How Sites Work" on page 3-4, "Viewing BOMs by Site" on page 5-7, "Viewing 
AML Information by Site" on page 4-18.
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Sites Tab of Items
Each item includes a Sites tab. The Sites tab lists the sites where that item can be used. If a site 
is not listed on an item's Sites tab, then that item cannot be included in the portion of a BOM 
specific to that site. If all the sites of the parent BOM are not listed on an item's Sites tab, then 
that item cannot be included in the common portion of a BOM. For a detailed explanation, see 
"Common BOM/AML Sections" on page 3-5.

See also: "How Sites Work" on page 3-4, "How Sites Can Be Used" on page 3-3.

Changes and Sites
Changes can affect all sites of an item or a specific site. The Affected Items tab lets you select 
sites to affect as you add affected items. Use site change orders (SCOs) to create site-specific 
changes to an item without changing the revision.

See also: "How Sites Work" on page 3-4, "Changes and Manufacturing Sites" on page 7-16, 
"Site Change Orders" on page 7-18.

Controlling Access to Sites
The use of sites is controlled by:

Your organization's enabled licenses.

Your assigned roles and privileges.

Your assigned Sites property in your user profile.

Your assigned Default Site property in your user profile determines which site you see by 
default.

You can create as many sites as you want.

Your organization may have implemented sites in such a way that users can access only the 
information pertaining to certain sites.

Your user profile Sites list controls which site objects you can discover in the Agile database 
and which item site-related rows (BOM tab, Manufacturers tab) you can discover. Your Read 
privileges control your ability to read site object attributes.

Users with Administrator privilege have the ability to assign all sites when modifying a user's 
User Profile attributes. However, when searching for sites in Web Client or Java Client, the 
Administrator user can discover only the sites listed in the Sites list of their own User Profile.

See also: "How Sites Can Be Used" on page 3-3, "How Sites Work" on page 3-4.

Common BOM/AML Sections
The common section of the BOM distinguishes information that is shared between all the sites 
listed on the Sites tab of the item. All the parts in the common section of the BOM of an 
assembly must have listed on their Sites tabs all the sites that are listed on the Sites tab of the 
assembly. That is, they have those sites in common.

For example, if part 300 is to appear on the Milpitas-specific portion of the BOM of assembly 
234, then part 300 and assembly 234 must both have the Milpitas site listed on their Sites tabs. 
If assembly 234 has three sites (Milpitas, India, and San Jose) on its Sites tab, for part 300 to 
appear on the common portion of the BOM of assembly 234, then part 300 must also have at 
least those three sites (Milpitas, India, and San Jose) included on its Sites tab. That is, they 
must have those sites in common. (Part 300's Sites tab may also include additional sites that do 
not relate to assembly 234.) A SmartRule (Items Released First) controls whether Agile checks 
an item's BOM components for the appropriate site association at release. Compliance with the 
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SmartRule is checked when an ECO, SCO, or MCO releases the assembly. You can also use the 
change Audit Release feature to check for compliance before release.

See also: "Creating a Common BOM" on page 2-5, "Creating a Site-Specific BOM" on 
page 2-6.

Where Sites Are Documented
You can find information about sites in the following sections:

Site Objects
A site object contains general information about a site. Unlike items, sites do not need to go 
through a release process.

This section includes the following topics:

"General Info Tab Fields - Sites" on page 3-7

"Attachments Tab" on page 3-9

"History Tab" on page 3-9

To locate and open a site object, follow the instructions in Getting Started with Agile PLM.

The following table lists the tabs for sites.

The Agile administrator may have added additional sections to the Title Block or General 
Information tab, called Page Two and Page Three by default (Web Client). In Java Client, 
these are separate tabs. These sections or tabs contain custom fields defined by the 
administrator.

Table 3–1 Topics related to Sites and where you can find that information

Topic Section or chapter

Site objects This chapter

Sites tab of items This chapter and Chapter 2, "Items"

Viewing site-specific information The following chapters:

Chapter 2, "Items"
Chapter 5, "Bills of Material"
Chapter 7, "Changes"
Chapter 4, "Manufacturing Objects"

Site-specific BOMs Chapter 5, "Bills of Material"

Site-specific AMLs Chapter 4, "Manufacturing Objects"

SCOs Chapter 7, "Changes"
Chapter 8, "Affected Items of Changes"

Effects of changes on sites Chapter 7, "Changes"
Chapter 8, "Affected Items of Changes"

Redlining site-specific information Chapter 8, "Affected Items of Changes"

Site-specific effectivity dates and 
dispositions

Chapter 8, "Affected Items of Changes"

Table 3–2 Site object tabs

Site tab name Tab information includes

General Info General information about the site
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General Info Tab - Sites
The General Info tab has fields that contain basic information about a site. Some fields are 
filled in automatically and you complete the rest. You may not be able to edit the content of 
some fields.

This section includes the following topics:

"General Info Tab - Sites" on page 3-7

"Site Lifecycle Phase" on page 3-8

A"AML Required on Buy Field" on page 3-8

"Site AML Allowed Field" on page 3-8

General Info Tab Fields - Sites
By default, the site object General Info tab contains the fields listed in the following table.

Attachments Attached drawings, files, and URLs pertaining to the site

History Actions taken on the site, for example, when attachments were added and 
removed

Table 3–3 Site object General Info tab fields

Field Definition

Name The name of the site. This field must be filled in with a unique value.

Type The subclass (type) of the site object.

Lifecycle Phase The current state of the site: Enabled or Disabled.

Site ERP Code The ERP system in use at the site, if applicable.

Address, Geography, 
Province/Region/State, 
Country/Area, City, Postal 
Code, Phone, URL, Fax,

Contact information for the site.

Contact The name of the contact person for the site.

Email The email address of the contact person.

Buyer The buyer code for the item at this site. Select one from a list of codes 
that have been assigned for sites.

Planner The planner code for the item at this site. Select one from a list of 
codes that have been assigned for sites.

Color The color associated with this site. Choose from a list of colors. This 
color will be used on the BOM, Manufacturers, and Affected Items 
tabs to distinguish common items from site-specific items. The same 
color can be used for more than one site.

Site AML Allowed For items specified as Buy, indicates whether a site-specific 
manufacturer value is required, allowed, or disallowed.

AML Required on Buy Indicates whether a manufacturer value is required for an item when 
the item is specified as a Buy (as opposed to a Make) for this site. 
Whether an item is Buy or Make is shown by the Make/Buy field on 
the Sites tab of the item.

Table 3–2 (Cont.) Site object tabs

Site tab name Tab information includes
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See also: "Site Objects" on page 3-6, "Site Lifecycle Phase" on page 3-8, "AML Required on 
Buy Field" on page 3-8, "Site AML Allowed Field" on page 3-8.

Site Lifecycle Phase
A site can be in one of the following states, as indicated in the Lifecycle Phase field on the 
General Info tab of the site:

– Enabled - When a site is enabled, users can define all site properties of the site itself. 
Also, users can associate the site with an item, define item-site properties, create 
site-specific BOMs and AMLs, and create changes for site-specific items.

– Disabled - All sites are disabled when they are first created. When a site is disabled, 
users cannot create site-specific BOMs, AMLs, or changes. However, disabled sites 
are displayed in searches and reports. Any in-process changes that involve a site that 
has been disabled are allowed to continue through release, but users will not be able to 
edit the site-specific Affected Item table rows associated with the disabled site, and 
users cannot make any redline add or redline edit modifications to in-process changes 
when the site has been disabled.

To change a site's lifecycle phase, select a lifecycle phase from the drop-down list.

See also: "General Info Tab Fields - Sites" on page 3-7.

AML Required on Buy Field
The AML Required on Buy field of a site determines whether an AML is required for an item 
when the item is specified as a Buy for a given site.

When an item is released, Agile checks to determine the sites for which the item is being 
released, as indicated on the Affected Items tab of the releasing change. Agile then checks the 
Make/ Buy field on the item's Sites tab to determine if any of the sites are specified as Buy. If 
an item is specified as a Make for all sites, then this rule is ignored.

Possible AML Required on Buy values are Yes or No (the default).

No - Default value. At time of release, the Agile PLM system does not check for whether 
the item has an AML for the site. The item can still be released. However, the Agile PLM 
system does perform additional checking on the setting of Site AML Allowed property.

Yes - The item being released must have either a common AML or an AML that is specific 
to the sites that are specified as Buy sites for the item.

When AML Required on Buy is set to Yes, if an autopromotion attempts to release the item 
(through a change), but the item does not have a site-specific AML for the appropriate sites, 
then the promotion fails, and the appropriate person is notified.

See also: "General Info Tab Fields - Sites" on page 3-7.

Site AML Allowed Field
This field, used when the item is specified as a Buy for a given site, governs whether an AML 
for an item:

Must be specific for the site

Can be modified for a specific site

Note: Whether an item is specified as a Buy is determined by the value in 
the Make/Buy field on the Sites tab of the item.
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Can use only the common site AML

When an item is released, the system checks to determine the sites for which the item is being 
released, as indicated on the Affected Items table of the releasing change. The Site AML 
Allowed field of the site object is then checked to determine if any of these sites are required or 
allowed to have a site-specific AML.

Possible Site AML Allowed values are Allowed (the default), Required, and Disallowed:

Allowed - The item being released is allowed to have a site-specific AML for the site, but 
it is not required. The item can be released.

Required - The item being released must have a site-specific AML for the sites specified 
as Buy sites for the item. The item cannot be released until this condition is satisfied.

If an auto-promotion attempts to release the item (through a change), but the item does not 
have a site-specific AML for the appropriate sites, then the promotion fails, and the 
appropriate person is notified.

Disallowed - The item being released cannot have a site-specific AML for the site. If the 
item has a site-specific AML, then it cannot be released.

If an autopromotion attempts to release the item (through a change), and the item includes 
a site-specific AML, then the promotion fails, and the appropriate person is notified.

If a site-specific AML is created for an item (through modification to the AML or redline of the 
AML), then, when the item is released, the system checks the Site AML Allowed field of the 
sites to determine if any of the sites have Site AML Allowed set to Disallowed. If a site is 
disallowed, then you cannot release a site-specific AML for that site.

See also: "General Info Tab Fields - Sites" on page 3-7.

Attachments Tab
All objects have an Attachments tab. On the Attachments tab, you can attach files and URLs 
to the object by referencing those files and URLs in a file folder object. On the Attachments 
tab, you can view, copy (get), or print attached files if you have the appropriate privileges.

Individual attached files are stored in file folder objects and can be attached to multiple objects. 
The files in a file folder object can be drawings or scanned images, documents, non-viewable 
files, compressed files, and so on.

For detailed information about working with file folder objects and the Attachments tab, see 
Getting Started with Agile PLM.

See also: "Site Objects" on page 3-6.

History Tab
The History tab shows a summary of actions taken against an object, including a description of 
the action, which user took the action, the date of the action, and other details.

Note: Whether an item is specified as a Buy for a given site is determined 
by the value in the Make/Buy field on the Sites tab of the item.

Note: If you do not have the appropriate Read privilege for an object, then 
you cannot see the contents of the fields on the History tab. See "Details 
about Discovery and Read Privileges" on page 10-1.
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The types of actions recorded for sites are:

Creating the site

Attachment actions: view, open, add, delete, and get

Save As

Send

Print

Change subclass

Modification of any field of a site

See also: "Site Objects" on page 3-6.

Creating Sites
The process for creating new objects involves two main steps: creating an empty object, and 
then filling in the object tabs with information specific to the object.

To create a site, you must have the appropriate Create Site privilege.

In Web Client, you can create a site with the Create New > Sites command or the Actions > 
Save As command.

In Java Client, you can create a site with the File > New > Sites command or the New Object 
button, or the Save As command, on the More Actions menu (click the More button at the top 
of the object window) and on the right-click shortcut menu.

Choose a color to help visually distinguish common items from site-specific items on the 
BOM, Manufacturers, Changes and Affected Items tabs. In Java Client, the site colors also 
appear on the item Where Used tab. For more information about site colors, see "General Info 
Tab Fields - Sites" on page 3-7.

When you create a site, you automatically have access to information specific to that site. The 
new site is included in the Sites field in your user profile.

Creating a Site Using the Save As Feature
Using the Save As feature is a quick way to create a site that is similar to an existing site.

All General Information and Page Two field values and Page Three (depending on Agile 
system settings) field values are copied to the new site. The new site's lifecycle phase is 
Disabled. The Attachments are created using the preferred method selected by the Agile 
administrator (Create New, Reference Existing, Do Not Copy Files, or by prompting). The 
History tab of the original site reflects that the new site was copied from it.

For more information about creating a site using Save As, see Getting Started with Agile PLM.

See also: "Creating an Item Using Save As" on page 2-16, and "Creating Sites" on page 3-10.

Associating a Site with an Item
This section includes the following topics:

Note: The site name must be unique to a site, just as an item number must 
be unique to an item.
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"Fields on the Sites Tab" on page 3-11

"Adding Sites to the Sites Tab" on page 3-12

"Removing Sites from the Sites Tab" on page 3-13

To make an item available to site-specific BOMs, you must add the sites to the item's Sites tab. 
If a site is not listed on an item's Sites tab, then you cannot define a site-specific BOM or AML 
for the item. A site can be listed only once on the Sites tab.

The Sites tab is not under change control, so you do not need to create a change to modify the 
information on this table.

Fields on the Sites Tab
The following table lists default fields on the Sites tab of items.

See also: "Adding Sites to the Sites Tab" on page 3-12, "Removing Sites from the Sites Tab" on 
page 3-13.

Modifying the Make/Buy Field on the Item Sites Tab
If you have the appropriate modify privileges, then you can modify the Make/Buy field in the 
Sites table of an item, even if the item has been released. However, the Make/Buy setting is not 
revision-specific. When you modify the Make/Buy setting on any item revision, it is also 
modified for all revisions. The following restrictions apply when modifying the Make/Buy 
setting:

When the item is included on the affected items table of a change order, the release audit 
validates the Site AML Allowed and AML Required on Buy settings of the site with the 
item Sites tab Make/Buy setting for that revision. Past revisions are not audited. (A release 
audit is performed automatically when the change order is released.)

Table 3–4 Item object Sites tab fields

Field Definition

Site Name The name of the site. Not editable from the Sites tab.

Buyer The buyer code for the item at this site. Select one from a list of codes 
that have been assigned for sites.

Planner The planner code for the item at this site. Select one from a list of 
codes that have been assigned for sites.

Make/Buy Indicates whether this site makes or buys the item.

Cost Yes or No. Indicates, for this site, whether there is a cost associated 
with the item.

Quote As Select from list. Indicates, for this site, how the item is to be quoted, 
for example, assembly or component.

Currency Default currency for this site.

Standard Cost Standard cost for the item for this site.

Target Cost Target cost set for the item for this site.

First Released Change The change that first released the item to this site. This is 
automatically filled in when the item is released. Not editable from the 
Sites tab.

Site Lifecycle Phase The current state of the site: Enabled or Disabled. Not editable from 
the Sites tab.

Site Type The subclass of the site. Not editable from the Sites tab.
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Because the Make/Buy setting is not revision-specific and can be changed without using a 
change order, any validation violations caused by a modification to Make/Buy remain on 
the latest released revision of the item and may not be detected until the next time the item 
is added to a change order and the change order is release audited.

For more information, see "AML Required on Buy Field" on page 3-8, and "Site AML Allowed 
Field" on page 3-8.

Adding Sites to the Sites Tab
When you add sites to the Sites tab of an item, you select the sites from a list. That list includes 
all enabled sites that you have access to-sites with a lifecycle phase of Enabled that are 
included in the Sites field of your user profile. Disabled sites do not appear in the list because 
disabled sites cannot be added to the Sites tab of an item.

After you add a site to the Sites tab of an item, you can edit the table to enter values for the 
other fields in the Sites table. You cannot change the Site Name value in the Sites table. To 
change which site is listed, remove the site and then add a new one.

See also: "Removing Sites from the Sites Tab" on page 3-13.

To add a site to the Sites tab in Web Client:

1. Click the Add button or press Ctrl-I to open the search pop-up.

2. To select Sites to add you can type the Site names:

a. If you know the names of the Sites you want, then, in the pop-up field, type the names 
separated by semicolons.

b. Begin typing a Site name in the pop-up field and Agile PLM displays a list of Sites 
that match the typed characters.

c. Use the up arrow and down arrow keys to highlight the Site you want.

d. Press the Tab key to add the Site to the pop-up field.

e. Repeat to add additional sites.

f. Press the Enter key to add the objects to the table.

To cancel, press the Escape key to close the search pop-up.

3. You can also search for Sites to add:

a. Click the pop-up Search button to open the Sites Search palette.

b. Type the search criteria.

c. Press the Enter key or click the Search button to run the search.

d. Double-click a search result row to add the Site to the table.

e. Type new search criteria to run a different search.

f. When you are finished, press Enter to close the Sites Search palette.

After you add a site to the Sites tab of an item, you can double-click a cell on the Sites table to 
begin editing and enter values for the other fields in the Sites table

To add a site to the Sites tab in Java Client:

1. On the Sites tab of an item, you can use the Add button in two ways:

2. Click the Add button to display the dialog that lets you select multiple sites. When you 
have made your selections, click OK.
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3. Click the drop-down arrow portion of the Add button to select the site name you want in 
the drop-down list.

After you add a site, you can select the site row on the Sites table and edit it to enter values for 
the other fields in the Sites table

Removing Sites from the Sites Tab
You can remove a site from the Sites tab of an item, if the item has not been released to that site 
and if you have the appropriate privileges. When an item has been released to a site, the site 
cannot be removed from the Sites tab of the item. Deleting a site from the Sites tab does not 
delete the site object from the database.

If you try to remove a site that is referenced by a site-specific BOM or AML, then the system 
displays a warning. Removing such a site also removes the corresponding site-specific BOMs 
and AMLs and site-specific Affected Item table rows and site-specific redlines on changes.

When a site is released on an item, the site is not allowed to be removed

To remove a site from an item's Sites tab in Web Client:

1. Select the site that you want to remove.

2. lick the Remove button on the Sites tab.

To remove a site from an item's Sites tab in Java Client:

1. Select the site that you want to remove.

2. Click the Remove button on the Sites tab.

See also: "Adding Sites to the Sites Tab" on page 3-12.

Deleting Site Objects
For important details about deleting site objects, see "Details about Discovery and Read 
Privileges" on page 10-1.

Editing Sites
Any user with the necessary privileges can modify values entered for a site. Sites are not 
required to go through the change control process and all modifications go into effect 
immediately.

To edit a site in Web Client:

1. Display the site's General Info tab.

2. Click Edit.

3. Make the changes you want.

4. Click Save.

To edit a site in Java Client:

1. Display the site's General Info tab.

2. Make the changes you want.

3. Click Save.

Keep the following in mind regarding some fields on the General Info tab:
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Name - If you change a site name, then the change is made to the Sites tab of the items 
where the site is listed and to any other tabs where the site is listed, such as the BOM tab. 
You cannot change the site name to the same name as another site.

Buyer or Planner - A buyer or planner cannot be removed if listed on the Site table of an 
item.

AML Required on Buy and Site AML Allowed - If you edit AML Required on Buy or 
Site AML Allowed, then released items are not affected. The new values are enforced with 
any new items and newly released changes.

See also: "Creating Sites" on page 3-10.

Printing Sites
You can print object tabs and other data from your Agile PLM system. You can print the current 
tab or all tabs. Attachments are printed from their native applications or from the AutoVue for 
Agile viewer.

In Web Client, with the object open, choose Actions > Print.

In Java Client, with the object open, use the Print button.

For additional information about printing objects, see Getting Started with Agile PLM.
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4Manufacturing Objects

Agile PLM provides a way to track the relationships between items and their manufacturers and 
to create an approved manufacturers list (AML). 

What Is Agile AML?
This section covers the following topics:

"What Does Agile AML Do?" on page 4-1

"About Manufacturing Objects" on page 4-1

"Many-to-One Relationships in Agile AML" on page 4-2

The Agile Approved Manufacturers List (AML) solution enables an organization to manage 
information related to manufacturers and the parts they produce.

What Does Agile AML Do?
With Agile AML, you can quickly find, for instance, which manufacturers are producing a 
particular part, their identification information for that part, where that part is used, and contact 
information for the manufacturer.

The AML of an item is represented by the rows of information on the Manufacturers tab of 
the item. Each row represents a manufacturer part. See "Manufacturers Tab of an Item" on 
page 4-16.

Additionally, you can use manufacturer change orders (MCOs) to change manufacturing data.

About Manufacturing Objects
The AML features let you work with the following manufacturing objects:

The manufacturer - this object holds data about product manufacturers, including contact 
information and where their parts are used in your assemblies.

The manufacturer part - this object describes product parts from the manufacturers' point 
of view, with information such as their part numbers and their names for that part, and also 
information about where this part is used in your assemblies and which manufacturing sites 
use this manufacturer part.

For more information about manufacturing objects, see "Manufacturing Objects: Manufacturers 
and Manufacturer Parts" on page 4-3.

Note: You can also use a site change order (SCO) to change site-specific 
manufacturing data.
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Many-to-One Relationships in Agile AML
AML capabilities allow you to track complex, many-to-one relationships. The following figure 
shows an example of a more complex situation such as those commonly found in real-life 
manufacturing.

Figure 4–1 Example of AML many-to-one relationships

In this example, one part has more than one manufacturer part, and some manufacturers 
provide more than one manufacturer part.

Sites and AML Data
A manufacturer part can apply to all manufacturing sites where the product is built, some sites, 
or just one site. The common portion of the AML lists AML information that is shared between 
all the sites assigned to the item. Each site can add other manufacturing information to the 
AML table that is site-specific-for example, manufacturers that are used by the site because 
they are located nearby. Also, a manufacturer part may be Preferred at one site and Alternate at 
another site. Manufacturer parts used by multiple sites are listed multiple times on the AML 
tab, once for each site.

The AML Required on Buy field of a site determines whether a manufacturer part is required 
for an item when the item is specified as a Buy for a given site. For more information about 
AML Required on Buy, see "AML Required on Buy Field" on page 3-8.

Note: Depending on the Agile Administrator setting for the Multiple Items 
Per Manuf Part SmartRule, your Agile PLM system may be configured so 
that a manufacturer part can be added to the Manufacturers tab of only one 
item. Contact the Agile administrator if you have questions about 
manufacturer parts associated with multiple items.

Note: Whether an item is specified as a Buy is determined by the value in 
the Make/Buy field on the Sites tab of the item.
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Setting Up Manufacturing Data
To track manufacturing data in Agile PLM, you must first set up the manufacturers in your 
database and then create the manufacturer parts that they produce for use in your assemblies.

Order is important. You cannot create a manufacturer part until you have created the 
corresponding manufacturer.

The process is performed in the following sequence:

1. Create the manufacturer.

For example, create a manufacturer named Acme.

2. Create the manufacturer part.

Create manufacturer part number AM230PS, specifying Acme as the manufacturer.

3. Add the manufacturer part to the Manufacturers tab of the internal part.

For example, on part P001232, go to the Manufacturers tab and add Acme AM230PS.

Once the relationships have been established, it is easy to track manufacturing data activity.

From this point on, manufacturing data can be managed through the redlining process. This is 
discussed in "Redlining through ECOs, DFCOs, MCOs, and SCOs" on page 7-20.

To set up manufacturer data in the database:

1. Create the manufacturer. This represents the manufacturer of the purchased part.

See "Creating and Managing Manufacturing Objects" on page 4-8.

2. Create the manufacturer part. This represents the part that the manufacturer produces.

See "Creating and Managing Manufacturing Objects" on page 4-8.

3. Match the manufacturer part to the corresponding item by adding it to the item's 
Manufacturers tab.

See "Adding a Manufacturer Part to the Manufacturers Tab" on page 4-19.

Manufacturing Objects: Manufacturers and Manufacturer 
Parts

This section covers the following topics:

"Manufacturing Object Tabs" on page 4-3.

"About Manufacturers" on page 4-7.

"About Manufacturer Parts" on page 4-7.

Manufacturing Object Tabs
Manufacturing objects have several of the same tabs as items (Where Used, Attachments, 
Relationships, and History), but they also have differences. For example, they have a General 
Info tab rather than a Title Block tab, and they do not have a Changes tab or BOM tab.

Note: Manufacturing objects are not subject to the change control process 
and can be created, edited, and deleted by any user granted the necessary 
privileges. Those changes go into effect immediately.
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The table below lists the default fields on the tabs of these two manufacturing objects.

The Agile administrator may have added additional sections (Web Client) or tabs (Java Client), 
called Page Two and Page Three by default. These sections or tabs contain custom fields 
defined by the administrator.

Manufacturer object tabs:

Manufacturer Part object tabs:

Table 4–1 Manufacturer object tabs

Tab Fields include

General Info tab Name
Lifecyle
Phase
Mfg. Type
Contact
URL
D-U-N-S Number
contact information

Where Used tab Item Number
Item Description
Mfr. Part Number
Mfr. Part Lifecycle Phase
See "Where Used Tab" on page 4-5.

Attachments tab Attachment Number
Attachment Description
File Name
File Version
File Size
File Type
Modified Date
Last View Date
Checkout User
Checkout Date
Checkout Folder
For information about working with attachments see Getting Started 
with Agile PLM.

History tab Action
User
Local Client Time
User Action Time (optional)
Comments
Details
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Where Used Tab
The manufacturer Where Used tab lists all the manufacturer part numbers for the manufacturer 
and the items that use the manufacturer parts. The information on this tab is filled in 
automatically.

Table 4–2 Manufacturer Part object tabs

Tab name Fields include

General Info tab Manufacturer Name
Manufacturer Part Number
Description
Mfr. Part Type
Lifecycle Phase
Item Group(s) - If this field has been enabled, then it displays the 
item group of which the current manufacturer part is a member

PG & C fields - The following fields are related to Agile PG&C. For 
more information, see the Agile Product Governance and Compliance 
User Guide.

Compliance Calculated Date
Part Family
Mass
Overall Compliance

Where Used tab Where Used table includes:

Item Sites
Item Number
Item Description
Mfr. Tab Preferred Status
Mfr. Tab Reference Notes
Pending Change Where Used table includes the same fields as above, 
with one additional field:

Pending Change

See "Where Used Tab" on page 4-5.

Attachments tab Attachment Number
Attachment Description
File Name
File Version
File Size
File Type
Modified Date
Last View Date
Checkout User
Checkout Date
Checkout Folder
For information about working with attachments see Getting Started 
with Agile PLM.

History tab Action
User
Local Client Time
User Action Time (optional)
Comments, Details

Prices tab This tab relates to Agile PCM.

For more information, see the Product Cost Management User Guide.

Compliance tab

Suppliers tab

These tabs relate to Agile PG&C.

For more information, see Agile Product Governance & Compliance 
User Guide.
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The manufacturer part Where Used tab lists all the items that use the manufacturer part. The 
information on this tab is filled in automatically.

The Where Used tab includes two tables:

Where Used - displays the latest revision of the items where the manufacturer part is used. 
Latest revision can be either an Introductory revision or the latest released revision.

Pending Change Where Used - displays the pending revisions of the items where the 
manufacturer part is used, including the pending change order number.

To view or hide the Pending Change Where Used table in Web Client:

1. On the Where Used tab, click the Pending Changes Where Used sub-tab.

To view an item from the Where Used tab using Web Client:

1. Click the item number.

To view or hide the Pending Change Where Used table in Java Client:

1. Use the View drop-down list to select either Show Pending or Hide Pending.

To view an item from the Where Used tab using Java Client:

1. Double-click the item's row.

Sites and the Manufacturer Part Where Used Tab
When you view the Where Used tab of a manufacturer part, the table displays where-used 
information according to item number and manufacturing site.

See also: "How Sites Work" on page 3-4.

Manufacturer Part Prices Tab

The Prices tab displays the price information for this manufacturer part. The information on 
this tab is filled in automatically. Click the price object number (in the Number column) to 
open that price object. For more information see the Product Cost Management User Guide.

Where Used Tab and the Discovery Privilege
If you do not have Discovery privilege for an item, site, or manufacturing object, then it does 
not appear on the Where Used tab. The Agile administrator can specify whether to display a 
warning message telling you how many objects are not displayed. (For sites, this applies only to 
the Where Used tab of manufacturer parts. The Where Used tab of manufacturers does not 
include a column for site information.) For more information, see "Details about Discovery and 
Read Privileges" on page 10-1.

Note: When you first view the Where Used tab, the Pending Change 
Where Used table is hidden by default.

Note: If your company has the necessary licenses, and you have been 
granted the necessary privileges, then you can perform the Prices tab 
processes described here.
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Read Privilege
Your Read privileges and Enforce Field Level Read privileges determine which fields you are 
able to view. For more information, see "Details about Discovery and Read Privileges" on 
page 10-1.

About Manufacturers
Manufacturer objects contain information about manufacturers with which your organization 
collaborates.

Creating a manufacturer is the first step in adding a new manufacturer part to the Agile PLM 
database. After you create the manufacturer, then you create the manufacturer part in 
association with that manufacturer. When you then associate the manufacturer part with an 
item, the manufacturer part is referenced on the Where Used tab of the manufacturer object.

If you have the necessary privileges, then you can modify a manufacturer object directly at any 
time. Manufacturers are not under change control.

To find manufacturers in your Agile PLM database, use the same search process as you use for 
any other object. For more information about searches, see Getting Started with Agile PLM.

See also: "Lifecycle Phase of a Manufacturer" on page 4-7, "D-U-N-S Number" on page 4-7.

Lifecycle Phase of a Manufacturer
The lifecycle phase field on the General Info tab of the manufacturer object indicates its 
lifecycle phase. The following table lists the default manufacturer lifecycle phases. The Agile 
administrator may define a customized list of lifecycles for your Agile PLM system.

See also: "Lifecycle Phase of a Manufacturer Part" on page 4-8.

D-U-N-S Number
The D-U-N-S Number field enables companies to list the DUNS of their suppliers in the 
system.

D-U-N-S stands for Data Universal Numbering System. A D-U-N-S number is a unique 
nine-digit sequence that identifies an organization.

See also: "Manufacturing Object Tabs" on page 4-3.

About Manufacturer Parts
The manufacturer part object displays information about a part produced by a specific 
manufacturer, including the manufacturer's part number, lifecycle phase, where it is used, and a 
history of actions affecting that manufacturer part.

The combination of the manufacturer name and manufacturer part number must be unique to 
that manufacturer part. In other words, you cannot create another manufacturer part for the 
same manufacturer using the same manufacturer part number. Agile PLM does support the 
situation in which different manufacturers use an identical part number, however.

Table 4–3 Manufacturer object Lifecycle phases

Lifecycle name Lifecycle definition

Approved This is an approved manufacturer.

Disqualified This manufacturer is no longer qualified for use.

Obsolete This manufacturer is no longer available for use.
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If you have the necessary privileges, then you can modify a manufacturer part object directly at 
any time. Manufacturer parts are not under change control.

To find manufacturer parts in your Agile PLM database, use the same search process as you use 
for any other object. For more information about searches, see Getting Started with Agile PLM.

After you create a manufacturer part, then you can add it to the Manufacturers tab of the Agile 
part to which it corresponds. For more information about working with manufacturer parts, see 
"Creating and Managing Manufacturing Objects" on page 4-8.

Lifecycle Phase of a Manufacturer Part
The lifecycle phase field on the General Info tab of the manufacturer part object indicates its 
lifecycle phase. The following table lists the default manufacturer part lifecycle phases. The 
Agile administrator may define a customized list of lifecycles for your Agile PLM system.

See also: "Lifecycle Phase of a Manufacturer" on page 4-7.

Creating and Managing Manufacturing Objects
This section covers the following topics:

"Creating Manufacturers" on page 4-8.

"Creating a Manufacturer Using the Save As Feature" on page 4-9.

"Creating Manufacturer Parts" on page 4-10.

"Modifying Manufacturing Objects" on page 4-16.

Creating Manufacturers
In Web Client, you can create a manufacturer with the Create New > Manufacturers 
command or the Actions > Save As command.

In Java Client, you can create a manufacturer with the File > New > Manufacturers command 
or with the New Object button, or the Save As command, on the More Actions menu (click the 
More button at the top of the object window) and on the right-click shortcut menu.

Unlike items, manufacturers do not need to go through the release process. They are 
immediately available for use.

Although different manufacturers can use the same manufacturer part number, the combination 
of manufacturer plus manufacturer part number must be unique to one manufacturer part 
object.

The process for creating new objects involves two main steps: creating an empty object, and 
then filling in the object tabs with information specific to the object.

To create a manufacturer using Web Client:

Table 4–4 Manufacturer Part object Lifecycle phases

Lifecycle name Lifecycle definition

Active This manufacturer part is available for use.

Obsolete This manufacturer part should no longer be used.

Note: The manufacturer name must be unique to one manufacturer, just as 
an item number must be unique to an item.
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1. Choose Create New > Manufacturers.

2. In the Create New dialog, use the Type drop-down list to select the type (subclass) of 
manufacturer you want to create.

3. Type a unique name for the manufacturer.

4. Complete any required fields.

5. Click Save.

The new manufacturer appears in the content pane with the General Info tab displayed in 
edit mode.

6. Fill in information on the General Info tab and click Save.

7. Fill in information on the remaining manufacturer tabs, as desired.

You do not enter information on the Where Used and History tabs. Those tabs are 
completed automatically.

To create and complete a manufacturer using Java Client:

1. Choose File > New > Manufacturers.

2. In the New dialog, use the Type drop-down list to select the type (subclass) of 
manufacturer you want to create.

3. Type a unique name for the manufacturer.

4. Complete any required fields.

5. Click OK.

The new manufacturer appears with the General Info tab showing.

6. Fill in information on the manufacturer tabs, as desired.

You do not enter information on the Where Used and History tabs. Those tabs are 
completed automatically.

See also: "Modifying Manufacturing Objects" on page 4-16.

Creating a Manufacturer Using the Save As Feature
Using the Save As feature is a quick way to create a manufacturer that is similar to an existing 
manufacturer.

In Web Client, you can create a manufacturer using the Actions > Save As command.

In Java Client, you can create a manufacturer using the File > Save As command, the Save As 
command on the More Actions menu (click the More button at the top of the object window) or 
the Save As command on the right-click shortcut menu.

To create a manufacturer using the Save As command in Web Client:

1. Select and open an existing manufacturer.

2. Choose Actions > Save As.

Caution: In general, you should not use Save As to create an object in a 
different class or subclass (type) from the original object. The different 
classes or subclasses may not have the same tabs or defined fields, and you 
may lose access to some data in the newly created object.
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3. If appropriate, select a different manufacturer type (subclass) from the list.

4. Enter the name of the new manufacturer.

5. Complete any required fields.

6. Click Save.

The new manufacturer appears in the content pane with the General Info tab displayed in 
edit mode.

7. Edit information on the General Info tab as required and click Save.

To create a manufacturer using the Save As command in Java Client:

1. Select and open an existing manufacturer.

2. Choose File > Save As.

3. If appropriate, select a different manufacturer type (subclass) from the list.

4. Enter the name of the new manufacturer.

5. Complete any required fields.

6. Click OK.

The new manufacturer opens with the General Info tab on top.

See also: "Modifying Manufacturing Objects" on page 4-16.

Creating Manufacturer Parts
To create manufacturer parts, you must have the appropriate Create Manufacturer Parts 
privilege.

In Web Client, you can create a manufacturer part with the Create New > Manufacturer Parts 
command. From an open manufacturer object, you can create a manufacturer part with the 
Actions > Create Manufacturer Parts command. You can also use the Actions > Save As 
command from an open manufacturer part.

In Java Client, you can create a manufacturer part with the File > New > Manufacturer Parts 
command or with the New Object button. You can also use the File > Save As command when 
a manufacturer part is open.

You can also create a manufacturer part on-the-fly as you add information to the 
Manufacturers tab of an item.

Unlike items, manufacturer parts do not need to go through the release process. They are 
immediately available for use.

See also:

"Creating a Manufacturer Part in Web Client" on page 4-11

"Creating a Manufacturer Part in Java Client" on page 4-11

"Creating a Manufacturer Part Using the Save As Feature" on page 4-14

"Modifying Manufacturing Objects" on page 4-16

Note: Different manufacturers can use the same manufacturer part number, 
however, the combination of manufacturer plus manufacturer part number 
must be unique to one manufacturer part object.
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Creating a Manufacturer Part in Web Client
To create a manufacturer part using Web Client:

1. Choose Create New > Manufacturer Part. (You can also choose Actions > Create 
Manufacturer Part from within a manufacturer.)

2. In the Create New dialog, use the Type drop-down list to select the type (subclass) of 
manufacturer part you want to create.

3. Select the manufacturer of the new manufacturer part by using one of the following 
methods:

Type-ahead search:

a. In the Manufacturer Name field, begin typing the name of the manufacturer. Agile 
PLM searches for manufacturer names that begin with the characters you type.

As you type, Agile PLM displays a list of the matching values alphabetically and 
automatically displays the first matching value in the Manufacturer field.

b. Use the up arrow and down arrow keys to highlight a value in the list. Press the 
Return key to select the highlighted value.

Or, click a value in the list to select it.

Quick Search:

a. Click the Launch the Palette button.

b. Enter the search criteria and click Search. Agile PLM searches for manufacturer 
names that contain the specified text.

c. In the search results table, double-click the name of the manufacturer you want.

d. Press the Escape key to close the search palette.

Create to Add:

a. Click the Create to Add button.

b. In the Create New dialog, use the Type drop-down list to choose a manufacturer 
subclass.

c. Enter the name of the new manufacturer.

d. Click Save.

4. Type a number for the manufacturer part.

5. Complete any required fields.

6. Click Save.

The manufacturer part is displayed in the right content pane with the General Info tab in 
edit mode.

7. Edit the General Info fields as desired, and click Save.

You do not enter information on the Where Used and History tabs. Those tabs are 
completed automatically.

Creating a Manufacturer Part in Java Client
To create and complete a manufacturer part using Java Client:

1. Choose File > New > Manufacturer Parts.
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2. In the New dialog, use the Type drop-down list to select the type (subclass) of 
manufacturer part you want to create.

3. Select the manufacturer of the new manufacturer part.

4. In the Manufacturer Name field, type the manufacturer name or a portion of the 
manufacturer name. Press the Tab key or click the Validate checkmark: 

If you enter a valid and unique manufacturer name, then Agile PLM selects that 
manufacturer name and the Validate checkmark is disabled. Press the Tab key to 
continue with the next step.

If you did not enter a valid and unique manufacturer name, then the resolution dialog 
appears.

In the resolution dialog, select the manufacturer you want and click OK.

If the manufacturer you want does not appear in the search results, then you can 
perform another search or you can create a new manufacturer:

– Search - In the resolution dialog, select a search method. If you choose to 
perform a simple search, then enter the value to search for and click Search. You 
can also define an advanced search, run a saved search, or select a bookmarked or 
recently visited manufacturer (Shortcuts). (For more information about searches, 
see Getting Started with Agile PLM.) In the search results, select the manufacturer 
you want, and click OK.

– Create - If you need to create a new manufacturer for the manufacturer part, then 
click the Create button in the resolution dialog. A create dialog appears that lets 
you select the manufacturer type (subclass) in the Type drop-down list and enter 
the manufacturer name. Click OK. The resolution dialog closes and the newly 
created manufacturer is selected.

For further details, see "How to Use Java Client Manufacturer Name Automatic 
Validation" on page 4-13.

5. Type a number for the manufacturer part.

6. Complete any required fields.

7. Click OK.

The new manufacturer part appears with the General Info tab showing.

8. Fill in information on the manufacturer part tabs, as desired.

You do not enter information on the Where Used and History tabs. Those tabs are 
completed automatically.

Java Client Manufacturer Name Automatic Validation
Whenever you create a manufacturer part, or add to or edit the table of an item's 
Manufacturers tab, Agile PLM provides an automatic search and validation process to quickly 
search for and select the manufacturer you want to specify.

This section includes the topics:

"Where is Java Client Manufacturer Name Automatic Validation Used?" on page 4-13

"How to Use Java Client Manufacturer Name Automatic Validation" on page 4-13
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Where is Java Client Manufacturer Name Automatic Validation 
Used?
Agile PLM Java Client uses automatic manufacturer name validation whenever you create a 
manufacturer part or you edit manufacturer part information.

With the appropriate privileges, you can create a manufacturer part by using the following 
Agile PLM features:

Object creation: File > New or Create New button.

Item object Manufacturers tab, add manufacturer part by create.

Change object Affected Items tab, Redline Manufacturers tab, add by create.

Change object Affected Items tab, manufacturer part bulk change process.

With the appropriate privileges, you can edit manufacturer part information on the following 
tabs:

Item object Manufacturers tab.

Change object Affected Items tab, Redline Manufacturers tab.

Change object Affected Items tab, manufacturer part bulk change process.

How to Use Java Client Manufacturer Name Automatic Validation
Whenever manufacturer name automatic validation is used, follow these steps:

1. In the Manufacturer Name field of the create or edit dialog, type the name of the 
manufacturer or a portion of the name for which you want to search.

If you enter a valid and unique manufacturer name, then Agile PLM selects that 
manufacturer name and the Validate checkmark is disabled. Press the Tab key to move to 
the next field in the dialog.

For example, to find the manufacturer name Motorola, then you can type any of the 
following text strings to begin your search. Agile PLM performs a Starts With search for 
any manufacturer name that starts with the letters you typed.

mot

motorla

mo

2. When you move the cursor out of the Manufacturer Name field, the validation process 
begins and the validation dialog appears. You can move the cursor out of the name field by 
using any of the following methods:

Press the Tab key.

Click the Validate checkmark in the Manufacturer Name field.

Note: You may leave the Manufacturer Name field blank. When the 
resolution dialog appears, use the search options to search for the 
manufacturer you want or to create a new manufacturer.

Note: Agile PLM automatically adds an asterisk character * to the end of 
the text string.
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Click another field in the dialog.

Attempt to exit the edit dialog by clicking OK.

Attempt to exit the create dialog by clicking OK.

3. In the resolution dialog, select a manufacturer name in the search results and click OK. 
The resolution dialog closes and the selected manufacturer name appears in the 
Manufacturer Name field of the create or edit dialog.

If the manufacturer name you want does not appear in the search results, then you can:

Run another search.

Select a search method. If you choose to perform a simple search, then enter the value 
to search for and click Search. You can also define an advanced search, run a saved 
search, or select a bookmarked or recently visited manufacturer (Shortcuts). (For more 
information about searches, see Getting Started with Agile PLM.)

Create a new manufacturer object.

Click the Create button in the resolution dialog to create a manufacturer object. See 
"Creating Manufacturers" on page 4-8.

See also: "Where is Java Client Manufacturer Name Automatic Validation Used?" on 
page 4-13.

Creating a Manufacturer Part Using the Save As Feature
Using the Save As feature is a quick way to create a manufacturer part that is similar to an 
existing manufacturer part.

To create a manufacturer part using the Save As command in Web Client:

1. Select and open an existing manufacturer part.

2. Choose Actions > Save As. The Save As dialog appears.

3. If appropriate, select a different manufacturer part type (subclass) from the list.

4. Select the manufacturer of the new manufacturer part, if desired.

To select a different manufacturer for the new manufacturer part, use one of the following 
methods:

Type-ahead search:

a. In the Manufacturer field, begin typing the name of the manufacturer. Agile PLM 
searches for manufacturer names that begin with the characters you type.

As you type, Agile PLM displays a list of the matching values alphabetically and 
automatically displays the first matching value in the Manufacturer field.

Caution: In general, you should not use Save As to create an object in a 
different class or subclass (type) from the original object. The different 
classes or subclasses may not have the same tabs or defined fields, and you 
may lose access to some data in the newly created object.

Note: If you use the same manufacturer, then you do not need to modify 
the Manufacturer Name field.
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b. Use the up arrow and down arrow keys to highlight a value in the list. Press the 
Return key to select the highlighted value.

Or, click a value in the list to select it.

Quick Search:

a. Click the Launch the Palette button.

b. Enter the search criteria and click Search. Agile PLM searches for manufacturer 
names that contain the specified text.

c. In the search results table, double-click the name of the manufacturer you want.

d. Press the Escape key to close the search palette.

Quick New:

a. Click the Create New button.

b. In the Create New dialog, use the Type drop-down list to choose a manufacturer 
subclass.

c. Enter the name of the new manufacturer.

d. Click Save.

5. Enter the new manufacturer part number.

6. Complete any required fields.

7. Click Save.

The new manufacturer part opens with the General Info tab on top.

8. Make any necessary modifications to the other tabs.

To create a manufacturer part using the Save As command in Java Client:

1. Select and open an existing manufacturer part.

2. Choose File > Save As.

3. If appropriate, select a different manufacturer part type (subclass) from the list.

4. Select the manufacturer of the new manufacturer part.

In the Manufacturer Name field, type the manufacturer name or a portion of the manufacturer 
name. Press the Tab key or click the Validate checkmark.

If you enter a valid and unique manufacturer name, then Agile PLM selects that 
manufacturer name and the Validate checkmark is disabled. Press the Tab key to continue 
with the next step.

If you did not enter a valid and unique manufacturer name, then the resolution dialog 
appears.

In the resolution dialog, select the manufacturer you want and click OK.

If the manufacturer you want does not appear in the search results, then you can perform 
another search or you can create a new manufacturer:

– Search - In the resolution dialog, select a search method. If you choose to perform a 
simple search, then enter the value to search for and click Search. You can also define 

Note: If you use the same manufacturer, then you do not need to modify 
the Manufacturer Name field.
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an advanced search, run a saved search, or select a bookmarked or recently visited 
manufacturer (Shortcuts). (For more information about searches, see Getting Started 
with Agile PLM.) In the search results, select the manufacturer you want, and click 
OK.

– Create - If you need to create a new manufacturer for the manufacturer part, then click 
the Create link in the Select Objects dialog. A create dialog opens that lets you select 
the manufacturer type (subclass) in the Type drop-down list and enter the 
manufacturer name. Click OK. The resolution dialog closes and the newly created 
manufacturer is selected.

For further details, see "How to Use Java Client Manufacturer Name Automatic 
Validation" on page 4-13.

See also: "Creating a Manufacturer Part in Java Client" on page 4-11, "Creating a Manufacturer 
Part in Web Client" on page 4-11.

Modifying Manufacturing Objects
Any user with the necessary privileges can modify information about a manufacturing object. 
Manufacturing objects are not required to go through the change control process, therefore, all 
modifications go into effect immediately.

See also: "Creating Manufacturers" on page 4-8, "Creating Manufacturer Parts" on page 4-10.

Deleting Manufacturing Objects
For important details about deleting manufacturing objects, see Appendix A, "Deleting Agile 
Objects."

Manufacturers Tab of an Item
This section includes the following topics:

"Manufacturers Tab of an Item" on page 4-16

"Manufacturers Tab Fields" on page 4-17.

The Manufacturers tab displays information taken from related manufacturing objects. For 
more information, see "Manufacturers Tab" on page 2-6.

See also: "Working with Manufacturing Data on Preliminary Items" on page 4-19, "Modifying 
Manufacturing Data from the Redlines Tab" on page 4-22.

Manufacturers Tab Buttons
The following table lists the buttons on the Manufacturers tab of an item.

Caution: If you change a manufacturer part number or manufacturer name, 
these changes are automatically made to the Manufacturers tab of the items 
where the manufacturer or manufacturer part is listed and to any other tabs 
where the manufacturer is listed, such as the Where Used tab.
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See also: "Working with Manufacturing Data on Preliminary Items" on page 4-19.

Manufacturers Tab Fields
The following table lists the default fields on the Manufacturers tab of an item. The Agile 
administrator may have created additional fields.

Table 4–5 Item object Manufacturers tab, Web Client buttons and actions

Button or Action,
Web Client Description

Edit mode - Enter edit mode 
by double-clicking any 
editable table cell.

Save

Cancel

Lets you edit the AML table using Web Client table editing features. 
The editable fields are in the form of text boxes, list boxes, and so on.

Use the Save and Cancel buttons to either save or cancel your edits.

Remove Removes the selected rows from the table.

Add Displays the Web Client table addition tool, which lets you select 
manufacturer parts to add to the AML table by type-ahead searching, 
quick searching, or by creating a new manufacturer part.

You can use the Add button if there is no ECO or MCO created 
against the item.

Table 4–6 Item object Manufacturers tab, Java Client buttons and actions

Button, Java Client Description

Edit (Java Client)
Lets you edit the AML row by displaying the selected rows in edit 
mode. The editable fields are in the form of text boxes, list boxes, and 
so on.

Remove (Java Client)
Removes the selected rows from the table.

Add > Create

(Java Client)

Add > Search

(Java Client)

Adds a manufacturer part at the end of the table. It can be an existing 
manufacturer part or one you create while adding it. (Use the button 
drop-down list to choose either the Search or Create add method.) You 
can use this button if there is no ECO or MCO created against the 
item.

View Redline (Java 
Client)

For the selected row, opens the associated change object with the 
Redline Manufacturers tab displayed.

Table 4–7 Item object Manufacturer tab fields

Field name Description

(icon)

Has Attachment

The appearance of this icon indicates that the manufacturer part has an 
attachment.

Click this icon to open the manufacturer part with its Attachments tab 
displayed.

Mfr.Name The name of the manufacturer.
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See also: "Working with Manufacturing Data on Preliminary Items" on page 4-19, "Modifying 
Manufacturing Data from the Redlines Tab" on page 4-22, "Viewing AML Information by Site" 
on page 4-18.

Viewing AML Information by Site
You can view the AML for a specific site by selecting a site from the Site drop-down list above 
the tabs. Sites included in the list are the sites specified on the Sites tab of the item that are also 
listed in the Sites field of your user profile.

When you select a site, the Manufacturers tab displays the common AML plus the AML of 
the site you selected. To view the AML for all sites at once, select ALL in the Site list.

You can perform actions only on the items associated with the selected site. For example, if you 
select San Francisco in the Site drop-down list, then you see all manufacturer parts that are part 
of the common and San Francisco portions of the AML.

The Rev and Site drop-down lists work independently. For more details, see "Working with 
Item Revisions" on page 2-9.

Associating a Manufacturer Part with Its Corresponding Item
After you have created a manufacturer and a manufacturer part, you associate them with a part 
in the Agile PLM system. You do this by adding the manufacturer part to the Manufacturers 
tab of the Agile part only for preliminary items. Otherwise, this requires a change through an 
MCO, ECO, or SCO. This establishes the link between your part (Agile PLM item object) and 
their part (manufacturer part number, for example, Motorola 467), which makes it possible to 
track the use of their part throughout the system.

You can list more than one manufacturer part from the same manufacturer, or from more than 
one manufacturer. For example, if a manufacturer makes two parts that you sometimes use for 
that assembly, then you can mark one as Preferred and the other as Alternate. (You can do the 
same thing if two different manufacturers supply a part.)

Mfr. Part Number The number assigned to the manufacturer part by the manufacturer of 
the part.

Mfr. Part Description The description assigned to the manufacturer part by the manufacturer 
of the part.

Mfr. Part Lifecycle Phase Indicates whether the manufacturer is an active manufacturer of the 
part.

Preferred Status Indicates whether the manufacturer is preferred or an alternate for this 
part.

Sites Lists the sites that use the manufacturer part.

Reference Notes Notes about the manufacturer.

Summary Compliance Compliance information. For more information, see Product 
Governance & Compliance User Guide.

AML Split

(visible only if the Agile 
administrator has enabled it)

Lets you define the percentage allocated for the manufacturer part at 
the selected site. For more information, see Product Cost Management 
User Guide.

Table 4–7 (Cont.) Item object Manufacturer tab fields

Field name Description
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Depending on the lifecycle phase of an item (and your assigned privileges), you can modify 
Manufacturers tab data by one of these methods:

Add or modify directly on the Manufacturers tab of items. This method is for preliminary 
items with no pending or released ECOs or MCOs. See "Adding a Manufacturer Part to the 
Manufacturers Tab" on page 4-19.

Use an ECO, MCO, or SCO to modify manufacturing data on the redlines tab. This method 
is for released items or items with pending ECOs or MCOs. See "Adding a Manufacturer 
Part on the Redline Manufacturers Tab" on page 4-24.

Important Considerations When Working with Manufacturing 
Objects

Once a manufacturing object has been used on the Manufacturers tab of an item, any 
alterations you make to the manufacturing object are also made on the Manufacturers tab of 
that item. Because manufacturing objects are not required to go through the change control 
process, all modifications that are made go into effect immediately. Because these alterations 
are not made through a change object, they will not be passed to the ERP system by 
ChangeCAST or Agile Content Service. To avoid potential problems between the Agile PLM 
and ERP systems, it is important to bear this in mind when making changes to any 
manufacturing object that is in use on an item's Manufacturers tab.

See also: "Modifying Manufacturing Data from the Redlines Tab" on page 4-22.

Working with Manufacturing Data on Preliminary Items
The following sections describe how to modify data directly on the Manufacturers tab of an 
item has not been released and does not have a pending revision:

"Adding a Manufacturer Part to the Manufacturers Tab" on page 4-19

"Deleting a Manufacturer Part from the Manufacturers Tab" on page 4-21

"Modifying a Manufacturer Part on the Manufacturers Tab" on page 4-21

Adding a Manufacturer Part to the Manufacturers Tab
You can add manufacturer parts to the Manufacturers tab of an item.

To add a manufacturer part to the Manufacturers tab in Web Client:

1. On the Manufacturers tab, select the site for which you want to add the manufacturer part 
from the Site drop-down list.

2. Click the Add button. The table addition palette appears adjacent to the Mfr. Part 
Number column.

3. Select the manufacturer part by using one of the following methods:

Type-ahead search:

a. If you did not select a site in the object Site drop-down list, then you can select a site 
now in the palette drop-down list.

Note: If you want a manufacturer part to apply to a specific site, then 
before adding the manufacturer part to the Manufacturers tab, select that site 
from the Site drop-down list above the tabs.
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In the Mfr. Part Number field, begin typing the number of the manufacturer part. 
Agile PLM searches for manufacturer part numbers that begin with the characters you 
type.

b. As you type, Agile PLM displays a list of the matching values alphabetically and 
automatically displays the first matching value in the Mfr. Part Number field.

Use the up arrow and down arrow keys to highlight a value in the list. Press the Return 
key to select the highlighted value.

Or, click a value in the list to select it.

Quick Search:

a. Click the Launch the Palette button.

b. If you did not select a site in the object Site drop-down list, then you can select a site 
now in the palette drop-down list.

c. Enter the search criteria and click Search. Agile PLM searches for manufacturer part 
numbers that contain the specified text.

d. In the search results table, double-click the name of the manufacturer part you want.

Or, highlight a search result row and press Enter.

e. Press the Escape key to close the search palette.

Create New:

1. Click the Create to Add button.

2. In the Create New dialog, use the Type drop-down list to choose a manufacturer 
subclass.

3. Select the name of the new manufacturer.

4. Enter the manufacturer part number

5. If you did not select a site in the object Site drop-down list, then you can select a site 
now in the palette drop-down list.

6. Click Add.

To add a manufacturer part to the Manufacturers tab in Java Client:

1. 1. On the Manufacturers tab, select the site for which you want to add the manufacturer 
part from the Site drop-down list.

2. 2. In the Add button drop-down list, choose either Add > Create or Add > Search.

3. 3. If you chose Add > Create, then:

a. Fill in the required information in the New dialog. See "Creating Manufacturers" on 
page 4-8..

If you enter information for a manufacturer part that already exists, then Agile PLM 
displays a prompt asking you whether to use the existing manufacturer part when you 
click OK in step c.

b. If you have not already done so, select the site to which you want to associate the 
manufacturer part for this item. Select Common to associate the manufacturer part 
with this item for all sites assigned to this item.

c. Click OK.

4. If you chose Add > Search, then:
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a. In the Select Object dialog, select a search method to search for an existing 
manufacturer part, or select a bookmarked or recently visited manufacturer part 
(Shortcuts). If you choose to perform a simple search, then enter the value to search 
for. (For morin information about searches, see Getting Started with Agile PLM.)

b. If you have not already done so, select the site to which you want to associate the 
manufacturer part for this item. Select Common to associate the manufacturer part 
with this item for all sites assigned to this item.

c. Click OK.

See also: "Modifying Manufacturing Data from the Redlines Tab" on page 4-22.

Deleting a Manufacturer Part from the Manufacturers Tab
To delete a manufacturer part from the Manufacturers tab of an item that is in the 
Preliminary lifecycle phase in Web Client:

1. On the Manufacturers tab, select the manufacturer part row to be deleted.

2. Click the Remove button on the Manufacturers tab.

To delete a manufacturer part from the Manufacturers tab of an item that is in the 
Preliminary lifecycle phase in Java Client:

1. On the Manufacturers tab, select the manufacturer part row to be deleted.

2. Click the Remove button on the Manufacturers tab.

See also: "Modifying Manufacturing Data from the Redlines Tab" on page 4-22.

Modifying a Manufacturer Part on the Manufacturers Tab
You can directly edit manufacturer part information from the Manufacturers tab of an item if 
the item is in the preliminary state, has never been released, and has no pending ECOs or 
MCOs against it.

To edit values for a manufacturer part in Web Client:

1. Open the item to be edited.

2. On the Manufacturers tab, double-click any editable cell in the redline Manufacturers 
table to edit the field. The table is now in edit mode.

3. Press the Tab key or the arrow keys to move the focus to the next editable cell.

4. Use the tab toolbar buttons (Add, Remove, More) and table editing features to make the 
modifications you want.

5. Click Save to save your modifications.

To edit values for a manufacturer part in Java Client:

1. Open the item to be edited.

2. On the Manufacturers tab, select the rows that you want to edit.

3. Click the Edit button, and change the data as necessary in the Edit dialog.

You can use the navigation buttons in the open Edit dialog to select other rows to edit.

4. Click OK.

See also: "Modifying Manufacturing Data from the Redlines Tab" on page 4-22.



Modifying Manufacturing Data from the Redlines Tab

4-22 Product Title/BookTitle as a Variable

Modifying Manufacturing Data from the Redlines Tab
If you have the appropriate privileges and Agile PLM system SmartRule settings allow it, then 
you can modify AML information through the Redline Manufacturers tab of an ECO, MCO, 
or SCO.

This section contains the following topics:

"Overview of Redlining Manufacturing Data" on page 4-22

"Redline Manufacturers Tab" on page 4-22

"Adding a Manufacturer Part on the Redline Manufacturers Tab" on page 4-249

"Adding Nonexistent Manufacturer Parts on the Redlines Tab" on page 4-24

"Deleting a Manufacturer Part from the Redlines Tab" on page 4-24

"Editing Manufacturer Part Information on the Redline Manufacturers Tab" on page 4-25

"Undoing Changes to the Redline Manufacturers Tab" on page 4-26

Overview of Redlining Manufacturing Data
On some Agile PLM systems, depending on how the Agile administrator has configured 
settings, you can make manufacturer part redline changes from ECOs, SCOs, and MCOs. 
MCOs can redline only manufacturer parts data; ECOs can redline manufacturer parts data, 
BOMs, and attachments; SCOs can redline manufacturer parts data and BOMs for specific sites 
only.

MCOs and SCOs do not advance, or roll, the revisions of the affected items, however, ECOs do 
advance the revisions of the affected items.

Redlining manufacturing data from an ECO or SCO is the same as the process from an MCO. 
However, because you can use ECOs to redline manufacturing data, BOMs, or attachments, the 
ECO redlines include a Redline BOM tab, a Redline Manufacturers tab, and a Redline 
Attachments tab. The SCO redlines include a Redline BOM tab and a Redline 
Manufacturers tab.

For more information about changes, see Chapter 7, "Changes."

Redline Manufacturers Tab
You display the Redline Manufacturers tab from the Affected Items tab of an ECO, MCO, or 
SCO.

To open the redlines for the AML of an item in Web Client:

1. Open the change through which you want to redline the AML of an item.

2. On the Affected Items table, select the item you want to redline.

When you choose a view in the Views list that excludes Sites information (for example, 
Hide Site Rows), the items are listed once on the Affected Items table. When you choose a 
view in the Views list that includes Sites information (for example, Base View), the items 
are listed multiple times, once for each site. Simply select one row in the table. If needed, 
then you can select a different site setting on the Redline Manufacturers tab.

Note: If a change includes conflicting redlines made from multiple 
manufacturing sites, then those conflicting redlines are removed from the 
BOM and Manufacturers table for all associated sites.
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3. In the redlines pane at the bottom of the Affected Items tab, display the Manufacturers 
tab.

If you selected a site-specific row in the Affected Items table, then only that row appears in 
the redline Manufacturers tab. If you selected the common site row in the Affected Items 
table, then both the common manufacturer part row and the site-specific manufacturer part 
rows are displayed in the redline Manufacturers tab.

4. Double-click any editable cell in the redline Manufacturers table to edit the field. The table 
is now in edit mode.

5. Use the tab toolbar buttons (Add, Remove, Undo Redlines, More) and table editing 
features to make the modifications you want.

6. Click Save to save your modifications. See the following table for details.

To open the redlines for the AML of an item in Java Client:

1. Open the change through which you want to redline the AML of an item.

2. In the Affected Items table, select the item you want to redline.

The View drop-down list has two settings: Hide Sites and Show Sites. When you select 
Hide Sides, the items are listed once on the Affected Items table. When you select Show 
Sites, the items are listed multiple times, once for each site. Simply select one row in the 
table. If needed, then you can select a different site setting on the Redline Manufacturers 
tab.

3. In the bottom pane of the Affected Items tab, display the Redline Manufacturers tab.

4. In the Site drop-down list, select the site for which you want to redline manufacturer part 
information. Select ALL to redline manufacturer part information for all the item's sites.

5. Select a row in the Redline Manufacturers table and use the buttons to make the 
modifications you want. See the following table for details.

Table 4–8 Redline Manufacturers tab buttons and actions, Web Client

Web Client button Action

Double-click an editable cell 
to enter table edit mode.

Use the Web Client edit features to edit table cells. Press Tab or arrow 
keys to move the focus to the next editable cell.

More menu In table edit mode, choose Copy, Paste, Fill-down, Fill-down (selected 
cells), Fill-up, Fill-up (selected cells), or Full Display Mode

Save Saves modifications made in table edit mode.

Remove Redline-deletes the selected rows from the redline Manufacturers 
table.

Undo Redlines Clears the redlines from the selected rows. See Chapter , "Undoing 
Changes to the Redline Manufacturers Tab."

Add Lets you redline-add a manufacturer part to the item.

Table 4–9 Redline Manufacturers tab buttons and actions, Java Client

Java Client button Action

Redline Manufacturer
Displays the selected row in the Redline Manufacturer dialog so 
that you can redline editable fields. Use the buttons in the upper left 
corner to view and edit other rows in the table. Click OK when you 
are finished.
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If a row in the table has a red line through every cell, then it means that manufacturer part was 
deleted from the Manufacturers table. If just a few of the cells have a short red line through 
them, then it means Manufacturer table attributes were modified. Any cell that was modified 
has a red line through the old value and the new value appears in red.

See also: Chapter 7, "Changes," Chapter 8, "Affected Items of Changes."

Adding a Manufacturer Part on the Redline Manufacturers Tab
To add a manufacturer part to the Redline Manufacturers tab in Web Client:

1. Follow the instructions in "Redline Manufacturers Tab" on page 4-22.

2. When the redline Manufacturers tab is displayed, click the Add button and use the Web 
Client object selection palette features to search for and to select the manufacturer parts 
you want.

3. Continue as described in "Adding a Manufacturer Part on the Redline Manufacturers Tab" 
on page 4-24.

To add a manufacturer part to the Redline Manufacturers tab in Java Client:

1. Follow the instructions in "Redline Manufacturers Tab" on page 4-22.

2. When the Redline Manufacturers tab is displayed, use the Add button drop-down list to 
choose Add > Search to search for a manufacturer part.

3. Continue as described in "Adding a Manufacturer Part on the Redline Manufacturers Tab" 
on page 4-24.

Adding Nonexistent Manufacturer Parts on the Redlines Tab
To create a new manufacturer part to add to the Manufacturers tab:

In Web Client, use the Add button, and then click the Create to Add button in the search 
palette.

In Java Client, use the Add button drop-down list to choose Add > Create.

If you use this option, then you must also select a manufacturer from a list of existing 
manufacturers or, if needed, create a new manufacturer. See "Adding a Manufacturer Part on 
the Redline Manufacturers Tab" on page 4-24.

Deleting a Manufacturer Part from the Redlines Tab
Redline-deleting a manufacturer part has these behaviors:

Add > Create

Add > Search

Lets you redline-add a manufacturer part to the item.

Remove
Redline-deletes the selected rows from the Redline Manufacturers 
table.

Undo Redlines
Clears the redlines from the selected rows.

See "Undoing Changes to the Redline Manufacturers Tab" on 
page 4-26.

Table 4–9 (Cont.) Redline Manufacturers tab buttons and actions, Java Client

Java Client button Action
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If the selected row is red, then redline-deleting it removes the row.

If the selected row is black, then redline-deleting it puts a red line through the row.

To delete a manufacturer part in Web Client:

1. Select the row to delete.

2. Click the Remove button on the redline Manufacturers tab.

To delete a manufacturer part in Java Client:

1. Select the row to delete.

2. Click the Remove button on the Redline Manufacturers tab.

See also: "Overview of Redlining Manufacturing Data" on page 4-22.

Editing Manufacturer Part Information on the Redline Manufacturers 
Tab

An item's AML (approved manufacturers list) is represented by the rows of information on the 
item object Manufacturers tab. Each row in the AML table represents a manufacturer part. If 
the item has not yet been released, then you can edit this table on the item Manufacturers tab, 
for example, add or remove manufacturer parts, modify editable fields, including any editable 
custom fields that the Agile administrator has enabled. Your assigned roles and privileges 
determine which AML table fields you are allowed to edit. See "Modifying a Manufacturer Part 
on the Manufacturers Tab" on page 4-21.

If the item has been released or has a pending revision, then you must use the Redline 
Manufacturers tab to modify the AML (Manufacturers tab) of the item. You display the 
Redline Manufacturers tab from the Affected Items tab of an ECO or MCO.

On the Redline Manufacturers tab you can make the same modifications that you are allowed 
to make on the Manufacturers tab of an item that has not been released, including modifying 
any editable custom fields that the Agile administrator has enabled.

If the Agile administrator has enabled them, then the item Manufacturers tab may also include 
read-through fields that display additional information derived from the manufacturer object or 
the manufacturer part object, for example, the manufacturer address fields or the manufacturer 
part Page Two fields. On both the item Manufacturers tab and the Redline Manufacturers 
tab, a read-through field contains a read-only copy of attribute data from a manufacturer or 
manufacturer part.

To modify the attributes of a manufacturer or manufacturer part, you must open the 
manufacturer or manufacturer part and then modify it with the edit feature. See "Modifying 
Manufacturing Objects" on page 4-16.

For more information about read-through fields and about which fields are editable on the item 
Manufacturers tab, see Agile PLM Administrator Guide.

Note: You cannot use the item Manufacturers tab or Redline 
Manufacturers tab to modify the read-through fields nor to modify the 
attributes of the manufacturer part objects. The Manufacturers tab and 
Redline Manufacturers tab are used only for defining the AML of the item - 
the relationship between the item and the manufacturer parts.

Note: Your assigned roles and privileges also determine which attributes 
you are allowed to edit.
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To edit a field on the redlines tab in Web Client:

1. Double-click any editable cell in the redline Manufacturers table to edit the field. The table 
is now in edit mode.

2. Use the tab toolbar buttons (Add, Remove, Undo Redlines, More) and table editing 
features to make the modifications you want.

3. Click Save to save your modifications.

To edit a field on the redlines tab in Java Client:

1. Select one or more rows to edit, and then click the Redline Manufacturer button.

2. In the Redline Manufacturers dialog, make the required changes in the fields. Use the 
buttons in the upper left corner to display and edit other rows in the table.

3. When you are finished, click OK.

Agile PLM draws a red line through the old information and enters the new information, in red, 
below the old information.

See also: Chapter 7, "Changes," Chapter 8, "Affected Items of Changes."

Undoing Changes to the Redline Manufacturers Tab
The Undo Redlines button lets you undo modifications to the redlines tab. The Undo Redlines 
button removes the red elements from the selected rows.

To undo a deletion (where Agile PLM has drawn a red line through the entire row):

1. Select a deleted row.

2. Click the Undo Redlines button.

3. Respond to the confirmation dialog.

Web Client: Click Undo.

Java Client: Click Yes.

To undo a modification (where Agile PLM has drawn a short red line through the 
modified value):

1. Select the modified row.

2. Click the Undo Redlines button.

3. Respond to the confirmation dialog.

Web Client: Click Undo.

Java Client: Click Yes.

See also: "Modifying Manufacturing Data from the Redlines Tab" on page 4-22.

Conflict AML Validation When Releasing Changes
When conflict AML redlines are created with multiple change orders, releasing one change 
order will cause other unreleased changes to lose redlines. System informs the user that there 
are conflict redlines when releasing the change and will remove the conflict record. 

When creating conflict AML redlines in a part with multiple change orders, the system will 
prompt the user with warning messages when releasing one of the change orders.
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Releasing this change will cause another change to lose redlines. This change has AML 
redlines that conflict with the AML redlines of other pending change(s). Releasing this 
change will prevent the redlines of the pending change(s) from being displayed.

Pending change(s) [ChangeNumber] contains conflicting redlines in AML for 
[PartNumber] that will become non-displayable if you release this change.

Figure 4–2  

Once the change is released, the system will prompt the user to remove the conflict redlines 
when:

Opening the Manufacturers redline tab of other unreleased changes with conflict AML 
redlines or

Opening the Manufacturers tab of the Part under unreleased change revision with conflict 
AML redlines. 

Figure 4–3
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Conflict AML Validation on Sites
If the part has more than one site with conflict AML redlines, instead of prompting the user to 
address the conflict on each site, the system will prompt the user only once and then all conflict 
AML redlines on all sites will be removed. Even if the user has no access to a specific site that 
has conflict AML redlines, the conflict on that site will still be removed.

Duplicate AML Validation When Releasing Changes
Starting from 9.3.6.19, when duplicate AML redlines are added with multiple change orders, 
releasing one change order will cause other unreleased changes to lose redlines. System 
informs the user that there are duplicate redlines when releasing the change and will remove the 
duplicate record. 

When adding the same AML to a part with multiple change orders, the system will prompt the 
user with warning messages when releasing one of the change orders.

Releasing this change will cause another change to lose redlines. This change has AML 
redlines that are duplicated with the AML redlines of other pending change(s). Releasing 
this change will prevent the redlines of the pending change(s) from being displayed.

Pending change(s) [ChangeNumber] contains duplicate redlines in AML for [PartNumber] 
that will become non-displayable if you release this change.

Figure 4–4

Once the change is released, the system will prompt the user to remove the duplicated redlines 
when:

Opening the Manufacturers redline tab of other unreleased changes with duplicate AML 
redlines or

Opening the Manufacturers tab of the Part under unreleased change revision with duplicate 
AML redlines. 
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Figure 4–5

Duplicate AML Validation on Sites
If the part has more than one site with duplicate AML redlines, instead of prompting the user to 
address the duplication on each site, the system will prompt the user only once and then all 
duplicate AML redlines on all sites will be removed. Even if the user has no access to a specific 
site that has duplicate AML redlines, the duplication on that site will still be removed.

Printing Manufacturing Objects and AMLs
You can print object tabs and other data from your Agile PLM system. You can print the current 
tab or all tabs. Attachments are printed from their native applications or from the AutoVue for 
Agile viewer.

In Web Client, with the object open, choose Actions > Print.

In Java Client, with the object open, use the Print button.

For additional information about printing objects, see Getting Started with Agile PLM.
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5Bills of Material

A bill of material (BOM) is a listing of all the subassemblies, parts, and raw materials that go 
into a parent assembly. It shows the quantity of each part required to make an assembly. Items 
on a BOM can be single items or assemblies of several items.

About Bills of Material
Documents may or may not have BOMs, depending on your system settings.

BOM items can apply to all manufacturing sites where the product is built, some sites, or just 
one site. The common portion of the BOM lists all the parts that the assembly shares between 
sites. Each site can add other objects to the BOM table that are site-specific-for example, 
documents containing assembly instructions that are specific to how something is built at that 
site. When you select Show Sites on the BOM tab, BOM items used by multiple sites are listed 
multiple times on the BOM tab, once for each site.

See also: Chapter 3, "Sites and Distributed Manufacturing."

BOM Tab
This section includes the following topics:

"How the Agile Administrator Controls What You See" on page 5-1

"BOM Tab Buttons" on page 5-2

"BOM Table Fields" on page 5-4

The BOM tab lists all the items on a BOM.

The BOM table displays the items on the BOM in a graphical hierarchy, using icons to indicate 
whether an item number represents:

How the Agile Administrator Controls What You See
The Agile administrator may assign to you:

Table 5–1 Item icons on the BOM tab

BOM table item icon Description

A part

A document

An assembly
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Discovery privileges, which determine and limit which Agile PLM objects you can find, or 
discover, in the Agile PLM database.

Read privileges, which determine and limit which discovered Agile PLM objects you can 
open and read and which specific fields you can view on the Agile PLM objects that you 
can open and read.

Sites, which determine and limit the site-specific information you can see and modify on 
BOMs and AMLs.

If you do not have the Discovery privilege for an item, then that item may not be displayed on 
the BOM table, depending on which SmartRule setting the Agile administrator has selected. 
For the BOM table only, the SmartRule setting is also applied to the fields for which you do not 
have Read privilege.

The items on the BOM for which you do not have Discovery privilege and the fields on the 
BOM table for which you do not have Read privilege are indicated by one of the following 
methods:

Only the item number and rev are displayed on the BOM table. You cannot open the item if 
you do not have Discovery privilege.

Only the item description is displayed on the BOM table. You cannot open the item if you 
do not have Discovery privilege.

The item is not displayed on the BOM table. A message at the top of the BOM table tells 
you how many items have not been displayed.

There is no indicator for inaccessible site information.

If you have questions about your Discovery or Read privileges or the sites assigned to you, see 
the Agile administrator.

See also: "Opening Items on a BOM" on page 5-7.

BOM Tab Buttons
This section includes the topics:

"Web Client BOM Tab Buttons" on page 5-2

"Java Client BOM Tab Buttons" on page 5-3

See also: "BOM Table Fields" on page 5-4.

Web Client BOM Tab Buttons
The following table explains the BOM tab buttons that appear in Web Client.

Note: The Actions menu lets you print, email, export, and perform other 
activities from the BOM tab.

Table 5–2 Web Client BOM tab buttons or modes

Button or mode Description

Double-click an editable cell 
to enter table edit mode.

Use the Web Client edit features to edit table cells. Press Tab or arrow 
keys to move the focus to the next editable cell.

Remove Removes the selected rows from the BOM table.
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See also: "BOM Table Fields" on page 5-4, "Java Client BOM Tab Buttons" on page 5-3.

Java Client BOM Tab Buttons
You can print, send, export, and perform other activities from the BOM tab. Use the buttons on 
the top of the object window, including the More Actions menu (click the More button). Or, 
right click in the item window to open the shortcut menu, and choose the command you want.

The following table explains the BOM tab buttons that appear in Java Client.

Add Add - Adds an item or an empty row to the BOM table. Depending on 
which option you choose, you can:

Begin typing the number of an existing item and select from the 
displayed type-ahead search list.

Execute a Quick Search to find an existing item.

Type in Known Number(s) of one or more existing items.

Create an item while adding it.

Add a temporary item - adds a row to the BOM table that can be 
filled in later.

By default, the new item or row has a find number of zero (0) and a 
quantity of one (1).

Expanded Display Lets you select the number of BOM levels to display, and then 
displays the expanded BOM in the separate Expanded BOM Display 
window.

The Expanded BOM Display window includes Go To and Display 
Level controls and Print and Copy commands.

Go To Locates and highlights a specific BOM item based on the criteria you 
enter in the Go To dialog.

The Go To search can be limited to a particular BOM column and to 
the specified number of levels. For example, specifying level 3 
searches through levels 1, 2, and 3.

(place holder row icon)

Double-click this cell to enter cell edit mode to fill in the temporary 
item place-holder row.

Navigator Displays the BOM tree in the navigation pane to the left of the content 
pane. You can expand and collapse subassemblies and click any item 
number to open that item in the content pane. This button appears 
above the item tabs and is always visible, regardless of which tab is 
displayed.

The BOM tree view does is not automatically refreshed to match the 
BOM table. For example, if you expand the BOM table, then the BOM 
tree in the navigation pane remains collapsed until you use the BOM 
tree controls.

Table 5–3 Java Client BOM tab buttons

Button Description

Go To - Finds and highlights a specific BOM item based on the criteria you enter in 
the Go To dialog.

The Go To search can be limited to a particular BOM column and to the specified 
number of levels. For example, specifying level 3 searches through levels 1, 2, and 3.

Table 5–2 (Cont.) Web Client BOM tab buttons or modes

Button or mode Description
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See also: "BOM Table Fields" on page 5-4, "Web Client BOM Tab Buttons" on page 5-2.

BOM Table Fields
The BOM table displays BOM item fields in columns. The Agile administrator configures the 
BOM table fields to meet the needs of your company. The columns that you see in your Agile 
PLM system may differ from the list of BOM table fields presented here. If you have questions 
about the BOM table fields, contact the Agile administrator.

Web Client BOM Table Fields
Web Client BOM table fields and icons appear as listed in the following table.

Expand Tree or Collapse All – Select from menu. Expands or collapses all the 
subassemblies in the BOM. When expanded, all levels of the BOM are displayed.

Edit – Lets you edit the selected rows in the BOM. You can edit the find number, 
quantity, reference designator and BOM notes. This button is available for 
introductory items that are not yet released, and that have no changes pending against 
them.

Add – Adds an item or an empty row to the BOM table. Depending on which option 
you choose, you can:

Create an item while adding it.

Search for an existing item.

Type in Known Number(s) of one or more existing items.

Add Blank Row – adds a blank row to the BOM table that can be filled in later.

By default, the new item or row has a find number of zero (0) and a quantity of one 
(1).

Remove – Removes the selected rows from the BOM table.

View Redline – Opens the change that released this revision of the item, and displays 
the Affected Items tab and redline tabs. This button is disabled on pending revisions.

(place holder 
row icon)

Select a BOM Item – Double-click in a blank row with this symbol to select or 
create an item number to fill in the blank row.

Table 5–4 Web Client BOM table columns

Web Client BOM 
column name or 
icon Description

Has Attachment

A dot icon  in this column indicates that the item has an attachment.

Click the dot icon to open the BOM item with its Attachments tab displayed.

Table 5–3 (Cont.) Java Client BOM tab buttons

Button Description
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Has Approved Manufacturers

A dot icon  in this column indicates that the item contains manufacturing 
data.

Click the dot icon to open the BOM item with its Manufacturers tab displayed.

Has Pending Changes

A dot icon  in this column indicates that the item has a pending change.

A red square icon  in this column indicates that the item has a released 
Deviation or Stop Ship that has not expired.

Click the dot icon to open the BOM item with its Changes tab displayed.

Item Number The Item Number field contains the number of the item object. Click an item 
number to open that item object.

Has Product Service Requests

A dot icon  in this column indicates that the item has a PSR (Product Service 
Request) or QCR (Quality Change Request) that is not closed.

Click the dot icon to open the BOM item with its Quality tab displayed.

Item Description The Item Description field contains the description of that item.

Item Rev The Item Rev field shows the revision number of the BOM item. The latest 
released revision is displayed.

Qty The Qty field shows the quantity of that item used in the assembly or 
subassembly.

Find Num The Find Num field shows the internal number used to locate that item in an 
Agile BOM.

Ref Des The Ref Des field contains the reference designators.

Sites The Sites field shows which manufacturing sites are associated with the item. 
Items associated with multiple sites are listed on the BOM once per site.

BOM Notes The BOM Notes field contains notes about the item.

Has Prices

A dot icon in this column indicates that the item has published prices.

Click the dot icon to open the BOM item with its Prices tab displayed.

Has Pending Declarations

A dot icon in this column indicates that the item has pending declarations.

Click the dot icon to open the BOM item with its Compliance tab displayed.

Note: The Effective From date is different from the Rev Release Date field 
on the Title Block tab. The rev release date is the release date of the ECO 
that released the current revision of the item.

Table 5–4 (Cont.) Web Client BOM table columns

Web Client BOM 
column name or 
icon Description
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Java Client BOM Table Fields
Java Client BOM table fields and icons appear as listed in the following table.

Common and Site-specific Portions of the BOM
If your company is using distributed manufacturing, then the BOM table may include both 
common portions and site-specific portions. The sites listed on an item's Sites tab determine 
whether the item can be added to the common or site-specific portions of the BOM table.

For an item to appear on the common portion of the BOM table, then the Sites tab of the item 
must include all the sites that appear on the Sites tab of the parent item assembly. For example, 
parent assembly 4444 includes the sites India and San Jose on its Sites tab. Items added to the 
common portion of the BOM table must also include at least India and San Jose on their Sites 
tab. If these items include additional sites on their Sites tab, then it does not prevent them from 
being included on the common portion of the BOM table of assembly 4444.

Table 5–5 Java Client BOM table columns

Field name Description

Has Attachment

The appearance of this icon indicates that the item has an attachment.

Click this icon to open the BOM item with its Attachments tab displayed.

The appearance of this icon indicates that the item contains manufacturing 
data.

Click this icon to open the BOM item with its Manufacturers tab 
displayed.

The appearance of this icon indicates that the item has a pending change.

Click this icon to open the BOM item with its Changes tab displayed.

Item Number The Item Number field contains the item's number. Click an item number to 
open that item page.

The appearance of this icon indicates that the item has a PSR (Product 
Service Request) or QCR (Quality Change Request) that is not closed.

Click this icon to open the BOM item with its Quality tab displayed.

Item Description The Item Description field contains the description of that item.

Item Rev The Item Rev field shows the revision number of the BOM item. The latest 
released revision is displayed.

Qty The Qty field shows the quantity of that item used in the assembly or 
subassembly.

Find Num The Find Num field shows the internal number used to locate that item in 
an Agile BOM.

Ref Des The Ref Des field contains the reference designators.

Sites The Sites field shows which manufacturing sites are associated with the 
item. Items associated with multiple sites are listed on the BOM once per 
site.

BOM Notes The BOM Notes field contains notes about the item.

Note: The Effective From date is different from the Rev Release Date field 
on the Title Block tab. The rev release date is the release date of the ECO 
that released the current revision of the item.
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In a similar manner, items added to a site-specific portion of the BOM table must include at 
least that site on their Sites tab. For example, to be included on the India site-specific portion of 
the BOM table, then items must include at least India on their Sites tab. If these items include 
additional sites on their Sites tab, then it does not prevent them from being included in the India 
portion of the BOM table of assembly 4444.

Items that appear on the top level of the BOM must adhere to these rules. Items that appear on 
the BOM tables of subassemblies must appropriately match the sites list of their own parent 
item, but they do not need to match the site list of the top assembly item.

You will need to add the site associations to the child items before the assembly item is 
released. When an assembly is released, the item is audited for the proper site association of the 
items on the BOM table. Depending on Agile PLM system SmartRule settings, you might not 
be able to release a change order or site change order if the site associations are not correct. See 
also "Site-Specific Effectivity and Obsolete Dates" on page 7-18.

If you use Add > Create to Add (Web Client) or Add > Create (Java Client), then the 
appropriate site associations are automatically added during the create process.

See also: Chapter 3, "Sites and Distributed Manufacturing."

Viewing BOMs by Site
You can view the BOM for a specific manufacturing site by selecting a site from the Site 
drop-down list above the tabs. Sites included in the list are the ones specified on the Sites tab of 
the item. (For information about manufacturing sites, see Chapter 3, "Sites and Distributed 
Manufacturing.")

When you select a site, the BOM tab displays the common BOM plus the BOM of the site you 
selected. To view the BOM for all sites at once, select ALL in the Site list.

If your organization assigns colors to sites, then the rows in the BOM table may appear in 
different colors, distinguishing one site from another. Site colors are assigned on the site object 
General Info tab.

You can perform actions only on the items that are displayed in the BOM table. For example, if 
you select San Francisco in the Site drop-down list, then you see all items that are part of the 
common and the San Francisco portions of the BOM, and you can modify the common portion 
of the BOM and the San Francisco portion of the BOM. However, you cannot modify the Hong 
Kong portion of the BOM. The Hong Kong portion of the BOM is not displayed.

The Rev and Site drop-down lists work independently. For more details, see Chapter , 
"Working with Item Revisions."

Opening Items on a BOM
In general, you can open any item listed on a BOM by clicking its item number (Web Client) or 
by double-clicking its row (Java Client). When you open an item, its page appears.

This section includes the following topics:

"Opening a Part, Assembly, or Document from the BOM Tab" on page 5-8

Important: When you are creating or modifying a BOM table (adding by 
Search or Type in Known Numbers), if the appropriate sites are not 
associated with the Sites tab of added or modified items, then you will see a 
warning telling you that the item does not have the correct site association. 
Accept the warning to add the item anyway or cancel the action.
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"Expanding and Collapsing an Assembly" on page 5-8

"Using BOM Go To" on page 5-9

Opening a Part, Assembly, or Document from the BOM Tab
Web Client:

You can open any item listed on a BOM by clicking its item number.

You can view any item listed in the BOM in the Quick View palette.

a. Place your cursor on the item number link until the Quick View tooltip appears.

b. Click the Quick View tooltip. The Quick View palette appears.

c. Use the Next and Back buttons in the Quick View palette to view the next or previous 
item in the BOM table.

d. Click the palette Close button to close the Quick View palette.

Java Client:

You can open any item listed on a BOM by double-clicking its row.

You can also view the BOM of a pending revision by selecting the pending revision (marked 
with parentheses, for example, Rev (B)) from the Rev drop-down list above the tabs.

See "Working with Item Revisions" on page 2-9 for more information about viewing different 
revisions of the same item.

Expanding and Collapsing an Assembly
See also: "Opening Items on a BOM" on page 5-7.

Close-up of the BOM tree, Web Client:

To expand an assembly or subassembly, click the Expand icon before its item number.

To collapse an assembly or subassembly, click the Collapse icon before its item number

Figure 5–1 Web Client BOM tree
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Close-up of the BOM tree, Java Client:

To expand an assembly or subassembly, click the Plus icon before its item number.

To collapse an assembly or subassembly, click the Minus icon before its item number

Figure 5–2 Java Client BOM tree

Using BOM Go To
The BOM Go To feature enables you to search for a specific item in the BOM tree.

To use the BOM Go To feature in Web Client:

1. On the BOM tab, click the Go To button.

2. In the Go To Item in BOM dialog, define your search:

a. In the Find: field, enter the text you want to find. The Go To search finds any item that 
includes (contains) the specified text in its attribute fields. You can use any type of 
character, including numerals and punctuation.

b. In the drop-down list, choose which BOM table column you want to search. You can 
choose all columns or one specific column.

c. Check Match Case to perform a case-sensitive search where text capitalization 
matters.

d. Choose how many BOM levels you want to search: Enter a number or check All 
levels.

3. To start the search, click Find Next. The first item that matches the search criteria is 
highlighted in the BOM table.

Note: You can also use the BOM Go To feature in the Expanded BOM 
Display window. See also "Expanded BOM Display Window, Web Client" on 
page 5-11.
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4. Use the Find Next and Find Previous buttons to scroll up and down the BOM table, 
highlighting items that match the search criteria.

5. When you have found the item you want, click Close in the Go To Item in BOM dialog. 
The last item you highlighted in the BOM table remains highlighted.

To use the BOM Go To feature in Java Client:

1. Click the BOM tab of the item to display the BOM table.

2. To limit your search to a specific assembly, then expand the BOM as needed, and select the 
assembly you want in the BOM table. Otherwise, go to the next step.

3. Click the Go To button. 

4. In the Go To dialog, define your search:

a. Enter the text you want to find. The Go To search finds any item that includes 
(contains) the specified text in its attribute fields. You can use any type of character, 
including numerals and punctuation.

b. In the drop-down list, choose which BOM table column you want to search. You can 
choose all columns or one specific column.

c. Check Match case to perform a case-sensitive search where text capitalization matters.

d. Choose how many BOM levels you want to search: Enter a number or check All 
levels.

e. If you selected an assembly in step 2, then check Limit the search to the selected 
assembly to limit your search to the selected assembly. If you did not select an 
assembly, then this check box is disabled.

5. To start the search, click Find.

The search results are displayed in a search results dialog. If it is not already expanded, 
then the BOM table in the object window is expanded to show the number of levels 
specified in the search criteria dialog.

You can sort the search results in the following ways:

Drag and drop the column headers to rearrange the order in which the columns are 
displayed.

In the Add: [Available Columns] drop-down list, choose more columns to display. For 
example, add the Sites column to the results table so you can sort items by their sites.

To remove displayed columns, use the Remove: [Displayed Columns] drop-down list.

6. To modify the search criteria and run the search again, click Criteria. The search results 
dialog closes and the search criteria dialog is displayed with the settings you last specified. 
To redefine the search, go to step 4 above.

7. Find the item you want in the search results table. Use the Next and Previous buttons to 
scroll up and down the search results list. You can also click an item row to select it. The 
selected item in the search results table is highlighted. At the same time, that item is also 
highlighted in the BOM table in the object window. Whenever you select a different item 
in the search results table, that item is then highlighted in the BOM table.

8. When you have found the item you want, click Close in the search results dialog. The last 
item you selected in the search results table remains highlighted in the BOM table in the 
object window.

See also: "Opening Items on a BOM" on page 5-7.
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Expanded BOM Display Window, Web Client
The Web Client Expanded Display button opens the BOM in a separate window called the 
Expanded BOM Display window. While the Expanded BOM Display window is open, the Web 
Client content pane remains visible. Clicking an item link in the Expanded BOM Display 
window causes that item to be opened in the Web Client content pane. In the content pane, you 
can click and open any item tab.

By using the Expanded BOM Display feature in Web Client, you can view and edit objects in 
the Web Client content pane while viewing the entire BOM structure in the Expanded BOM 
Display window at the same time.

In addition, you can have two Expanded BOM Display windows open simultaneously. 
Navigate to another BOM item, and use the Expanded Display button on the BOM tab to open 
a second Expanded BOM Display window.

To use the Web Client Expanded Display feature:

1. On the BOM tab, click the Expanded Display button.

2. In the Select Levels to Display dialog, choose how many BOM levels you want to display: 
All, or from 1 to 7 levels. Click Display.

3. The Expanded BOM Display window opens. The following controls are available in the 
Expanded BOM Display window:

Go To – Use this BOM Go To feature to find a specific BOM item in the Expanded 
BOM Display window. See "Using BOM Go To" on page 5-9.

Display Levels – Click this button to open the Select Levels to Display dialog. If 
desired, choose a different BOM level to display.

More menu - This menu includes the following commands:

– Print – Choose More > Print. In the Print Options dialog, you can choose to 
include manufacturers, preview the print page, print, or cancel.

– Copy – Select and highlight one or more rows in the Expanded BOM Display 
window table. Choose More > Copy. You can now paste those items into any 
appropriate table in the Web Client content pane.

– Refresh – Click Refresh to update the BOM information in the Expanded BOM 
Display window according to any modifications that have been made to the BOM.

4. In the Expanded BOM Display window, click any item link. That item is displayed in the 
Web Client content pane.

5. Close the Expanded BOM Display window by clicking the Close button.

Revisions Listed on BOMs
The revision number (or letter) that appears in the Item Rev field of the BOM table is 
calculated by checking the release date of the parent item (if already released), and then 
locating the latest revision of the child item before that date and analyzing it. If the parent item 
has not been released, then the most recent revision of the child item is found. For details, see 
"Details About Revision Display on BOMs" on page 10-6.

Caution: Be aware that the unrelease and release of child items may affect 
the child revisions displayed on the parent BOM.
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BOMs of Items Affected by an ECO
When you create an ECO against an item, Agile PLM creates a new revision of any item 
affected by that ECO. The new revision has an updated BOM based on the redlines.

For example, consider the following scenario in which someone does the following:

1. Creates an ECO that modifies part 1000-02 by replacing the currently used 1.0 GB disk 
with a 2.1 GB hard disk.

2. Releases the ECO.

3. Examines the BOM of item 1000-02.

When the ECO is released, Agile PLM displays the changed item as a new revision of item 
1000-02. The new revision incorporates the modifications made by the ECO.

See also: Chapter 7, "Changes," Chapter 8, "Affected Items of Changes."

About Modifying the BOM Table
If an item is not yet released, and has no changes pending against it, then you can modify the 
BOM table directly (add, delete, or edit items).

If the item has been released or has a pending MCO against it, then you must write an ECO 
against the item and redline its BOM. (If the item already has a pending ECO against it, then 
you can redline the BOM through the pending ECO without creating another ECO.) See 
"Redlining the BOM of a Released Item" on page 5-38.

The following list illustrates how the BOM table of an item can be modified as a preliminary 
item and as a production released item.

Phase 1:

– Part_123

– Lifecylcle = Preliminary

– Revision = Introductory

– Changes: No pending changes.

Part_123 has not yet been released. You may modify the BOM table as explained in 

Phase 2:

– Part_123

– Lifecylcle = Preliminary

– Revision = (A) ECO_001

– Changes: Pending ECO_001 has not yet been released. It creates pending Revision 
(A).

Modify the BOM table of Part_123 by redlining the BOM through ECO_001.

Phase 3:

– Part_123

– Lifecylcle = Production

Note: You can use an SCO to modify the Site-specific portion of the BOM 
of a released item.
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– Revision = A ECO_001

– Changes: ECO_001 releases Part_123.

You cannot modify the BOM table of Part_123 because it has been production released.

Phase 4:

– Part_123

– Lifecylcle = Production

– Revision = (B) ECO_005

– Changes: ECO_005 creates pending revision (B) of Part_123.

Part_123 is production released. You must make all changes to the BOM table by creating 
a change and redlining the BOM.

This section includes the following topics:

"Modifying Site-Specific Portions of the BOM of a Preliminary Item" on page 5-13

"Web Client, Adding Items to the BOM Table of a Preliminary Item" on page 5-13

"Java Client, Adding Items to the BOM Table of a Preliminary Item" on page 5-20

"Modifying the BOM Table of a Preliminary Item" on page 5-25

"Removing Items from the BOM Table" on page 5-25

Modifying Site-Specific Portions of the BOM of a Preliminary Item
If your organization practices distributed manufacturing, then you can modify separately the 
site-specific portion of the BOM for each manufacturing site. To modify a site-specific item on 
the BOM, select the site in the Site drop-down list, and then select the site-specific item you 
want to modify or edit. See "Modifying the BOM Table of a Preliminary Item" on page 5-25 
When adding an item to the BOM, you select the site you want. See "Web Client, Adding Items 
to the BOM Table of a Preliminary Item" on page 5-13, "Java Client, Adding Items to the BOM 
Table of a Preliminary Item" on page 5-20.

Web Client, Adding Items to the BOM Table of a Preliminary Item
There are several different ways to add items to the BOM tab. You can:

Use the Add button on the BOM table, which enables you to:

– Type in the number of an item.

See "Web Client, Type in the Number of an Item to Add to the BOM Table" on 
page 5-14.

– Execute a Quick Search by clicking the palette Search to Add button.

See "Web Client, Quick Search to Add Items to the BOM Table" on page 5-15.

– Create a new item by clicking the palette Create to Add button.

Note: Modifying the site-specific portion of the BOM of a released item 
does not require a revision change and can be done through an SCO. 
Modifying the common portion of the BOM of a released item requires a 
revision change and can be done only through an ECO. For more information 
about modifying the BOM of an item that has been released, see Chapter 7, 
"Changes" and Chapter 8, "Affected Items of Changes."
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See "Web Client, Create New to Add Items to the BOM Table" on page 5-16.

Execute a saved search and then, from the search results table, you can use the More... 
menu Copy command, or you can populate the NAVIGATOR drawer, and then drag and 
drop to add to the BOM table.

See "Web Client, Custom Search to Add Items to the BOM Table" on page 5-17.

Open a custom search palette and define a search (Basic or Advanced) and search for the 
items you want to add.

See "Web Client, Custom Search to Add Items to the BOM Table" on page 5-17.

Add a place-holder row with a temporary number, and select an item for that row later.

See "Web Client, Adding a Place-holder Row to the BOM Table" on page 5-18.

– Edit the blank row to enter BOM row details, including a temporary Item Number or 
item descriptions.

See "Web Client, Editing a Place-holder Row" on page 5-19.

– Complete a blank row by selecting the item you want to use.

See "Web Client, Completing a Place-holder Row in the BOM Table" on page 5-19.

See also: "About Modifying the BOM Table" on page 5-12..

Web Client, Type in the Number of an Item to Add to the BOM Table
If you know the number of the item you want to add to the BOM table, then you can use the 
Type in Known Numbers option in Web Client. See also, "Web Client, Quick Search to Add 
Items to the BOM Table" on page 5-15 and "Web Client, Create New to Add Items to the BOM 
Table" on page 5-16.

To add one or more known items to the BOM table in Web Client:

1. Click the BOM tab.

2. To add a site-specific item to the BOM tab, select the site you want in the Site drop-down 
list of the item. To add items to the common portion of the BOM, select ALL.

3. Click the Add button. The object addition palette appears.

4. In the text entry field, type the item numbers you want to add, separated by semicolons. 
For example:

P00487; P00259; P00264

5. Or, you can also use the Web Client Type-Ahead search feature:

a. If you type a partial item number, then Agile PLM displays a list of items that match 
the text typed so far.

b. Use the arrow up and arrow down keys to highlight the object you want.

c. Press the right arrow key to select the object.

d. Repeat steps a through c to select multiple objects to add.

Note: If you enter a non-existent item number, then Agile PLM displays a 
warning. If you accept the warning, then Agile PLM adds a placeholder row 
with the non-existent item number. See also "Web Client, Adding a 
Place-holder Row to the BOM Table" on page 5-18.
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6. In the palette drop-down list, select the site you want. To add an item to the common 
portion of the BOM, select Common.

If you have already selected the site you want in the Site drop-down list of the item, then it 
is preselected for you in the palette.

7. Press the Enter key to add the selected items to the table and close the palette.

The items appear in the BOM table.

8. To add items for a different site, select the site you want in the Site drop-down list of the 
item and repeat the procedure.

For information about other methods of adding items to the BOM table, see "Web Client, 
Adding Items to the BOM Table of a Preliminary Item" on page 5-13.

Web Client, Quick Search to Add Items to the BOM Table
Use Web Client Add features to perform a quick search to find the items you want to add to the 
BOM table.

To execute a quick search to find one or more known items to add to the BOM table in 
Web Client:

1. Click the BOM tab.

2. To add a site-specific item to the BOM tab, select the site you want in the Site drop-down 
list of the item. To add items to the common portion of the BOM, select ALL.

3. Click the Add button. The object addition palette appears.

4. Click the palette Search to Add button. The Items Search palette appears.

5. Enter the search criteria and click to execute the quick search.

6. In the results table, select one or more items, and then:

Press Enter on the keyboard to add the selected items to the BOM table.

Or, drag the selected items and drop them onto the BOM table.

The items are added to the BOM table.

7. To add site-specific items, use the Site drop-down list in the Items Search palette to select 
the site you want. Repeat step 6.

8. When you are finished, press Escape on the keyboard to close the Items Search palette.

To execute a Custom Search from the Quick Search palette:

1. Click the BOM tab.

2. To add a site-specific item to the BOM tab, select the site you want in the Site drop-down 
list of the item. To add items to the common portion of the BOM, select ALL.

3. Click the Add button. The object addition palette appears.

4. Click the palette Search to Add button. The Items Search palette appears.

5. Click the Custom Search button. The Basic Search palette appears.

6. Search for the items you want:

a. Enter the search criteria and click Search.

or

b. Click the Launch Saved Searches button.
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c. In the Saved Searches palette, navigate to the saved search you want and double-click 
it.

7. In the Search Results table, select the rows you want and click the Copy button.

8. On the BOM tab, paste your selections by choosing Paste in the More menu or by pressing 
Ctrl-C.

Web Client, Create New to Add Items to the BOM Table
You can add to a BOM an item that hasn't been created yet.

Adding nonexistent items to the BOM table using Web Client:

1. Click the BOM tab.

2. To add a site-specific item to the BOM tab, select the site you want in the Site drop-down 
list of the item. To add an item to the Common portion of the BOM, select ALL.

3. Click the Add button. The object addition palette appears.

4. Click the palette Create to Add button.

The Create New dialog appears.

5. In the Create New dialog, use the Type drop-down list to select the type (subclass) of item 
you want to create.

6. Use the number that appears, click the Autonumber button, or type a number.

7. Type a description in the Description field, if desired.

8. In the Add for Site drop-down list, select the site you want. To add an item to the common 
portion of the BOM, select Common.

If you have already selected the site you want in the Site drop-down list of the item, then it 
is preselected for you in the dialog.

9. Complete any required fields.

10. Click Add.

For information about other methods of adding items to the BOM table, see "Web Client, 
Adding Items to the BOM Table of a Preliminary Item" on page 5-13.

Web Client, Saved Search to Add Items to the BOM Table
Web Client table addition features allow you use a saved search to find items to add to the 
BOM table.

To use a saved search in Web Client to locate items to add to the BOM table:

1. Execute the saved search.

2. Use one of the following methods to add search result items to the BOM table:

3. Copy and Paste:

a. In the Search Results table, select one or more item rows.

Note: If you create a new item and decide you do not want to keep it, then 
you should delete it from the database with the Delete command on the 
Actions menu. For more information about deleting items from the BOM, see 
the section, "Removing Items from the BOM Table" on page 5-25..
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b. Copy the items by choosing Copy in the More... menu, or use the Ctrl + C keyboard 
shortcut.

c. Open the desired item and click the BOM tab to display the BOM table.

d. Choose Paste in the More... menu, or use the Ctrl + V keyboard shortcut.

4. NAVIGATOR Drawer:

a. In the Search Results table, click the Navigator button. The NAVIGATOR drawer in 
the left navigation pane is populated with the search results.

b. Select one or more items in the NAVIGATOR drawer. Click to the left of the item icon 
to highlight and select a NAVIGATOR link.

c. Drag and drop the highlighted items onto the BOM table.

d. Alternately, you can copy the NAVIGATOR highlighted items (Ctrl + C) and paste 
them into the BOM table (Choose Paste in the More... menu, or use the Ctrl + V 
keyboard shortcut.)

Web Client, Custom Search to Add Items to the BOM Table
In Web Client, you can execute a custom search to locate items to add to the BOM table. Then, 
use copy and paste to add the items to the BOM table.

You can execute a custom search in the content pane and use the search results table features to 
populate the NAVIGATOR drawer or copy search results rows and paste them into the BOM 
table. See "Web Client, Saved Search to Add Items to the BOM Table" on page 5-16.

You can also open a custom search palette, which enables you to view the BOM table while 
you search for and select the items you want to add.

To open a Custom Search palette to find items to add to the BOM table:

1. Click the BOM tab to display the BOM table.

2. On the keyboard, press Ctrl + Shift + X. The custom search palette appears. The BOM 
table remains visible behind the palette.

3. In the search palette, define a Basic search or an Advanced search. Execute the search. For 
more information about defining searches, see Getting Started with Agile PLM.

4. Select one or more search results rows.

5. Click the Copy button.

6. Put the focus in the BOM table by clicking in the content pane or by selecting a BOM table 
row, and then choose Paste in the More... menu.

7. If the BOM item has sites, then Agile PLM prompts you are prompted to select a site 
setting for the pasted BOM rows. In the prompt drop-down list, select the site you want. To 
add an item to the common portion of the BOM, select Common.

You can execute multiple searches to find and select additional items.

8. Press the Escape key on the keyboard to close the custom search palette.

Note: In the upper left corner of the custom search palette, click to collapse 
the entire palette. Click to expand the palette again.
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For information about other methods of adding items to the BOM table, see "Web Client, 
Adding Items to the BOM Table of a Preliminary Item" on page 5-13.

Web Client, Adding a Place-holder Row to the BOM Table
In Web Client, you can add a place-holder row to the BOM table as a place holder for an item 
that you want to add later. You can edit the BOM Notes field of a place-holder row to specify 
which type of object to add later.

For example, Bob is creating a BOM for a computer. He is not sure which specific power cord 
he wants to use. He adds a place-holder row to the BOM, and then edits the fields on that 
place-holder row. He specifies the find number, reference designator, and quantity. In the BOM 
Notes field, he types a note about the type of power cord that should be included in the BOM. 
Later, when he views the BOM again, Bob sees the place-holder row. It reminds him that he 
must select the appropriate item number to complete the information needed in that BOM row. 
See also "Web Client, Completing a Place-holder Row in the BOM Table" on page 5-19.

To add a place-holder row to the BOM table in Web Client:

1. Click the BOM tab.

2. To add the place-holder row to a site-specific portion of the BOM, select the site from the 
Site drop-down list of the item. To add the place-holder row to the common portion of the 
BOM, select ALL in the Site drop-down list of the item. (Items or place-holder rows must 
be associated with the site for which you want to add them. "Associating a Site with an 
Item" on page 3-10 for information.)

3. Click the Add button. The object addition palette appears.

4. In the text entry field, type a text string that will not match an existing item number. For 
example:

xyz-456

5. Press the Enter key.

A warning appears stating that item xyz-456 does not exist.

6. Ensure that the Continue option is selected in the warning and click Finish.

A place-holder row is added to the appropriate section of the BOM table with a default find 
number and a default quantity. The default find number is zero (0). The default quantity is 
set by the Agile administrator.

A red question mark icon precedes the place-holder number to indicate that information is 
missing in that row. For example:

Note: You cannot add a site-specific row to the BOM table for an item that 
belongs to a subclass for which the Site-Specific BOM property is set to 
Disallow. If you have questions, contact the Agile administrator.

Note: You cannot add a site-specific row to the BOM table for an item that 
belongs to a subclass for which the Site-Specific BOM property is set to 
Disallow. If you have questions, contact the Agile administrator.

Note: If you entered the number of an existing item in step 4 above, then 
no warning appears and that item is added to the BOM.
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xyz-456

For information about other methods of adding items to the BOM table, see "Web Client, 
Adding Items to the BOM Table of a Preliminary Item" on page 5-13.

Web Client, Editing a Place-holder Row
In the same manner that you can edit any BOM row, you can also edit a place-holder row, 
which lets you fill in some BOM table fields before you specify the object you want to add. For 
example, you can fill in the Quantity, Find Number, Reference Designators, and additional 
custom fields that the Agile administrator has defined.

You can also provide a temporary Item Number or a temporary description for the item by 
following the instructions below.

To edit a place-holder row (including entering or editing a temporary Item Number or 
Item Description) using Web Client:

1. To begin editing the BOM table, double-click in any editable cell.

The table enters edit mode and the Save and Cancel buttons become active (not grayed).

2. Make the required changes in each field. Navigate to other fields by clicking the field, 
pressing the Tab key, or using the arrow keys.

3. When you are finished, click Save.

If you modified the temporary item number, then Agile PLM displays a Warning dialog 
which includes a warning that the item number does not exist. To finish specifying the 
temporary item number, check the Ignore this warning check box and click Finish.

For information about methods of adding items to the BOM table, see "Web Client, Adding 
Items to the BOM Table of a Preliminary Item" on page 5-13.

Web Client, Completing a Place-holder Row in the BOM Table
In Web Client, you can complete a blank row in a BOM table using the procedures below. The 
following conditions apply:

If there is no pending change against the item, then you can edit the BOM table and 
remove the place-holder BOM row.

If the change order has not been released, then you can perform a redline remove of the 
place-holder BOM row in the change order Redline BOM tab.

Temp BOM row replacement (a blank BOM row with a name) can take place outside of 
the BOM table edit process:

– When you create an item with that place-holder BOM row name, for example, from 
the main Create menu.

– When an existing item is renamed to the same name as the place-holder BOM item.

– On a Save As of an existing item to a new item with the same name as the 
place-holder BOM item.

To complete a place-holder row in the BOM table using Web Client:

1. On the BOM table, double-click the place-holder number in the Item Number cell of the 
place-holder row. For example, to complete the following place-holder row, click the 
xyz-456 link:

? xyz-456

The add item palette appears. The text entry field is prepopulated with the place-holder 
number, which is selected and highlighted.
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2. Begin typing to enter an item number and replace the place-holder number. See "Web 
Client, Type in the Number of an Item to Add to the BOM Table" on page 5-14.

Or, select a different palette option:

Click the palette Search to Add button to execute a quick search for the item you 
want. See "Web Client, Quick Search to Add Items to the BOM Table" on page 5-15.

Click the palette Create to Add button to create a new item. See "Web Client, Create 
New to Add Items to the BOM Table" on page 5-16.

3. Press Enter on the keyboard to add the item and close the add item palette.

The place-holder item number is replaced in the BOM table.

For information about methods of adding items to the BOM table, see "Web Client, Adding 
Items to the BOM Table of a Preliminary Item" on page 5-13.

Java Client, Adding Items to the BOM Table of a Preliminary Item
In Java Client, there are several different ways to add items to the BOM tab. You can:

Type in the number of an item. See "Java Client, Type in the Number of an Item to Add to 
the BOM Table" on page 5-20.

Select one of the available search methods and search for the items you want to add. See 
"Java Client, Search for Items to Add to the BOM Table" on page 5-21.

Create a new item. See "Java Client, Adding Nonexistent Items to the BOM Table" on 
page 5-24.

Add a blank row, and select an item for that row later. See "Java Client, Adding a Blank 
Row to the BOM Table" on page 5-22.

– Edit the blank row to enter BOM row details, including a temporary Item Number or 
item descriptions. See "Java Client, Editing a Blank Row" on page 5-22.

– Complete a blank row by selecting the item you want to use. See "Java Client, 
Completing a Blank Row in the BOM Table" on page 5-23.

See also: "About Modifying the BOM Table" on page 5-12..

Java Client, Type in the Number of an Item to Add to the BOM Table
If you know the number of the item you want to add to the BOM table, then you can use the 
Type in Known Numbers option in Java Client.

To add one or more known items to the BOM table in Java Client:

1. Click the BOM tab.

2. To add a site-specific item to the BOM tab, select the site you want in the Site drop-down 
list of the item. To add items to the common portion of the BOM, select ALL.

3. Click the Add drop-down menu button and choose the Type in Known Numbers option. A 
dialog appears.

Note: If you enter a non-existent item number, then Agile PLM displays a 
warning. If you accept the warning, then Agile PLM adds a placeholder row 
with the non-existent item number. See also "Java Client, Adding a Blank 
Row to the BOM Table" on page 5-22.
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4. In the Item Number(s) field, enter the item numbers you want, each number on a separate 
row.

For example, type P00002, then press the Enter key to place the cursor on the next row. 
Now type P00044.

5. In the Add for Site drop-down list, select the site you want. To add an item to the common 
portion of the BOM, select Common.

If you have already selected the site you want in the Site drop-down list of the item, then it 
is preselected for you in the dialog.

6. Click Add.

The item appears in the BOM table.

7. To add items for a different site, select the site you want in the Site drop-down list of the 
item and repeat the procedure.

For information about other methods of adding items to the BOM table, see "Java Client, 
Adding Items to the BOM Table of a Preliminary Item" on page 5-20.

Java Client, Search for Items to Add to the BOM Table
You can use a saved search or define either a simple search or an advanced search to find items 
to add to the BOM table. You can also select items in your Bookmarks folder or Recently 
Visited folder.

To search for and add one or more items to the BOM table in Java Client:

When you add an item to the BOM, it is added below the selected item.

1. Click the BOM tab.

2. To add a site-specific item to the BOM tab, select the site you want in the Site drop-down 
list of the item. To add items to the common portion of the BOM, select ALL.

3. Click the Add drop-down menu button and choose the Search option. The Add BOM 
dialog appears.

4. To edit the item information immediately after adding items, ensure that Edit rows after 
adding is checked.

5. Search for one or more existing items. In the Add BOM dialog, select a search method. If 
you choose to perform a simple search, then enter the value to search for and click Search. 
You can also define an advanced search, run a saved search, or select a bookmarked or 
recently visited item (Shortcuts). (For more information about searches, see Getting Started 
with Agile PLM.)

6. In the search results, select the items you want by moving them into the Selected Item(s) 
list.

You can run multiple searches to find and select additional items.

7. If you have not already done so, then select a site in the Site field. To add the selected 
items to the Common portion of the BOM, select Common. If you previously selected a 
specific site in the Site drop-down list of the item, then that site is preselected for you in 
the dialog.

8. Click OK.

9. If Edit rows after adding was checked, then edit the item information in the Editing Added 
Rows dialog and click OK.

All the items in the Selected Item(s) list are added to the BOM. The BOM tab Site column 
is automatically completed with the selected site as the associated site. If you added items 
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to the Common portion of the BOM, then the Site column is blank to indicate that the item 
is common to all sites, instead of being specific to one site.

10. To add items for a different site, select the site you want in the Site drop-down list of the 
item and repeat the procedure.

For information about other methods of adding items to the BOM table, see "Java Client, 
Adding Items to the BOM Table of a Preliminary Item" on page 5-20.

Java Client, Adding a Blank Row to the BOM Table
You can add a blank row to the BOM table as a place holder, editing the BOM Notes field to 
specify which type of object you want to add later.

For example, Bob is creating a BOM for a computer. He is not sure which specific power cord 
he wants to use. He adds a blank row to the BOM, and then edits the blank row. He specifies 
the find number, reference designator, and quantity. In the BOM Notes field, he types a note 
about the type of power cord that should be included in the BOM. Later, when he views the 
BOM again, Bob sees the blank row. It reminds him that he must select the appropriate item 
number to complete the information needed in that BOM row. See also "Java Client, 
Completing a Blank Row in the BOM Table" on page 5-23.

To add a blank row to the BOM table in Java Client:

When you add a blank row to the BOM, it is added above the selected rows.

1. Click the BOM tab.

2. To add the blank row to a site-specific portion of the BOM, select the site from the Site 
drop-down list of the item. To add the blank row to the common portion of the BOM, 
select ALL in the Site drop-down list of the item. (Items or blank rows must be associated 
with the site for which you want to add them. See "Associating a Site with an Item" on 
page 3-10.for information.)

3. Click the Add drop-down menu button and choose the Add a blank row option.

A blank row is added to the appropriate section of the BOM table with a default find 
number and a default quantity. The default find number is zero (0). The default quantity is 
set by the Agile administrator.

For information about other methods of adding items to the BOM table, see "Java Client, 
Adding Items to the BOM Table of a Preliminary Item" on page 5-20..

Java Client, Editing a Blank Row
In the same manner that you can edit any BOM row, you can also edit a blank row, which lets 
you fill in some BOM table fields before you specify the object you want to add. For example, 
you can fill in the Quantity, Find Number, Reference Designators, and additional custom fields 
that the Agile administrator has defined.

Note: You cannot add a site-specific row to the BOM table for an item that 
belongs to a subclass for which the Site-Specific BOM property is set to 
Disallow. If you have questions, contact the Agile administrator.

Note: You cannot add a site-specific row to the BOM table for an item that 
belongs to a subclass for which the Site-Specific BOM property is set to 
Disallow. If you have questions, contact the Agile administrator.
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You can also provide a temporary Item Number or a temporary description for the item by 
following the instructions below.

To edit a blank row (including entering or editing a temporary Item Number or Item 
Description) using Java Client:

1. Select one or more BOM rows, including the blank rows you want to modify and click the 
Edit button.

The Edit BOM window appears.

2. Make the modifications in the table.

3. To provide a temporary description for the blank row, in the BOM Description field, type 
the text you want to use as the temporary item description.

The Item Description field of a blank row cannot be edited. However, Agile PLM uses the 
text in BOM Description field as a temporary description of the item when you save your 
modifications.

4. To provide a temporary item number, in the Item Number field, type a number that does 
not exist in the Agile PLM database.

5. When you are finished, click OK.

If you entered a temporary item number, then Agile PLM displays a Warnings and Errors 
dialog which includes a warning that the item number does not exist. To finish specifying 
the temporary item number, check the Accept check box and click OK.

If you entered text for a temporary description in the BOM Description field, then that text 
is now also displayed in the Item Description field of the blank row.

For information about methods of adding items to the BOM table, see "Java Client, Adding 
Items to the BOM Table of a Preliminary Item" on page 5-20.

Java Client, Completing a Blank Row in the BOM Table
In Java Client, you can complete a blank row in a BOM table using the procedures below. The 
following conditions apply:

If there is no pending change against the item, then you can perform a blank BOM row 
replacement in the item BOM table.

If the change order has not been released, then you can perform a blank BOM row 
replacement in the change order Redline BOM tab.

Temp BOM row replacement (a blank BOM row with a name) can take place outside of 
the BOM table edit process:

– When you create an item with that Temp name, for example, from the main Create 
menu.

– When an existing item is renamed to the same name as the Temp BOM item.

– On a Save As of an existing item to a new item with the same name as the Temp BOM 
item.

To complete a blank row in the BOM table using Java Client:

1. On the BOM table, double-click the blank row, which displays the red question mark blank 
row placeholder symbol. (See "Java Client BOM Tab Buttons" on page 5-3.)

2. In the Replace Temporary Item dialog, select the method you want to use:

Create a new Item

a. In the Replace Temporary Item dialog, select Create a new Item and click OK.
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b. In the New dialog, select the item type in the Type drop-down list, fill in the required 
fields, and click OK. If an autonumber is not required, then the New dialog Number 
field is prepopulated with the temporary number. You can use the temporary number 
or you can replace it. If an autonumber is required, then the temporary number is 
automatically replaced with an autonumber.

Search for an Item

a. In the Replace Temporary Item dialog, select Search for an Item and click OK.

b. In the Select Objects dialog, select a search method. If you choose to perform a simple 
search, then enter the value to search for and click Search. You can also define an 
advanced search, run a saved search, or select a bookmarked or recently visited item 
(Shortcuts). (For more information about searches, see Getting Started with Agile 
PLM.)

You can run multiple searches until you find the item you want.

c. In the search results, select the one item you want by moving it into the Selected 
Object(s) list and click OK.

Replace it with Item

a. In the Replace Temporary Item dialog, select Replace it with Item.

b. Enter the item number of an existing item and click OK.

For information about methods of adding items to the BOM table, see "Java Client, Adding 
Items to the BOM Table of a Preliminary Item" on page 5-20.

Java Client, Adding Nonexistent Items to the BOM Table
You can add to a BOM an item that has not been created yet.

Adding nonexistent items to the BOM table using Java Client:

1. Click the BOM tab.

2. To add a site-specific item to the BOM tab, select the site you want in the item's Site 
drop-down list. To add an item to the Common portion of the BOM, select ALL.

3. Click the Add drop-down menu button and choose the Create option. The New dialog 
appears.

4. In the New dialog, use the Type drop-down list to select the type (subclass) of item you 
want to create.

5. Assign a number to the item. To do so, either accept the number that appears, click the 
Autonumber button to use the next autonumber, or type a number.

6. In the Add for Site drop-down list, select the site you want. To add an item to the common 
portion of the BOM, select Common.

If you have already selected the site you want in the Site drop-down list of the item, then it 
is preselected for you in the dialog.

7. Complete any required fields.

8. Click OK.

Note: If you create a new item and decide you do not want to keep it, then 
you should delete it from the database with the Delete button in the object 
window. For more information about deleting items from the BOM, see 
"Removing Items from the BOM Table" on page 5-25.
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For information about other methods of adding items to the BOM table, see "Java Client, 
Adding Items to the BOM Table of a Preliminary Item" on page 5-20.

Modifying the BOM Table of a Preliminary Item
You can directly modify the BOM table of an item that has not been released and has no 
pending changes.

When you create a new item and then click the BOM tab, Agile PLM displays a blank BOM 
tab.

To modify items in the BOM table of a preliminary item in Web Client:

1. Open the unreleased item (the item that has not been released and has no pending changes).

2. Click the BOM tab.

3. If the BOM information you need is on a site-specific portion of the BOM, then select the 
site from the Site drop-down list.

4. To begin editing the BOM table, double-click in any editable cell.

The table enters edit mode and the Save and Cancel buttons become active (not grayed).

5. Make the required changes in each field. Navigate to other fields by clicking the field, 
pressing the Tab key, or using the arrow keys.

6. When you are finished, click Save.

See also: "Web Client, Adding Items to the BOM Table of a Preliminary Item" on 
page 5-13.

To modify items in the BOM table of a preliminary item in Java Client:

1. Open the unreleased item (the item that has not been released and has no pending changes).

2. Click the BOM tab.

3. If the BOM information you need is on a site-specific portion of the BOM, then select the 
site from the Site drop-down list.

4. Select one or more items to modify.

5. Click the Edit button.

The Edit BOM window appears.

6. Make the modifications in the table.

7. When you are finished, click OK.

See also: "Java Client, Adding Items to the BOM Table of a Preliminary Item" on 
page 5-20.

Removing Items from the BOM Table
To remove an item from the BOM table in Web Client:

1. To remove an item from a site-specific portion of the BOM that is not currently displayed, 
select the site (or ALL) from the Site drop-down list to display the site-specific rows.

2. Select one or more items to remove from the BOM table.

3. Click the Remove button on the BOM tab or press the Delete key on the keyboard.

The items are deleted from the BOM table.
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See also: "Web Client, Adding Items to the BOM Table of a Preliminary Item" on 
page 5-13.

To remove an item from the BOM table in Java Client:

1. To remove an item from a site-specific portion of the BOM that is not currently displayed, 
select the site (or ALL) from the Site drop-down list to display the site-specific rows.

2. Select one or more items to remove from the BOM table.

3. Click the Remove button on the BOM tab.

The items are deleted from the BOM table.

See also: "Java Client, Adding Items to the BOM Table of a Preliminary Item" on 
page 5-20.

Conflict BOM Validation When Releasing Changes
When conflict BOM redlines are created with multiple change orders, releasing one change 
order will cause other unreleased changes to lose redlines. System informs the user that there 
are conflict redlines when releasing the change and will remove the conflict record. 

When creating conflict BOM redlines in a part with multiple change orders, the system will 
prompt the user with warning messages when releasing one of the change orders.

Releasing this change will cause another change to lose redlines. This change has BOM 
redlines that conflict with the BOM redlines of other pending change(s). Releasing this 
change will prevent the redlines of the pending change(s) from being displayed.

Pending change(s) [ChangeNumber] contains conflicting redlines in BOM for 
[PartNumber] that will become non-displayable if you release this change.

Note: Be sure to use the Remove button on the BOM tab, not the Delete 
button in the item window. If you use the Delete button, then the entire item 
is deleted.
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Figure 5–3

Once the change is released, the system will prompt the user to remove the conflict redlines 
when:

Opening the BOM redline tab of other unreleased changes with conflict BOM redlines or

Opening the BOM tab of the Part under unreleased change revision with conflict BOM 
redlines.

Figure 5–4

Conflict BOM Validation on Sites
If the part has more than one site with conflict BOM redlines, instead of prompting the user to 
address the conflict on each site, the system will prompt the user only once and then all conflict 
BOM redlines on all sites will be removed. Even if the user has no access to a specific site that 
has conflict BOM redlines, the conflict on that site will still be removed.
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Duplicate BOM Validation When Releasing Changes
Starting from 9.3.6.19, when duplicate BOM redlines are added with multiple change orders, 
releasing one change order will cause other unreleased changes to lose redlines. 

System informs the user that there are duplicate redlines when releasing the change and will 
remove the duplicate record. 

There is a SmartRule "Duplicate ItemNumbers" with values: Allow, Disallow, and Warning 
(default), which controls the use of duplicate item numbers as BOMs. The validation is 
different per each SmartRule setting:

If the SmartRule is set to Allow, the system will not prompt any warning message when adding 
the same BOM to a part with multiple change orders and releasing one of the change orders.

If the SmartRule is set to Disallow or Warning, the system will prompt the user with a warning 
message when adding the same BOM to a part with multiple change orders and releasing one of 
the change orders.

Releasing this change will cause another change to lose redlines. This change has BOM 
redlines that are duplicated with the BOM redlines of other pending change(s). Releasing 
this change will prevent the redlines of the pending change(s) from being displayed.

Pending change(s) [ChangeNumber] contains duplicate redlines in BOM for [PartNumber] 
that will become non-displayable if you release this change.

Figure 5–5

Once the change is released. If the SmartRule is set to Disallow, the system will prompt the 
user to remove the duplicated redlines when:

Opening the BOM redline table of other unreleased changes with duplicate BOM redlines 
or
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Opening the BOM tab of the Part under unreleased change revision with duplicate BOM 
redlines.

Figure 5–6

If the SmartRule is set to Warning, the system will provide an additional option for the user to 
choose whether to retain the duplicated redlines or remove the duplicated redlines. 

Figure 5–7

Duplicate BOM Validation on Sites
If the part has more than one site with duplicate BOM redlines and the SmartRule "Duplicate 
ItemNumbers" is set to Warning, the system will prompt the user for each site to address the 
duplication (either retain or remove). Different sites can choose different options to resolve the 
duplication. If the user has no access to a specific site that has duplicate BOM redlines, the 
duplicate on that site will not be resolved. Releasing the change will get the following error 
message. The change cannot be released until the duplication is resolved by a user who has 
access to that site.
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Figure 5–8

If the part has more than one site with duplicate BOM redlines and the SmartRule "Duplicate 
ItemNumbers" is set to Disallow, the system will prompt the user once and then all duplicate 
BOM redlines on all sites will be removed. Even if the user has no access to a specific site that 
has duplicate BOM redlines, the duplication on that site will still be removed. 

Working with Reference Designators
Reference designators are commonly used in the electronics industry as a labeling system to 
refer to components. If your company uses reference designators, then you can assign and edit 
reference designators in Agile BOMs.

This section includes the following topics:

"Viewing Reference Designators" on page 5-30

"Adding Reference Designators" on page 5-32

"Deleting Reference Designators" on page 5-36

"Modifying Reference Designators" on page 5-37

Viewing Reference Designators
Reference designators may appear in the BOM table in an expanded display (R1, R2, R3) or a 
collapsed display (R1-R3). The Agile administrator sets the following system preference to 
select the method of reference designator display used on your Agile PLM system.

This section includes the topics:

"Reference Designators Allow Range Expand Collapse Preference Setting" on page 5-31

"Viewing Reference Designators in Web Client" on page 5-31

"Viewing Reference Designators in Java Client" on page 5-31
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Reference Designators Allow Range Expand Collapse Preference 
Setting
Depending on the setting of the Reference Designators Allow Range Expand Collapse system 
preference, ranges of reference designators appear in the Ref Des field as either collapsed or 
expanded. For example, the range of reference designators R1, R2, R3, R4, R5 appear as 
follows:

Expanded: R1, R2, R3, R4, R5

Each reference designator is displayed in the Ref Des field.

Collapsed: R1-R5

Ranges of three or more reference designators are represented by the first reference 
designator in the sequence (R1), followed by the Reference Designator Range Indicator 
character (- the hyphen character), followed by the last reference designator in the 
sequence (R5). The hyphen character is the default reference designator character, 
however, the Agile administrator may choose a different character, if needed.

If the reference designators include leading zeros, then in collapsed mode the reference 
designators are displayed in groups according to the number of leading zeros. For example, 
the 100 reference designators:

R0001, R0002, R0003, R0004, ... R0099, R0100

Are displayed in collapsed mode as:

R0001-R0009, R0010-R0099, R0100

See also: "Adding Reference Designators" on page 5-32, "Viewing Reference Designators" on 
page 5-30.

Viewing Reference Designators in Web Client
When there are many reference designators to display, Web Client displays the beginning of the 
list in the Ref Des cell. You can resize the Ref Des column width, or you can display an 
expanded Ref Des cell with a scroll bar.

To display all the reference designators in the Ref Des field in Web Client:

1. Click the Ref Des cell to select it. The cell is highlighted.

2. Right-click once in the highlighted cell.

The cell expands to display an expanded cell with a scroll bar. The expanded cell displays 
several lines of reference designators.

3. Use the scroll bar in the Ref Des expanded cell in the BOM table to scroll up and down to 
view the reference designators.

Regardless of the Expand/Collapse system preference setting, the reference designators are 
displayed in expanded mode in the expanded cell. Each reference designator appears in the 
expanded cell.

See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32.

Viewing Reference Designators in Java Client
When there are many reference designators to display, Java Client displays one line of 
reference designators, followed by an ellipsis ( ... ) to indicate that there are more reference 
designators in the Ref Des field.

To display all the reference designators in the Ref Des field:
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1. Click the Ref Des field cell in the BOM table.

A drop-down pane appears. The entire list of reference designators are displayed in this 
pane. If needed, a scroll bar is included in the pane.

Regardless of the Expand/Collapse system preference setting, the reference designators are 
displayed in expanded mode in the pane. Each reference designator appears in the pane.

See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32.

Adding Reference Designators
This section includes the topics:

"Reference Designator Entry Format Guidelines" on page 5-33

"Leading Zeros in Reference Designators" on page 5-33

"Multi-segmented Reference Designator Entry Format Guidelines" on page 5-34

"Entering Multi-segmented Reference Designator Ranges" on page 5-34

"Editing the Reference Designator Field" on page 5-35

"Duplicate Reference Designators and Sites" on page 5-36

You can enter, delete, and modify reference designators, either individually or several at once. 
If you have very few reference designators, then you can enter them one by one (that is, R1, 
R2, R3). If you need to enter a larger set, then you may use the format (Rx-Ry), where x and y 
are any numbers, but whose difference is less than 10,000 (for example: R6-R6055).

Reference designators are limited to 10,000 per BOM row. If you need more than 10,000 
reference designators, then add a duplicate item to the BOM with a different find number (use 
same item number) to define additional reference designators.

Reference designators are not sorted until you complete edits to the current item.

If the number in the Qty field does not match the number of reference designators, then you see 
a message indicating that the reference designators and quantity do not match.

If Qty is blank (null), then Agile PLM treats the contents of the Qty field as a 0 (zero), and 
verifies that the number of reference designators match, that is, that the number of reference 
designators is also 0 (zero). If there are any reference designators in the Ref Des field and Qty 
is blank, then you see a message indicating that the reference designators and quantity do not 
match.

If Qty is not an integer, then Agile PLM treats the contents of the Qty field as text characters 
and does not verify that the Qty and the number of reference designators match. Decimal 
numbers (for example, 7.8) are not integers and are therefore considered a text entry.

The length of an individual reference designator may be a minimum of 1 character and a 
maximum of 19 characters.

Duplicate reference designators are not allowed in the same unique single BOM row. If you 
enter the same reference designator twice (for example: A1, A1), then Agile PLM resolves this 
to one reference designator (A1).

A unique BOM row is defined by a unique find number. If BOM table rows have the same find 
number, then the Duplicate Ref Des SmartRule is ignored for those BOM table rows. However, 
if Find Number is blank for multiple BOM rows, then Agile PLM validates Duplicate Ref Des 
SmartRule as if all those rows have Find Number = 0. For more information about the 
Duplicate Ref Des SmartRule, see the Agile PLM Administrator Guide.



Working with Reference Designators

Bills of Material 5-33

See also: "Deleting Reference Designators" on page 5-36, "Modifying Reference Designators" 
on page 5-37.

Reference Designator Entry Format Guidelines
The following rules apply when entering reference designators:

Entering ranges - You can always use ranges when entering reference designators, 
regardless of the setting of the Reference Designators Allow Range Expand Collapse 
system preference. If the preference is set to Expand, then the reference designators are 
displayed in expanded format after you save your edits. For example:

Enter: R1-R5

Expanded Display: R1, R2, R3, R4, R5

Collapsed Display: R1-R5

For more information, see "Reference Designators Allow Range Expand Collapse 
Preference Setting" on page 5-31.

To add groups of reference designators that begin with different letters, you must separate 
each letter group with commas. For example, to enter the 10 designators A1, A2, A3, B4, 
B5, B6, B7, C8, C9, and C10, you would type:

A1-A3,B4-B7,C8-C10

See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32..

Leading Zeros in Reference Designators
You can use leading zeros when you enter individual reference designators or ranges of 
reference designators. For example,

R001, R002, R010

B001-B100

The number of numeric characters in each segment of the range does not need to match. 
For example:

R0001-R100

When the number of numeric characters in each segment of the range does not match, the 
number of numeric characters in the first segment is used for all the reference designators 
in the range. In the above example, the range is saved as:

R0001, R0002, R0003, R0004, ... R0099, R0100

When you exit edit mode, the reference designators are displayed according to the 
Reference Designators Allow Range Expand Collapse preference setting. For more 
information, see "Reference Designators Allow Range Expand Collapse Preference 
Setting" on page 5-31.

Note: Whenever you edit the reference designator field, the existing 
reference designators are displayed in Expand format while the BOM table 
row is in edit mode. If, during the same edit session, you navigate away from 
the Ref Des edit field, and return to the Ref Des edit field again, then any 
ranges you entered previously are now displayed in Expanded format.
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See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32.

Multi-segmented Reference Designator Entry Format Guidelines

Reference designators may be separated into a maximum of three parts:

<Prefix> <Number> <Suffix>

Prefix – may be any character that is not defined as the range indicator (for example, [ - 
hyphen] the default range indicator) or a delimiter (for example, [ , comma] used to 
separate - delimit - a list of reference designators).

Number – must be a number (numerals 0 through 9)

Suffix – may be any character that is not designated as the range indicator or a delimiter, 
and does not start with 0 (zero).

Only the last number string is considered the reference designator <Number>. For example,

A10B30D

<Prefix> = A10B <Number> = 30 <Suffix> = D

A segmented reference designator may also include characters that divide the segments if they 
meet the requirements outlined above. If the Agile administrator has selected a non-hyphen 
character as the range indicator, then the hyphen character can be used. Contact the Agile 
administrator if you have questions about which characters you may use in a multi-segmented 
reference designator. For example:

A*10*B30D

<Prefix> = A*10*B <Number> = 30 <Suffix> = D

See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32.

Entering Multi-segmented Reference Designator Ranges
When you enter a range, Agile PLM evaluates the formats of the begin-range designator and 
the end-range designator to ensure that the formats are compatible and, therefore, the range is 
valid.

When you enter a multi-segmented range, both the prefix and the suffix must be identical in the 
begin-range designator and end-range designator. (For details, refer to step 3 below.)

The number segment may use leading zeros as described in"Leading Zeros in Reference 
Designators" on page 5-33.

Agile PLM uses the following rules to evaluate the number portions of a multi-segmented 
range and the validity of the entered range:

Note: These rules apply when using a suffix, as defined below.

Note: If the Agile administrator has selected a non-hyphen character as the 
range indicator, then the hyphen character can be used. Contact the Agile 
administrator if you have questions about which characters you may use in a 
multi-segmented reference designator.



Working with Reference Designators

Bills of Material 5-35

1. Agile PLM determines the number segments by scanning from right to left to find the first 
whole number in both the begin-range designator and the end-range designator.

2. Agile PLM valuates the begin-range number and the end-range number to ensure that they 
are the same formats.

a. The numbers are the same precision (number of characters) from the end of the 
designator.

b. The end-range designator number is greater than the begin-range designator number.

3. Agile PLM evaluates the suffixes and prefixes to ensure that they match:

a. The string of characters to the right of the whole number (suffix) is the same in both 
the begin-range designator and the end-range designator.

b. The string of characters to the left of the whole number (prefix) is the same in both the 
begin-range designator and the end-range designator.

Optionally, the prefix can be omitted in the end-range designator. Agile PLM will use 
the same prefix as the start-range designator. This satisfies the rule that both prefixes 
must be the same. The following two ranges are equivalent:

A1B1C - A1B3C

<Prefix> = A1B <Number> = 1 <Suffix> = C -<Prefix> = A1B <Number> = 3 
<Suffix> = C

A1B1C - 3C

<Prefix> = A1B <Number> = 1 <Suffix> = C -<Prefix> = <use start-range 
designator prefix><Number> = 3 <Suffix> = C

The following table shows examples of valid multi-segmented reference designator ranges. The 
range indicator is - (hyphen):

See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32.

Editing the Reference Designator Field
To add reference designators in Web Client:

Table 5–6 Multi-segmented reference designator ranges

Range entered as: Reference designators saved as:

A1B*A3B A1B*A3B

A*07*FG - A*10*FG A*07*FG, A*08*FG, A*09*FG, A*10*FG

A*001*TT - A*3*TT A*001*TT, A*002*TT, A*003*TT

A*07 - A*10 A*07, A*08, A*09, A*10

A*001 - A*3 A*001, A*002, A*003

A1B1 - A1B3 A1B1, A1B2, A1B3

A1B1C - A1B3C A1B1C, A1B2C, A1B3C

A1B1C - 3C A1B1C, A1B2C, A1B3C

A1B1CD - A1B3CD A1B1CD, A1B2CD, A1B3CD

A1B1CD - 3CD A1B1CD, A1B2CD, A1B3CD

A1B1C1 - A1B1C3 A1B1C1, A1B1C2, A1B1C3
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1. To begin editing the Redline BOM table, double-click the Ref Des field you want to 
modify.

The table enters edit mode and the Save and Cancel buttons become active (not grayed).

2. Type the reference designators in the Ref Des field. Make any other required modifications 
to the row.

3. When you have finished your edits, click Save.

To add reference designators in Java Client:

1. Select the item to modify. You can select multiple items.

2. Click the Edit button.

The Edit BOM window appears.

3. Click the Ref Des field you want to modify. A drop-down edit pane appears.

4. Type the reference designators in this pane. Make any other required modifications to the 
row.

5. When you are finished, click OK.

See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32.

Duplicate Reference Designators and Sites
The same reference designator can be used in more than one site-specific portion of the BOM, 
regardless of the Duplicate Ref Des SmartRule setting. (See the Agile PLM Administrator 
Guide.) For example, reference designator B22 can be used for Part 123 in the India portion of 
the BOM and also for Part 556 in the San Jose portion of the BOM.

If the SmartRule is set to Disallow, then the same reference designator cannot be used in the 
common portion of the BOM and in a site-specific portion of the BOM, for example, using 
reference designator C55 for both Part 333 on the common portion of the BOM and for Part 
678 on the Milpitas portion of the BOM. Nor can the same reference designator be used more 
than once in the same site-specific portion of the BOM, for example, using reference designator 
D46 for both Part 989 on the Milpitas portion of the BOM and for Part 765, also on the 
Milpitas portion of the BOM.

See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32.

Deleting Reference Designators
You can delete reference designators either individually or several at once.

Note: You can double-click any editable field to enter edit mode. Navigate 
to the fields you want to modify by clicking the field, by pressing the Tab 
key, or by using the arrow keys.

Note: If you need to, you can enter a new number in the Qty field.

Note: If you need to, you can enter a new number in the Qty field.
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To delete reference designators in Web Client:

1. To begin editing the Redline BOM table, double-click the Ref Des field you want to 
modify.

The table enters edit mode and the Save and Cancel buttons become active (not grayed).

2. Select the appropriate reference designators.

To select a single reference designator, either double-click the appropriate reference 
designator, or use the Shift and arrow keys. To select several contiguous reference 
designators, use the Ctrl+Shift and arrow keys.

3. Press the keyboard Delete key.

4. When you have finished your edits, click Save.

To delete reference designators in Java Client:

1. Select the item to modify by clicking its row.

2. Click the Edit button.

The Edit BOM window appears.

3. Click the Ref Des field you want to modify. A drop-down edit pane appears.

4. Select the appropriate reference designators.

To select the appropriate single reference designator, use the Shift and arrow keys. To 
select several contiguous reference designators, use the Ctrl+Shift and arrow keys.

5. Press the keyboard Delete key.

6. When you have finished your edits, click OK.

See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32.

Modifying Reference Designators
You can modify reference designators, either singly or several at once.

To modify reference designators in Web Client:

1. To begin editing the Redline BOM table, double-click the Ref Des field you want to 
modify.

The table enters edit mode and the Save and Cancel buttons become active (not grayed).

Note: You can double-click any editable field to enter edit mode. Navigate 
to the fields you want to modify by clicking the field, by pressing the Tab 
key, or by using the arrow keys.

Note: Be sure to use the keyboard Delete key, not the Remove button on 
the BOM tab. If you click the BOM Remove button, then the entire item is 
removed from the BOM.
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2. In the editable Ref Des cell, select the appropriate reference designators.

To select a single reference designator, either double-click the appropriate reference 
designator, or use the Shift and arrow keys.

To select several contiguous reference designators, use the Ctrl+Shift and arrow keys.

To add a reference designator, position the cursor at the end of the list of reference 
designators.

3. Type the modified reference designator.

4. Click Save.

To modify reference designators in Java Client:

1. Select one or more items to modify.

2. Click the Edit button.

The Edit BOM dialog appears.

3. Click the Ref Des field you want to modify. A drop-down edit pane appears.

4. Select the appropriate reference designators.

To select a single reference designator, position your cursor in the list of reference 
designators and use the Shift and arrow keys.

To select several contiguous reference designators, use the Ctrl+Shift and arrow keys.

To add a reference designator, position the pointer at the end of the list of reference 
designators.

5. Type the modified reference designator.

6. When you are finished, click OK.

See also: "Working with Reference Designators" on page 5-30, "Adding Reference 
Designators" on page 5-32.

Redlining the BOM of a Released Item
This section includes the following topics:

Note: You can double-click any editable field to enter edit mode. Navigate 
to the fields you want to modify by clicking the field, by pressing the Tab 
key, or by using the arrow keys.

Note: Although you may position the cursor anywhere in the list to add a 
reference designator, it is not necessary to insert the reference designator in a 
particular place in the list because the list is sorted after you save your 
modifications.

Note: Although you may position the cursor anywhere in the list to add a 
reference designator, it is not necessary to insert the reference designator in a 
particular place in the list because the list is sorted after you save your 
modifications.
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"Overview of BOM Redlining" on page 5-39

"Redline BOM Tab" on page 5-39

"Adding an Item to a Redline BOM Table" on page 5-42

"Removing an Item from a Redline BOM Table" on page 5-43

"Editing Item Information on a Redline BOM Table" on page 5-43

"Undoing Changes to a Redline BOM Table" on page 5-44

Overview of BOM Redlining
To modify the BOM table, you must create a change against the item if:

The item is released.

The item is unreleased and it has a pending MCO against it.

You can use an ECO or SCO to redline the BOM:

Use an ECO to modify common or site-specific portions of the BOM on the latest released 
revision of the item. Using an ECO creates a new revision of the item.

Use an SCO to modify site-specific portions of the BOM on the latest released revision. 
Using an SCO does not create a new revision of the item. For more information about 
SCOs, see "Site Change Orders" on page 7-18.

When you add an item that has pending changes to the Affected Items tab, Agile PLM displays 
a warning that informs you that the item has a separate pending change, and lets you choose 
whether to add it to the Affected Items tab. If you choose to add it, then you can open the item 
from the Affected Items table. To view the pending changes, click the Changes tab of the item.

If you have the appropriate privileges, then you can modify a redlined BOM. For details, see 
the following sections:

"Editing Item Information on a Redline BOM Table" on page 5-43

"Adding an Item to a Redline BOM Table" on page 5-42

"Removing an Item from a Redline BOM Table" on page 5-43

Redline BOM Tab
You display the Redline BOM tab from the Affected Items tab of an ECO or SCO. Select an 
item row in the Affected Items table and the corresponding BOM is displayed in the Redline 
BOM tab.

When the Redline BOM tab is displayed:

Note: If you do not have the Discovery privilege for an item on the BOM 
table, then you cannot redline that item. You cannot replace an item on the 
BOM table with an item that you cannot discover.

Note: You can add nonexistent items to the Redline BOM table. See "Web 
Client, Adding Items to the BOM Table of a Preliminary Item" on page 5-13 
and "Java Client, Adding Items to the BOM Table of a Preliminary Item" on 
page 5-20.
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If a row in the table has a red line through every cell in the row, then it means that item was 
deleted from the BOM.

If just a few of the cells have a short red line through them, then it means the item was 
modified, but not deleted. For example, redlines in only the Qty and Find Number cells 
indicate that the Qty and Find Number of that BOM item have been modified, while other 
values remain unchanged.

Any cell that was modified has a red line through the old value and the new value appears 
in red. For example, in the Qty cell, a numeral seven with a redline through it 7 and a red 
numeral ten 10 indicates that the old quantity was 7 and the new quantity is 10.

For information about other BOM redlining actions, see "Redlining the BOM of a Released 
Item" on page 5-38.

To display the redline BOM for an item in Web Client:

1. Open the ECO or SCO through which you want to redline the BOM of an item.

2. Click the Affected Items tab of the change.

3. In the Affected Items table, click to select the row of the item for which you want to view 
or create redlines. If the item has already been redlined, then a dot icon appears in the Has 
Been Redlined column of the row.

In the redline pane under the Affected Items table, the following redline tabs appear if they 
have been enabled on your Agile PLM system:

Title Block - Change-controlled item attributes as defined for the item.

BOM - displays item BOM data.

Manufacturer - displays manufacturing data.

Attachments - (on ECOs only) displays item attachments.

4. Click the redline BOM tab to display it (if it is not already displayed).

To display the Redline BOM tab for an item in Java Client:

1. Open the ECO or SCO through which you want to redline the BOM of an item.

2. Click the Affected Items tab of the change.

3. In the Affected Items table, click the row of the item for which you want to view or create 
redlines.

In the redline pane under the Affected Items table, the Redline BOM tab, Redline 
Manufacturers tab, and Redline Attachments tab (on ECOs) only appear, displaying the 
BOM data of the item, the manufacturing data of the item, and the attachments of the item, 
respectively

Note: If your Agile PLM system does not use the Manufacturers tab or, 
on documents, the BOM tab, then those redline tabs do not appear in the 
redlines pane. The ECO redline Title Block tab appears on an ECO only if 
change-controlled item attributes have been enabled.

Note: If your Agile PLM system does not use the Manufacturers tab or, 
on documents, the BOM tab, then those redline tabs do not appear in the 
redlines pane. The ECO redline Title Block redline tab is not displayed in 
Java Client.
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4. Click the Redline BOM tab to display it (if it is not already displayed).

Redline BOM Tab Buttons
The following table lists the functions and buttons on the Redline BOM tab in Web Client:

The following table lists the buttons on the Redline BOM tab in Java Client:

Table 5–7 Web Client Redline BOM tab buttons

Button or function Use

Edit mode Double-click any editable cell in the table to enter edit mode. Move from one 
editable field to another by clicking the field, by pressing the Tab key or by 
pressing the arrow keys.

Make the desired changes in each field and then click Save when you are 
finished.

Add The Add button opens the add palette, which enables you to use one of the 
Web Client add options: type in a known number (with type-ahead search 
suggestions), click Search to Add, or click Create to Add.

You can add an item or a place-holder row to the Redline BOM table. By 
default, the new item or row has a find number of zero (0) and a quantity of 
one (1).

See "Web Client, Adding Items to the BOM Table of a Preliminary Item" on 
page 5-13.

Remove The Delete button removes the selected row from the Redline BOM table.

Undo Redlines The Undo Redlines button clears the redlines from the selected rows. See 
"Undoing Changes to a Redline BOM Table" on page 5-44.

More... The More... menu button provides the following Redline BOM table editing 
capabilities:

Copy

Paste

Fill-down

Fill-down (selected cells)

Fill-up

Fill-up (selected cells)

Full Display Mode and Standard Display Mode (toggle setting)

Table 5–8 Java Client Redline BOM tab buttons

Button Use

Redline BOM - Displays the selected rows in a Redline BOM window so that you 
can change editable fields.
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For information about BOM redlining actions, see "Redlining the BOM of a Released Item" on 
page 5-38.

Adding an Item to a Redline BOM Table
To add an item to the Redline BOM table in Web Client:

1. Click the Add button.

2. Use one of the Web Client add options: type in a known number (with type-ahead search 
suggestions), click Search to Add, or click Create to Add.

3. Adding items to the Redline BOM table is similar to adding items to the BOM table. For 
more information about how to complete the dialogs, see:

"Web Client, Create New to Add Items to the BOM Table" on page 5-16

"Java Client, Type in the Number of an Item to Add to the BOM Table" on page 5-20

"Web Client, Quick Search to Add Items to the BOM Table" on page 5-15

"Web Client, Saved Search to Add Items to the BOM Table" on page 5-16

"Web Client, Custom Search to Add Items to the BOM Table" on page 5-17

"Web Client, Adding a Place-holder Row to the BOM Table" on page 5-18 and "Web 
Client, Completing a Place-holder Row in the BOM Table" on page 5-19

To add an item to the Redline BOM table in Java Client:

1. Click the Add drop-down menu button and choose one of the add options: Create, Type in 
Known Numbers, Search, or Add Blank Row.

2. Adding items to the Redline BOM table is similar to adding items to the BOM table. For 
more information about how to complete the dialogs, see:

Add - Adds an item or an empty row to the Redline BOM table. Depending on 
which option you choose, you can:

Create an item while adding it.

Search for an existing item.

Type in Known Number(s) of one or more existing items.

Add Blank Row - adds a blank row to the Redline BOM table that can be 
filled in later.

By default, the new item or row has a find number of zero (0) and a quantity of one 
(1).

See "Java Client, Adding Items to the BOM Table of a Preliminary Item" on 
page 5-20.

Remove - Removes the selected row from the Redline BOM table.

Undo Redlines - Clears the redlines from the selected rows. See "Undoing Changes 
to a Redline BOM Table" on page 5-44.

Table 5–8 (Cont.) Java Client Redline BOM tab buttons

Button Use
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"Java Client, Adding Nonexistent Items to the BOM Table" on page 5-24

"Java Client, Type in the Number of an Item to Add to the BOM Table" on page 5-20

"Java Client, Search for Items to Add to the BOM Table" on page 5-21

"Java Client, Adding a Blank Row to the BOM Table" on page 5-22 and "Java Client, 
Completing a Blank Row in the BOM Table" on page 5-23

For information about other BOM redlining actions, see "Redlining the BOM of a Released 
Item" on page 5-38.

Removing an Item from a Redline BOM Table
You use the buttons on the Redline BOM tab to remove one or more rows and items.

If a selected row is red (indicating that the row is redline-added to the BOM), then it is 
removed.

If a selected row is black, then a red line is drawn through it, thus redline-deleting the item 
from the BOM.

To remove an item from a redline BOM table in Web Client:

1. Select one or more rows to delete.

2. Click the Remove button on the Redline BOM tab.

To remove an item from a redline BOM table in Java Client:

1. Select one or more rows to delete.

2. Click the Remove button on the Redline BOM tab.

For information about other BOM redlining actions, see "Redlining the BOM of a Released 
Item" on page 5-38.

Editing Item Information on a Redline BOM Table
On the Redline BOM tab you can modify any editable BOM tab field, including any editable 
custom fields that the Agile administrator has enabled. Editable BOM tab fields usually 
describe or define the relationship between the parent item (the item BOM you are redlining) 
and the child item (the item that appears on the BOM table). For example, the Qty, Find 
Number, and Ref Des fields define the relationship between the assembly (parent item) and the 
BOM item (child item).

When you modify information on the Redline BOM tab, Agile PLM enters the new 
information, in red, below the old information.

When you redline the BOM Notes field, you can add, replace, or edit text. In the BOM Notes 
field, the new text and any redlined text are displayed.

You cannot modify the Redline BOM table Sites, Item Description, and Item Rev fields.

Redlining reference designators in the Redline BOM table is the same as editing reference 
designators on the BOM table. For more information, see "Working with Reference 
Designators" on page 5-30. Any new reference designators appear in red. Any deleted reference 
designators have a red line drawn through them.

Note: You cannot use the Redline BOM tab to modify the attributes of the 
items that are listed on the BOM table. You cannot use the Redline BOM tab 
to modify non-editable BOM table fields.
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If the Agile administrator has enabled them, then the item BOM tab may also include 
read-through fields that allow you to conveniently view additional information derived from 
the items that are listed on the BOM table, for example, the Page Two fields of a child item. A 
read-through field contains a read-only copy of attribute data from a child item. BOM tab 
read-through fields cannot be edited on the BOM tab, nor can they be edited on the Redline 
BOM tab.

To modify the attributes of an item listed on the BOM table, if it is a Preliminary item with no 
pending revisions, you can open it and use the Edit feature to modify it. See "Editing an 
Unreleased Item" on page 2-18. If an item listed on the BOM table has been released, then you 
must use a change order to modify it. See "Editing a Released Item" on page 2-19.

For more information about read-through fields and about which fields are editable on the item 
BOM tab, see Agile PLM Administrator Guide.

Your assigned roles and privileges also determine which attributes you are allowed to edit.

To edit a field on the Redline BOM table in Web Client:

1. To begin editing the Redline BOM table, double-click in any editable cell.

The table enters edit mode and the Save and Cancel buttons become active (not grayed).

2. Make the required changes in each field. Navigate to other fields by clicking the field, by 
pressing the Tab key, or by using the arrow keys.

3. Click Save when you are finished.

To edit a field on the Redline BOM table in Java Client:

1. Select the rows to edit, and click the Edit button.

The Redline BOM dialog appears.

2. Make the modifications.

3. When you are finished, click OK.

For information about other BOM redlining actions, see "Redlining the BOM of a Released 
Item" on page 5-38.

Undoing Changes to a Redline BOM Table
The Undo Redlines button lets you undo modifications to the Redline BOM tab. It removes 
the red elements from the selected row.

To undo a deletion (where Agile PLM has drawn a red line through the entire row):

1. Select the deleted row. You can select more than one deleted row.

2. Click Undo Redlines.

To undo a modification (where Agile PLM has drawn a short red line through the 
modified value):

1. Select the modified row (or rows).

2. Click Undo Redlines.

To undo a newly added item (remove it from the Redline BOM table):

1. Select the added row (or rows).

2. Click Undo Redlines.

For information about other BOM redlining actions, see "Redlining the BOM of a Released 
Item" on page 5-38.
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Printing BOM Data
You can print object tabs and other data from your Agile PLM system. You can print the current 
tab or all tabs. Attachments are printed from their native applications or from the AutoVue for 
Agile viewer.

In Web Client, with the object open, choose Actions > Print.

In Java Client, with the object open, use the Print button.

For additional information about printing objects, see Getting Started with Agile PLM.

In Java Client, to print only the BOM tab data, use the Print button drop-down menu and 
choose BOM. Complete the BOM Printing Options dialog, including the number of BOM 
levels you want to print and whether to include the AML.

See also: Chapter 9, "Working with Product Reports and Process Reports."
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6Variant Management

Variant Management is a strategic direction for Agile Product Lifecycle Management solutions.

About Agile PLM Variant Management
Diversity and complexity of product variance is a cross-industry challenge, driven by strong 
demand among consumers for mass customization and personalization. Consequently, Variant 
Management continues to be a critical consideration early in the product lifecycle, especially as 
evolving design paradigms influence product variance.

The Variant Management solution enables Product Collaboration to store a single "Model 
Option BOM", which represents all variants of a product line. The Model Option BOM is the 
basis for deriving an Instance BOM, to validate prototypes, and establish made to stock 
pre-configurations. An Instance BOM can be generated either internally or externally:

Internal Configurator

Instance Manager - an Agile 9 mask and User Interface.

External Configurator

Oracle Generic Configurator User Interface - an Oracle mask and User Interface.

Depending on which Configurator you would like to work with, a setting has to be made in the 
Preferences tab of My Settings.

Detailed information about privileges, activating the Internal Configurator, activating the 
External Configurator, and Event Management for Variant Management can be found at 
Appendix C, "Configuring Variant Management."

Configuring Agile PLM Variant Management
This section discusses how Variant Management works and how to configure Variant 
Management.

Note: This document describes the Instance Manager in detail. The Oracle 
Generic Configurator User Interface is described only briefly.

Further information about the Oracle Generic Configurator User Interface can 
be found in the Oracle Configurator Implementation Guide from OTN 
(http://www.oracle.com/technology/documentation/applications
.html).
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How Agile PLM Variant Management Works
In Agile PLM a BOM is created that contains Items like Models, Option Classes, Parts, 
Assemblies, and Documents for a product range. This BOM is called Model Option BOM.

Each BOM item can be a mandatory or an optional item. Because a Model Option BOM 
contains all possible variants, the Internal Configurator (Instance Manager) or the external 
Configurator (Oracle Generic Configurator User Interface) is used to derive an individually 
configured product, an Instance BOM. The Model Option BOM is a superset of all potential 
BOMs and is not itself intended to be manufactured.

The creation of the Model Option BOM, and the configuration of the Instance BOM with the 
internal or external Configurator depend on rules. Further information about these rules can be 
found at "Combination Rules" on page 6-7.

Description of the BOM Items

Table 6–1 BOM items

Item Description

Model A Model is denoted by the Model icon.

A Model is used as the top level element of a Model Option BOM, but can also 
used as a generic item on lower levels under Models or Option Classes.

Models cannot be added to Parts or Documents.

The BOM tab of a Model contains the additional fields:

Min Qty (minimum quantity)
Max Qty (maximum quantity)
Optional
Mut Excl (mutually exclusive)
A Model can contain items such as Models, Option Classes, Parts, Assemblies, and 
Documents in its BOM structure. These items can also be components of other 
objects to define a different product.

A Model with an assigned BOM structure is denoted by the BOM Structure icon.

Notes: 

The internal or external Configurator can be opened only from a Model.

The Variant Management solution does not support a site specific BOM for 
Models.

The Agile administrator can create subclasses with the part subtype of the type 
Model.
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Possible Combinations
The possible combinations include:

"Mandatory" on page 6-6.

"Optional" on page 6-6.

"Minimum/Maximum Quantity" on page 6-6.

"Mutually Exclusive" on page 6-7.

The following diagrams show possible combinations of Models, Option Classes, Assemblies, 
and Parts in the Model Option BOM.

Option Class An Option Class is denoted by the Option Class icon.

An Option Class acts like a placeholder in a BOM which is later replaced by at 
least one of its options.

The BOM tab of an Option Class contains the additional fields:

Min Qty (minimum quantity)
Max Qty (maximum quantity)
Optional
Mut Excl (mutually exclusive)
An Option Class can have Models, Option Classes, Parts, Assemblies, and 
Documents in its BOM structure.

An Option Class with an assigned BOM structure is denoted by the Option Class 
BOM Structure icon.

Notes:

The Variant Management solution does not support a site specific BOM for Option 
Classes.

The Agile administrator can create subclasses with the part subtype of the type 
Option Class.

Part A Part is a final standard item.

A Part can have Parts and Documents in its BOM structure, thus it is called 
Assembly.

A Part is also used as the Instance for the Instance BOM. The Title Block tab of 
the Part contains the field Base Model that lists the number and revision of the 
Model to which this Part was added as Instance.

Assembly An Assembly is a Part with a BOM.

Documents Documents are treated as Parts.

Table 6–1 (Cont.) BOM items

Item Description
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Figure 6–1 Possible combination in a Model Option BOM

The following diagram shows all possible Model combinations.

Figure 6–2 Possible Model combinations

The following diagram shows all possible combinations with Option Classes.
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Figure 6–3 Possible Options Class combinations

The following diagram shows all possible combinations with Parts and Assemblies.
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Figure 6–4 Possible combinations with Parts and Assemblies

Mandatory
Items that are defined as mandatory Items in the Model Option BOM, will automatically be 
copied to the Instance BOM. They cannot be deselected in the Instance Manager.

A detailed description of combination rules and their impact on the Instance BOM can be found 
under "Combination Rules" on page 6-7.

Optional
When defining an Item as an Optional Item in the Model Option BOM, it can be selected or 
deselected for the Instance BOM.

By default, this field is set to Null which is equivalent to the setting No.

A detailed description of combination rules and their impact on the Instance BOM can be found 
under "Combination Rules" on page 6-7.

Minimum/Maximum Quantity
When defining a minimum and maximum quantity for an Item in the Model Option BOM, 
it is possible to choose a quantity value of type Floating Point Value within this range 
(including the minimum and maximum quantity) in the Instance Manager.

The minimum and maximum quantity value has to be >0. It cannot be a negative value.
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When no minimum and maximum quantity is defined, the Quantity column in the Instance 
Manager is read only.

When entering only a minimum quantity, the maximum quantity can be up to the biggest 
possible number.

When entering only a maximum quantity, the minimum quantity has to be > 0.

A detailed description of combination rules and their impact on the Instance BOM can be found 
under "Combination Rules" on page 6-7.

Mutually Exclusive
Only the BOM entries of an Option Class can be defined as Mutually Exclusive in the Model 
Option BOM. This defines that exactly one valid option of an Option Class has to be selected 
for the Instance BOM. In case the Option Class is Optional AND Mutually Exclusive, and is 
not selected in the Instance Manager, no option of the Option Class has to be selected.

By default, this field is set to Null which is equivalent to the setting No.

A detailed description of combination rules and their impact on the Instance BOM can be found 
under "Combination Rules" on page 6-7.

Combination Rules
The following rules influence the behavior of the Instance Manager and are applied when 
deriving an Instance BOM.

"Valid Options of an Option Class" on page 6-7.

"Mutually Exclusive BOM Items" on page 6-8.

"Mandatory BOM Items" on page 6-9.

"Quantities of BOM Items" on page 6-9.

"Selecting BOM Items" on page 6-10.

"Documents as BOM Items" on page 6-10.

Further information about the combination rules for the Oracle Generic Configurator User 
Interface can be found in the Oracle Configurator Implementation Guide from OTN 
(http://www.oracle.com/technology/documentation/applications.html).

Valid Options of an Option Class
1. An Option Class has to have at least one valid option. An empty Option Class is not valid.

2. Options are mandatory or optional items.

3. An Option Class containing only mandatory options is valid.

4. If a mandatory Option Class has only optional options, at least one option has to be 
selected in the Instance Manager.

5. If an optional Option Class has only optional options and is selected in the Instance 
Manager, at least one option has to be selected in the Instance Manager.

Note: Mandatory items of an Option Class are not affected by the Mutually 
Exclusive regulation.

Note: The following screenshots show only possible examples.
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6. If an optional Option Class is not selected in the Instance Manager, it is not required to 
select an option in the Instance Manager.

Figure 6–5 Valid options of an Option Class example: Model Option BOM and Instance 
Manager

Mutually Exclusive BOM Items
1. Only Option Classes can be mutually exclusive.

2. Mandatory items (Parts, Assemblies, Option Classes, and Models) have no influence on 
the mutually exclusive behavior.
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Figure 6–6 Mutually Exclusive BOM items example, Model Options BOM and Instance 
Manager

Mandatory BOM Items
1. Mandatory items are always selected and cannot be deselected in the Instance Manager.

2. All mandatory child items of a selected parent item are automatically selected.

3. An optional item that is the only valid option of an Option Class is automatically selected 
and cannot be deselected.

4. Child items of a Part are mandatory items. The system considers this Part as an Assembly.

Figure 6–7 Mandatory BOM Items example, Model Option BOM and Instance Manager

Quantities of BOM Items

Note: Quantities are not calculated during the configuration in the Instance 
Manager. The entered quantity is independent of other quantities in upper or 
lower levels. The quantity does not change automatically during a 
configuration. The quantity of an item is relative.
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1. For every selected item a default quantity is automatically assigned.

2. Entered quantities have to be >0. Otherwise, an error message is displayed.

3. If a minimum quantity, a maximum quantity, or both have has been defined for an item, the 
quantity can be entered manually, however, the quantity entered must be within the defined 
parameters.

4. If a predefined alphanumeric quantity value is not a valid number, the system ignores the 
minimum and maximum values and copies this predefined value into the quantity column.

5. The default quantity can have alphanumeric quantity values, thus the quantity is not 
changeable in the Instance Manager.

Figure 6–8 Quantities of BOM Items example, Model Option BOM and Instance Manager

Selecting BOM Items
1. When selecting a child item, the parent item is automatically selected.

2. Every item with a valid quantity (>0) in the Quantity column of the Instance Manager is 
selected.

Documents as BOM Items
Documents and their structure are treated like Parts and Assemblies.

Model Option BOM
When you create the Model Option BOM, make sure all entries are created like defined in the 
Combination Rules, and explained in the Possible Combination sections.

Note: When deselecting an optional parent item, all selected child items are 
deselected as well.

When clearing the Quantity field of an entry with minimum and maximum 
values, this entry is deselected.
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A Model Option BOM is the basis for a derived Instance BOM.

Further information about possible combinations in the Model Option BOM can be found at 
"Possible Combinations" on page 6-3.

Further regulations about combinations (for example, only Parts can be children of Parts) can 
be found in the Smart Rules in the Agile PLM Administrator Guide.

Quantities
For every BOM item, quantity values can be defined, either as a constant value or selectable 
between minimum and maximum values.

For further information about minimum and maximum quantities see "Minimum/Maximum 
Quantity" on page 6-6.

See also:

"Alphanumeric Quantity Values" on page 6-12.

"Reference Designator" on page 6-12.

Quantity fields are restricted to 20 characters and can be either Integer or Floating Point Values.

When working with the external configurator, ensure that Models and Option Classes have only 
Integer Values assigned for Quantity. Floating Point Values are not supported for Models and 
Option Classes. Otherwise, the external configurator produces warnings and sets it to an invalid 
configuration.

Quantity values cannot be negative values, they must be >0.

Important: DO NOT modify the Model Option BOM, from which the 
Instance BOM will be derived, once the Instance Manager is opened. 
Modifying the Model Option BOM when the Instance Manager is open will 
result in discrepancies with the actual loaded structure and the currently 
modified structure.

Variant Management does not support:

Temporary items that are added to the Model Option BOM as 
placeholders.

Duplicate item numbers on the same BOM level.

Variant Management does not support recursive structures.

Important: Recommendation for Model Option BOMs with more than 
2500 entries in total:

By default, Agile A9 permits the creation of BOMs with a maximum 2500 
entries. To be able to create BOMs with more than 2500 entries, the 
preference value can be updated through the following SQL statement:

update propertytable set value = 2500 where PARENTID = 5004 
and PROPERTYID = 811;

commit;

Setting the value to 0, permits expanding BOMs with unlimited entries.

You must have Administrator rights to update the SQL statements.
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The Quantity field in the Instance Manager is a read-only field for BOM items:

– with the same minimum and maximum quantity value

– with a predefined alphanumeric value

The Quantity field in the Instance Manager is an editable field for BOM items:

– with a defined minimum or maximum value range

Alphanumeric Quantity Values
An alphanumeric quantity value (for example, xy) can be entered into the Qty field of a Part as 
placeholder. This placeholder can be replaced by a real value in the Instance BOM.

The Quantity field in the Instance Manager shows the entered alphanumeric value and is 
read-only.

Reference Designator
For detailed information about the Reference Designator, see: "Working with Reference 
Designators" on page 5-30.

Reference Designator can be entered only for a BOM item of subtype Part. The quantity value 
in the Qty field should match the quantity of the Ref Des field. Otherwise, a warning is 
displayed which can be ignored or resolved.

In the Instance BOM, it can be possible that the quantity value does not match the Reference 
Designator. This is due to the multiplication of the quantity of Option Classes with the quantity 
of their options. To correct the discrepancy, you must amend either the value of the quantity or 
the value of the Reference Designator in the Instance BOM.

Instances Tab
Instance tab actions include:

"Instance" on page 6-13.

"Propagate Instance Revision" on page 6-13.

"Instance Manager" on page 6-14.

"Configuration Graph" on page 6-16.

The Instances tab lists all created Instances with a status symbol.

Only items of subtype 'Part' can be added as an Instance. A Part without a BOM can also be 
dragged and dropped from the Recently Visited folder in the left pane.

Table 6–2 Instances tab symbol icons

Symbol Name Description

Has no configuration This symbol is assigned to an Instance that has not 
been configured with the Instance Manager.

Has Configuration Draft This symbol is assigned to an Instance that has been 
configured with the Instance Manager but has not been 
derived.

Has derived Instance 
BOM

This symbol is assigned to an Instance that has been 
configured with the Instance Manager and has been 
derived.
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Although the drag-and-drop process of other items like Models, Option Classes, or Documents 
is displayed with a green drag-and-drop symbol, an error message will be displayed when 
dropping them onto the Instances tab. These items cannot be dropped onto the Instances tab.

A Part can only be associated to a specific revision of a specific Model. A user, who attempts to 
add the same Instance (Part) to another revision of the Model, or to a different Model, will get 
an error message.

Instance
To configure an Instance BOM in the Instance Manager, you must add a so-called Instance (a 
Part) to the Instances tab of the top level Model of the Model Option BOM.

Important guidelines and restrictions for the configuration of an Instance BOM:

A Part can only be added to the Instances tab when it does not have a BOM structure.

The added Part, which is the Instance, has to be in a state in which its BOM table can still 
be modified. This Part should not be assigned to a Pending Change or is in the state 
Released.

To avoid inconsistencies in the Instance Manager do not create a pending change or 
revision for a configurable Instance which is currently opened in the Instance Manager.

Do not assign a BOM manually to an Instance. When you assign a BOM manually to an 
Instance, the status symbol changes to ' Has derived Instance BOM', but no Configuration 
Graph has been created.

A BOM will automatically be assigned to an Instance once the Instance has been 
configured and an Instance BOM has been derived.

You can display and configure several Instances in the Instance Manager.

An Instance can only be configured by one user at a time. When you try to launch the Instance 
Manager for an Instance that is in use by a different user, a message is displayed.

You can load a derived Instance into the Instance Manager to compare the configuration of the 
derived Instance with a new Instance. If you load only the derived Instance into the Instance 
Manager, only the functions Expand, Collapse, personalized view, and Close are available.

Propagate Instance Revision
Important guidelines and restrictions to note:

The Propagate button is activated if you have Modify privilege for the Configuration 
Graph. Otherwise, the Propagate button is grayed out.

The Propagate function can only be applied to a not derived Instance.

On the Instances tab, when clicking the Propagate button, a pop-up window is opened that 
lists all Instances with Configuration Graph for all Model Option BOM revisions. Selecting an 
Instance from this list, copies its configuration to the selected Instance of the current Model 
Option BOM revision.

Example of the information shown in the select menu:

Note: Performed actions on the Instances tab are not tracked on the 
History tab.
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Figure 6–9 Instance select menu

Instance Manager

The Instance Manager is launched from the Instances tab of the Model containing the Model 
Option BOM. It shows the complete Model Option BOM and enables configuring the entries to 
derive the Instance BOM.

In the Instance Manager, more than one Instance can be opened. Configurable Instances are 
displayed with radio button options. The Save as Draft options applies to all opened Instances. 
To perform any of the other options, click to select the respective Instance first.

Figure 6–10 Configurable Instance display

Table 6–3 An example of the select menu selections

Model Revision Instance Item Name Item Description

A C00010 P00010 Test Name

Important: To be able to work with the Instance Manager, the setting 
'Internal Configurator' must be activated in the User Preferences.

To activate it, see: "Activating 'Internal Configurator' - Instance Manager" on 
page C-2.

You must have the Configure Instance privilege to open the Instance 
Manager. Otherwise the Launch Configurator button on the Instances tab is 
grayed out.

Important: Only one Instance Manager can be opened at a time.

Only if the Model Option BOM is valid, the Instance Manager is opened. 
Otherwise, an error message is displayed.

No error message is displayed when opening the Instance Manager for a 
Model without a BOM.



Configuring Agile PLM Variant Management

Variant Management 6-15

Table 6–4 Instance Manager buttons

Button Description

Validate Validates the selected configured instance against the combination 
rules.

Copy Configuration Note: Only active when more than one instance is opened in the 
Instance Manager.

Two instances open

First, a select mask is opened to select the source instance. Then 
it copies the configuration of the source instance into the target 
instance.

More than two instances open

First, a select mask is opened to select the source instance. Then 
it copies the configuration of the source instance into the target 
instance.

Reset Configuration Resets the configuration only for the selected instance only.

Reset Configuration resets the user configuration in the user interface. 
Reset Configuration does not save the Configuration Graph.

Note: If the Reset Configuration button is clicked a second time, and 
no modifications have been made since the first time the Reset 
Configuration button was clicked, then the reset configuration 
operation is not carried out again. An error message is displayed to 
inform the user that no reset was performed.

Expand Permits expanding either a certain number of levels of the Model 
Option BOM or only the normal assembly levels of Models and 
Option Classes.

Collapse Collapses the expanded structure.

Personalize Enables a View to be:

Personalized

Saved As

Deleted

Set as Default

Save as Draft Saves all user-modified configurations of opened Instance(s) in the 
Configuration Graph. The configuration graph is stored in the 
Configuration Graph field of the Instances tab.

The Configuration Graph of an Instance is deleted if the Instances 
were reset and the user did not subsequently modify the instance.

Note: This operation is not carried out if no modifications have been 
made to any of the opened Instances. Thus, no Configuration Graph 
will be generated or updated for those Instances. To inform the user 
that no save was performed, an error message will be displayed.

Create Instance Before creating the Instance BOM, the Save as Draft operation is 
called implicitly for all opened instances. All user-modified 
configurations of opened Instances are saved in the Configuration 
Graph. Then, only for the selected Instance, Crate Instance saves the 
Configuration Graph and creates the Instance BOM based on this 
graph. These actions are performed even if no user modifications have 
been made to the selected Instance.

Note: The Save as Draft operation, which is called implicitly, will not 
return an error in this situation if there are no user modifications to be 
saved.
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In the Instance Manager, quantities are displayed as entered. The correctly calculated value is 
only displayed in the derived Instance BOM.

Before continuing to work in the main Agile 9 window, make sure the Instance Manager 
window is closed.

When configuring the Instance, open issues of BOM items are indicated by the following icons:

Configuration Graph

In the Instance Manager, when you click the Save as Draft or Create Instance button, a 
Configuration Graph is created for the Instance. This Configuration Graph is stored as an XML 
file and contains information about all configurations that you made in the Instance Manager.

Derive Instance BOM
Once you have configured the Instance in the Instance Manager, you can derive the Instance 
BOM. For the derivation process, the Model Option BOM and the Configuration Graph are 
considered.

The derivation process starts when you click the Create Instance button, and no error message 
is returned for the configuration of the Instance.

If an error occurs during the derivation process, the derivation is stopped and the Instance BOM 
is not created completely. Remove manually the incomplete Instance BOM from the respective 
Instance, resolve the occurred error, and derive the Instance again.

Close Closes the Instance Manager.

If the configured instance wasn't saved before clicking the Close 
button, then a confirmation message is displayed.

Note: Before continuing to work in the main Agile PLM window, ensure 
that the Instance Manager window is closed.

Table 6–5 BOM item open issue icons

Icon Description

Indicates that there is an open issue at the respective BOM item. A detailed 
description of the open issue is shown in a tool tip when you place your mouse 
over the icon.

Indicates that there is an open issue in the structure of the respective BOM item.

Indicates that there is an open issue at the respective BOM item and in the 
structure of the respective BOM item.

Important: By default, the Configuration Graph field of the Instances tab is 
hidden. To make it visible, use the table Personalize command to edit the 
view.

Do not manually modify the Configuration Graph.

Table 6–4 (Cont.) Instance Manager buttons

Button Description
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During the process of deriving the Instance BOM, the Configuration Graph is stored, and the 
Instance BOM is saved.

The following is performed:

Models are replaced by newly created Parts.

Option Classes are replaced by options that were selected in its structure.

The correct quantity is calculated for parts, considering the quantities of all parent Option 
Classes.

Instance BOM
The Instance BOM describes a specific configuration derived from a Model Option BOM and 
contains only those options that have been selected in the Instance Manager. In addition, all 
mandatory BOM items of a Model Option BOM are also part of the Instance BOM.

The Instance BOM shows every Part with its correctly calculated quantity. The correct quantity 
for a Part that replaces an Option Class is calculated with the quantity of the Part, multiplied 
with the quantity of its parent Option Classes. The quantity calculation for Assemblies is done 
at top level, thus the quantity for children of Assemblies is not calculated. The quantity for an 
Assembly in the Instance BOM is the same as defined in the Model Option BOM.

The Instance Manager, after clicking the Create Instance button, shows a read-only preview of 
the derived Instance BOM. Modifications to the Instance BOM can be made in the BOM tab of 
the respective Instance.

Revisions

The following guidelines apply to revisions:

The Instances tab is revision specific. Each Instance is assigned to one specific Model 
revision. Thus, after creating a new revision of a Model, the Instances tab is empty. Newly 
added Instances to the Instances tab of this Model revision are always shown with their 
latest released revision.

Note: When a model is replaced by a newly created Part, in the Java Client, 
the Part subclass should have at least one Autonumber assigned to it and also 
AutoGenerate set to Yes.

Note: Once the Instance BOM is derived, the Instance BOM and the Model 
Option BOM can be modified independent of each other.

Note: If the quantity shows an alphanumeric value, no calculation is 
performed with this value. The Quantity field in the Instance BOM will show 
the alphanumeric value.

Important: The Model Option BOM and its objects can have different 
revisions, but it is strongly recommend to always use the latest revision of a 
Model Option BOM in the Instance Manager.
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– Instances on the Instances tab of older revisions of this Model are shown with their 
revision at the state before the revision of the Model was changed.

– In the just created Instance BOM, a Part is always shown with its latest released 
revision.

– In the just created Instance BOM, the Part, which replaces a selected Model, shows the 
same tab content as the tabs of the replaced Model.

Import / Export
The import / export behavior for Variant Management is the same as the standard import / 
export behavior. Variant Management import options include:

"Import Objects into Instances Table" on page 6-18.

"Import Configuration Graph into Instances Table" on page 6-18.

For more information see Agile PLM Import/Export User Guide.

Import Objects into Instances Table
For Variant Management you can import Parts as Instances into the Instances tab of Models.

Check the Instances tab for already derived Instances before performing an import to the 
Instances tab.

If the Instances tab contains already derived Instances, set the Smart Rule 
DeleteInstanceWithBOM to Allow. Otherwise, a warning is displayed and the import process 
is stopped at the point where the error occurred.

Import Configuration Graph into Instances Table
The Configuration Graph can only be imported into the same Agile 9 system.

When importing an Instance with Configuration Graph into a Model Option BOM, make sure 
the Model Option BOM contains the same BOM items and structure as the Configuration 
Graph.

Do not manually modify the Configuration Graph before importing it.

Important: Do not add and do not delete Instances from old Model 
revisions. Contact your Agile administrator to set the correct privileges for 
this behavior.

Note: This revision can be different to the revision shown in the Model 
Option BOM from which the Instance BOM is derived.

Note: The import from, or export into PDX files is not supported.

Note: The import process will not be rolled back and may be partially 
performed.

The import process will replace the complete Instances tab, independent of 
the selected import preferences for the Multi Row Update Mode.
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For further information about the Configuration Graph format see the Appendix of the Agile 
PLM SDK Developer Guide.

Working with Agile PLM Variant Management
The instructions in this section refer to Web client only, although some actions can also be 
performed in Java client.

Creating a Model Option BOM
The top level element of a Model Option BOM is always a Model. For a detailed description of 
possible combinations see Appendix C, "Configuring Variant Management."

A Model Option BOM can contain Models, Option Classes, Parts, Assemblies, and Documents.

To simplify the following examples, only Option Classes are added to the Model Option BOM.

Creating a Model
To create a Model:

1. Select Create New > Items > Parts.

The Create New Parts dialog box is opened.

2. In the new window, select the Type Model.

3. Enter a unique identification number (unique identifier for the Model) in the Number 
field, or click for the system to generate a number based on the Auto Numbering 
functionality defined for Models.

4. Click Save.

The new Model appears with the Title Block tab showing.

5. Fill in information as desired.

6. Click Save.

Creating a BOM Entry with Min/Max Value
You can define a minimum and maximum value for a BOM entry. The concrete value for this 
item is then selected in the Instance Manager for the Instance BOM.

To create a BOM Entry with Min/Max Value

1. Open the newly created Model.

2. Open the BOM tab.

3. Click the Add button.

4. Select an Option Class.

If no Option Class is selectable, create a new one.

5. Click the Add button.

Note: You must have Modify privilege for the Configuration Graph field. 
Item.Instance.Configuration Graph must be included in the Applied To 
property of Modify Items privilege mask in your role. Contact your Agile 
administrator if you have questions about your assigned roles.
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The Option Class is added to the Model BOM list.

6. To edit the Min Qty field double click it.

7. Enter a value for the minimum quantity and hit the enter key.

8. To edit the Max Qty field double click it.

9. Enter a value for the maximum quantity and hit the enter key.

The maximum quantity value has to be greater than or equal to the minimum quantity 
value.

10. Enter a value into the Qty field that is within the defined minimum / maximum range.

The value that is defined here is the default value shown in the Instance Manager.

11. To save the changes click the Save button.

Creating an Optional BOM Entry
You can define optional BOM entries. Such entries CAN be selected for the Instance BOM.

To create an Optional BOM Entry

1. Open the newly created Model.

2. Open the BOM tab.

3. Click the Add button.

4. Select an Option Class.

If no Option Class is selectable, create a new one.

5. Click the Add button.

The Option Class is added to the Model BOM list.

6. To edit the Optional field, double click it.

A select menu is opened.

7. Select Yes.

8. To save the changes click the Save button.

Creating a Mutually Exclusive BOM Entry
You can define mutually exclusive Option Class BOM entries. Only one valid BOM entry of 
this Option Class must be selected for the Instance BOM.

A detailed description of combination rules and their impact on the Instance BOM can be found 
under"Combination Rules" on page 6-7.

To create a Mutually Exclusive BOM Entry

1. Open the newly created Model.

2. Open the BOM tab.

3. Click the Add button.

4. Select an Option Class.

If no Option Class is selectable, create a new one.

5. Click the Add button.

The Option Class is added to the Model BOM list.
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6. To edit the Mut Excl field, double click it.

A select menu is opened.

7. Select Yes.

8. To save the changes click the Save button.

Creating an Optional Mutually Exclusive BOM Entry
You can define mutually exclusive Option Class BOM entries that are optional. If selecting this 
optional Option Class for the Instance BOM, only one valid BOM entry of this Option Class 
has to be selected for the Instance BOM as well.

A detailed description of combination rules and their impact on the Instance BOM can be found 
under "Combination Rules" on page 6-7..

To create a Mutually Exclusive BOM Entry

1. Open the newly created Model.

2. Open the BOM tab.

3. Click the Add button.

4. Select an Option Class.

If no Option Class is selectable, create a new one.

5. Click the Add button.

The Option Class is added to the Model BOM list.

6. To edit the Mut Excl field, double click it.

A select menu is opened.

7. Select Yes.

8. To edit the Optional field, double click it.

A select menu is opened.

9. Select Yes.

10. To save the changes click the Save button.

Adding Manufacturer Sites to a Model Option BOM
Agile PLM does not support site-specific information for Models and Option Classes, and thus 
the Site tab is disabled for Models and Option Classes.

Checking the Model Option BOM
A first check of the Model Option BOM can be carried out with the Check Model-Option BOM 
function in the More menu of the BOM tab.

Note: The BOM tab of this Option Class has to have at least one valid 
option. A detailed description of valid options can be found under 
Combination Rules.

Note: The BOM tab of this Option Class must have at least one valid 
option. A detailed description of valid options can be found under 
Combination Rules.
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To check the Model Option BOM:

1. Open the Model that contains the Model Option BOM.

2. Open the BOM tab.

3. Open the More menu.

4. Select Check Model-Option BOM.

If the Model Option BOM is correct, no error message is displayed.

If the Model Option BOM contains errors, a list with all errors is displayed.

Deriving an Instance BOM with the Internal Configurator
The information of this section applies to Web client only.

Once all BOM items have been added to the Model Option BOM, the different product variants 
can be derived to an Instance BOM.

The Instance BOM is referenced in the Instances tab of the Model containing the Model 
Option BOM. For every product variant an Instance (a Part) has to be created here. The 
Instance BOM, which will be derived with the help of the Instance Manager, is then added to 
the BOM tab of this Instance. Once the Instance BOM is derived, the Instance is displayed as 
an Assembly.

Creating an Instance
To Create an Instance:

1. Open the top level Model of the Model Option BOM.

2. Open the Instances tab.

3. Click the Add button.

4. Click the Create to Add button.

The Create New window for the type Part is opened.

5. Create a new Part.

This Part is then called Instance.

The created Part, which is the Instance, must be in a state in which it still can be modified 
(that is, a released part or a part with a pending change cannot be used as an Instance).

6. Click the Add button.

The Part is added to the Instances tab with the status Has no configuration.

Configuring One Instance
To configure one Instance:

1. In the Instances tab select the Instance of the respective product variant.

You can configure only Instances with no BOM assigned.

2. Click Launch Configurator.

Only if the Model Option BOM has been created with valid entries, then the Instance 
Manager is opened. Otherwise, error messages are displayed.

The Instance Manager is opened, showing all entries of the Model Option BOM. Guide 
icons are displayed next to any selections with open issues.



Working with Agile PLM Variant Management

Variant Management 6-23

Figure 6–11 Guide icons indicate open issues

At the end of the table, the columns Select and Quantity have been added to an Instance.

An entered Reference Designator in the Model Option BOM is copied into the Ref Des 
field of the Instance Manager. Its value of the Qty field in the Model Option BOM is 
copied into the Quantity field of the Instance Manager.

For complete information about Reference Designator, see "Working with Reference 
Designators" on page 5-30.
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Figure 6–12 Reference Designators

3. In the Select column, select all entries for the Instance BOM.

4. In the Quantity column, - where possible - enter the quantity for the Instance BOM.

5. Click Save as Draft to save the configured Instance BOM.

As soon as the Instance is saved, the Configuration Graph is created. The status of this Instance 
is set to Has Configuration Draft.

Validating the Instance
Before you can create the Instance BOM, you must validate the configured Instance.

To validate the Instance:

1. In the Instances tab select an Instance.

2. Click Launch Configurator.

The Instance Manager is opened, showing all entries of the Model Option BOM.

3. Click Validate.

This checks if the configuration complies with all combination rules.

A detailed description of combination rules and their impact on the Instance BOM can be 
found under "Combination Rules" on page 6-7.

If the validation returns errors, a message similar to the following is displayed.
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Figure 6–13 Instance manager validation error

In this case, you must resolve the listed errors first.

Comparing and Modifying Instances
In the Instance Manager, more than one Instance can be opened. Opening multiple Instances 
enables you to compare the configuration of Instances with each other and modify more than 
one Instance at a time.

To compare the configuration of Instances:

1. In the Instances tab select all Instances that you want to compare.

For comparison, an already derived Instance BOM can also be opened in the Instance 
Manager.

2. Click Launch Configurator.

The Instance Manager is opened, showing all entries of the Model Option BOM, and the 
configuration of each Instance.

Note: The same validation is carried out when clicking the Create 
Instance button.

Note: Only if the Model Option BOM is valid, the Instance Manager is 
opened. Otherwise, an error message is displayed.

An already derived Instance BOM is not validated again before opening it in 
the Instance Manager.
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Figure 6–14 Comparing and modifying instances

Creating the Instance BOM
Once you have done all configurations and resolved possible errors, the Instance BOM can be 
created.

To create the Instance BOM:

1. Select the Instance.

2. Click Create Instance.

The Instance BOM is created and is displayed as a preview in the Instance Manager window. A 
Back button at the bottom left of the Instance Manager window lets you go back to the 
configuration window in the Instance Manager, which is displayed as read-only.

The BOM tab of this Instance shows the result of the configurations performed in the Instance 
Manager.

Note: The Save as Draft operation applies to all Instances opened in the 
Instance Manager. The Create Instance operation applies only to the 
selected Instance.

Note: In the Instances tab of the Model, the previously created Part for the 
Instance is now displayed with the Icon of an Assembly. The status of the 
Instance is set to Has derived Instance BOM.
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Propagating the Configuration of One Instance to Another
Once the Instances tab of the Model Option BOM contains a derived Instance BOM or an 
Instance with Configuration Graph, the Configuration Graph of this Instance BOM can be 
propagated to a not derived Instance.

To propagate the Configuration Graph of one Instance to another:

1. Open the Instances tab.

2. Select a not derived Instance (target Instance).

3. Click Propagate.

The Select an Instance for propagating a configuration to Pxxxx window is opened.

4. From the Instance: drop-down menu, select the source Instance from which the 
configuration should be propagated to the target Instance.

5. Click OK.

If the target Instance already contains a configuration, then a Warning is issued.

Now, the target Instance contains the same configuration as the source Instance and its status is 
set to Has Configuration Draft.

Importing / Exporting Variant Management Information
All items and their subclasses can be imported into, and exported from Agile PLM.

For complete information about how to import/export, see Agile Product Lifecycle Management 
Import/Export User Guide.

Exporting into aXML Files
To export into aXML files:

1. Open the model you would like to export.

2. Click Actions.

3. Select Export.

The Export - Select Objects to Export window is opened.

4. From the Format field, select aXML.

5. Click Next.

6. Select Create custom filter.

7. Click Next.

The Export - Select Item content to export window opens.

8. Select Instances.

Ensure that the selection Instances is selected. Otherwise, it is not included in the exported 
file.

9. Click Next.

The Export - Specify Export Properties window opens.

10. Enter your information.

11. Click Export.
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Importing aXML Files
For detailed information on how to import aXML files, see the Agile Product Lifecycle 
Management Import/Export User Guide.

To import aXML files:

1. In Agile 9 from the Tools and Settings menu select Import.

2. In the Import Wizard, browse for the file to be imported.

3. Click Next.

The Import - Specify File Content window is opened.

4. Expand Item.

5. Select Item only, Bill of Material, and Instances.

Every other selection is optional.

6. Click Next.

The Import - Select Content Options window is opened.

Make your selections.

7. Click Next.

The Import - Specify Attribute Mapping window is opened.

8. Map the fields to be imported to the Agile Fields.

9. Click Next.

The Import - Review Import Definition window is opened.

10. Review the summary of your import definition.

11. Click Import.

Importing/Exporting PDX Files
The capability to import from and to export to PDX files is not supported for Variant 
Management.

Exporting into Text (csv) or Excel (xls) Files
To export into Text (csv) or Excel (xls) files:

1. Open the model you would like to export.

2. Click Actions.

3. Select Export.

The Export - Select Objects to Export window is opened.

4. From the Format field, select either Text (csv) or Excel (xls).

5. Click Next.

6. Select Create custom filter.

7. Click Next.

The Export - Select Item content to export window is opened.

8. Select Instances.
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Ensure that the selection Instances is selected. Otherwise, it is not included in the exported 
file.

9. Click Next.

The Export - Specify Export Properties window is opened.

10. Enter your information.

11. Click Export.

Importing Text (csv) or Excel (xls) Files
For detailed information on how to import Text (csv) or Excel (xls) files, see the Agile Product 
Lifecycle Management Import/Export User Guide.

To import Text (csv) or Excel (xls) files:

1. Prepare the file to be imported.

2. Open the Import Wizard.

3. Browse for the file to be imported.

4. Click Next.

The Import - Specify File Content window is opened.

5. In the Item section, select the Instances option.

6. Click Next.

The Import - Select Content Options window is opened.

Make your selection.

7. Click Next.

The Import - Specify Attribute Mapping window is opened.

8. Map the fields to be imported to the Agile Fields.

9. Click Next.

The Import - Review Import Definition window is opened.

10. Review the summary of your import definition.

11. Click Import.

Repeat these steps to import the information from any other tab of a Model.

Working with Agile PLM Variant Management - External 
Configurator

The following section describes how to derive an Instance BOM with the Oracle Generic 
Configurator User Interface.

Deriving an Instance BOM with the External Configurator
Settings, as described in the section External Configurator - Oracle Generic Configurator User 
Interface must be done before working with the Oracle Generic Configurator User Interface.

After creating the Model Option BOM as described in this document, you can use the Oracle 
Generic Configurator User Interface to derive an Instance BOM.
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Creating an Instance BOM with the External Configurator
For further information about how to create an Instance, see "Creating an Instance" on 
page 6-22.

To create an Instance BOM:

To configure the instance in the Oracle Generic Configurator User Interface, a Change Order 
with the respective workflow assigned to it must be created first.

For further information about how to set up the respective workflow, see: Agile PLM 
Integration Pack for Oracle E-Business Suite - Design to Release 2.5 - Implementation Guide.

1. Select the Model that contains the Model Option BOM.

2. Select Actions > Create New > Change.

3. From the Type field select ECO.

4. Click Save.

5. On the Cover Page tab in the Workflow field select the respective workflow.

6. Open the Affected Item tab.

7. Add all items of the Model Option BOM.

8. Add a new revision in the NewRev column for all entries (for example, A).

9. In the Lifecycle Phase column select Prototype for all entries.

10. Set the Status of the ECO to Released.

In EBS, the released ECO must be set to Implemented. The Oracle Generic Configurator 
User Interface can only show those BOM items that have been set to Implemented.

11. In the Instances tab of the Model select the Instance of the respective product variant.

You can configure only Instances with no BOM assigned.

The created Part, which is the Instance, has to be in a state in which it still can be modified 
(for example, a released part or a part with a pending change cannot be used as an 
Instance).

12. Click Launch Configurator.

The Oracle Generic Configurator User Interface window is opened. A login is required for 
it.

Only if the Model Option BOM has been created with valid entries, the Oracle Generic 
Configurator User Interface is opened. Otherwise, an error message is displayed.

The Oracle Generic Configurator User Interface shows only optional BOM items. 
Mandatory BOM items are not displayed.

13. In the Select column, select all entries for the Instance BOM.

14. In the Quantity column, - where possible - enter the quantity for the Instance BOM.

The Oracle Generic Configurator User Interface always shows the absolute quantity 
values.

When changing the quantity of a child item, consider that the new value has to be a 
multiple of its default quantity. Further information about Quantity Cascade Calculations 
can be found in the Oracle Configurator Developer User Guide on OTN 
(http://www.oracle.com/technology/documentation/applications.html).

15. In the Generic Configurator User Interface click Finish to save the configured Instance 
BOM back to Agile A9.
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In Agile A9 the Configuration Graph calculates the absolute quantity values back to 
relative quantity values.
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7Changes

The following classes, or types, of changes are available in Agile PLM:

Change Orders class, including engineering change orders (ECOs) and Design File Change 
Orders (DFCOs)

Change Requests class, including engineering change requests (ECRs)

Manufacturer Orders class, including manufacturing change orders (MCOs)

Site Change Orders class, including site change orders (SCOs)

Deviations class

Stop Ships class

Change Classes
Each Agile PLM class has at least one out-of-the-box subclass. The Agile administrator may 
decide to use some or all of these change classes and subclasses, and may have created 
additional subclasses. For example, under the Change Orders class, you might have ECOs, 
Mechanical ECOs, Software ECOs, and so on.

The purpose of each change subclass is listed in the following table. Corresponding change 
icons are also listed. These icons are displayed next to the change number on the Changes tab 
of the item, and next to each change in search results.

Table 7–1 Change subclasses

Change type Purpose

Change Order:

ECO

(Web Client)

 

(Java Client)

An engineering change order tells users that changes need to be made to specific 
items, and to go ahead and do the work required to make those changes.

ECOs create a new, trackable revision of an item.

ECOs can affect common and site-specific portions of the BOM and AML.

ECOs allow you to:

Release new items.

Create revision-specific redline modifications to BOMs, to manufacturer data, 
and to attachments.

Create change-controlled redline modifications to item attributes.

See Chapter 8, "Affected Items of Changes."

See "Redlining through ECOs" on page 7-21.
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Change Order:

DFCO

Web Client only

The Design File Change Order (DFCO) change order subclass is used to publish 
Design files. The DFCO has an Affected Files tab. Typically, DFCOs are used in 
conjunction with Agile Engineering Collaboration, which connects Agile PLM 
with your CAD system environment.

The DFCO subclass is available only if your Agile administrator has enabled it.

See "Affected Files Tab" on page 7-8.

ECR

(Web Client)

(Java Client)

An engineering change request is used to request a change to be made to items. 
You can create an ECR against a non-latest released revision of an item.

MCO

(Web Client)

(Java Client)

A manufacturer change order tells users that changes need to be made to the 
manufacturing data of specific items.

MCOs can affect common and site-specific portions of the AML.

MCOs allow you to:

Release new items.

Redline the manufacturer data of an item.

Change the lifecycle phase of items.

Create change-controlled redline modifications to item attributes.

See "Redlining through MCOs" on page 7-21.

SCO

(Web Client)

(Java Client)

A site change order tells users that changes need to be made to site-specific 
items, and to go ahead and do the work required to make those changes. SCOs 
affect only the site-specific portion of the BOM and AML. They do not affect the 
common portion of the BOM and AML. You can create an SCO against a 
non-latest released revision of an item. SCOs let you redline BOMs and AMLs.

Deviation

(Web Client)

(Java Client)

A deviation is used to deviate from a process or specification for a specific time 
period. You can create a deviation against a non-latest released revision of an 
item. Deviations do not have any redlining functions.

Table 7–1 (Cont.) Change subclasses

Change type Purpose
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For information about changing the subclass of a change, see the chapter about workflows in 
Getting Started with Agile PLM.

Change Objects
This section includes the following topics:

"Cover Page Tab" on page 7-4

"Affected Items Tab" on page 7-7

"Workflow Tab" on page 7-8

"Relationships Tab" on page 7-13

"Attachments Tab" on page 7-13

"History Tab" on page 7-14

When you view a change in Web Client, information about the change is displayed on tabs in 
the right pane, the content pane.

When you view a change in Java Client, information about it is displayed on tabs in its object 
window.

The following table shows the tabs and the default fields for changes.

The Agile administrator may have added additional tabs or sections, called Page Two and Page 
Three by default. (The Agile administrator may have renamed these tabs in your Agile PLM 
system.) These tabs or sections contain custom fields defined by the administrator.

Stop Ship

(Web Client)

(Java Client)

A stop ship alerts users to stop shipping or using an item. You can create a stop 
ship against a non-latest released revision of an item. Stop ships do not have any 
redlining functions.

Table 7–2 Change object tabs

Tab name Tab information includes

Cover Page General information about the change plus any unique fields defined 
by the Agile administrator.

Affected Items Which items are affected by the change. ECOs include redlined 
BOMs, AMLs, and file folders. SCOs include redlined BOMs and 
AMLs for a site. MCOs include redlined AMLs.

ECOs and MCOs also include change-controlled redlined item 
attributes.

Affected Files Which file folder files are affected by the DFCO.

See "Affected Files Tab" on page 7-8.

Workflow Approvers, observers, and acknowledgers of the change and the results 
of their reviewing the change.

The statuses of the workflow.

Table 7–1 (Cont.) Change subclasses

Change type Purpose
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Cover Page Tab
The Cover Page tab of a change shows the information traditionally shown on a paper ECO 
form. Agile PLM completes some fields and then you complete the rest of the fields.

This section contains the following topics:

"Fields on the Cover Page Tab" on page 7-4

"Status on the Cover Page Tab" on page 7-6

To edit fields on the cover page tab in Web Client:

1. Click the Edit button, modify the fields, and then click the Save button.

To edit fields on the Cover Page tab in Java Client:

1. Modify the fields and click Save.

Sometimes you cannot edit a field. A field may be uneditable for three reasons:

You do not have sufficient privileges to modify that field.

The field is automatically filled in as the change progresses through its workflow statuses, 
for example, Status, Date Released, or Final Complete Date.

The field may not be edited when a certain event has occurred - for example, the 
Workflow field cannot be edited after the workflow has moved out of the Pending status.

For information about all change object tabs, see "Change Objects" on page 7-3.

Fields on the Cover Page Tab
The following table summarizes the Cover Page fields and the information that they contain. 
The fields on the Cover Page tab vary from one change type to another.

In Web Client, the Cover Page can contain two additional sections, called Page Two and Page 
Three by default. In Java Client, these are separate tabs. The Agile administrator determines 
whether these sections are enabled, and what they are called.

Relationships The Relationships tab lets you create relationships and dependencies 
between the current change object and other Agile PLM objects, both 
routable objects and lifecycle objects. For more information about 
relationships, see Getting Started with Agile PLM.

Attachments Attached files and URLs.

History A record of the actions taken on the change.

Table 7–3 Cover Page tab fields

Field How completed Contents

Number Usually automatically, when created, 
but may be configured for manual 
entry.

The number assigned to the change 
when you create it.

Status Automatically, when created, updated 
as the change moves through the 
assigned workflow.

Change status, described in "Status on 
the Cover Page Tab" on page 7-6. If no 
workflow has been selected, then this 
field is Unassigned.

Change Type Automatically, when created. The type of change selected when you 
create the change.

Table 7–2 (Cont.) Change object tabs

Tab name Tab information includes
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Change Category Usually manually, can contain a 
default.

Category defined by the Agile 
administrator (can be selected from a 
drop-down list).

Description Of 
Change

Usually manually, can contain a 
default.

Maximum number of bytes is set by 
the Agile administrator, can be up to 
4000 bytes, including spaces and 
carriage returns (which count as 2 
bytes). Non-English characters can be 
2, 3, or 4 bytes.

Reason For 
Change

Usually manually, can contain a 
default.

Maximum number of bytes is set by 
the Agile administrator, can be up to 
4000 bytes, including spaces and 
carriage returns (which count as 2 
bytes). Non-English characters can be 
2, 3, or 4 bytes.

Reason Code Usually manually, can contain a 
default.

Code defined by the Agile 
administrator (can be selected from a 
drop-down list).

Workflow Automatically (if only one workflow 
applies to the change), when the 
change is moved to the next status 
from the Unassigned status. If more 
than one workflow applies to the 
change, then the workflow is selected 
manually, the workflow selection can 
be changed only if the change is in the 
Pending status type. Selecting the 
blank field in the Workflow 
drop-down list switches the change to 
the Unassigned status.

The name of the workflow being used 
to move this change through the 
change control process.

Change Analyst or 
Component 
Engineer

May be provided automatically by the 
workflow. If you have the appropriate 
Modify privilege, then the routing 
manager can be selected manually 
from an address book list of change 
analysts or component engineers.

Default routing manager. If the 
workflow is defined to notify the 
default change analyst or component 
engineer, then the user in this field 
receives notifications about the 
change. If this field is left blank, then 
the notifications are sent to every 
change analyst or component engineer 
on the list. If the notification definition 
in the workflow is blank, then no 
notifications are sent.

Originator Usually automatically, when created 
(with the default set by the Agile 
administrator).

The user who created the change (can 
be selected from a drop-down list).

Date Originated Usually automatically, when created. The date the change was created.

Date Released Automatically, when released. The date the change was released.

Final Complete 
Date

Automatically, when the change enters 
the Complete status Type.

The date the change moved into the 
Complete status Type.

Product Line(s) Usually manually, can contain a 
default.

Product line defined by the Agile 
administrator (can be selected from a 
drop-down list).

Table 7–3 (Cont.) Cover Page tab fields

Field How completed Contents
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The Cover Page tab for deviations has two unique fields, Effective From and Effective To. 
The Cover Page tab for stop ships has one unique field, Resume Date.

The Cover Page tab for MCOs has a Component Engineer field (in the place of a Change 
Analyst field).

For information about all change object tabs, see "Change Objects" on page 7-3.

If the workflow specifies a Default Change Analyst, then the Change Analyst field is 
automatically populated by the workflow, even if you do not have Modify privilege for the 
Change Analyst field.

Status on the Cover Page Tab
A label in the top right corner of a change indicates the status of the change. The Agile 
administrator defines the name of each status in each workflow.

Functional Teams Manually. One or more Functional Teams that are 
used to assign approvers, observers, 
and acknowledgers according to work 
place job functions. For more 
information about functional teams and 
the approval matrix feature, see Agile 
PLM Administrator Guide and Getting 
Started with Agile PL M.

Effective From Manually. Deviations only. The date the deviation 
goes into effect.

Effective To Manually. Deviations only. The date the deviation 
is no longer in effect.

Resume Date Manually. Stop Ships only. The date the stop ship 
is no longer effective and the company 
can resume shipping of the item.

Note: The Agile administrator may have created customized workflows 
and statuses for your company. The table below lists only the 12 Agile PLM 
default workflow statuses.

Table 7–4 Default Workflow status definitions

Status name Status definition

Unassigned

(no status type)

No workflow has been assigned to this change. The originator may 
still be developing the change. No statuses are displayed on the 
Workflow tab.

Pending

(Pending status type)

The originator may still be developing the change. It has not yet been 
approved or perhaps even completed.

Submitted

(Submit status type)

The change has been routed to the change analyst or component 
engineer for review and analysis.

CCB

(Review status type)

The change has been routed to the members of the change control 
board (CCB) for approval.

Table 7–3 (Cont.) Cover Page tab fields

Field How completed Contents
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The Workflow tab shows all the statuses the change has been through, and the statuses 
remaining to complete the change control process. See "Workflow Tab" on page 7-8.

With appropriate privileges, you can switch a change to another status with the Workflow tab 
or the Next Status button. For more information, see the chapter on workflows in Getting 
Started with Agile PLM.

For information about all change object tabs, see "Change Objects" on page 7-3.

Affected Items Tab
The Affected Items tab lists the items that are affected by a change. Users with sufficient 
privileges can complete the Affected Items tab and use it to redline BOMs, manufacturing 
data, and attachments. Also, on the Affected Items tab of ECOs and MCOs, you can create 
change-controlled redline modifications to item attributes.

To open an item listed on the Affected Items tab:

In Web Client, click the item number link. The item opens with the Title Block tab on top. 
Alternately, you can use the Quick View feature to display Title Block attributes and 
attachment information of an item. Hover the cursor over the item link, and when the 
Quick View tooltip appears, click the tooltip to open the Quick View palette.

In Java Client, double-click the affected item row. The item opens with the Title Block tab 
on top.

Released

(Released status type)

The change has been signed off by the CCB members and released.

Closed

(Complete status type)

The change is an ECR that has been accepted and implemented.

Expired

(Complete status type)

The change is a deviation where the Effective To date has been 
reached.

Implemented

(Complete status type)

The change is an ECO or SCO that has been implemented or 
incorporated into new drawings.

Hold

(Hold status type)

The change has been placed on hold while information is being 
gathered by the component engineer.

Resumed

(Complete status type)

The change is a stop ship that has been lifted. Production of affected 
items can resume.

Canceled

(Cancel status type)

The change has been canceled due to a fundamental flaw or rejection 
by several people.

First Article Complete

(Complete status type)

The manufacturer part has been received and passed incoming 
inspection or quality assurance. The physical part has been validated 
against design documents or specifications (MCO only).

Note: If you do not have Discovery and Read privileges for an item, then it 
does not appear on the Affected Items tab. You may see a message telling 
you how many items are not displayed.

Table 7–4 (Cont.) Default Workflow status definitions

Status name Status definition
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Or, right-click the item row, choose Open, and then choose a tab. The item opens with the 
selected tab on top.

The revision associated with the change is selected in the Rev drop-down list.

For information about all change object tabs, see "Change Objects" on page 7-3.

For information about working with Affected Items tabs, see the chapter, Chapter 8, "Affected 
Items of Changes."

Affected Files Tab
The Affected Files tab is an optional change object tab; it is visible only if the Agile 
administrator has enabled it for a specific change subclass. The Affected Files tab is visible on 
the Design File Change Order (DFCO) subclass. Typically, DFCOs are used in conjunction 
with Agile Engineering Collaboration, which connects Agile PLM with your CAD system 
environment.

DFCOs use the Agile PLM workflow process to submit file folders and the files they contain 
for publication, to redline and update those files, to route them for signoff approval, and then to 
publish the files folders with a specified LifeCyle Phase and a specific Version number and 
Publication Sequence number.

For more information about the Affected Files tab and the Design File change process, see:

Getting Started with Agile PLM, chapter "Working with Design File Change Orders 
(DFCOs)"

Agile PLM Administrator Guide, chapter "Administering Design File Change Orders 
(DFCOs)"

Agile Engineering Collaboration 3.5 Documentation:

http://www.oracle.com/technetwork/documentation/agile-085940.html#ec

Workflow Tab
The Workflow tab shows all the statuses the change has passed through, and which statuses 
remain to be completed. It also shows all the approvals, rejections, and acknowledgments made 
during each approval cycle.

For example, suppose a change is returned to the originator, reworked, and then resubmitted for 
a second approval cycle. The Workflow tab shows the approvals, rejections, and 
acknowledgments of the change made during the first approval cycle, and during the second 
approval cycle.

Depending on where the change is in the workflow, the Workflow tab can have up to three 
sections:

"Workflow Overview Section" on page 7-9

"Web Client Workflow Tab, Base View" on page 7-9

"Web Client Current Signoff Status View" on page 7-10

"Java Client Workflow Tab Summary Table" on page 7-11

"Java Client Workflow Tab Signoff History Table" on page 7-11

For information about all change object tabs, see "Change Objects" on page 7-3.
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Workflow Overview Section
The top section of the Workflow tab (visible for all changes that have been assigned a 
workflow) displays the name of the assigned workflow and a flowchart of the workflow. The 
current status of the change is highlighted in the flowchart.

Some of the statuses in the flowchart are links. Links are underlined. You can switch the change 
to one of these statuses by clicking the link and filling in the Notify field. You need sufficient 
privileges to do this.

In Web Client, the status with an orange background is the current status. At the top of the 
Summary flowchart pane, click to hide the flowchart, or click to display the hidden flowchart.

In Java Client, the status with a yellow background is the current status. At the top of the 
flowchart pane, click the Hide/View workflow chart button to hide the flowchart or view a 
hidden flowchart.

The ability to add or remove approvers, observers, or acknowledgers is controlled by the Ad 
Hoc Reviewers property settings for each workflow. In addition, you must have the appropriate 
privileges to add or remove approvers, observers, or acknowledgers. If the Agile administrator 
has not granted the appropriate privileges to you, then the buttons on the Workflow tab are not 
available, and you cannot perform the actions.

In Web Client:

The Add Reviewers and Remove Reviewers buttons appear at the top left of the Workflow 
table. Click the button for the action you want to perform, and then follow the dialog 
instructions.

In Web Client, the Resolve Missing User action also adds a reviewer to the workflow table. 
When the Missing User icon appears in the Reviewer cell of the workflow table, double-click 
inside the cell where the icon appears and specify a job function user for the missing reviewer. 
For more information, see Getting Started with Agile PLM, "Routing Objects with Workflows" 
chapter.

In Java Client:

The Add Approvers/Observers and Remove Approvers/Observers buttons appear at the top 
left of the Workflow tab. To add approvers or observers, and click and select the workflow 
status you want in the dialog. To remove an approver or observer, click and choose the status 
you want in the dialog.

Web Client Workflow Tab, Base View
The Web Client workflow table shows the status information for the change, including the 
signoff information for past, current, and future signoff statuses. It has the following columns 
by default. The Agile administrator may have modified the table:

Status Code - icon indicating the action or state for the status table row.

Table 7–5 Workflow status code icons

Icon Definition

Future. The change workflow has not yet moved to this status.

Current. The workflow status of the change, the workflow is currently in this status.

Forward. The change moved forward to the next status in the workflow.
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Workflow - the name of the workflow that the change is following.

Workflow Status - the name of the status.

Action - the action taken by the reviewer.

Req'd - whether the reviewer is a required reviewer (approver or acknowledger) or not 
(observer).

Reviewer - the user who reviewed the change. This can be an approver, an acknowledger, 
or an observer, and it can be a single user or a user group.

Signoff User - the name of the user who actually approved, acknowledged, or rejected the 
change.

Status Changed By - the name of the user who switched the status.

Local Client Time - the date and time of the action.

Signoff Comments - any comments made by the reviewers (approvers, acknowledgers, 
and observers) during signoff.

Reviewer Job Function - the assigned job function of the reviewer as defined in the 
functional team.

Signoff Duration - the number of days the reviewer has taken to sign off the change for 
that status.

User Action Time - This is the date and time on the computer where the action was 
performed. See "User Action Timestamp" on page 7-12.

See also "Workflow Tab" on page 7-8, "User Action Timestamp" on page 7-12, "Signoff 
Duration" on page 7-12.

Web Client Current Signoff Status View
In the Views drop-down list, choose Current Sign-off Status to view only the signoff 
information for the current Review-type or Release-type status. If the current status is not a 
review or release status, then no data is displayed for this view.

The Current Signoff Status view has the following columns by default. The Agile administrator 
may have modified the table

Status Code - icon indicating the action or state for that table row, not used in the Current 
Status View.

Workflow - the name of the workflow that the change is following.

Workflow Status - the name of the status, not used in the Current Signoff Status View.

Action - the action taken by the reviewer.

Req'd - whether the reviewer is a required reviewer (approver or acknowledger) or not 
(observer).

Backward. The changed moved backward in the status list of the workflow. For example, 
when the Change Analyst returns the change to the originator, the change moves backward 
in the workflow.

Skip. The change skipped a status as it moved forward in the workflow.

Table 7–5 (Cont.) Workflow status code icons

Icon Definition
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Reviewer - the user who reviewed the change. This can be an approver, an acknowledger, 
or an observer, and it can be a single user or a user group.

Signoff User - the name of the user who actually approved, acknowledged, or rejected the 
change.

Status Changed By - the name of the user who switched the status.

Local Client Time - the date and time of the action.

Signoff Comments - any comments made by the reviewers during signoff.

Signoff Duration - the number of days a reviewer has taken to sign off the change for that 
status.

Reviewer Job Function - the assigned job function of the reviewer as defined in the 
functional team.

See also "Workflow Tab" on page 7-8, "User Action Timestamp" on page 7-12, "Signoff 
Duration" on page 7-12.

Java Client Workflow Tab Summary Table
The Summary table records the transition of the change through the workflow statuses and the 
signoff information for the each review-type status or released-type status. It has the following 
columns by default. The Agile administrator may have modified the table:

Action - the action taken by the reviewer.

Req'd - whether the reviewer is a required reviewer (approver or acknowledger) or not 
(observer).

Reviewer - the user who reviewed the change. This can be an approver, an acknowledger, 
or an observer, and it can be a single user or a user group.

Signoff User - the name of the user who actually approved or rejected the change.

Local Client Time - the date and time of the action.

Signoff Comments - any comments made by the reviewers during signoff.

Signoff Duration - the number of days a reviewer has taken to sign off the change for that 
status.

Reviewer Job Function - the assigned job function of the reviewer as defined in the 
functional team.

See also "Workflow Tab" on page 7-8, "User Action Timestamp" on page 7-12, "Signoff 
Duration" on page 7-12.

Java Client Workflow Tab Signoff History Table
The Signoff History table of the Workflow tab lists and signoff information for the current 
Review-type or Release-type status. If the current status is not a review or release status, then 
the Signoff History table is not displayed.

The Signoff History table has the following columns by default. The Agile administrator may 
have modified the table:

Workflow - the name of the workflow that the change is following.

Workflow Status - the name of the status.

Action - the action taken by the reviewer.

Req'd - whether the reviewer is a required reviewer (approver or acknowledger) or not 
(observer).
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Reviewer - the user who reviewed the change. This can be an approver, an acknowledger, 
or an observer, and it can be a single user or a user group.

Signoff User - the name of the user who actually approved, acknowledged, or rejected the 
change.

Status Changed By - the name of the user who switched the status.

Local Client Time - the date and time of the action.

Signoff Comments - any comments made by the reviewers during signoff.

Signoff Duration - the number of days a reviewer has taken to sign off the change for that 
status.

Reviewer Job Function - the assigned job function of the reviewer as defined in the 
functional team.

See also "Workflow Tab" on page 7-8, "User Action Timestamp" on page 7-12, "Signoff 
Duration" on page 7-12.

Signoff Duration
Signoff Duration data is recorded for statuses that have reviewers: Review-type statuses and 
Release-type statuses. Signoff Duration records time in a manner similar to a stop watch or 
timer. The recorded time indicates either how long each reviewer has been able to signoff the 
change for that status, but has not yet done so, or the number of days it took the reviewer to 
signoff the change for that status.

Signoff Duration is recorded for each user in days. It is the lesser of:

Time since the change entered the workflow status. The time is recorded for the most 
recent entry into the status.

Time since the user was last added to this workflow status.

The Signoff Duration timer begins recording duration time when the user becomes a reviewer, 
either when the change enters the signoff status or the user is added as a reviewer to the signoff 
status.

The signoff duration timer continues to increment one day at a time. The timer freezes when:

The reviewer signs off the change for that status.

The change exits that status

If the change enters a specific signoff status multiple times, then a separate duration is recorded 
for each time the change enters the status.

Signoff Duration time is recorded in days. When a change enters a signoff status, if a reviewer 
signs off within the first 24 hours, then the Signoff Duration time is recorded as 0 (zero).

User Action Timestamp
Agile PLM provides two ways to record the date and time of any action taken against the 
change:

Local Client Time - This is the date and time as shown on the local client computer of the 
user who is viewing the timestamp. Local client time is the default method of viewing 
timestamps.

For example, if Mary approves a change at 12 noon in New York (Eastern Time), then 
when John looks at the Workflow tab of the change in California, he sees the time Mary 
approved the change as 9 o'clock in the morning (Pacific Time).
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User Action Time - This is the date and time on the computer where the action was 
performed. User action time is optional.

If Mary approves a change at 12 noon in New York, then when John in California looks at 
the Workflow tab of the change, he sees the following:

– In the Local Client Time column, the time Mary approved the change is 9 o'clock in 
the morning (Pacific Time).

– In the User Action Time column, the time Mary approved the change is 12 noon 
(Eastern Time).

When Mary looks at the Workflow tab of the change, she sees the following:

– In the Local Client Time column, the time she approved the change is 12 noon 
(Eastern Time).

– In the User Action Time column, the time she approved the change is 12 noon 
(Eastern Time).

Local Client Time always appears on the Workflow tab and History tab. User Action Time is 
optional, and is displayed on the Workflow tab of changes and the History tab of any Agile 
PLM object only if the Agile administrator specifies this.

See also: "Workflow Tab" on page 7-8.

Relationships Tab
The item object Relationships tab lets you create relationships with other business objects, 
both lifecycle objects and routable objects. If the related object is a routable object, then you 
can specify a rule for the relationship, thus creating a dependency between the current item and 
the routable object. A relationship with a rule indicates a routable object whose workflow 
progression is affected by the lifecycle phase of the current item object.

A relationship with no specified rule does not limit or affect the workflow progression of the 
related routable object. You can use non-rule relationships to record objects that are somehow 
related to the current item, but do not have any dependencies with the current item.

Revision-specific relationships are available to you only if the Agile administrator has 
configured Agile PLM to enable revision-specific relationship capabilities. Revision-specific 
relationships allow you to select a specific revision for a Part object, Document object, or 
Published Price object in a relationship 

If Agile PLM has been configured for the use of reference objects, then you can add, on the 
Relationships tab, a reference, or link, to an object in an external application.

For more information about relationships, revision-specific relationships, reference objects, and 
how to use this tab, see the chapters about working with business objects in Getting Started 
with Agile PLM.

Attachments Tab
All objects have an Attachments tab. On the Attachments tab, you can attach files and URLs 
to the object by referencing those files and URLs in a file folder object. On the Attachments 
tab, you can view, copy (get), or print attached files if you have the appropriate privileges.

Note: You cannot specify a rule for an item relationship with another 
lifecycle phase (non-routable) object.
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Individual attached files are stored in file folder objects and can be attached to multiple objects. 
The files in a file folder object can be drawings or scanned images, documents, non-viewable 
files, compressed files, and so on.

For detailed information about working with file folder objects and the Attachments tab, see 
Getting Started with Agile PLM.

For information about all change object tabs, see "Change Objects" on page 7-3.

For information about working with Thumbnails, see Getting Started with Agile PLM.

History Tab
The History tab shows a summary of actions taken against an object, including a description of 
the action, which user took the action, the date of the action, and other details.

The History tab shows a summary of actions taken against the change, including:

The current status of the change

The next status of the change

A description of the action

Which user took the action

The date and time of the action (local client time)

The user action time (optional, see "User Action Timestamp" on page 7-12.

Which affected object was the subject of the action

The find number of the component of the affected item

Details of the action

Comments made by users

Users notified

While the change status is Unassigned or Pending, the following actions are recorded on the 
History tab:

The creation of the change.

Any subclass modifications.

Any actions on the Relationships tab and the Attachments tab.

Comments

Send

Print

Note: Files that pertain to an item should be referenced on the 
Attachments tab of the item, rather than the Attachments tab of a change 
that affects the item.

Note: If you do not have the appropriate Read privilege for an object, then 
you cannot see the contents of the fields on the History tab. See "Details 
about Discovery and Read Privileges" on page 10-1.
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Subscribe

Save As

Share

Export

Delete

Undelete

The types of actions recorded after a change moves out of the Pending status are:

Modify or remove an item on the Affected Items tab

Redline an item on the redlines tab of the Affected Items tab (Note: Redline modifications 
for LargeText attributes are not recorded on the change History tab due to application 
performance reasons. User may view the modifications on the item object History tab 
instead.)

Add, get, check in, or check out a file attachment through the Attachments tab of the 
change

Add or remove reviewers

Approvals and rejections

Reminder notifications

Escalation notifications

Field change, any tab

Status change

Autopromotion failure

Attempt to change status without satisfying status-specific criteria

Subclass change

Comments

Send

Print

Subscribe

Save As

Share

Export

Delete

Undelete

Note: Actions for changes that have not moved out of the Pending status 
types are recorded for modifications to the Relationships tab and 
Attachments tab only. A change must have a status Type other than Pending, 
such as Submit or Review, before other actions are recorded on the History 
tab.
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When you make modifications to a date field on a change after the change has exited the 
Pending status type, then Agile PLM records the dates and times in the Details column of the 
History tab using the local date and time on the computer where the Agile PLM Application 
Server is installed. Agile PLM uses a static format, for example, 2003/08/02 15:00:23 (GMT - 
07:00) (yyyy/MM/dd) (Greenwich Mean Time).

Comments on the History tab are different from the comments on the Workflow tab. 
Comments on the Workflow tab come from approvers, acknowledgers, and observers when 
they perform the online approval process. Comments on the History tab can be made by 
anyone with sufficient privileges at any time.

For information about all change object tabs, see "Change Objects" on page 7-3.

Workflow Routings Inbox
You can view Agile PLM changes that have been submitted to you in the Agile Workflow 
Routings Inbox.

To view the Workflow Routings Inbox in Web Client:

In the menu bar, click the Home button (or press Ctrl+Shift+H). Depending on the Preferred 
Inbox View setting in your user profile, either the Workflow Routings tab appears, or you can 
click Workflow Routings tab to display it.

To view the Workflow Routings Inbox in Java Client:

In the menu bar, click the small down arrow next to the Inbox button, and choose Workflow 
Routings.

See also: "Routing Managers: Change Analyst and Component Engineer" on page 7-22.

For detailed information about working with routable objects, see Getting Started with Agile 
PLM.

Changes and Manufacturing Sites
Changes can affect site-specific information. Before you add affected items to a change, specify 
the manufacturing site that you want to affect. For general information about sites, see the 
chapter Chapter 3, "Sites and Distributed Manufacturing."

This section includes the following topics.

"Site Information Affected by Changes" on page 7-17

"Sites and ECOs" on page 7-17

"Sites and MCOs" on page 7-18

"Site Change Orders" on page 7-18

For information about working with the Affected Items tab, see the chapter Chapter 8, 
"Affected Items of Changes."
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Figure 7–1 How ECOs, MCOs and SCOs relate to each other

Site Information Affected by Changes
The following data is subject to change control:

Site-specific portion of the BOM

Site-specific portion of the AML

Dispositions

Effectivity dates

Release of a site association after the item is released

All of the above data can be directly edited before an item is released. After the item is 
released, BOM data and AML data may be redlined through an ECO, MCO, or SCO. A new 
item revision is not required, but will be made if the modification is made using an ECO.

See also: "Changes and Manufacturing Sites" on page 7-16.

Sites and ECOs
You can use an ECO to perform the following site-related actions:

Modify the common or site-specific BOM of an item.

Modify the common or site-specific AML of an item.

Modify dispositions site-specifically.

Modify the effectivity and obsolete dates of site-specific items.

See also: "Changes and Manufacturing Sites" on page 7-16.
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Sites and MCOs
You can use an MCO to modify the common and site-specific AML of an item or change the 
lifecycle phase of an item.

You can use MCOs for all sites. In this example, there are two competing MCOs with 
site-specific information. When the first MCO is released, then the pending MCO is rebased to 
the newly released MCO. In a similar manner, if a pending MCO has competing site-specific 
redlines with a pending ECO or SCO, then when the ECO or SCO is released, the pending 
MCO is rebased to the newly released ECO or SCO.

See also: "Changes and Manufacturing Sites" on page 7-16.

Site Change Orders
You can use site change orders (SCOs) to make site-specific changes to an item without 
changing the revision of the parent item.

With SCOs, you can modify the effectivity and obsolete dates, and the dispositions of previous 
revisions of an item, on a site-by-site basis. SCOs let you use an explicit process to propose, 
review, and approve the modification of effectivity dates and to record the reasons why the 
effectivity dates were changed.

You can use an SCO to do the following:

Modify the site-specific BOM of an item for latest revisions.

Modify the site-specific AML of an item for the latest revisions.

Modify the site-specific dispositions. Includes latest and non-latest revisions.

Modify the effectivity and obsolete dates of site-specific items. Includes latest and 
non-latest revisions.

More than one site can be affected by an SCO, however, each row on the Affected Items tab 
applies to only one site. Duplicate items are not allowed. For example, if you add item P001 for 
site A, then you cannot also add P001 for site B. You cannot use an SCO to modify the 
common site portion of the BOM or AML. Also, you cannot use an SCO to modify the BOM 
of an item that has not been released by an ECO, that is, an SCO cannot modify preliminary 
BOMs.

See also: "Changes and Manufacturing Sites" on page 7-16.

Site-Specific Effectivity and Obsolete Dates
To modify or set the effective and obsolete date for a specific site, and nothing else is being 
done with the ECO, add the item to the Affected Items tab and create a new revision. If you do 
not want to create a new revision just for this modification, then create an SCO and modify the 
effective and obsolete dates for the site on the SCO Affected Items tab.

The Relationship of Changes to Item Revisions
This section describes the rules Agile PLM uses to determine which revision of an item is 
affected by the change and offers additional guidelines. For more information about item 
revisions, see "Working with Item Revisions" on page 2-9.

Note: You cannot use an SCO to make redline modifications to a previous 
revision of an item. All redline modifications must be made to the latest 
released revision of an item.
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Items with an ECO Revision Only

A pending or released SCO can be based only on a revision created by a released ECO.

An ECO cannot be unreleased if there is a pending or released SCO based on it.

MCOs on Items with ECO Revisions

When a new ECO is created and released, and a pending MCO exists against a previous 
revision of the item, the MCO changes to be based on the new ECO revision, and it 
inherits content from the new revision.

An MCO cannot be unreleased if there is a released SCO based on it.

Items with an Initial MCO Revision Only

When an MCO is released against the item before the item is released by an ECO (called an 
initial MCO revision, or blank revision), a pending SCO cannot be based on the blank revision.

Creating Changes
To create a change, you must have the appropriate privilege.

In Web Client, you can create an item with the Create New > Change command or the Actions 
> Save As command.

In Java Client, you can create a change with the File > New > Change command, the New 
Object button, or the Save As command, on the More Actions menu (click the More button at 
the top of the object window) and on the right-click shortcut menu.

For more information about creating changes and other objects, see Getting Started with Agile 
PLM.

See also: "Modifying Changes" on page 7-20.

Site Change Order Save As Limitations
You cannot initiate Save As from a non-Site Change Order (SCO) change object to create an 
SCO object, nor can you initiate Save As from an SCO object to create a non-SCO change 
object. Because Site Change Orders (SCOs) affect only site-specific information, and other 
types of changes are not limited to site-specific information (for example, ECOs and MCOs), 
SCOs can be Save-As-created only from another SCO. The Site Change Order's site-specific 
only usage makes it incompatible with other change types when using the Save As feature.

Note: For a site change order (SCO), when you add an item to the Affected 
Items table, if the selected site is not listed on the Sites tab of the item, then 
you are prompted to add it to the Sites tab of the item. If you later cancel the 
SCO, or remove the item from the Affected Items table, then the new site 
assignment remains on the Sites tab of the item.

Note: Once a change is created, it exists until you delete it. If you create a 
new change, and you then decide that you do not want to keep it, then be sure 
to delete the change (soft-delete, then hard-delete). Otherwise, the new 
change remains in the database, and the number cannot be reused. For 
information, see "Deleting Changes" on page 7-23.
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Modifying Changes
With sufficient privileges, you can modify editable fields. You can modify only fields that have 
been made editable by the Agile administrator.

To edit a change:

1. On the Cover Page tab:

In Web Client, click Edit to put the Cover Page tab in edit mode. Modify the 
appropriate fields. Click Save when you are finished.

In Java Client, modify the appropriate fields. Click Save when you finish editing the 
Cover Page tab.

2. On the Affected Items tab, you can remove, add, and edit rows of affected items. (For 
more information, see "Adding an Item to the Affected Items Tab" on page 8-8.)

3. On the Relationships tab, you can add, edit, or remove relationships, and you can add, 
edit, or remove relationship rules. (For more information, see Getting Started with Agile 
PLM.)

4. On the Attachments tab, you can add and remove references to files and URLs in file 
folder objects. (For more information, see Getting Started with Agile PLM.)

You cannot edit information on the Workflow or History tabs. Those tabs are completed 
automatically.

See also: "Creating Changes" on page 7-19.

Agile Change Control Workflows
An Agile PLM workflow is a sequence of statuses that a change follows as it goes through the 
change control process. The Agile administrator specifies the name of the workflow, the 
number and names of the statuses, and the properties that define each status.

See also: "Routing Managers: Change Analyst and Component Engineer" on page 7-22.

For more information about routing changes and other Agile PLM objects through workflows, 
see Getting Started with Agile PLM.

Redlining through ECOs, DFCOs, MCOs, and SCOs
Redlining highlights, in red, changes made to an object. ECOs, MCOs, and SCOs are the only 
changes that have redlining functions. Use these changes when you need to modify a released 
item. For information about the functions of these types of changes, see "Change Classes" on 
page 7-1.

This section contains the following topics:

"Redlining through ECOs" on page 7-21

"Redlining through DFCOs" on page 7-21

"Redlining through MCOs" on page 7-21

"Redlining through SCOs" on page 7-21

Depending on your company policy, when you redline manufacturing data, use an ECO when 
you want to advance the revision of an item, or use an MCO when you do not want to advance 
the revision of an item.

For information about redlining a BOM, see "Redlining the BOM of a Released Item" on 
page 5-38



Redlining through ECOs, DFCOs, MCOs, and SCOs

Changes 7-21

For information about redlining an AML, see "Modifying Manufacturing Data from the 
Redlines Tab" on page 4-22

For information about redlining attachments and Affected Files, see Getting Started with Agile 
PLM.

Redlining through ECOs
You can redline BOM and AML data and attachments using an ECO. In addition, you can 
create change-controlled redline modifications to item attributes.

ECOs let you release new items and modify previously released items. When you create an 
ECO, a pending item revision is created for any items modified by the change (the ones listed 
on the Affected Items tab). When the ECO is released, the pending item revision is converted 
to a released revision for each modified item.

See also: "What are Change Controlled Attributes?" on page B-9

Redlining through DFCOs
You can redline Design or File Folder files on the Affected Files tab of a Design File Change 
Order (DFCO). In addition, you can create change-controlled version-specific Title Block 
redline modifications.

DFCOs lets you publish new Design files and modify previously published files. You can add 
redline markup the affected files with the Agile AutoVue viewer, and you can add local files as 
redline markups. You can also use the Associate Redlines feature to consolidate Ad Hoc 
redlines, ECO redlines, and ECR redlines on the Redlines/Markup Files tab of the DFCO 
Affected Files tab.

For more information, see Getting Started with Agile PLM, chapter "Working with Design File 
Change Orders (DFCOs)."

See also: "What are Change Controlled Attributes?" on page B-9

Redlining through MCOs
You can redline AML data using an MCO. In addition, you can create change-controlled 
redline modifications to item attributes.

MCOs are similar in appearance and function to an ECO. However, MCOs do not change the 
revision of an item, unlike an ECO. Instead, the MCO number is displayed alongside the 
corresponding revision number in the Rev drop-down list. For example, if there is a pending 
MCO #M12345 against Rev B of an item, then, on the Rev drop-down list, that revision is 
listed as (B) M12345.

MCOs can be used to:

Release a new item without a revision (but you can select its lifecycle phase)

Modify the lifecycle phase of an item without changing its revision

Redline manufacturing data (add, modify, or delete) on items (Manufacturers tab)

Redlining through SCOs
You can redline site-specific BOM data and site-specific AML data using an SCO, but only 
against the latest released revision.

SCOs are similar in appearance and function to an ECO. However, SCOs do not change the 
revision of an item, unlike an ECO. Instead, the SCO number is displayed alongside the 
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corresponding revision number in the Rev drop-down list. For example, if there is a pending 
SCO S12345 against revision B of an item, then, on the Rev drop-down list, that revision is 
listed as (B) S12345.

Routing Managers: Change Analyst and Component 
Engineer

The user who oversees the routing and approval process of a change is the routing manager. 
The routing manager for changes is called the change analyst, and the routing manager for 
manufacturing change orders (MCOs) is called the component engineer. The Change Analyst 
or Component Engineer field on the Cover Page tab of the change lists the routing manager 
for that change. These fields are filled in automatically (as designated by the Agile 
administrator in the workflow settings) or selected manually by the user from a drop-down list.

Routing managers evaluate and assign changes, and they receive email notifications pertaining 
to the change objects to which they are assigned. Specific roles and privileges are required to 
perform the tasks of a routing manager. If you have questions about your assigned roles, contact 
the Agile administrator.

If the workflow specifies a Default Change Analyst, then the Change Analyst field is 
automatically populated by the workflow, even if you do not have Modify privilege for the 
Change Analyst field.

The following is an example of a typical change control process for a change using default 
Agile workflows:

1. A change (for example, an ECO or MCO) is created, and a workflow is selected.

2. The change is submitted to the change analyst (ECO) or component engineer (MCO).

3. The change analyst or component engineer switches the change to the next status, which 
routes the change to the specified approvers (members of the change control board) and 
observers.

4. The members of the change control board (CCB) either approve or reject the change, and 
their approval or rejection is recorded on the Workflow tab of the change.

5. If all the approvers approve the change and the acknowledgers acknowledge the change, 
then it is automatically promoted to the Released status (the next status).

If any approvers reject the change, then the change analyst or component engineer is notified 
and either:

Cancels the change by switching the status to Canceled.

Returns the change to the originator by switching the status to Pending.

Note: For detailed information about how to perform routing manager 
tasks, see the chapter "Routing Objects with Workflows" in Getting Started 
with Agile PLM.

Note: Agile Administrator settings, including workflow settings and 
SmartRule settings, control when a change can be autopromoted. These 
settings determine the required fields that must be completed, the required 
actions of the approvers and acknowledgers, and other conditions that must 
be met for autopromotion.
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Releases the change despite the rejection.

Depending on the workflow settings, the change may automatically be switched to a specified 
status when an approver rejects it.

For detailed information about working with and managing changes, see the chapter "Routing 
Objects with Workflows" in Getting Started with Agile PLM.

See also: "Agile Change Control Workflows" on page 7-20

Deleting Changes
See Appendix A, "Deleting Agile Objects" for important details about deleting change objects 
and about undeleting change objects.

Printing Change Tabs
You can print object tabs and other data from your Agile PLM system. You can print the current 
tab or all tabs. Attachments are printed from their native applications or from the AutoVue for 
Agile viewer.

In Web Client, with the object open, choose Actions > Print.

In Java Client, with the object open, use the Print button.

For additional information about printing objects, see Getting Started with Agile PLM.

When you print the Affected Items tab, redline information is also included.
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8Affected Items of Changes

On the Affected Items tab you add, modify, and remove items that are affected by the change. 
Redline modifications are initiated from the Affected Items tab and are viewed through the 
Affected Items tab.

Affected Items Tab
This section includes the following topics:

"Buttons on the Affected Items Tab" on page 8-2

"Fields on the Affected Items Tab" on page 8-4

The Affected Items tab of a change lists the items that are affected by the change. If an item 
belongs to multiple manufacturing sites, then the default Affected Items row values are the 
default value for each site row. Users with sufficient privileges can use the Affected Items tab 
to:

List the items affected by a change and give those items a pending revision (ECOs)

Specify the revision of the item that is affected by the change (SCOs, ECRs, Deviations, 
Stop Ships)

View items listed on the Affected Items tab

Create, view, or modify the Redline BOM tab data of affected items (ECOs and SCOs)

Create, view, or modify the Redline Manufacturers tab data of affected items (SCOs and 
MCOs - ECOs if SmartRule is set to allow it)

Add redlines to attachments of items through the Redline Attachments tab (ECOs only)

Specify the disposition of existing parts (ECOs, MCOs, SCOs, ECR, Deviation, and Stop 
Ship)

Users with Read privileges can:

Open affected items

Redline affected items (ECOs, MCOs, and SCOs)

View the disposition of existing parts (ECOs, MCOs, and SCOs). You must scroll to the 
right to bring the disposition fields into view.

Note: ECOs and MCOs affect only the most recently released revision of 
the item.
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To open an item listed on the Affected Items tab:

In Web Client, click the item number. The item opens with the Title Block tab on top.

In Java Client, double-click the affected item row. The item opens with the Title Block tab 
on top.

Or, right-click the item row, choose Open, and then choose a tab. The item opens with the 
selected tab on top.

The revision associated with the change is selected in the Rev drop-down list.

Buttons on the Affected Items Tab
The following buttons on the Affected Items tab in Web Client are available or unavailable, 
depending on your privileges and whether it is appropriate to use them.

Note: If you do not have the Discovery privilege for an item, then it does 
not appear on the Affected Items tab. You may see a message telling you 
how many items are not displayed. Depending on your Read privileges, you 
may not be able to view all the fields on the Affected Items tab.

Table 8–1 Buttons and Modes on the Affected Items tab, Web Client

Button or Mode Description

(edit mode) Double-click any editable cell of the affected items table. The affected 
items table enters edit mode and the Save and Cancel buttons become 
active.

Remove Deletes the selected item from the Affected Items table.

Add Add - Adds an item below the selected item. Depending on which 
option you choose, you can:

Create an item while adding it.

Search for an existing item.

Type in Known Number(s) of one or more existing items.

Bulk Change Applies a change of an item to multiple BOMs or AMLs that use the 
item.
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The following buttons on the Affected Items tab in Java Client are available or unavailable, 
depending on your privileges and whether it is appropriate to use them.

More.. More..menu button

Provides access to the following actions:

Copy - Copy the selected item row to paste it into a different table.

Paste - Paste a previously copied item row into the affected items 
table.

Fill Down - Copy the contents of the highlighted cell to all the cells 
below it.

Fill-down (selected cells) - When non-contiguous cells are selected 
(highlighted), copy the contents of the uppermost highlighted cell to 
the highlighted cells below.

Fill Up - Copy the contents of the highlighted cell to all the cells 
above it.

Fill Up (selected cells) - When non-contiguous cells are selected 
(highlighted), copy the contents of the uppermost highlighted cell to 
the highlighted cells below.

Full Display Mode - Hide the redline tabs and use the full content 
pane to display the affected items table.

Standard Display Mode - Display the previously hidden redline tabs 
and use the content pane to display both the affected items table and 
the redline tabs.

See "Editing Affected Items Tab Rows in Web Client" on page 8-27.

Save

Cancel

Active only in table edit mode.

Click the appropriate button to either save or cancel the edits to the 
affected items table.

Views drop-down list Select the view you want, for example, Hide Site Rows or Base View.

Select Base View to list the site-specific information for each affected 
item. Each item is listed in multiple rows in the table, once for the 
default or common display of the item (the Sites field is blank) and 
once for each site associated with the item (the Sites field contains the 
appropriate site name.)

Select Hide Site Rows to list only the default or common information 
of the item. Each item is listed only once in the table, and the Sites 
field is blank.

You can select other views if the Agile administrator has defined 
global views or if you have defined personal views. For more 
information about personal views, see Getting Started with Agile PLM.

Table 8–2 Buttons on Affected Items tab, Java Client

Button Description

Edit Affected Items Displays the selected (checked) item in edit mode.

Remove Deletes the selected item from the Affected Items table.

Table 8–1 (Cont.) Buttons and Modes on the Affected Items tab, Web Client

Button or Mode Description
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Fields on the Affected Items Tab
The following table shows the Affected Items fields for each change class. Yes indicates that 
the field is included and hyphen (-) indicates that the field is not included.

Add - Adds an item below the selected item. Depending on which 
option you choose, you can:

Create an item while adding it.

Search for an existing item.

Type in Known Number(s) of one or more existing items.

Fill Down Rows, Fill Up 
Rows

Copies the values in each column of the first selected row (for Fill 
Down) or the last selected row (for Fill Up), and pastes them into the 
corresponding cells of all other selected rows. See "Fill Up Rows and 
Fill Down Rows Buttons in Java Client" on page 8-28.

BOM Bulk Change Applies a change of an item to multiple BOMs that use the item.

Manufacturer Part Bulk 
Change

Applies a change of an item to multiple AMLs that use the item.

View drop-down list Select Show Sites to list the site-specific information for each affected 
item. Each item is listed in multiple rows in the table, once for the 
default or common display of the item (the Sites field is blank) and 
once for each site associated with the item (the Sites field contains the 
appropriate site name.)

Select Hide Sites to list only the default or common information of the 
item. Each item is listed only once in the table, and the Sites field is 
blank.

Table 8–3 Fields on the Affected Items tab for each change class

Affected Items tab field ECO MCO SCO ECR
Stop 
Ship

Deviati
on

Sites Yes Yes Yes - - -

Item Number Yes Yes Yes Yes Yes Yes

Old Rev Yes - - - - -

Old Lifecycle Phase Yes Yes - - - -

Obsolete Date Yes - Yes - - -

New Rev Yes - - - - -

Revision - - Yes Yes Yes Yes

Effective Date Yes - Yes - - -

Lifecycle Phase Yes Yes - Yes Yes Yes

Table 8–2 (Cont.) Buttons on Affected Items tab, Java Client

Button Description
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Sites Field in Affected Items Table
The Sites field indicates the manufacturing site for which the affected item was added. When 
the Sites field is blank, it indicates that the row shows information about the item that is 
common among all sites assigned to the item.

Old Item Description and Item Description
If the Agile administrator has configured the Agile PLM system so that the Description field of 
a released item can be changed only by using the Affected Items tab of a change order, then the 
affected items table will include both the Old Item Description field and the Item Description 
field (which might be renamed to New Item Description).

If your Agile PLM system is configured for change order modification the Description field of 
an item, then the Old Item Description field is filled in automatically when you add the item 
to the Affected Items tab. You cannot modify the Old Item Description field on the Affected 
Items tab. However, if you have the appropriate privileges, then you can enter a new 
description in the affected items table (New) Item Description field. This description appears 
in the Description field of the pending revision of the item.

The Item Description field (or New Item Description field) of a released change order cannot 
be used to modify the Description field of an item. The Description field of a released item 
can only be modified through the Title Block tab of the item, with the appropriate modify item 
privileges. Once the change order with the item on its Affected Items tab is released, even 
though you may have a modify privilege for released change orders, the change order Item 
Description field of released change orders cannot be modified, and therefore cannot be used 
to modify the Description field of the item.

For more information about modifying the item Description field, see "Editing a Released 
Item's Description Field" on page 2-19.

Change Function Yes - - - - -

Old Item Description

(appears only if enabled)

Yes - - - - -

Item Description Yes Yes Yes Yes Yes Yes

On Order Yes - Yes - - -

Stock Yes - Yes - - -

Work in Progress Yes - Yes - - -

Finished Goods Yes - Yes - - -

Field Yes - - - - -

Note: All required fields must be completed before a change can be 
released. (A user with Override privilege can release a change without filling 
in the required fields.) The Agile administrator determines which fields are 
required, but the New Rev field on an ECO is always required and cannot be 
overridden. Perform a status audit or a release audit to verify that all required 
fields have been completed. For more information about auditing, see the 
chapter "Routing Objects with Workflows" in Getting Started with Agile 
PLM. See the Agile administrator if you have questions about required fields.

Table 8–3 (Cont.) Fields on the Affected Items tab for each change class

Affected Items tab field ECO MCO SCO ECR
Stop 
Ship

Deviati
on
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Revision
The Revision field indicates which revision of the item is affected by the change. The 
following table explains which item revisions can be affected by each kind of Agile PLM 
change.

Note: The item Description field cannot be modified through an MCO 
because an MCO does not create a new item revision. The MCO uses the 
Description field information from the ECO revision or Introductory revision 
on which it is based.

Table 8–4 Default Revision for each Change class

Change class
Can be 
edited? Default revision when item is added to Affected Items table

Change Order 
(ECO)

No When an item is added to the Affected Items table of a change order, 
the most recently released revision of the item appears in the Old 
Rev field.

You cannot edit the ECO Affected Items table Old Rev field.

Change orders always affect the most recently released revision of 
the item. If the item has never been released, then the change order 
affects the Introductory revision of the item. An ECO creates a new 
revision of the item and you must specify a new revision number or 
letter in the Affected Items table New Rev field.

Note: A change order is the only Agile change object that can create 
a new item revision.

For more information about ECOs, see "Special Considerations for 
ECOs" on page 8-21.

Manufacturer 
Change Order 
(MCO)

- Manufacturer change orders always affect the most recently released 
revision of the item. If the item has never been released, then the 
MCO affects the Introductory revision of the item.

The item revision number upon which the MCO is based is not 
displayed on the Affected Items tab if an MCO.

For more information about MCOs, see "Special Considerations for 
MCOs" on page 8-23.

Site Change Order 
(SCO)

Yes When an item is added to the Affected Items table of a site change 
order, the most recently released revision of the item appears in the 
Revision field.

You can edit the SCO Affected Items table Revision field to select a 
different item revision.

An SCO can affect any released revision of the item. An SCO cannot 
affect an Introductory revision of an item.

Only one revision of an item can be included on the Affected Items 
table of an SCO

Engineering 
Change Request 
(ECR)

Yes When an item is added to the Affected Items table of an engineering 
change request, the Revision field is blank. When the Revision field 
is blank, the ECR will affect the most recently released revision. 
Only released revisions are available for selection in this field. 
Pending revisions do not appear in this field. If the item has never 
been released, then the engineering change request affects the 
Introductory revision of the item.

You can edit the ECR Affected Items table Revision field to select a 
different item revision.
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Obsolete Date and Effective Date
The Obsolete Date field applies to the prior revision of the affected item, not to the new 
revision. The obsolete date is the date that the old revision becomes obsolete.

The Effective Date field applies to the new revision, and reflects the date that the new revision 
becomes effective.

Lifecycle Phase and Old Lifecycle Phase
By default, the Lifecycle Phase list has the following entries (the Agile administrator can add 
more):

Inactive - Temporarily not in use and may be reactivated.

Obsolete - Permanently discontinue the item.

Pilot - Build with limited initial quantities as a pilot project.

Production - Release for regular production.

Prototype - Produce in very limited quantities for testing.

The Old Lifecycle Phase field is filled in automatically when you add the item to the Affected 
Items tab. You cannot modify the Old Lifecycle Phase field on the Affected Items tab.

If the item has been released, then when you add it to the Affected Items tab, the Lifecycle 
Phase field is automatically filled in with the current lifecycle phase of the item. You can then 
modify the Lifecycle Phase field. If the item has never been released, then when you add it to 
the Affected Items tab, initially both the Old Lifecycle Phase field and the Lifecycle Phase 
field are blank. You can then modify the Lifecycle Phase field.

Affected Items by Manufacturing Site
With a change order (for example, an ECO), you can view and work with affected items for a 
specific manufacturing site by:

Deviation Yes When an item is added to the Affected Items table of a deviation, the 
Revision field is blank. When the Revision field is blank, the 
deviation will affect the most recently released revision of the item. If 
the item has never been released, then the deviation affects the 
Introductory revision of the item.

You can edit the deviation Affected Items table Revision field to 
select a different item revision.

Stop Ship Yes When an item is added to the Affected Items table of a stop ship, the 
Revision field is blank. When the Revision field is blank, the stop 
ship will affect the most recently released revision of the item. If the 
item has never been released, then the stop ship affects the 
Introductory revision of the item.

You can edit the stop ship Affected Items table Revision field to 
select a different item revision.

Note: If you leave the Affected Items table Lifecycle Phase field blank and 
release the change order, then Agile PLM uses the Old Lifecycle Phase to 
determine the lifecycle phase of the released object.

Table 8–4 (Cont.) Default Revision for each Change class

Change class
Can be 
edited? Default revision when item is added to Affected Items table
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Web Client – select Base View in the Views drop-down list on the Affected Items tab.

Java Client – select Show Sites in the View drop-down list on the Affected Items tab.

Each item on the table is expanded to display a row for each site associated with the item. The 
sites displayed are the sites to which you have access.

For example, to work with part number P345 for the Hong Kong site, select the row for part 
P345 with the site name Hong Kong in the Sites field of the row.

With a site change order (SCO), you view and work with items for a specific manufacturing 
site by selecting the appropriate site when you add the item to the Affected Items table. The 
modifications you specify on an SCO apply only to the site selected for the item.

Fields That Allow Site-Specific Values
The following fields in the Affected Items table can contain values that differ by site:

Disposition fields: On Order, Work in Progress, Finished Goods, Stock, Field

Effective Date

Obsolete Date

The following fields in the Affected Items table cannot contain values that differ by site:

Item Description

Old Item Description

Lifecycle Phase

Old Lifecycle Phase

Old Rev

New Rev

The Agile administrator uses the Site-Specific Field property to determine whether the other 
fields in the Affected Items table can contain values that differ by site.

Site-Specific Effectivity and Obsolete Dates
To modify or set the effective and obsolete date for a specific site, and nothing else is being 
done with the ECO, add the item to the Affected Items tab and create a new revision. If you do 
not want to create a new revision just for this modification, then create an SCO and modify the 
effective and obsolete dates for the site on the SCO Affected Items tab.

Viewing the Disposition of Parts in an ECO or SCO
ECOs and SCOs have fields on the Affected Items table that specify what to do with existing 
parts affected by the change: On Order, Stock, Work In Progress, or Finished Goods. ECOs also 
include Field (for "in the field"). Each of these fields can have a list of disposition types defined 
by the Agile administrator. Examples of dispositions are Use, Scrap, and Rework.

Adding an Item to the Affected Items Tab
You can use the Add button to add an item to the Affected Items tab.

In Web Client, if you create a change from an open item by using Actions > Create New > 
Change, then that item is added to the Affected Items tab automatically.
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In Java Client, you can create a change from an open item by using the Create Change 
command on the More Actions menu (click the More button at the top of the object window) 
and on the right-click shortcut menu. Then that item is added to the Affected Items tab 
automatically.

This section contains the following topics:

"Web Client, Adding Items to the Affected Items Table" on page 8-9

"Java Client, Using the Add Affected Items Wizard" on page 8-13

"Performing Bulk Changes" on page 8-13

"Special Considerations for ECOs" on page 8-21

"Special Considerations for MCOs" on page 8-23

"Removing an Item from the Affected Items Tab" on page 8-26

Web Client, Adding Items to the Affected Items Table
There are several different ways to add items to the Affected Items tab:

The Add button on the Affected Items table enables you to:

– Type in the number of an item.

See "Web Client, Type in the Number of an Item to Add to the Affected Items Table" 
on page 8-9.

– Execute a Quick Search by clicking the palette Search to Add button.

See "Web Client, Quick Search to Add Items to the Affected Items Table" on 
page 8-10.

– Create a new item by clicking the palette Create to Add.

See "Web Client, Create New to Add Items to the Affected Items Table" on page 8-11.

Execute a saved search - from the search results table, you can use the More.. menu Copy 
command, or you can populate the NAVIGATOR drawer, and then drag and drop to add to 
the Affected Items table.

See "Web Client, Saved Search to Add Items to the Affected Items Table" on page 8-11.

Open a custom search palette and define a search (Basic or Advanced) and search for the 
items you want to add.

See "Web Client, Custom Search to Add Items to the Affected Items Table" on page 8-12.

Web Client, Type in the Number of an Item to Add to the Affected 
Items Table
If you know the number of the item you want to add to the BOM table, then you can use the 
Type in Known Numbers option in Web Client. See also, "Web Client, Quick Search to Add 
Items to the Affected Items Table" on page 8-10 and "Web Client, Create New to Add Items to 
the Affected Items Table" on page 8-11.

To add one or more known items to the Affected Items table in Web Client:

1. Click the Affected Items tab.

Note: You cannot add an item that is locked by another user. An item is 
locked if a user has made modifications to the item, but has not yet saved 
those modifications. Once the item is saved, it is unlocked.
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2. Click the Add button. The object addition palette appears.

3. In the text entry field, type the items numbers you want to add, separated by semicolons. 
For example:

P00487; P00259; P00264

4. Or, you can also use the Web Client Type-Ahead search feature:

a. If you type a partial item number, then Agile PLM displays a list of items that match 
the text that you have typed so far.

b. Use the arrow up and arrow down keys to highlight the object you want.

c. Press the right arrow key to select the object.

d. Repeat steps a through c to select multiple objects to add.

5. Press the Enter key to add the selected items to the table and close the palette.

The items appear in the Affected Items table.

For information about other methods of adding items to the Affected Items table, see "Web 
Client, Adding Items to the Affected Items Table" on page 8-9.

Web Client, Quick Search to Add Items to the Affected Items Table
Use Web Client Add features to perform a quick search to find the items you want to add to the 
Affected Items table.

To execute a quick search to find one or more known items to add to the Affected Items 
table in Web Client:

1. Click the Affected Items tab.

2. Click the Add button. The object addition palette appears.

3. Click the palette Search to Add button. The Items Search palette appears.

4. Enter the search criteria and click to execute the quick search.

5. In the results table, select one or more items, and then:

Press Enter on the keyboard to add the selected items to the Affected Items table.

Or, drag the selected items and drop them onto the Affected Items table.

The items are added to the Affected Items table.

6. When you are finished, press Escape on the keyboard to close the Items Search palette.

To execute a Custom Search from the Quick Search palette:

1. Click the Affected Items tab.

2. Click the Add button. The object addition palette appears.

3. Click the palette Search to Add button. The Items Search palette appears.

4. Click the Custom Search button. The Basic Search palette appears.

Note: For SCOs, in the palette drop-down list, select the site you want.

Note: For SCOs, in the palette drop-down list, select the site you want.
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5. Search for the items you want:

Enter the search criteria and click Search.

or

Click the Launch Saved Searches button.

In the Saved Searches palette, navigate to the saved search you want and double-click it.

6. In the Search Results table, select the rows you want and click the Copy button.

7. On the Affected Items tab, paste your selections by choosing Paste in the More menu or 
by pressing Ctrl-C.

Web Client, Create New to Add Items to the Affected Items Table
You can add an item that has not yet been created to Affected Items table.

Adding nonexistent items to the Affected Items table using Web Client:

1. Click the Affected Items tab.

2. Click the Add button. The object addition palette appears.

3. Click the palette Create to Add button.

The Create New dialog appears.

4. In the Create New dialog, use the Type drop-down list to select the type (subclass) of item 
you want to create.

5. Use the number that appears, click the Autonumber button, or type a number.

6. Type a description in the Description field, if desired.

7. Complete any required fields.

8. Click Add.

For information about other methods of adding items to the Affected Items table, see "Web 
Client, Adding Items to the Affected Items Table" on page 8-9.

Web Client, Saved Search to Add Items to the Affected Items Table
Agile PLM table addition features allow you use a saved search to find items to add to the 
Affected Items table.

To use a saved search in Web Client to locate items to add to the Affected Items table:

1. Execute the saved search.

2. Use one of the following methods to add search result items to the Affected Items table:

Copy and Paste:

a. In the Search Results table, select one or more item rows.

b. Copy the items by choosing Copy in the More.. menu, or use the Ctrl + C 
keyboard shortcut.

Note: If you create a new item and decide that you do not want to keep it, 
then you should delete it from the database with the Delete command on the 
Actions menu. For more information about deleting items from the Affected 
Items table, see the section, "Removing an Item from the Affected Items Tab" 
on page 8-26.
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c. Open the desired item and click the Affected Items tab to display the Affected 
Items table.

d. Choose Paste in the More.. menu, or use the Ctrl + V keyboard shortcut.

NAVIGATOR Drawer:

a. In the Search Results table, click the Navigator button. The NAVIGATOR 
drawer in the left navigation pane is populated with the search results.

b. Select one or more items in the NAVIGATOR drawer. Click to the left of the item 
icon to highlight and select a NAVIGATOR link.

c. Drag and drop the highlighted items onto the Affected Items table.

d. Alternately, you can copy the NAVIGATOR highlighted items (Ctrl + C) and 
paste them into the Affected Items table (Choose Paste in the More.. menu, or 
use the Ctrl + V keyboard shortcut.)

Web Client, Custom Search to Add Items to the Affected Items Table
In Web Client, you can execute a custom search to locate items to add to the Affected Items 
table. Then, use copy and paste to add the items to the Affected Items table.

You can execute a custom search in the content pane and use the search results table features to 
populate the NAVIGATOR drawer or copy search results rows and paste them into the 
Affected Items table. See "Web Client, Saved Search to Add Items to the Affected Items Table" 
on page 8-11.

You can also open a custom search palette, which lets you view the Affected Items table while 
you search for and select the items that you want to add.

To open a Custom Search palette to find items to add to the Affected Items table:

1. Click the Affected Items tab to display the Affected Items table.

2. On the keyboard, press Ctrl + Shift + X. The custom search palette appears. The Affected 
Items table remains visible behind the palette.

3. In the search palette, define a Basic search or an Advanced search. Execute the search. For 
more information about defining searches, see Getting Started with Agile PLM.

4. Select one or more search results rows.

5. Click the Copy button.

6. Put the focus in the Affected Items table by selecting an Affected Items table row, and then 
choose Paste in the More.. menu.

You can run multiple searches to find and select additional items.

7. Press the Escape key on the keyboard to close the custom search palette.

For information about other methods of adding items to the Affected Items table, see "Web 
Client, Adding Items to the Affected Items Table" on page 8-9.

Note: In the upper left corner of the custom search palette, click to collapse 
the entire palette. Click to expand the palette again.
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Java Client, Using the Add Affected Items Wizard

To add an item to theAffected Items tab in Java Client:

1. Open a change and display the Affected Items tab.

2. Click the Add drop-down menu button and choose one of the add options: Search, Type 
in Known Numbers, or Create.

3. Depending on your menu selection, do one of the following:

Search - Search for one or more existing items. In the Add Affected Item dialog, 
select a search method. If you choose to perform a simple search, then enter the value 
to search for and click Search. You can also define an advanced search, run a saved 
search, or select a bookmarked or recently visited item (Shortcuts). (For more 
information about searches, see Getting Started with Agile PLM.) In the search results, 
select the items you want, and click OK. All the items in the Selected Affected Item(s) 
list are added to the Affected Items table.

Type in Known Numbers - enter one or more numbers and click Add.

Create - Select a type from the Type drop-down list. If appropriate, enter an object 
number. Click OK.

Adding items to the Affected Items table is similar to adding items to the BOM table. For 
more information about how to complete the dialogs, see "Java Client, Search for Items to 
Add to the BOM Table" on page 5-21, "Java Client, Type in the Number of an Item to Add 
to the BOM Table" on page 5-20, and "Java Client, Adding a Blank Row to the BOM 
Table" on page 5-22.

Performing Bulk Changes
You can create an ECO that automatically adds, replaces, or removes an item from the 
assemblies on several BOMs simultaneously. Likewise, you can create an ECO or MCO that 
automatically replaces or removes a manufacturer part on the AML (Manufacturers tab) of 
several assemblies simultaneously. Such changes are called bulk changes and are created with a 
Bulk Change wizard.

The following sections explain how to use the bulk change features:

"BOM Bulk Changes Overview" on page 8-14

"Web Client BOM Bulk Change Wizard" on page 8-14

Note: Tip: An easy way to use the Add button on the Affected Items tab in 
Java Client is to click it once. The dialog appears that lets you enter the 
number of an item, if you know it. In this dialog, click the Create or Search 
link to use those add item methods. If you are adding affected items to an 
SCO, then the Create link is not available.

Note: If you are adding affected items to an SCO, then the Create option is 
not available.

Note: If you are adding affected items to an SCO, then, in the Add for Site 
drop-down list, select the site you want.
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"Java Client BOM Bulk Change Wizard" on page 8-16

"Manufacturer Part (AML) Bulk Changes Overview" on page 8-17

"Web Client Manufacturer Part Bulk Change Wizard" on page 8-18

"Java Client Manufacturer Part Bulk Change Wizard" on page 8-19

BOM Bulk Changes Overview
BOM bulk changes are available only from ECOs by using the BOM Bulk Change wizard. The 
BOM bulk change process provides the following options:

Add an item to multiple assemblies.

Remove an item from all assemblies or from some assemblies that use the item, and 
automatically redline the BOM of the assemblies affected by the Bulk Change.

Replace an item in all assemblies or from some assemblies that use the item, and 
automatically redline the BOM of the assemblies affected by the Bulk Change.

Find assemblies related to a specific item and add them to the Affected Items tab. No 
BOM Bulk redlines are preformed, rather, you manually redline the BOMs after the items 
are added to the Affected Items table.

Web Client BOM Bulk Change Wizard
The Web Client BOM Bulk Change wizard lets you specify modifications to multiple 
assemblies simultaneously. You have the following BOM bulk change options:

Add one item to multiple assemblies.

Replace an item on multiple assemblies.

Remove an item from multiple assemblies.

Find assemblies related to an item and add them as affected items.

The procedures vary slightly, however, each wizard step guides you through the process. All the 
procedures are described below.

To add an item to multiple assemblies, Web Client:

1. From a pending or unassigned change, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)

2. Click the Bulk Change button and choose BOM from the menu. The BOM Bulk Change 
wizard appears.

3. In the Select Bulk Change Option wizard step, select Add an item to multiple assemblies, 
and then click Next.

4. In the Select Item To Add wizard step, you specify the item that you want to add to 
multiple assemblies. Type an item number, or click the Launch the Palette button to 
execute a quick search for the item. After you select an item number, click Next.

5. In the Identify Assemblies to Add to wizard step, you specify which assemblies this bulk 
change will affect.

Click the Add button and type a list of item numbers separated by semi-colons and 
press the Return key.

Or, click the Add button, and then click to execute a quick search for the assemblies. 
Select the items you want by double-clicking the rows in the palette quick search 
results.
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6. After you have identified the assemblies to which you want to add the item selected in step 
4, click Finish.

The redlined assemblies are added to the Affected Items table. You can view the change on 
the Redline BOM tab.

To replace an item from multiple assemblies, Web Client:

1. From a pending or unassigned change, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)

2. Click the Bulk Change button and choose BOM from the menu. The BOM Bulk Change 
wizard appears.

3. In the In the Select Bulk Change Option wizard step, select Replace an item on multiple 
assemblies, and then click Next.

4. In the Select Item To Replace wizard step, you specify both the item that you want to 
redline remove from the assemblies that use it and you specify the item that will replace 
the removed item. In the Item to Remove field, type an item number, or click the Launch 
the Palette button to execute a quick search for the item.

5. In the Replacement Item field, type an item number, or click the Launch the Palette 
button to execute a quick search for the item. Click to create a new item. When you have 
specified both the item to remove and its replacement item, click Next.

6. In the Select Assemblies on which to Replace Item wizard step, you specify which 
assemblies this bulk change will affect. From the displayed list of assemblies that use the 
item specified in step 4, select the assemblies you want to affect, and then click Finish.

The redlined assemblies (selected in step 6) will be added to the Affected Items table if 
they are not already in the Affected Items table. You can view the changes on the Redline 
BOM tab.

To remove an item from multiple assemblies, Web Client:

1. From a pending or unassigned change, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)

2. Click the Bulk Change button and choose BOM from the menu. The BOM Bulk Change 
wizard appears.

3. In the In the Select Bulk Change Option wizard step, select Remove an item from 
multiple assemblies, and then click Next.

4. In the Select Item To Remove wizard step, you specify the item that you want to redline 
remove from the assemblies that use it. In the Item to Remove field, type an item number, 
or click the Launch the Palette button to execute a quick search for the item. After you 
select an item, click Next.

5. In the Select Assemblies on which to Replace Item wizard step, you specify which 
assemblies this bulk change will affect. From the displayed list of assemblies that use the 
item specified in step 4, select the assemblies you want to affect, and then click Finish.

The redlined assemblies (selected in step 5) will be added to the Affected Items table if 
they are not already in the Affected Items table. You can view the changes on the Redline 
BOM tab.

To find assemblies related to a specific item and then add those assemblies to the affected 
items table (without making any redline BOM modifications to the assemblies), Web 
Client:

1. From a pending or unassigned change, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)
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2. Click the Bulk Change button and choose BOM from the menu. The BOM Bulk Change 
wizard appears.

3. In the In the Select Bulk Change Option wizard step, select Find assemblies related to an 
item and add them as affected items, and then click Next.

4. In the Select Item wizard step, you specify the item that is used on the BOM of the 
assemblies you want to add to the affected items table. In the Item field, type an item 
number, or click the Launch the Palette button to execute a quick search for the item. 
After you select an item, click Next.

5. In the Select Assemblies to Add to the Affected Items Table wizard step, you specify 
which assemblies this bulk change will affect. From the displayed list of assemblies that 
use the item specified in step 4, select the assemblies you want to affect, and then click 
Finish.

6. The assemblies (selected in step 4) will be added to the Affected Items table and no redline 
changes will be made to them. Select an assembly in the Affected Items table, and then 
make the redline changes you want on the Redline BOM tab.

Java Client BOM Bulk Change Wizard
The Java Client BOM Bulk Change wizard lets you specify modifications to multiple 
assemblies simultaneously. You have two BOM bulk change options:

Add one item to multiple assemblies.

Replace or remove one item from multiple assemblies.

The two procedures vary slightly, however, each wizard dialog guides you through the process. 
Both procedures are described below.

To add an item to multiple assemblies, Java Client:

1. Select the option Add an Item to multiple Assemblies, and click Next.

2. In the next wizard dialog, you specify the item that you want to add to multiple assemblies. 
Type an item number, or click the Add by Search button to search for the item. In the 
Select Objects dialog, you can click the Create link to create a new item. After you specify 
an item number, click Next.

3. In the next wizard dialog, you specify which assemblies this bulk change will affect. Click 
the Add button to search for the assemblies to which you want to add the item selected in 
step 2. After you specify the assemblies, click Finish.

4. From a pending or unassigned change, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)

5. Click the BOM Bulk Change button.

The BOM Bulk Change wizard appears.

The redlined assemblies are added to the Affected Items table. You can view the change on the 
Redline BOM tab.

To replace or remove an item from multiple assemblies, Java Client:

1. From a pending or unassigned change, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)

2. Click the BOM Bulk Change button.

The BOM Bulk Change wizard appears.

3. Select Replace or remove and item from multiple Assemblies, and click Next.
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4. In the next wizard dialog, you specify the item that you want to redline (replace, delete, or 
otherwise modify) in the assemblies that use it. Type an item number, or click to search for 
the item. After you specify an item number, click Next.

5. In the next wizard dialog, you specify which assemblies this bulk change will affect. From 
the displayed list of assemblies that use the item specified in step 4, select the assemblies 
you want to affect, and then click Next.

6. In the next wizard dialog, you specify which action to perform. Your options are:

Replace <item> on all selected assemblies with <item>.

That is, on the assemblies you selected in step 5, replace the item you selected in step 
4 with the item you specify here. Type an item number, or click to search for the item.

When you are done, click Next.

The redlined assemblies (selected in step 5) will be added to the Affected Items table. 
You can view the changes on the Redline BOM tab.

Remove item from all selected assemblies

That is, remove the item you selected in step 4 from the assemblies you selected in 
step 5.

Click Next.

The redlined assemblies (selected in step 5) will be added to the Affected Items table 
if they are not already in the Affected Items table. You can view the changes on the 
Redline BOM tab.

Just add the selected assemblies to the Affected Items table and I will redline the 
BOMs myself.

That is, add the assemblies you selected in step 5 to the Affected Items table (if they 
are not already in the Affected Items table), but do not make any redline changes to 
the assemblies.

Click Finish.

The assemblies (selected in step 5) will be added to the Affected Items table if they are 
not already in the Affected Items table, and no redline changes will be made to them. 
Select an assembly in the Affected Items table, and then make the redline changes you 
want on the Redline BOM tab.

The assemblies are added to the Affected Items table according to the option you selected in 
step 6 above.

Manufacturer Part (AML) Bulk Changes Overview
You can perform a manufacturer part bulk change from an ECO (with AML capabilities) or an 
MCO, which automatically replaces or removes a manufacturer part from the Manufacturers 
tab of several items simultaneously. Manufacturer part bulk changes are created with the 
Manufacturer Part Bulk Change wizard.

You can use MCOs to bulk-change manufacturers data without rolling the revision, and use 
ECOs to bulk-change manufacturers data when you want to roll the revision. Depending on 
your company policy, use an ECO or an MCO to determine if the revision of an item advances 
when you redline manufacturers data.
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Figure 8–1 Manufacturer Part bulk change capabilities of ECOs and MCOs

The Manufacturer Part Bulk Change wizard, from an MCO or an ECO, gives you the option to:

Remove a manufacturer part from all parts or from some parts that use it, and 
automatically redline the Manufacturers tab of the assemblies affected by the 
manufacturer part bulk change.

Replace a manufacturer part in all parts or in some parts that use it, and automatically 
redline the Manufacturers tab of the assemblies affected by the manufacturer part bulk 
change.

Just add the selected manufacturer part to the Manufacturers tabs, and then go back later 
to manually redline it.

Web Client Manufacturer Part Bulk Change Wizard
To replace or remove a manufacturer part from multiple items, Web Client:

1. From a change that has not been released, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)

2. Click the Bulk Change button and choose Manufacturer Part from the menu.

The Manufacturer Part Bulk Change wizard appears.

3. In the Select Bulk Change Option wizard step, choose Replace a manufacturer part on 
multiple items. Click Next.

4. In the Select Manufacturer Part to Replace wizard step, you specify the manufacturer part 
that you want to redline replace in the items that use it and you also select the replacement 
manufacturer part. In the Manufacturer Part to Remove field, begin typing a 
manufacturer part number, and then select the appropriate number/manufacturer 
combination from the displayed list, or click the Launch the Palette button to execute a 
quick search for the manufacturer part.

5. In the Replacement Manufacturer Part field, begin typing a manufacturer part number, 
and then select the appropriate number/manufacturer combination from the displayed list, 
or click the Launch the Palette button to execute a quick search for the manufacturer part. 
Click the Create to Add button to create a new manufacturer part. When you have 
specified both the manufacturer part to remove and its replacement manufacturer part, 
click Next.

6. In the Select Items on which to Replace Manufacturer Part wizard step, you specify which 
items this bulk change will affect. From the displayed list of items that use the 
manufacturer part specified in step 3, select the items you want to affect, and then click 
Finish.
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7. The redlined items (selected in step 6) will be added to the Affected Items table if they are 
not already in the Affected Items table. You can view the changes on the redline 
Manufacturers tab.

To remove a manufacturer part from multiple items:

1. From a change that has not been released, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)

2. Click the Bulk Change button and choose Manufacturer Part from the menu.

The Manufacturer Part Bulk Change wizard appears.

3. In the Select Bulk Change Option wizard step, choose Remove a manufacturer part 
from multiple items. Click Next.

4. In the Select Manufacturer Part to Remove wizard step, you specify the manufacturer part 
that you want to redline delete from the items that use it. In the Manufacturer Part to 
Remove field, begin typing a manufacturer part number, and then select the appropriate 
number/manufacturer combination from the displayed list, or click the Launch the Palette 
button to execute a quick search for the manufacturer part. Click Next.

5. In the Select Items on which to Replace Manufacturer Part wizard step, you specify which 
items this bulk change will affect. From the displayed list of items that use the 
manufacturer part specified in step 4, select the items you want to affect, and then click 
Finish.

The redlined items (selected in step 5) will be added to the Affected Items table if they are 
not already in the Affected Items table. You can view the changes on the redline 
Manufacturers tab.

To find items related to a specific manufacturer part and then add those items to the 
affected items table (without making any redline Manufacturers modifications to the 
items), Web Client:

1. From a change that has not been released, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)

2. Click the Bulk Change button and choose Manufacturer Part from the menu.

The Manufacturer Part Bulk Change wizard appears.

3. In the Select Bulk Change Option wizard step, choose Find items related to a 
manufacturer part and add them as affected items. Click Next.

4. In the Select Manufacturer Part wizard step, you specify the manufacturer part for which 
you want from the items that use it. In the Manufacturer Part field, begin typing a 
manufacturer part number, and then select the appropriate number/manufacturer 
combination from the displayed list, or click the Launch the Palette button to execute a 
quick search for the manufacturer part. Click Next.

5. In the Select Items on which to Replace Manufacturer Part wizard step, you specify which 
items this bulk change will affect. From the displayed list of items that use the 
manufacturer part specified in step 4, select the items you want to affect, and then click 
Finish.

The items (selected in step 5) will be added to the Affected Items table and no redline 
changes will be made to them. Select an item in the Affected Items table, and then make 
the redline changes you want on the redline Manufacturers tab.

Java Client Manufacturer Part Bulk Change Wizard
To replace or remove a manufacturer part from multiple items, Java Client:
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1. From a change that has not been released, click the Affected Items tab to bring it forward. 
(You can use an existing change or create a new one.)

2. Click the Manufacturer Part Bulk Change button.

The Manufacturer Part Bulk Change wizard appears.

3. In the first wizard dialog, you specify the manufacturer part that you want to redline 
(replace, delete, or otherwise modify) in the items that use it. Enter a manufacturer name 
and manufacturer part number, or click to search for the manufacturer part you want. After 
you specify a manufacturer part, click Next.

4. In the next wizard dialog, you specify which items this bulk change will affect. From the 
displayed list of items that use the manufacturer part specified in step 3, select the items 
you want to affect, and then click Next.

5. In the next wizard dialog, you specify which action to perform. Your options are:

Replace <manufacturer part> on all selected assemblies with <manufacturer part>.

That is, on the items you selected in step 4, replace the manufacturer part you selected 
in step 3 with the manufacturer part you specify here. Enter a manufacturer name and 
manufacturer part number, or click to search for the manufacturer part you want.

For additional information about selecting a manufacturer name, see "How to Use Java 
Client Manufacturer Name Automatic Validation" on page 4-13..

When you are done, click Next.

The redlined items (selected in step 4) will be added to the Affected Items table if they 
are not already in the Affected Items table. You can view the changes on the Redline 
Manufacturers tab.

Remove <manufacturer part> from all selected assemblies

That is, remove the manufacturer part you selected in step 3 from the items you 
selected in step 4.

Click Next.

The redlined items (selected in step 4) will be added to the Affected Items table if they 
are not already in the Affected Items table. You can view the changes on the Redline 
Manufacturers tab.

Just add the selected assemblies to the affected items table.

That is, add the items you selected in step 4 to the Affected Items table (if they are not 
already in the Affected Items table), but do not make any redline changes to the items.

Click Finish.

The items (selected in step 4) will be added to the Affected Items table and no redline 
changes will be made to them. Select an item in the Affected Items table, and then 
make the redline changes you want on the Redline Manufacturers tab.

The items are added to the Affected Items table according to the option you selected in step 
5 above.

Working with the Affected Items Table
Once items have been added to the Affected Items table, there are additional steps required to 
complete each type of Agile PLM change. The following sections summarize those steps.

"Title Block Redline Tab of ECOs and MCOs" on page 8-21
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"Special Considerations for ECOs" on page 8-21

"Special Considerations for MCOs" on page 8-23

"Special Considerations for SCOs" on page 8-23

"Special Considerations for ECRs" on page 8-24

"Special Considerations for Deviations" on page 8-25

"Special Considerations for Stop Ships" on page 8-25

Title Block Redline Tab of ECOs and MCOs

When change-controlled attributes have been enabled, the Title Block redline tab appears on 
the Affected Items tab of ECOs and MCOs. Use the Title Block redline tab to modify the 
change controlled attributes.

Until the change is approved, the new attribute values are not in use. If the change is canceled, 
then the new values are discarded and are never used.

To view and compare attributes of different item revisions, use the "Compare Item Attributes 
Report" on page 9-9 and the "Item Attribute History Report" on page 9-15.

Change Controlled Attributes
The Agile PLM Change Controlled Attributes feature enables an Agile PLM system to use 
Change objects to control how the item attribute values change.

The Agile administrator uses Agile PLM system settings to define which item attributes are 
under change control. An item attribute that is not change-controlled can be modified if you 
have the appropriate Modify privileges. By comparison, a change-controlled attribute can be 
modified only by using a change (ECO or MCO).

For more information, see "What are Change Controlled Attributes?" on page B-9.

Special Considerations for ECOs
The basic steps to complete an ECO are:

1. Add the items you want to modify to the Affected Items tab.

See "Adding an Item to the Affected Items Tab" on page 8-8.

2. Edit the Affected Item tab fields, including the required fields, as described in "Fields 
Required to Release an ECO" on page 8-22.

See "Editing Rows in the Affected Items Tab" on page 8-26.

3. If you added a released item that has BOM data or manufacturing data, then you can 
redline the BOM data or manufacturing data and attachments (referenced in file folder 
objects) on the Redlines pane of the Affected Items tab.

Important: The Affected Items redline tab for Title Block 
change-controlled attributes and the Affected Files redline tab for Title block 
change-controlled attributes are available in Web Client only.

Note: If you add a released item that has pending changes against it, then 
Agile PLM tells you that the item has pending changes
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See "Redlining the BOM of a Released Item" on page 5-38.

See "Modifying Manufacturing Data from the Redlines Tab" on page 4-22.

For information about redlining attachments, see the Viewer Supplement. For more 
information about attachments, see Getting Started with Agile PLM.

4. In Web Client, if the Agile administrator has configured Change-Controlled attributes for 
items, then you can make redline edits to those Change-Controlled attributes. (See "What 
are Change Controlled Attributes?" on page B-9.

In Java Client, the Create Change command is available on the item More Actions menu (click 
the More button at the top of the object window) and on the right-click shortcut menu. In Web 
Client, use Actions > Create Change in the item Actions menu.

Fields Required to Release an ECO
Required fields are defined for each status in the workflow. Use the audit feature to determine if 
all the required fields have been filled in.

In addition to the required fields defined in the workflow, the following Affected Items tab 
fields must always be completed before Agile PLM releases the ECO:

New Rev (for each item on the Affected Items table)

Item Number

To complete the fields required to release an ECO:

1. In the New Rev field, type the new revision number.

If you leave the New Rev field blank, then Agile PLM places a question mark (?) in the 
Rev field of the item.

You cannot release an ECO with a blank value in the affected item's Rev field.

In Web Client, use the Audit Release command on the Actions menu to verify that all required 
fields have been completed. Use the Audit Status command on the Actions menu to verify that 
status required fields have been completed.

In Java Client, use the Audit Release button on the object window toolbar to verify that all 
required fields have been completed. Use the Audit Status button to verify that status required 
fields have been completed.

You cannot change the New Rev field on the Affected Items tab on a released change, even if 
you have the appropriate privileges to modify released changes. If you do not have the 

Note: If you use the Create Change command to create an ECO from an 
open item, then Agile PLM adds the item to the Affected Items table and, for 
released items, automatically prompts you to redline any BOM or 
manufacturer data.

Note: The Item Number field is completed automatically when you add 
the item to the Affected Items tab.

Note: Other tabs may also have required fields that must be completed. The 
specific fields on your system may vary, depending on the workflow settings.
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appropriate privilege to modify the Lifecycle Phase on the Affected Items tab of a released 
change, then you can use an MCO to modify the lifecycle phase of an item without changing its 
revision level. See "Redlining through MCOs" on page 7-21. or more information.

Special Considerations for MCOs
The basic steps to complete an MCO are:

1. Add the items you want to modify to the Affected Items tab.

See "Adding an Item to the Affected Items Tab" on page 8-8.

2. Edit the Affected Item tab fields, including the required fields. MCOs allow you to select 
a new Lifecycle Phase.

See "Editing Rows in the Affected Items Tab" on page 8-26.

3. If you added a released item that has manufacturing data, then redline the manufacturers 
data.

See "Modifying Manufacturing Data from the Redlines Tab" on page 4-22.

In Web Client, use Actions > Create New > Change.

In Java Client, the Create Change command is available on the item More Actions menu (click 
the More button at the top of the object window) and on the right-click shortcut menu.

In addition to the required fields defined in the workflow, the Item Number field on the 
Affected Items tab must be completed before Agile PLM releases the MCO. This field is 
completed automatically when you add items to the Affected Items tab.

In Web Client, use the Audit Release command on the Actions menu to verify that all required 
fields have been completed.

In Java Client, use the Audit Release button on the object window toolbar to verify that all 
required fields have been completed.

Special Considerations for SCOs
The basic steps to complete an SCO are:

1. Add the items you want to modify to the Affected Items tab.

See "Adding an Item to the Affected Items Tab" on page 8-8.

Note: If you use the item object Create Change command to create an 
MCO from an open item, then Agile PLM adds the item to the Affected Items 
table and, for released items, automatically prompts you to redline any 
manufacturer data.

Note: Other tabs also have required fields that must be completed. The 
specific fields on your system may vary, depending on the workflow settings.

Note: If you add a released item that has pending changes against it, then 
Agile PLM tells you that the item has pending changes.
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2. Edit the Affected Item tab fields, including the required fields. You can modify the 
site-specific dispositions and the effective and obsolete dates of site-specific items for both 
the latest and non-latest revisions.

See "Site Change Orders" on page 7-18.

3. If you added the most recently released revision of an item to the SCO, then you can 
redline site-specific BOM and AML data, but only against the latest released revision.

See "Redlining through ECOs, DFCOs, MCOs, and SCOs" on page 7-20.

See "Redlining the BOM of a Released Item" on page 5-38.

See "Modifying Manufacturing Data from the Redlines Tab" on page 4-22.

In Web Client, use the Audit Release command on the Actions menu to verify that all required 
fields have been completed. Use the Audit Status command on the Actions menu to verify that 
status required fields have been completed.

In Java Client, use the Audit Release button on the object window toolbar to verify that all 
required fields have been completed. Use the Audit Status button to verify that status required 
fields have been completed.

Special Considerations for ECRs
The basic steps to complete an ECR are:

1. Add the items to the Affected Items tab.

See "Adding an Item to the Affected Items Tab" on page 8-8.

When adding by Type in Known Numbers, you can enter the revision, preceded by a 
space character, when you type the number. For example:

1000-02 A

P003872 D

2. Edit the Affected Item tab Revision field and any custom fields that may be defined for 
your Agile PLM system.

See "Editing Rows in the Affected Items Tab" on page 8-26.

In Java Client, use the Audit Release button on the object window toolbar to verify that all 
required fields have been completed.

Note: Only the most recently released revision of an item can be redlined 
with an SCO.

Other tabs also have required fields that must be completed. The specific 
fields on your system may vary, depending on the workflow settings.

Note: If you add a released item that has pending changes against it, then 
Agile PLM tells you that the item has pending changes.

Note: Other tabs also have required fields that must be completed. The 
specific fields on your system may vary, depending on the workflow settings.
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In Web Client, use the Audit Release command on the Actions menu to verify that all required 
fields have been completed.

Special Considerations for Deviations
The basic steps to complete a Deviation are:

1. Add the items to the Affected Items tab.

See "Adding an Item to the Affected Items Tab" on page 8-8.

When adding by Type in Knows Numbers, you can enter the revision, preceded by a 
space character, when you type the number. For example:

1000-02 AP003872 D

2. Edit the Affected Item tab Revision field and any custom fields that may be defined for 
your Agile PLM system.

See "Editing Rows in the Affected Items Tab" on page 8-26.

In Web Client, use the Audit Release command on the Actions menu to verify that all required 
fields have been completed.

In Java Client, use the Audit Release button on the object window toolbar to verify that all 
required fields have been completed.

Special Considerations for Stop Ships
The basic steps to complete a Stop Ship are:

1. Add the items to the Affected Items tab.

See "Adding an Item to the Affected Items Tab" on page 8-8.

When adding by Type in Knows Numbers, you can enter the revision, preceded by a 
space character, when you type the number. For example:

1000-02 A

P003872 D

2. Edit the Affected Item tab Revision field and any custom fields that may be defined for 
your Agile PLM system.

See "Editing Rows in the Affected Items Tab" on page 8-26.

Note: If you add a released item that has pending changes against it, then 
Agile PLM tells you that the item has pending changes.

Note: Other tabs also have required fields that must be completed. The 
specific fields on your system may vary, depending on the workflow settings.

Note: If you add a released item that has pending changes against it, then 
Agile PLM tells you that the item has pending changes.
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In Web Client, use the Audit Release command on the Actions menu to verify that all required 
fields have been completed.

In Java Client, use the Audit Release button on the object window toolbar to verify that all 
required fields have been completed.

Removing an Item from the Affected Items Tab
When you delete an item from the Affected Items tab, any attachments added to the item under 
the pending revision defined in that change are lost. This is true for all pending revisions, 
including items that have never been released and have only one change against them. If there 
is only one change pending against the item, and you delete the item from that change, then the 
item reverts to a preliminary item with no changes against it, and any attachments added under 
that last change are lost.

When you remove an item from the Affected Items tab, any item redlines made through that 
change are dropped and discarded. Any attachments added to the pending revision created by 
that change are removed from the item. Agile PLM displays warnings before dropping redlines 
or removing attachments. Accept the warnings to complete the item removal.

To remove an item from the Affected Items tab in Web Client:

1. If necessary, select Base View in the Views drop-down list to expand the table to show a 
row for each site assigned to the item.

2. Select one or more rows in the table. The selected rows are highlighted.

3. Click the Remove button.

To remove an item from the Affected Items tab in Java Client:

1. If necessary, select Show Sites in the View drop-down list to expand the table to show an 
item row for each site assigned to the item.

2. Click to select the row for the item that you want to delete. (You can select multiple items.)

3. Click the Remove button.

Editing Rows in the Affected Items Tab
You can edit rows on the Affected Items table, including rows associated with a specific site. 
You can also copy and paste information between these rows.

This section includes the topics:

Note: Other tabs also have required fields that must be completed. The 
specific fields on your system may vary, depending on the workflow settings.

Note: Be sure to use the Remove button on the Affected Items tab to 
remove items from that tab. If you use the Delete button on the object 
window toolbar (Java Client) or the Delete command on the object Actions 
menu (Web Client), then Agile PLM deletes the entire change.

Note: You cannot edit the item description from MCOs, ECRs, deviations, 
or stop ships. The item description is inherited from the latest released ECO.
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"Editing Affected Items Tab Rows in Web Client" on page 8-27

"Editing Affected Items Tab Rows in Java Client" on page 8-28

Editing Affected Items Tab Rows in Web Client
To edit affected item information in Web Client:

1. If necessary, select Base View in the Views drop-down list to expand the table to show a 
row for each site assigned to the item.

2. Double-click any editable cell of the affected items table.

The affected items table enters edit mode and the Save and Cancel buttons become active. 
Press the Tab key to move to the next editable field, use the arrow keys, or click in a cell.

3. Make any changes, and then click Save to save the changes, or click Cancel to cancel the 
changes.

Using Fill-Up and Fill-Down in Web Client Tables
From the tab More menu button, Web Client provides the following Fill-Up and Fill-Down 
table editing commands:

Fill-down

Fill-down (selected cells)

Fill-up

Fill-up (selected cells)

To Fill-down or Fill-up:

1. If the table is not already in edit mode, then enter table edit mode:

Double-click any editable cell of the table. The table enters edit mode and the Save and 
Cancel buttons become active. To navigate from one cell to another, press the Tab key to 
move to the next editable field, use the arrow keys, or click in a cell.

2. Select one cell in the column. The selected cell is highlighted.

To fill-down, choose More > Fill-down in the tab menu or use the Ctrl + Shift + D 
keyboard shortcut.

The contents of the highlighted cell are copied down the column into all the cells 
below the highlighted cell.

To fill-up, choose More > Fill-up in the tab menu or use the Ctrl + Shift + U keyboard 
shortcut.

The contents of the highlighted cell are copied up the column into all the cells above 
the highlighted cell.

To Fill-down or Fill-up selected cells only:

1. If the table is not already in edit mode, then enter table edit mode:

Double-click any editable cell of the table. The table enters edit mode and the Save and 
Cancel buttons become active. To navigate from one cell to another, press the Tab key to 
move to the next editable field, use the arrow keys, or click in a cell.

2. Select two or more cells in the column. Use Shift-click to select contiguous cells. Use 
Ctrl-click to select non-contiguous cells. The selected cells are highlighted.

To fill-down, choose More > Fill-down (selected cells) in the tab menu or use the Ctrl 
+ Shift + D keyboard shortcut.
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The content of the upper-most highlighted cell is copied down the column into only 
the highlighted cells below the up-most highlighted cell.

To fill-up, choose More > Fill-up (selected cells) in the tab menu or use the Ctrl + 
Shift + U keyboard shortcut.

The content of the lower-most highlighted cell is copied up the column into only the 
highlighted cells above the lower-most highlighted cell.

Editing Affected Items Tab Rows in Java Client
To edit affected item information in Java Client:

1. If necessary, select Show Sites in the View drop-down list to expand the table to show a 
row for each site assigned to the item.

2. Click to select the rows you want to edit. You can use Ctrl-click and Shift-click to select 
multiple rows.

3. Click the Edit button.

The Edit Affected Items dialog appears.

4. Make the modifications you want.

5. When you are finished, click OK.

Fill Up Rows and Fill Down Rows Buttons in Java Client
By selecting a group of fields in one column, you can use the Fill Up Rows button to copy the 
contents of the bottom-most selected field into all the selected fields above it. You can use the 
Fill Down Rows button to copy the contents of the top-most selected field into all the selected 
fields below it. You can use Ctrl-click to select non-contiguous fields, and you can use 
Shift-click to select contiguous fields.

You can fill up and fill down in multiple columns simultaneously. Once you have selected 
fields in one column, you can select multiple additional columns using Ctrl-click 
(non-contiguous columns) and Shift-click (contiguous columns). The Fill Up Rows button 
copies the contents of the bottom-most selected field in each column into all the selected fields 
in each column. The Fill Down Rows button copies the contents of the topmost selected fields 
in each column into all the selected fields in each column.

To copy information between rows in Java Client:

1. If necessary, select Show Sites in the View drop-down list to expand the table to show a 
row for each site assigned to the item.

2. Click to select the rows you want to edit. You can use Ctrl-click and Shift-click to select 
multiple rows.

3. Click the Edit button.

The Edit Affected Items dialog appears.

Note: Fill Up and Fill Down are available in edit mode for any editable 
table. Attributes that require unique identifier data or other unique data do not 
have Fill Up and Fill Down capability, for example: Item Number on the 
Affected Items tab, Manufacturer Name and Manufacturer Part Number 
on the item Manufacturers tab, or Item Number and Find Number on the 
item BOM tab.
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4. Click to select the fields you want to fill in. Use Shift-click and Ctrl-click to select the 
fields in each column and to select additional columns you want to fill in. The fill up and 
fill down action is defined by the selected (highlighted) fields in each column in the 
Affected Items table.

Both the source row and the target rows must be highlighted. The top-most row or the 
bottom-most row is the source row.

You may want to edit the top-most or bottom-most row in the Affected Items table, and 
then use the Fill Up Rows and Fill Down Rows buttons to complete the remaining rows in 
the table.

5. Click the Fill Up Rows or Fill Down Rows button to fill in the selected Affected Items 
table fields.

6. When you are finished, click OK.

Viewing the Redlines of an Affected Item
In Web Client, if an affected item has a BOM, an AML, or attachments, and the Has Redlines 
icon appears in the Affected Items table if the item has any redlines, then you can view its 
Redlines tabs by selecting its row in the Affected Items table (click the row selector to highlight 
the row). The Redline tabs for the selected item appear in the bottom portion of the Affected 
Items tab.

In Java Client, if an affected item has a BOM, an AML, or attachments, then you can view its 
Redlines tabs by clicking in its row in the Affected Items table. The Redline tabs for the 
selected item appear in the bottom portion of the Affected Items tab.

For information about the Redline BOM tab, see "Redlining the BOM of a Released Item" 
on page 5-38.

For information about the Redline Manufacturers tab, see "Modifying Manufacturing 
Data from the Redlines Tab" on page 4-22.

For information about the Redline Attachment tab, see Getting Started with Agile PLM.
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9Working with Product Reports and Process
Reports

Reports allow you to display the values of your product records. By accessing this information 
and summarizing it in a meaningful way, reports provide insight into your business processes 
and can help guide better-informed decisions. Agile PLM provides a robust reporting platform 
that enables you to:

Measure and monitor business performance using standard out-of-the-box reports. These 
standard reports capture the best practices in product lifecycle management business 
processes.

Configure reports with Agile PLM custom reporting to obtain the specific information you 
need.

Use a single point of access to all relevant reports-even those developed outside of the 
Agile PLM application-through Agile PLM external reporting capability.

About Agile Reports
For detailed information about using all types of Agile reports, see the Working with Agile 
Reports chapter in Getting Started with Agile PLM, which includes information about:

How your roles and privileges affect reports

Report object tabs

Creating and modifying report layouts

Creating custom and external reports

Running, scheduling, saving, and deleting reports

Report output window

This chapter covers the Agile standard reports that are included as part of Agile Product 
Collaboration: product reports and process reports.

About Product Reports and Process Reports
Standard reports provide you with the information you commonly need to analyze your 
business processes. Product reports and process reports are the standard out-of-the-box reports 
for Product Collaboration. You select predefined criteria and specify the results you want. You 
can run them as they are, modify the default layouts, or create your own layouts. You can run 
Agile product reports and process reports from Agile Finish or Java Client.
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Accessing Product Reports and Process Reports
To access product reports in Web Client:

1. Click the REPORTS drawer in the left pane to display the reports folders.

2. Open the Reports and Analytics folder.

3. Open the Standard Reports folder to locate the Product Reports folder or the Process 
Reports folder.

4. Open the Product Reports folder or the Process Reports folder and click the report you 
want. The report page is displayed in the content pane on the right.

To access product reports in Java Client:

1. Click the Analytics and Reports tab in the left pane to display the reports folders.

2. Open the Standard Reports folder to locate the Product Reports folder or the Process 
Reports folder.

3. Open the Product Reports folder or the Process Reports folder and double-click the 
report you want. Web Client opens and displays the report page you selected.

Agile Products Reports Summary
The Products Reports folder under Standard Reports in the navigation pane lists the Product 
Collaboration reports.

The following table describes reports related to bills of material:

Table 9–1 BOM reports

Bill of Material (BOM) Report Displays..

Assembly Cost (Item Master) 
Report

The Assembly Cost report takes the bill of material for a specified 
assembly and computes the cost of the BOM and each 
subassembly.

BOM Explosion Report The BOM Explosion report displays the bill of material for a 
specified assembly up to the desired number of levels. Select a 
BOM snapshot date.

Consolidated BOM Report The Consolidated BOM report takes the bill of material for a 
specified assembly and consolidates it into a single-level bill, 
computing the total quantity of each item.

Effective BOM Explosion 
Report

The Effective BOM report displays the bill of material for a 
specified assembly that is effective during a specific time period.

Item Activity Report The Item Activity report shows the items that were processed 
during a specified time period.

Compare Item Attributes 
Report

Shows the attribute differences between two or more items.

Where Used Report The Where Used report shows where the component or 
subassembly is used, up to any practical number of levels.

BOM Comparison Report The BOM Comparison report shows the differences between two 
bills of material. Select the number of BOM levels to compare and 
select a BOM snapshot date.

Legacy BOM Comparison 
Report - Single Level Only

The Legacy BOM Comparison report shows the differences 
between two or more bills of material, using the first BOM level.

Item Attribute History Report Shows how Item Attribute Values have been changed over time 
through Change Orders or Manufacturing Orders.
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The following table describes reports related to manufacturers and manufacturer parts:

Agile Process Reports Summary
The Agile Process reports provide information about changes and transfer orders. The Process 
Reports node folder under Standard Reports in the navigation pane lists the following 
reports:

The following table describes reports related to the change process:

The following table describes reports related to IP transfer:

Products Reports
The Products Reports folder lists the following reports:

"Assembly Cost (Item Master) Report" on page 9-4

"BOM Explosion Report" on page 9-5

Table 9–2 Manufacturer and Manufacturer Part reports

Manufacturer Report Displays..

Item Manufacturers Report The Manufacturer Item report displays a list of all the items matching 
a query and shows the manufacturers that are used for each item. 
(Requires AML server license.)

Manufacturer BOM Report The Manufacturer BOM report runs the BOM Explosion report and 
includes the manufacturers that are used for each item in the bill of 
material. (Requires AML server license.)

Table 9–3 Change Process reports

Change Process 
Report Displays..

Change Activity 
Report

The Change Activity report shows the changes that were processed during a 
specified time period.

Change Backlog 
Report

The Change Backlog report counts the changes that were at a specified 
status but have not moved to another specified status during a time period.

Change Cycle Time 
Report

The Change Cycle Time report calculates the time it took the specified 
changes to move from one status to another during the specified period. For 
example, the report indicates the average time it took for a change to go 
from Submitted to Released each month during the last year, grouped by 
product line.

User Signoff Duration 
Report

The User Signoff Duration report calculates the amount of time that a user 
has had to sign off a routable object requiring their approval, and they have 
not acted yet upon it.

Change Metrics Report The Change Metrics report counts the changes that were moved to a 
specified status during a specified period.

Change Package 
Report

You can print the Change Package report to view the information about a 
change in an easy-to-read format.

Table 9–4 IP Transfer report

IP Transfer Report Displays..

IP Transfer Report The IP Transfer report show the objects sent (by Agile transfer orders) 
to a given destination and when they were sent. (Requires the Agile 
Content Service server license.)
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"Consolidated BOM Report" on page 9-6

"Effective BOM Explosion Report" on page 9-7

"Item Activity Report" on page 9-8

"Compare Item Attributes Report" on page 9-9

"Manufacturer BOM Report" on page 9-10

"Where Used Report" on page 9-11

"BOM Comparison Report" on page 9-12

"Legacy BOM Comparison Report - Single Level Only" on page 9-13

"Item Attribute History Report" on page 9-15

"Item Manufacturers Report" on page 9-16

For more information about specific product reports, see "Products Reports" on page 9-3.

Assembly Cost (Item Master) Report
This report generates a cost rollup by determining the cost and quantity of each component and 
assembly and calculating the total cost. The report shows the same data as the BOM Explosion 
report with the addition of three columns:

Individual Cost

Total Cost

Assembly Cost

To run the Assembly Cost report:

1. Select the Assembly Cost report in the Products Reports folder. The Assembly Cost 
Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select Items for Report wizard step appears.

5. Select the items you want to include in the report.

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

Click Custom Search and define a query. Copy rows from the search results table and 
paste them into the Select Items for Report wizard table.

6. By default, the most recently released revision of the item is selected in the Select Items 
for Report step of the report wizard. To select a different revision, edit the Revision column 
of the table.

7. To select multiple revisions of an item, use the following procedure:

a. Edit the Revision field for the item and select a revision other than the most recently 
released revision. Press Enter on the keyboard to save your edits.
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b. Click the Add button. In the add palette, type the item number and add it to the table 
again. The most recently released revision is selected.

c. Repeat steps a and b to select as many item revisions as you want.

8. Click Next. The Select Additional Parameters step is displayed.

9. Specify the item types you want. Click the small X button to remove an item type. Click 
the Launch the Palette button to launch the palette and select additional item types.

10. Click Next. The Select Cost Field and Cost Option wizard step appears.

11. Select values from the Cost Field and Option drop-down lists. The options are Part Cost 
Only, Assembly Level Cost only, or Assembly Level Cost Plus Rolled-Up Cost.

12. Click Finish to run and display the report.

BOM Explosion Report
The BOM Explosion report displays the items that are in the bill of material for a specified 
assembly, up to the desired number of levels.

To run the BOM Explosion report:

1. Select the BOM Explosion report in the Products Reports folder. The BOM Explosion 
Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select Items for Report wizard step appears.

5. Select the items you want to include in the report.

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

Click Custom Search and define a query. Copy rows from the search results table and 
paste them into the Select Items for Report wizard table.

Table 9–5 Assembly Cost report

Report layout fields Description

Level The BOM level, for example, 0, 1, 2, or 3.

Individual Cost The part cost selected in the Cost Field in the report wizard.

Total Cost Individual Cost * total quantity (Qty) for that row

Assembly Cost Cost of the assembly.

Item fields as specified in the 
selected layout

Depending on the layout, the report can include any attributes from the 
selected item's Title Block, Page Two or BOM tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting Started with Agile PLM.
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6. By default, the most recently released revision of the item is selected in the Select Items 
for Report step of the report wizard. To select a different revision, edit the Revision column 
of the table.

7. To view a snapshot of the exploded BOM at a specific date and time, double-click the Date 
As Of field and select the date and time you want.

8. To select multiple revisions of an item, use the following procedure:

a. Edit the Revision field for the item and select a revision other than the most recently 
released revision. Press Enter on the keyboard to save your edits.

b. Click the Add button. In the add palette, type the item number and add it to the table 
again. The most recently released revision is selected.

c. Repeat steps a and b to select as many item revisions as you want.

9. Click Next. The Select Additional Report Parameters step appears.

10. Specify the depth, or number of levels in the BOM, you want to include.

11. Specify the item types you want. Click the small X button to remove an item type. Click 
the Launch the Palette button to launch the palette and select additional item types.

12. Click Finish to run and display the report.

Consolidated BOM Report
The Consolidated BOM report takes the bill of material for a specified assembly and 
consolidates it into a single-level bill, computing the total quantity of each item. It shows a 
summary of all parts for a given assembly, regardless of level, including total quantities in the 
whole assembly.

To run the Consolidated BOM report:

1. Select the Consolidated BOM report in the Products Reports folder. The Consolidated 
BOM Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select Items for Report wizard step appears.

5. Select the items you want to include in the report.

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

Table 9–6 BOM Explosion report

Report layout fields Description

Level The BOM level, for example, 0, 1, 2, or 3.

Item fields as specified in the 
selected layout

Depending on the layout, the report can include any attributes from the 
selected item's Title Block, Page Two or BOM tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting Started With Agile PLM.
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Click Custom Search and define a query. Copy rows from the search results table and 
paste them into the Select Items for Report wizard table.

6. By default, the most recently released revision of the item is selected in the Select Items 
for Report step of the report wizard. To select a different revision, edit the Revision column 
of the table.

7. To select multiple revisions of an item, use the following procedure:

a. Edit the Revision field for the item and select a revision other than the most recently 
released revision. Press Enter on the keyboard to save your edits.

b. Click the Add button. In the add palette, type the item number and add it to the table 
again. The most recently released revision is selected.

c. Repeat steps a and b to select as many item revisions as you want.

8. Click Next.

9. Specify the depth, or number of levels in the BOM, you want to include.

10. Specify the item types you want. Click the small X button to remove an item type. Click 
the Launch the Palette button to launch the palette and select additional item types.

11. Click Finish to run and display the report.

Effective BOM Explosion Report
The Effective BOM Explosion report displays the report based on the Rev Release Date of 
parts in the BOM and the dates selected for the reporting period.

To run the Effective BOM Explosion report:

1. Select the Effective BOM Explosion Report in the Products Reports folder. The Effective 
BOM Explosion Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select Items for Report wizard step appears.

5. Select the items you want to include in the report.

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

When using Search to Add, you can click Custom Search and define a query or use a 
saved search (click Launch Saved Searches). Copy rows from the search results table 
and paste them into the Select Items for Report wizard table.

Table 9–7 Consolidated BOM report

Report layout fields Description

Total Quantity Total quantity of each specific item in the whole assembly (BOM)

Item fields as specified in the 
selected layout

Depending on the layout, the report can include any attributes from the 
selected item's Title Block, Page Two or BOM tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting started With Agile PLM.
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Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

6. Click Next. The Select Additional Report Parameters step appears.

7. Specify the depth, or number of levels in the BOM, you want to include.

8. Specify the item types you want. Click the small X button to remove an item type. Click 
the Launch the Palette button to launch the palette and select additional item types.

9. Select the Sort Type: Maintain BOM Structure or Sort by Item Number.

10. Click Next. The Select Date Range step appears.

11. Specify the date range by choosing a start date and an end date.

12. Click Finish to run and display the report.

Item Activity Report
The Item Activity report shows the items that were processed during a specified time period.

To run the Item Activity report:

1. Select the Item Activity report in the Products Reports folder. The Item Activity Report 
page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select Date Range step appears.

5. Specify the date range by choosing a start date and an end date.

6. Click Next. The Select Additional Report Parameters step appears.

7. In the Item Lifecycle Phase field select the lifecycles to be included. Click the Launch 
the Palette button to launch the palette and select lifecycles. Click the small X button to 
remove a lifecycle.

8. In the Sites field you may specify sites. Click the Launch the Palette button to launch the 
palette and select the sites you want. Click the small X button to remove a site.

9. Click Finish to run and display the report.

Table 9–8 Effective BOM Explosion report

Default fields Description

Level The BOM level, for example, 0, 1, 2, or 3

Item fields as specified in the 
selected layout

Depending on the layout, the report can include any attributes from the 
selected item's Title Block, Page Two, Changes, or BOM tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting started With Agile PLM.
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Compare Item Attributes Report
The Compare Item Attribute report enables you to compare Item Attribute values of multiple 
items or item revisions.

Reported attributes include change-controlled attributes and revision-controlled attributes.

To run the Compare Item Attributes report:

1. Select the Compare Item Attributes report in the Products Reports folder. The Compare 
Item Attributes Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Select a report output format: PDF, WORD, EXCEL, or HTML.

5. Click Next. The Select Items for the Report step appears.

6. Select the items you want to include in the report.

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

Click Custom Search and define a query. Copy rows from the search results table and 
paste them into the Select Items for Report wizard table.

7. By default, the most recently released revision of the item is selected in the Select Items 
for Report step of the report wizard. To select a different revision, edit the Revision column 
of the table.

8. To select multiple revisions of an item, use the following procedure:

a. Edit the Revision field for the item and select a revision other than the most recently 
released revision. Press Enter on the keyboard to save your edits.

b. Click the Add button. In the add palette, type the item number and add it to the table 
again. The most recently released revision is selected.

9. Click Finish to run and display the report.

You are prompted to download the report in the format you selected.

Table 9–9 Item Activity report

Report layout fields Description

Site The name of the site associated with the listed item.

The sites listed are determined by the sites you selected in the report 
wizard.

Item fields as specified in the 
selected layout

Depending on the layout, the report can include any attributes from the 
listed item's Title Block or Page Two tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting started With Agile PLM.
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Manufacturer BOM Report
The Manufacturer BOM report runs the BOM Explosion report and shows the manufacturers 
that are used for each item in the bill of material. Manufacturer data can be filtered by the 
lifecycle status of the manufacturer or of the manufacturer part.

To run the Manufacturer BOM report:

1. Select the Manufacturer BOM report in the Products Reports folder. The Manufacturer 
BOM Report page is displayed.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select Items for Report wizard step appears.

5. Select the items you want to include in the report.

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

Click Custom Search and define a query. Copy rows from the search results table and 
paste them into the Select Items for Report wizard table.

6. Click Next. The Select Additional Report Parameters step appears.

7. Specify the depth, or number of levels in the BOM, you want to include.

8. Specify the item types you want. Click the small X button to remove an item type. Click 
the Launch the Palette button to launch the palette and select additional item types.

9. Click Next in the report wizard. The Select AML Information step appears. Complete the 
required fields:

a. Select one or more manufacturer part Preferred Status. Type in the text field or click 
the Launch the Palette button to launch the palette.

b. Select one or more Manufacturer Part Lifecycle Phase. Type in the text field or click 
the Launch the Palette button to launch the palette.

10. Click Finish to run and display the report.

Table 9–10 Compare Item Attributes report

Report layout fields Description

Items The Items listed are determined by the items you selected in the report 
wizard.

Item fields as specified in the 
selected layout

Depending on the layout, the report can include attributes from the 
listed item's Title Block or Page Two or Page Three tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting started With Agile PLM.



Products Reports

Working with Product Reports and Process Reports 9-11

Where Used Report
The Where Used report shows where the specified component or subassembly is used, up to the 
specified number of levels. It can show just the highest level of the assembly, all levels, or any 
number of levels in between.

To run the Where Used report:

1. Select the Where Used report in the Products Reports folder. The Where Used Report 
page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select Items for Report wizard step appears.

5. Select the items you want to include in the report.

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

Click Custom Search and define a query. Copy rows from the search results table and 
paste them into the Select Items for Report wizard table.

6. Click Next. The Select Additional Parameters step is displayed.

7. Specify the depth, or number of levels in the BOM, you want to include. Deselect the Top 
Level Assemblies Only check box to change the default All Levels setting.

Table 9–11 Manufacturer BOM report

Report layout fields Object type attribute Description

Level Item attribute The BOM level, for example, 0, 1, 2, or 3.

For each item listed in 
the report, item fields as 
specified in the selected 
layout

Item attributes Depending on the layout, the report can include 
any attributes from the listed item's Title Block, 
Page Two, or BOM tabs.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Under each listed item, 
manufacturer part 
information as specified 
in the selected layout

Manufacturer part 
attributes

Depending on the layout, the manufacturer part 
information under each item can include any 
attributes from the listed item's Manufacturers 
tab, attributes from the manufacturer part's 
General Info tab, and attributes from the 
manufacturer's General Info tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Note: An item will be selected for the report only if the specified 
component or subassembly is included in the BOM of the item's latest 
released revision.
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The Top Level Assemblies Only check box determines which items that contain the 
specified item are included in the report. In a Where Used report on Item P0003 below, 
selecting the check box causes only P0001 to be included, while clearing the check box 
causes P0001 and P0002 to be included.

Figure 9–1 BOM tree hierarchy example diagram

8. Specify the item types you want. Click the small X button to remove an item type. Click 
the Launch the Palette button to launch the palette and select additional item types.

9. Click Finish to run and display the report.

BOM Comparison Report
The BOM (Bills of Material) Comparison report shows the differences between two bills of 
material. It compares multiple levels of the BOM of one selected item to the BOM of the other 
item on the report. The report includes the entire BOM structure for both BOMs and highlights 
the differences between the two in grey. An item may be listed multiple times to indicate the 
differences in find number and reference designator information.

You can compare the BOMs by item number or by find number. The comparison will be sorted 
by item number and by find number.

To run the BOM Comparison report:

1. Select the BOM Comparison report in the Products Reports folder. The BOM 
Comparison Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Select a report output format: PDF, WORD, EXCEL, or HTML.

5. Click Next. The Set Compare Parameters step appears.

6. Specify the depth, or number of levels in the BOM, you want to include.

Table 9–12 Where Used report

Default fields Description

Level The BOM level, for example, 0, 1, 2, or 3.

Item fields as specified in the 
selected layout

Depending on the layout, the report can include any attributes from the 
listed item's Title Block, Page Two, or BOM tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting started With Agile PLM.
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7. Select the Compare Structures you want to use. By default, BOM structure is always 
selected. You can also compare the AML and Attachment information by selecting the 
appropriate check box.

8. Specify the item types you want. Click the small X button to remove an item type. Click 
the Launch the Palette button to launch the palette and select additional item types.

If you selected AML compare structure, then specify the AML attributes you want. 
Click the small X button to remove an item type. Click the Launch the Palette button 
to launch the palette and select additional AML attributes.

If you selected Attachment compare structure, then specify the Attachment attributes 
you want. Click the small X button to remove an item type. Click the Launch the 
Palette button to launch the palette and select additional Attachment attributes.

9. Select the two items you want to include in the report.

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

Click Custom Search and define a query. Copy rows from the search results table and 
then paste them into the Select Items for Report wizard table.

10. By default, the most recently released revision of the item is selected in the Select Items 
for Report step of the report wizard. To select a different revision, edit the Revision column 
of the table.

11. To compare snapshots of a BOM at a specific date and time, double-click the Date As Of 
field and select the date and time you want.

12. To select multiple revisions of an item, use the following procedure:

a. Edit the Revision field for the item and select a revision other than the most recently 
released revision. Press Enter on the keyboard to save your edits.

b. Click the Add button. In the add palette, type the item number and add it to the table 
again. The most recently released revision is selected.

13. Click Finish to run and display the report.

You are prompted to download the report in the format you selected.

Legacy BOM Comparison Report - Single Level Only
The BOM (Bills of Material) Comparison report shows the differences between two or more 
bills of material. It compares the first-level BOM of the selected items to the BOMs of the other 
items on the report and shows you which components are not common to both.

Table 9–13 BOM Comparison report

Report layout fields Description

Comparison Data The report includes one column for each item revision selected in the 
Select Items for Report wizard page.

Item fields as specified in the 
selected layout

Depending on the layout, the report can include any attributes from the 
selected item's Title Block, Page Two or BOM tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting started With Agile PLM.
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Only those items that have differences are listed in the report. Components that match exactly 
are not listed. An item may be listed multiple times to indicate the differences in find number 
and reference designator information.

You can compare the BOMs by item number or by find number. The comparison will be sorted 
by item number and by find number.

To run the BOM Comparison report:

1. Select the BOM Comparison report in the Products Reports folder. The BOM 
Comparison Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select items for the Report step appears.

5. Select the two items you want to include in the report.

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

Click Custom Search and define a query. Copy rows from the search results table and 
paste them into the Select Items for Report wizard table.

6. By default, the most recently released revision of the item is selected in the Select Items 
for Report step of the report wizard. To select a different revision, edit the Revision column 
of the table.

7. To select multiple revisions of an item, use the following procedure:

a. Edit the Revision field for the item and select a revision other than the most recently 
released revision. Press Enter on the keyboard to save your edits.

b. Click the Add button. In the add palette, type the item number and add it to the table 
again. The most recently released revision is selected.

8. Click Next. The Select Type step appears.

9. Specify the Item types you want to include in the report. Click the small X button to 
remove an item type. Click the Launch the Palette button to launch the palette and select 
additional item type.

10. Click Next. The Set Compare Attribute step appears.

11. Select the Compare Attribute you want to use.

a. In the Compare By field, select the attribute used to match items being compared: 
Item Number or Find Number.

b. To use a secondary compare attribute, make a selection in the Then By field.

c. Complete the Select Other Attributes Used for Comparison section: In the View in 
field, select an item type, and then use the arrow buttons to move values to and from 
the Selected Values list.

12. Click Finish to run and display the report.
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Item Attribute History Report
The Item Attribute History report enables you to view how Item Attribute values have changed 
over time through Change Order (ECOs) or Manufacturing Change Orders (MCOs).

Reported attributes include change-controlled attributes and revision-controlled attributes. The 
attributes included in the report are defined in the report layout. You can create a report layout 
that includes the attributes you want.

To run the Item Attribute History report:

1. Select the Item Attribute History report in the Products Reports folder. The Item Attribute 
History Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Select a report output format: PDF, WORD, EXCEL, or HTML.

5. Click Next. The Select Item wizard step appears.

6. Select the item you want to include in the report. Type in the text field or click to execute a 
quick search.

7. In the Change Type field, use the drop-down list to select the changes you want to include 
in the report: Changer Orders, Manufacturing Orders, or Both.

8. Click Finish to run and display the report.

You are prompted to download the report in the format you selected.

Table 9–14 Legacy BOM Comparison report

Report layout fields Description

Comparison Data The report includes one column for each item revision selected in the 
Select Items for Report wizard page.

Item fields as specified in the 
selected layout

Depending on the layout, the report can include any attributes from the 
selected item's Title Block, Page Two or BOM tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting started With Agile PLM.

Table 9–15 Item Attribute History report

Report layout fields Description

For the item listed in the 
report, item fields as specified 
in the selected layout

Depending on the layout, the report can include revision-controlled 
attributes and any change-controlled attributes from the listed item's 
Title Block or Page Two tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting started With Agile PLM.

Item changes, ECOs, MCOs or 
both, as selected in the report 
wizard.

Item field content is displayed for each field at each change revision.

Modified fields are highlighted.
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Item Manufacturers Report
The Item Manufacturers report displays a list of all the items matching a query and shows the 
manufacturers that are used for each item.

To run the Item Manufacturers report:

1. Select the Item Manufacturer report in the Products Reports folder. The Item 
Manufacturer Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select or Create a Query wizard step appears.

5. To select a saved search:

a. Select the Saved Search option.

b. Click the Search to Add button to open the Saved Search palette.

c. Navigate to the saved search you want to use.

d. Double-click or press Enter on the keyboard to select the search.

e. Press Escape on the keyboard to close the palette.

6. To define an advanced search:

a. Select the Advanced Search option.

b. Click the Define Query button to open the Report Search definition palette.

c. Define the query you want to use and click Finish. For detailed information about 
advanced searches, see Getting Started with Agile PLM.

7. Click Next in the report wizard. The Select AML Information step appears. Complete the 
required fields:

a. Select one or more manufacturer part Preferred Status. Type in the text field or click 
the Launch the Palette button to launch the palette.

b. Select one or more Manufacturer Part Lifecycle Phase. Type in the text field or click 
the Launch the Palette button to launch the palette.

c. The Sites selection is optional. Select one or more sites. Type in the text field or click 
to execute a quick search.

8. Click Finish to run and display the report.

Table 9–16 Item Manufacturers report

Report layout fields Object type attribute Description

For each item listed in 
the report, item fields as 
specified in the selected 
layout

Item attributes Depending on the layout, the report can include 
any attributes from the listed item's Title Block or 
Page Two tabs.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.
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Process Reports
The Process Reports folder lists the following reports:

"Change Activity Report" on page 9-17

"Change Backlog Report" on page 9-18

"Change Cycle Time Report" on page 9-20

"User Signoff Duration Report" on page 9-22

"Change Package Report" on page 9-23

"IP Transfer Report" on page 9-24

"Change Metrics Report" on page 9-25

For more information about specific product reports, see "Process Reports" on page 9-17.

Change Activity Report
The Change Activity report shows the changes that were processed during a specified time 
period. You choose which workflow to include in the report (for example, Default Change 
Orders or All Change Workflows). You also choose which status transitions to include in the 
report. For example, if you select Default Change Orders workflow and Released status type, 
then the reports lists all the changes orders that used the Default Change Orders workflow and 
that moved into the Released type status during the specified time period.

To run the Change Activity report:

1. Select the Change Activity report in the Process Reports folder. The Change Activity 
Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting Started with Agile PLM.

4. Click Next. The Select Date Range wizard step appears.

5. Specify the start and end dates of the period to be covered by the report. Click Next.

6. Select the workflow type from the drop-down list.

7. Select one or more Status Changes To: options. Type in the text field or click the Launch 
the Palette button to launch the palette.

Under each listed item, 
manufacturer part 
information as specified 
in the selected layout

Manufacturer part 
attributes

Depending on the layout, the manufacturer part 
information under each item can include any 
attributes from the listed item's Manufacturers 
tab, attributes from the manufacturer part's 
General Info tab, and attributes from the 
manufacturer's General Info tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Table 9–16 (Cont.) Item Manufacturers report

Report layout fields Object type attribute Description
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8. Click Finish to display the report.

Change Backlog Report
The Change Backlog report counts the changes that were at a specified status but have not 
moved to another specified status during a time period.

To run the Change Backlog report:

1. Select the Change Backlog report in the Process Reports folder. The Change Backlog 
Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

Note: If you select All Change Workflows, then the status types are listed 
in the Status Changes selection dialog. This lets you select status types that 
apply to all workflows (for example, Released status type). However, if you 
select a specific workflow (for example, All Change Orders), then the 
specific status names that apply to that workflow are listed in the Status 
Changes selection dialog.

Table 9–17 Change Activity report

Report layout fields Object type attribute Description

Status Main report header, 
Change object attributes

Status based on the Status Changes selections in 
wizard.

Status Date Main report header, 
Change object attributes

Date the change entered the selected status.

For each change listed 
in the report, change 
object fields as 
specified in the selected 
layout

Main report header, 
Change object attributes

Depending on the layout, the report can include 
any attributes from the Cover Page tab or the 
Page Two tab of the listed change.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Under each change 
object status transition 
row, item information 
from the change's 
Affected Items tab, as 
specified in the selected 
layout

Affected Item attributes Depending on the layout, the report can include 
any attributes from the listed change's Affected 
Items tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Under each change 
object status transition 
row, item information 
from the change's 
Affected Files tab, as 
specified in the selected 
layout

Affected File attributes Depending on the layout, the report can include 
any attributes from the listed change's Affected 
Files tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.
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4. Click Next. The Select or Create a Query wizard step appears.

5. To include all changes in the report, select the All Changes option.

6. To select a saved search:

a. Select the Saved Search option.

b. Click the Search to Add button to open the Saved Search palette.

c. Navigate to the saved search you want to use.

d. Double-click or press Enter on the keyboard to select the search.

e. Press Escape on the keyboard to close the palette.

7. To define an advanced search:

a. Select the Advanced Search option.

b. Click the Define Query button to open the Report Search definition palette.

c. Define the query you want to use and click Finish. For detailed information about 
advanced searches, see Getting Started with Agile PLM.

8. Click Next in the report wizard. The Define Report wizard step appears.

9. Specify the other settings for the report:

The time period covered

The time unit used in the report

The workflow

The starting status (to include changes that were in this status or moved into this status 
during the specified time period) and ending status (to include changes that have not 
yet moved into this status during the specified time period)

For example, if you select starting status = Pending and ending status = Released, then 
the report will count changes that were either in the Pending status or moved into the 
Pending status during the specified time period, but these changes have not moved 
into the Released status. The changes might be in a Submit type or Review type status, 
but they have not moved through the workflow to the Released status.

The way to group data to evaluate trends

Select the check boxes to display the changes or price change orders and exclude empty 
columns.

10. Click Finish to display the report.

Note: For more detailed information about layouts, see the Working with 
Agile Reports chapter in Getting Started with Agile PLM. To run this report 
for price change orders, select a layout that applies to price change orders. 
(The Agile-provided default layouts are Default Layout for Change and 
Default Layout for PCO.) If you create new layouts for this report, then you 
can choose a Layout Type: either Changes or Price Change Orders. Make 
sure the name you choose for the new layout indicates whether the layout 
applies to changes or price change orders.
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Change Cycle Time Report
The Change Cycle Time report calculates the time it took the specified changes to move from 
one status to another during the specified period. For example, the report indicates the average 
time (in days) it took for a change to go from Submitted to Released each week during the last 
year, grouped by product line.

To run the Change Cycle Time report:

1. Select the Change Cycle Time report in the Process Reports folder. The Change Cycle 
Time Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

Table 9–18 Change Backlog report

Report layout fields Object type attribute Description

Days since Submitted Main report header, 
Change attributes

Number of days since the change entered the 
Submit type status.

Days at current status Main report header, 
Change attributes

Number of days the change has been at the current 
status.

Hold Date Main report header, 
Change attributes

Date the change entered the Hold type status.

Submit Date Main report header, 
Change attributes

Date the change entered the Submit type status

For each change listed 
in the report, change 
object fields as 
specified in the selected 
layout

Main report header, 
Change attributes

Depending on the layout, the report can include 
any attributes from the listed change's Cover Page 
or Page Two tabs.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Under each change 
object status transition 
row, item information 
from the change's 
Affected Items tab, as 
specified in the selected 
layout

Affected Item attributes Depending on the layout, the report can include 
any attributes from the listed change's Affected 
Items tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Under each change 
object status transition 
row, item information 
from the change's 
Affected Files tab, as 
specified in the selected 
layout

Affected File attributes Depending on the layout, the report can include 
any attributes from the listed change's Affected 
Files tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Note: For more detailed information about layouts, see the Working with 
Agile Reports chapter in Getting Started with Agile PLM. To run this report 
for price change orders, select a layout that applies to price change orders. 
(The Agile-provided default layouts are Default Layout for Change and 
Default Layout for PCO.) If you create new layouts for this report, then you 
can choose a Layout Type: either Changes or Price Change Orders. Make 
sure the name you choose for the new layout indicates whether the layout 
applies to changes or price change orders.
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4. Click Next. The Select or Create a Query wizard step appears.

5. To include all changes in the report, select the All Changes option.

6. To select a saved search:

a. Select the Saved Search option.

b. Click the Search to Add button to open the Saved Search palette.

c. Navigate to the saved search you want to use.

d. Double-click or press Enter on the keyboard to select the search.

e. Press Escape on the keyboard to close the palette.

7. To define an advanced search:

a. Select the Advanced Search option.

b. Click the Define Query button to open the Report Search definition palette.

c. Define the query you want to use and click Finish. For detailed information about 
advanced searches, see Getting Started with Agile PLM.

8. Click Next in the report wizard. The Define Report wizard step appears.

9. Specify the other settings for the report:

The time period covered

The time unit used in the report

The workflow

The starting status (to include changes that were in this status or moved into this status 
during the specified time period) and ending status (to include changes that have not 
yet moved into this status during the specified time period)

For example, if you select starting status = Pending and ending status = Released, then 
the report will count changes that were either in the Pending status or moved into the 
Pending status during the specified time period, but these changes have not moved 
into the Released status. The changes might be in a Submit type or Review type status, 
but they have not moved through the workflow to the Released status.

The way to group data to evaluate trends

Select the check boxes to display the changes or price change orders and exclude empty 
columns.

10. Click Finish to display the report.

Table 9–19 Change Cycle Time report

Default fields Object type attribute Description

Days since Submitted Main report header, 
Change attributes

Number of days since the change entered the 
Submit type status.

Days at current status Main report header, 
Change attributes

Number of days the change has been at the current 
status.

Enter Status Date Main report header, 
Change attributes

Date the change entered the starting status selected 
in the report wizard.

End Status Date Main report header, 
Change attributes

Date the change entered the ending status selected 
in the report wizard.

Number Days Main report header, 
Change attributes

The number of days between the Enter Status Date 
and the End Status Date.
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User Signoff Duration Report
The User Signoff Duration report calculates the time it took the specified users to signoff the 
specified changes at the specified statuses. Duration is calculated in days.

To run the Change Cycle Time report:

1. Select the User Signoff Duration report in the Process Reports folder. The User Signoff 
Duration Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

4. Select a report output format: PDF, WORD, EXCEL, or HTML.

5. Click Next. The Select Changes for the Report step appears

6. Select the changes you want. You can:

Use the table Add button. Type the item numbers you want or use the Search to Add 
palette button.

Use More.. > Paste to paste item rows you have copied from another table or from the 
FOLDERS navigation drawer Bookmarks or Recently Visited list.

Click Custom Search and define a query. Copy rows from the search results table and 
paste them into the Select Items for Report wizard table.

Click Next. The User Signoff Duration wizard step appears.

7. Select the number of days for the duration.

8. Click Next. The Set Other Parameters wizard step appears.

9. Specify the other settings for the report:

For each change listed 
in the report, change 
object fields as 
specified in the selected 
layout

Main report header, 
Change attributes

Depending on the layout, the report can include 
any attributes from the listed change's Cover Page 
or Page Two tabs.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Under each change 
object row, item 
information from the 
change's Affected 
Items tab, as specified 
in the selected layout

Affected Item attributes Depending on the layout, the report can include 
any attributes from the listed change's Affected 
Items tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Under each change 
object row, item 
information from the 
change's Affected Files 
tab, as specified in the 
selected layout

Affected File attributes Depending on the layout, the report can include 
any attributes from the listed change's Affected 
Files tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Note: Users who signoff within 24-hours are not included in the report.

Table 9–19 (Cont.) Change Cycle Time report

Default fields Object type attribute Description
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The workflow statuses you want. The default is the current status of the workflow.

Check to Include Historical Statuses.

Include all users (default) or select specific users.

User Role: Approver, Observer, Approver or Observer.

User Signoff Action: All, Pending Signoff Only, Signed Off Only

The workflow

10. Click Finish to display the report.

You are prompted to download the report in the format you selected.

Change Package Report
You can print the Change Package report to view the information about a change in an 
easy-to-read format.

To run the Change Package report:

1. Select the Change Package report in the Process Reports folder. The Change Package 
Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

For more detailed information about layouts, see the Working with Agile Reports chapter 
in Getting started With Agile PLM.

Table 9–20 User Signoff Duration report

Default fields Description

Change Number The number of the change.

Status Status as selected in the report wizard.

Status Entry Date Date the change entered the status as selected in the report wizard.

User Name Name of signoff user.

User Role User role, as selected in the report wizard.

User Add Date Date the user was added as a approver or observer

User Signoff Date Date the user signed off the change.

Signoff Duration The number of days between the Status Entry Date and the User 
Signoff Date.

Reviewer Job Function The Job Function for which the reviewer signed off.

Note: The option to use Oracle Business Intelligence Publisher (BI 
Publisher) is not available with this report.
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4. Click Next. The Select Changes for the Report wizard step appears.

5. Select the changes you want to include in the report.

Use the table Add button. Type the change numbers you want or use the Search to 
Add palette button.

Use More.. > Paste to paste change rows you have copied from another table or from 
the FOLDERS navigation drawer Bookmarks or Recently Visited list.

Click Custom Search and define a query. Copy rows from the search results table and 
paste them into the Select Changes for Report wizard table.

6. Click Next. The Select Tables to Include wizard step appears.

7. Specify the tables to include in the report. Click the small X button to remove a table. 
Click the Launch the Palette button to launch the palette and select additional tables.

8. Click Finish to display the report.

IP Transfer Report
For information about Agile Content Service (ACS) and transfer orders see Agile Content 
Service User Guide.

Note: Agile PLM supplies a default layout for each change type. If you 
create new layouts for this report, then you can choose a Layout Type. The 
layout type can be for all changes in a particular class (for example, change 
orders) or the layout type can be for a specific type of subclass of change (for 
example, ECOs). For ease of use, make sure the name you choose for the new 
layout indicates the selected layout type.

Table 9–21 Change Package report

Report layout pages and 
fields Description

Cover Page

Affected Items

Affected Files

Workflow

Attachments

History

Tabs of the change object that can be included in the report layout. 
Depending on the layout, the report can include any attributes from the 
change's tabs.

For detailed information about layouts, see the Working with Agile 
Reports chapter in Getting started With Agile PLM.

All Change Package layouts can include these tabs. Some change 
types can include additional information, as explained below.

Affected Items.BOM Lists the BOM redlines that appear on the change's affected item 
Redline BOM tab. Depending on the layout, the report can include 
any attributes from this tab.

Available for change orders and site change orders only.

Affected 
Items.Manufacturers

Lists the manufacturer redlines that appear on the change's affected 
item Redline Manufacturers tab. Depending on the layout, the report 
can include any attributes from this tab.

Available for change orders, site change orders, and manufacturer 
orders only.

Affected Items.Attachments Lists the attachments that appear on the change's affected item 
Redline Folder tab: the list of attachments for the pending revision of 
the item. Depending on the layout, the report can include any attributes 
from this tab.

Available for change orders only.
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This report shows the objects sent by transfer orders to a given destination and when they were 
sent.

For details about running this report, see the Working with Transfer Orders chapter of Agile 
Content Service User Guide.

Change Metrics Report
The Change Metrics report counts the changes that were moved to a specified status during a 
specified period.

To run the Change Metrics report:

1. Select the Change Metrics report in the Process Reports folder. The Change Metrics 
Report page appears.

2. Click the Execute button. The Select Layout and Configuration wizard step appears.

3. Select the layout you want from the drop-down list, or use the Edit button to edit an 
existing layout or use the Create button to create a new layout.

4. Click Next. The Select or Create a Query wizard step appears.

5. To include all changes in the report, select the All Changes option.

6. To select a saved search:

a. Select the Saved Search option.

b. Click the Search to Add button to open the Saved Search palette.

c. Navigate to the saved search you want to use.

d. Double-click or press Enter on the keyboard to select the search.

e. Press Escape on the keyboard to close the palette.

7. To define an advanced search:

a. Select the Advanced Search option.

b. Click the Define Query button to open the Report Search definition palette.

c. Define the query you want to use and click Finish. For detailed information about 
advanced searches, see Getting Started with Agile PLM.

8. Click Next in the report wizard. The Define Report wizard step appears.

9. Specify the other settings for the report:

The time period covered

The time unit used in the report

The workflow

Note: For more detailed information about layouts, see the Working with 
Agile Reports chapter in Getting Started with Agile PLM. To run this report 
for price change orders, select a layout that applies to price change orders. 
(The Agile-provided default layouts are Default Layout for Change and 
Default Layout for PCO.) If you create new layouts for this report, then you 
can choose a Layout Type: either Changes or Price Change Orders. Make 
sure the name you choose for the new layout indicates whether the layout 
applies to changes or price change orders.
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The status type (to include changes that moved into this status type during the 
specified time period)

The way to group data to evaluate trends

Select the check boxes to display the changes or price change orders and exclude empty 
columns.

10. Click Finish to display the report.

If you chose a format other than the STANDARD, you are prompted to download the 
report in the format you selected.

Table 9–22 Change Metrics report

Report layout fields Object type attribute Description

Date Main report header, 
Change attributes

Date the change entered the status you selected in 
the report wizard.

For each change listed 
in the report, change 
object fields as 
specified in the selected 
layout

Main report header, 
Change attributes

Depending on the layout, the report can include 
any attributes from the listed change's Cover Page 
or Page Two tabs.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Under each change 
object row, item 
information from the 
change's Affected 
Items tab, as specified 
in the selected layout

Affected Item attributes Depending on the layout, the report can include 
any attributes from the listed change's Affected 
Items tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.

Under each change 
object row, item 
information from the 
change's Affected Files 
tab, as specified in the 
selected layout

Affected File attributes Depending on the layout, the report can include 
any attributes from the listed change's Affected 
Files tab.

For detailed information about layouts, see the 
Working with Agile Reports chapter in Getting 
started With Agile PLM.
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Details about Discovery and Read Privileges
The Agile administrator can use the Discovery privilege to limit discovery of objects in the 
following ways:

Prevent a set of users from seeing certain objects when they run a search. These objects are 
not displayed on the results table, even though they meet the search criteria. The Agile 
administrator can specify whether to display a warning message on the search results page.

Prevent a set of users from seeing certain objects that are listed on these tables:

– Affected items

– Where used

– Manufacturers

– Changes

– Sites

– User address book

The Agile administrator can specify whether to display a warning message.

Prevent a set of users from seeing certain objects on the BOM tab. The Agile administrator 
specifies whether to display a warning message. The Agile administrator also has the 
option of displaying either the item number only or the item description only on the BOM 
tab, so the user can see a complete BOM, but does not have access to the undiscovered 
items.

Prevent a set of users from running reports.

To see the objects they create, the creator of an object must also have the appropriate Discovery 
and Read privileges for the objects they create. (See Administrator Guide, "Roles" chapter, 
Default Agile PLM Roles list for information about the Creator can read and discover object 
they created role.)

Note: For more information about the discovery warning messages, see the 
chapter about SmartRules in the Administrator Guide.

Note: While one set of users is prevented from seeing certain objects or 
fields, other users with different Discovery privilege and Read privilege 
settings can see those same objects and fields.
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Discovery and Read privileges are assigned by the Agile administrator. If you have questions 
about your Discovery privileges or Read privileges, see the Agile administrator.

Displaying Non-viewable Fields

If you do not have the appropriate Read privilege for a field, then the words No Privilege 
appear in the field.

If a copy of a non-readable field appears in another object or in a table, then the words No 
Privilege appear there also. For example, if you do not have Read privilege for the Description 
field of changes, then when those changes are listed in a table, the words No Privilege also 
appear in the Description field of that table. Following are examples of tables where objects 
may be listed:

Search results

Change history

Manufacturers

Where used

Affected items

Audit results

On the BOM table only, the SmartRule that determines how non-discovered items are displayed 
on the BOM table is also applied to the non-readable fields. See "How the Agile Administrator 
Controls What You See" on page 5-1.

Part or Document?
In general, if the document is shipped as part of a product, or it has costs associated with it, 
then create it as a part object. If the document is an internal document, procedure, or reference, 
then create it as a document object.

In certain cases, though, you may want to create a document as a part. Here are three examples 
illustrating when you might choose to create a document as a part object or as a document 
object.

Part or Document Example 1:
If a document is the controlling document for a part (that is, it has the same number as the part), 
then create that document as a part object.

For example, if you have an engineering drawing number 123 that specifies and describes part 
number 123 (thus the document controls the part), then create part 123 and include the 
engineering drawing as an attachment.

Note: The Agile administrator can create Read privilege masks that limit 
your ability to read specific fields. The Enforce Field Level Read privilege 
determines whether the Read privilege mask is enforced at the field level. If 
you have a role that includes the Enforce Field Level Read privilege, then 
you may not be able to view the contents of specific fields. This section 
describes how those non-viewable fields are displayed. For more information, 
see the Agile PLM Administrator Guide.
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Use this method if the part number must be the same as the document number. When you use 
this method, the document does not exist as a separate document object in the Agile PLM 
database.

In contrast to the above example, if it is not necessary for the drawing number and part number 
to be the same, then create a document object (for example, document number 222) and add the 
engineering drawing to its Attachments tab (reference the engineering drawing in the 
appropriate file folder object). Then create a part object (for example, part 444). Add document 
222 to the BOM tab of part 444 and enter zero or REF as the quantity. Enter zero as the find 
number. This forces a document object to appear at the top of the BOM tab for easy reference.

Part or Document Example 2:
If the document has costs associated with it, or it is shipped as part of a product, then create it 
as a part object.

An example of a document that is shipped with a product is a manual. A manual might have a 
BOM that includes the binder, labels for the binder, binder tabs, and the printed document 
itself.

If a document goes to your customer with a product, then create it as a part object, even if it 
does not have a BOM. Examples of such a document might be a warranty card, an instruction 
booklet, assembly instructions, or a printed software licensing agreement.

If the document has costs associated with it, such as printing costs, then create it as a part 
object. When you add the document part to a BOM tab, and you enter a quantity of 1, the costs 
of the document part object are included in any reports that compute costs. (See Getting Started 
with Agile PLM for information about running reports.)

Part or Document Example 3:
If the following applies to a document, then create it as a document object:

It does not need to have the same number as a part.

It is not shipped as part of a product.

It does not have costs associated with it.

Examples of such documents might be a manufacturing process (a Quality Assurance 
procedure, a test procedure, or manufacturing instructions) or a reference document (a 
specification or an engineering drawing).

Create any internal company documents as document objects.

If you create a document object, and later want to change it to a part object, then you can 
hard-delete the document object (if you have the appropriate privileges), which removes it from 
the database and frees up the item number. Then you can create the document as a part object, 
using the same item number. For more information, see Appendix A, "Deleting Agile Objects."

Note: Because Agile PLM is so flexible, you are not required or forced to 
use the approach outlined in these examples when creating documents. You 
should, however, always follow your company's policies or guidelines when 
creating a document as a part object or as a document object. If you have 
questions, see the Agile administrator.
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Changing an Item's Subclass
If the Agile administrator has created additional subclasses, and you have the appropriate 
privileges, then you can change the subclass of an item. For example, you can change the 
subclass of a particular document from Specification to Data Sheet.

To change the subclass of an item:

1. On the Title Block tab of the part, select a new subclass from the Part Type drop-down 
list.

2. If Page Three is visible and has data, then a warning message appears, alerting you that all 
Page Three data is cleared.

Web Client:

– Choose Continue in the warning and click Finish to continue changing the 
subclass and to allow Page Three to be cleared.

– Choose Cancel in the warning and click Finish to cancel the change subclass 
process. No changes are made to the item. In the object pane, click Cancel to 
discard your modifications and exit the edit mode.

Java Client:

– Click Yes to continue changing the subclass and to allow Page Three to be 
cleared.

– Click No to cancel the change subclass process. No changes are made to the item. 
In the object window, click Cancel to discard your modifications and exit the edit 
mode.

3. If the new subclass has an autonumber scheme assigned by the Agile administrator, then 
Agile PLM asks you whether to select a new autonumber for the new subclass.

Web Client:

– Choose Continue in the warning and click Finish to continue changing the 
subclass and to allow the same number or name to be used.

– Choose Cancel in the warning and click Finish to cancel the change subclass 
process. No changes are made to the item. In the object pane, click Cancel to 
discard your modifications and exit the edit mode.

Java Client:

– Click Yes to change the subclass but retain the existing number.

– Click No to reject the existing number. Manually select or enter a number, and 
then click Save in the object page or window.

If you reject the existing number in the Java Client step above, then you must 
manually select a new number. Depending on your system configuration, do one of the 
following:

– If there is one autonumber source designated for the new subclass, then click the 
Autonumber button to assign a new autonumber. Click Save in the object 
window or page to complete the process.

Note: When you change the subclass of an item, its data fields change, and 
all previous information about the Page Three tab is cleared.
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– If autonumbering is required in your system, and more than one autonumber 
source is designated for the new subclass, then use the Autonumber button to 
select one of the autonumber sources. Click Save in the object window or page to 
complete the process.

– If an autonumber is not required, then you can type in a number. Click Save in the 
object window or page to complete the process.

4. Agile PLM displays the new number in the Number field, and enters the event on the 
History tab of the item.

About Matching Criteria in Workflows
Agile PLM uses matching criteria to find which workflows may be used for each change. Agile 
PLM matches each change to a list of valid workflows for that change.

When modifying an Item, the server validates the workflow entry matching criteria of those 
Changes, PSRs or QCRs that have a workflow associated with them, and the workflow is not in 
the Completed or the Canceled status type.

The Agile administrator selects matching criteria from a list of reusable criteria. A reusable 
criteria is a database query, just like an advanced search. Reusable criteria are named and 
defined by the Agile administrator.

Some examples of possible reusable criteria are:

All MECOs - finds all the changes that are MECOs (mechanical ECOs).

Scorpio ECOs - finds all the ECOs that include "Scorpio" in the Product Line(s) field of 
the change.

Libra Project - finds all the change orders that have any items on the Affected Items tab 
that contain "Libra" in the Product Line(s) field of the item.

By specifying a list of reusable criteria for each workflow, the Agile administrator limits which 
changes can use a specific workflow. For example, the Agile administrator might create a 
workflow named General Use, and select the three reusable criteria named above (All MECOs, 
Scorpio ECOs, and Libra Project) as the matching criteria for that workflow.

Matching Criteria Example 1:
If you create a change that is a Mechanical ECO (MECO), then it matches one of the matching 
criteria of the General Use workflow (All MECOs). The General Use workflow appears in the 
Workflow drop-down list on the Cover Page tab of the change.

Matching Criteria Example 2:
If you create a change that is an ECO that includes "Scorpio" in the Product Line(s) field of the 
ECO, then it matches one of the matching criteria of the General Use workflow (Scorpio 
ECOs). The General Use workflow appears in the Workflow drop-down list on the Cover Page 
tab of the change.

Matching Criteria Example 3:
If you create a change order and add items to its Affected Items tab that contain "Libra" in the 
Product Line(s) field, then Agile PLM examines the Product Line(s) field on the Affected Items 
tab for every affected item. The General Use workflow appears in the Workflow drop-down list 

Note: If the item is in use, then you may see a dialog alerting you that the 
item is locked. Click OK. The change subclass process is canceled.
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on the Cover Page tab of the change depending on the Criteria Matching Type setting for the 
workflow:

Some - One or more (but not all) affected items must match the affected item-based 
reusable criteria, in this case, Libra Project.

All - When multiple affected item-based reusable criteria are used as matching criteria, 
each affected item must match at least one affected item-based reusable criteria. However, 
each affected item does not have to match the same reusable criteria.

Same - All affected items must match the same affected item-based reusable criteria, in 
this case, Libra Project.

In Java Client, when editing a change object, click the Refresh button to save and update the 
change object and display the correct list of workflows in the Workflow drop-down list.

In Web Client, when editing the Cover Page tab, click the Validate button to save and update 
the change object and display the correct list of workflows in the Workflow drop-down list.

The Criteria Matching Type setting also applies for each status in the workflow. For detailed 
information about workflows and Criteria Matching Type, see the Administrator Guide.

Details About Revision Display on BOMs
Agile PLM calculates the revision number (or letter) that appears in the Rev field of the BOM 
table is by checking the release date of the parent item, if already released, and then locating the 
latest revision of the child item before that date and analyzing it. If the parent item has not been 
released, then the most recent revision of the child item is found.

The child item revision is analyzed according to three criteria:

Its lifecycle phase (Preliminary or other)

Whether there are any released revisions of the child item

Whether there are no released revisions of the child item

Depending on which revision of the parent you select, the child revision displayed may or may 
not be the latest revision of that child item. The following explains which child revision 
appears:

The latest revision of the parent item always displays the latest revision of the child item. 
That is, the parent BOM reflects any changes that may be made to the child item since the 
parent revision was released. This applies until the next revision of the parent is released.

The rev shown for a child item of any past revision of the parent item is the latest revision 
as of the time just preceding the next parent revision.

Note: As you add items to the Affected Items tab and complete the fields 
on the tabs of the change, the Workflow drop-down list on the Cover Page 
tab may vary, depending on which matching criteria apply at the moment. 
Contact the Agile administrator if you have questions about the matching 
criteria of a specific workflow.

Note: In Agile PLM, if there are no released revisions of an item (the item 
has never been released), then the Introductory revision is considered the 
latest revision, regardless of whether there are pending revisions of the 
never-released item. See Appendix , "Introductory Revisions."
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For each child item, the lifecycle phase appears that corresponds to the displayed revision.

The child item may display a blank Rev field if it has no revision number as of the release 
of the parent revision. This occurs:

– If the child item has never been released as of the present moment, if you are viewing 
the latest parent revision, or

– If it had not been released by the time of the next occurring parent revision, if you are 
viewing past parent item revisions.

The change order (ECO) or manufacturer change order (MCO) number associated with the 
displayed revision is included in the Item Rev column of the BOM table. The ECO number is 
the ECO that released the displayed revision. An MCO number is displayed with the revision 
upon which it is based.

Site change orders (SCO) are based on ECO-released revisions and the revision displayed on 
the BOM table may include SCO-defined content, however, SCO numbers are not displayed on 
the BOM table.

For more information about item revisions, see Appendix , "Working with Item Revisions."

Searching for Orphan Items That Do Not Have Parents
An orphaned item is an item that is not used in any BOM tree, therefore, the orphaned item 
does not have any parents. In the hierarchy of a BOM tree structure, there are parent items and 
children items. When an item no longer has any parents, then it is referred to as an orphan. On 
the Where Used tab of an orphaned item, the Where Used table is empty.

In an object search for item objects, in the search criteria attribute list, you can select the Where 
Used table Item Number text attribute as shown below. For this specific item search attribute, 
the search operators are limited to Is Null and Is Not Null.

This orphaned item search attribute can be combined with other search attributes to define a 
narrow search for specific orphaned items. For example, the following search finds all parts 
without parents for the latest released revision where the product line is Gemini, and the 
specified date is later than May 1, 2013.

Item Number Is Null And

Caution: Be aware that the unrelease and release of child items may affect 
the child revisions displayed on the parent BOM.

Note: Pending revisions of the child item are not displayed on the parent 
item BOM table. However, any child item that has a pending change is 
indicated by the icon in its row in the parent item BOM table.

Table 10–1 Orphaned item object search criteria

Item object search criteria 
attribute Description

Available 
Operators

Where Used

Item Number

Specifies the latest released revision of the item 
object.

Is Null

Is Not Null

Where Used

Item Number All Revisions

Specifies all the revisions of the item object. Is Null

Is Not Null
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Product Lines(s) Equal To Gemini And

Page Two Date 01 Greater Than May 1, 2013

For more information about searching for objects in Agile PLM, see Getting Started with Agile 
PLM, chapter "Finding Agile Data with Searches".

Quick Access to Agile Objects using Smart URLs
You can generate quick access URLs that provide direct pointers to Agile objects, to Agile 
attachment files, or to Agile searches.

These quick access URLs can be pasted into other applications or files such as spreadsheet 
files, word processing files, a company Intranet web page or WIKI page, or into an email. 
When a user clicks the Smart URL, an Agile PLM Web Client window opens and displays the 
object, attachment file or search window.

Smart URLs can specify a specific tab, revision, or version to display when the object opens in 
Agile PLM.

For detailed information about all types of Smart URLs, see Getting Started with Agile PLM, 
chapter "Working with Business Objects in Web Client", section "Smart URL Quick Access to 
Objects, Files, and Searches."
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ADeleting Agile Objects

Agile PLM objects can be soft-deleted, and then hard-deleted. The following topics are 
discussed:

"Soft Delete and Hard Delete Defined" on page A-1

"Soft-Deleting an Object" on page A-2

"Undeleting an Object" on page A-2

"Hard-Deleting an Object" on page A-2

"Notes about Deleting Specific Agile Object Types" on page A-3

Soft Delete and Hard Delete Defined
Java Client and Web Client support "soft" and "hard" deletes for many Agile object classes. 
When you soft-delete an object in the database, it is not permanently deleted. A soft-deleted 
object is marked "Deleted" in the database, and its object number or name is reserved. You 
cannot create another object with the same type and number or name as a soft-deleted object.

When you run a search, soft-deleted objects do not appear in the search results table. To locate 
soft-deleted objects, you must run the predefined deleted object searches in the Recycle Bin 
Searches folder.

A hard-deleted object is permanently removed from the database.

To soft-delete, hard-delete or undelete an Agile object:

You must have the appropriate Delete or Undelete privileges for that object.

All relationships and subscriptions must be removed.

The object must meet any additional conditions that determine whether it can be deleted or 
undeleted.

Note: You have access to the Recycle Bin Searches folder if Recycle Bin 
Searches is included in the Searches field of your user profile. If you have 
the appropriate privileges, then you can edit your user profile and add 
Recycle Bin Searches to the list of searches in the Searches field. If you do 
not have the appropriate privileges to modify the Searches field in your user 
profile, then ask the Agile administrator to modify your user profile.

Caution: You cannot undelete a hard-deleted object.
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In general, if deleting or undeleting an object would cause the compromise of data integrity, the 
delete or undelete action is disabled.

For detailed information about deleting specific object types, see"Notes about Deleting Specific 
Agile Object Types" on page A-3.

Soft-Deleting an Object
When an object is soft-deleted, it is no longer available for use. However, until it is 
hard-deleted, its number or name is reserved in the Agile PLM database and cannot be reused.

To soft-delete an object in Web Client:

1. Select and open the object you want to delete.

2. Choose Actions > Delete, and respond OK to the confirmation prompt.

The object is soft-deleted.

To soft-delete an object in Java Client:

1. Select and open the object you want to delete.

2. Click the Delete button, and respond Yes to the confirmation prompt.

The object is soft-deleted.

See also: "Soft Delete and Hard Delete Defined" on page A-1, "Undeleting an Object" on 
page A-2, and "Hard-Deleting an Object" on page A-2.

Undeleting an Object
If you have the appropriate privileges, then you can undelete soft-deleted objects.

To undelete an object in Web Client:

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.

2. Open the deleted object you want to restore.

3. Choose Actions > Undelete.

To undelete an object in Java Client:

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.

2. Open the deleted object you want to restore.

3. Click the Undelete button.

See also: "Soft Delete and Hard Delete Defined" on page A-1, "Soft-Deleting an Object" on 
page A-2, and "Hard-Deleting an Object" on page A-2,

Hard-Deleting an Object
Soft-deleted objects still exist in the database. To remove an object permanently, you must 
hard-delete it. While an object is still only soft-deleted, you can undelete it. Run the appropriate 
Deleted object search from the Recycle Bin Searches folder.

Note: You can click the Navigator button in the search results table to 
display the search result object links in the left pane NAVIGATOR drawer.



Notes about Deleting Specific Agile Object Types

Deleting Agile Objects A-3

To hard-delete a soft-delete object (if you have the appropriate privileges) in Web Client:

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.

2. Select the one or more object rows in the search results table.

3. Click the Delete button.

4. In response to the warning prompt, choose Continue and then click Finish.

5. Or, you can hard-delete one object at a time:

Open the object.

Choose Actions > Delete, and respond OK to the confirmation prompt.

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Java Client:

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder.

2. Open the object.

3. Click the Delete Object button, and respond Yes to the confirmation prompt.

See also: "Soft Delete and Hard Delete Defined" on page A-1, "Undeleting an Object" on 
page A-2, and "Soft-Deleting an Object" on page A-2,.

Notes about Deleting Specific Agile Object Types
The following topics provide notes about required conditions for deleting each Agile PLM 
object type.

Notes about Deleting Item Objects
Before you can delete an item object, it must meet the conditions described below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

The item has no released changes against it.

The item is not listed on the Affected Items tab of any pending changes.

You must first remove the item from the Affected Items tab of each pending change before 
you can delete the item.

The item has not been added to PSR.

The item has not been added to QCR.

The item has not been added to Material Declaration.

The item has not been added to Price.

The item has no content on its BOM tab for the current revision or any pending revisions.

The item has no content on its Manufacturers tab for the current revision or any pending 
revisions.

Note: You can click the Navigator button in the search results table to 
display the search results object links in the left pane NAVIGATOR drawer.
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The item is not used on the Bill of Materials of any other item, that is, the item to be 
deleted is not a child item on the BOM tab of a parent item revision, including the latest 
released revision, past released revisions, or pending revisions of the parent item.

The item is not associated with a Part Family, that is, the item does not appear on the Parts 
tab of a Part Family object. On the Title Page of the item to be deleted, the Part Family 
field must be empty. If the Part Family field is populated, then the Actions > Delete 
command is disabled.

Notes about Deleting Change Objects
Before you can delete a change object, it must meet the conditions described below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges. For example, you are the change analyst or component engineer, and the Agile 
administrator has given change analysts or component engineers the appropriate privileges 
to delete a change.

All relationships and subscriptions have been removed.

The change is at the Pending status type or the Unassigned status.

You have Discovery and Read privileges for any items on the Affected Items table, 
otherwise, you cannot delete the change.

When you soft-delete a change that has items on the Affected Items tab, all redlines 
associated with that change are discarded. To preserve data integrity, a soft-deleted change 
with items on the Affected Items tab cannot be undeleted. That is, a soft-deleted change 
can be undeleted only if there are no items on the Affected Items tab.

Notes about Deleting Transfer Order Objects
Before you can delete a Transfer Order object, it must meet the conditions described below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

The transfer order is at the Pending status type or the Unassigned status.

Notes about Deleting PSR or QCR Objects
Before you can delete a Product Service Request (PSR) or Quality Change Request (QCR) 
object, it must meet the conditions described below.

Note: To delete a change that has already been released, you must first 
unrelease the change. You need the appropriate privileges to unrelease a 
change by using the Workflow tab to switch it to a different status.

Note: If you think you might want to undelete a soft-deleted routable object 
in the future, then be sure to clear its Affected Items tab before you delete it. 
You can undelete only routable objects with no entries on the Affected Items 
tab. To keep the record of affected items but still want to delete the change 
object, use the Save As command to copy it under another change object 
number before deleting it.
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The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

The PSR or QCR is at the Pending status type or the Unassigned status.

You have Discovery and Read privileges for any items on the Affected Items table; 
otherwise, you cannot delete the PSR or QCR.

You cannot delete a PSR if:

It appears on the Relationships tab of a QCR.

It is currently part of a corrective action process. Remove the PSR from the QCR and then 
delete the PSR.

It appears in the Related PSR tab of another PSR.

It is currently part of a larger problem. Remove this PSR from the parent PSR and then 
delete it.

It appears on the Related PSR tab.

It is being used to aggregate multiple problems. Remove the related PSRs and then delete 
it.

You cannot delete a QCR if:

It has any PSRs on the Relationships tab.

If the corrective action process contains Problem Reports. Remove the PSR from the QCR 
and then delete the QCR.

It has any Changes on its Relationships tab.

If the corrective action process is already routed through engineering changes. Remove the 
Changes from the QCR and then delete the QCR.

Notes about Deleting Sourcing Project, RFQ and RFQ Response 
Objects

Agile Product Cost Management (PCM) objects include: Sourcing Project, RFQ, and RFQ 
Response. Before you can delete any Agile PCM object it must meet the conditions described 
below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

Sourcing Project

– The sourcing project has no RFQs.

– If the sourcing project has RFQs, the RFQs are in the closed state.

Note: To delete a PSR or QCR that has already been released, you must 
first unrelease it. You need the appropriate privileges to unrelease a PSR or 
QCR by using the Workflow tab to switch it to a different status.
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RFQ

– The RFQ has no released changes against it.

RFQ Response

– The delete action is not supported for RFQ response objects.

Notes about Deleting Package Objects
Before you can delete a Package object, it must meet the conditions described below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

The package is at the Pending status type or the Unassigned status.

Notes about Deleting Manufacturer Objects
Before you can delete a manufacturer object, it must meet the conditions described below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

It is not listed on the Manufacturers tab of an item. (Check the Where Used tab of the 
manufacturing object.)

If the object is a manufacturer, no manufacturer parts are associated with it.

Notes about Deleting Site Objects
Before you can delete a Site object, it must meet the conditions described below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

Note: Sourcing project objects can be soft deleted, but soft-deleted 
sourcing project objects cannot be undeleted or hard deleted.

Note: RFQ objects can be soft deleted, but soft-deleted RFQ objects cannot 
be undeleted or hard deleted.

Note: If all manufacturer parts associated with a manufacturer have been 
deleted, then the manufacturer can be deleted as well. However, you will not 
be allowed to undelete the soft-deleted manufacturer parts until the 
soft-deleted manufacturer object is undeleted.

Note: Site objects can be soft deleted, but soft-deleted sites cannot be 
undeleted or hard deleted. If you are no longer using a site, then Agile 
recommends that you disable it.
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The site does not appear on any item's Sites tab.

The site is not associated with any other Agile object.

The site has a lifecycle of Disabled.

Notes about Deleting User Objects
Before you can delete a User object, it must meet the conditions described below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

User access to Agile PLM can also be controlled by using the user profile Status property. For 
example, if someone leaves the company, or will no longer be using Agile PLM, or you need to 
prevent a user from logging in to the Agile PLM system, then disable the user object by setting 
the Status property to Inactive. The user remains listed on the Java Client Administrator Users 
node and on the Web Client Address Book Users tab, and the name still appears on existing 
workflows, escalations, and so forth, but the user will no longer appear in the Address Book for 
other users to select. You can reset the user to Active status at any time.

In Java Client Administrator, to display the list of deleted users, you can use either the Deleted 
Users node or the Recycle Bin search Deleted Users. In Agile Web Client, to display the list of 
deleted users, use the Recycle Bin search Deleted Users.

For detailed information about managing Agile PLM users, see Agile PLM Administrator 
Guide.

Notes about Deleting User Group Objects
You can delete a user group that is no longer needed.

Before you can delete a user group object, it must meet the conditions described below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

If you delete a user group to which users have been assigned, then you can do so without 
removing the users who were in the user group:

Note: If it meets the conditions listed above, then a disabled site can be 
soft-deleted even when it is listed in the Sites or Default Site field of user 
profiles. The deleted site is automatically removed from the Sites list in any 
user profile where it is listed.

Once the site has been associated with an item, you can change its status to 
Disabled, but you cannot delete it.

Note: User objects cannot be hard-deleted.

Note: If you set a user group Status to Inactive, then the inactive group 
appears in the search results table. In contrast, a soft-deleted user group does 
not appear in the search results table.
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Global User Groups – when you soft-delete a global user group, the group is listed in the 
group members' user profile Groups tabs as an inactive group. When you hard-delete a 
global user group, the user assignments to that global user group are also deleted and do 
not appear on the user profile Groups tab.

Personal User Groups – For personal user groups, whether active or inactive, assignments 
are not listed on the group members' user profile Groups tabs.'

When you delete a user group, it is removed from the Agile PLM address book. You cannot 
delete a user group if it is in use in these cases:

It is on any routable object signoff list on the routable object Workflow tab.

It is listed in any workflow definition Notify properties.

It is used as a designated escalation person for any users, user groups, and partners.

In Java Client Administrator, to display the list of deleted user groups, you can use either the 
Deleted User Groups node or the Recycle Bin search Deleted User Groups. In Agile Web 
Client, to display the list of deleted users, use the Recycle Bin search Deleted User Groups.

Notes about Deleting PG&C Objects
Agile Product Governance & Compliance (PG&C) objects include: Declarations, 
Specifications, Substances, and Part Groups. Before you can delete any Agile PG&C object it 
must meet the conditions described below.

The Agile administrator has assigned to you a role that has the appropriate Delete 
privileges.

All relationships and subscriptions have been removed.

Substances, Specifications, and Part Groups

– If the substance, specification or part group object is in use, then it cannot be deleted.

Declaration

– The Declaration is at the Pending status type or the Unassigned status.
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BConfiguring Product Collaboration in Agile
Administrator

This chapter provides information about Product Collaboration administration settings.

Reference Designator Preferences
Agile PLM 9.3 includes two system preferences related to reference designators. One 
preference defines the way reference designators are displayed in the BOM table. The second 
preference helps to determine the format of individual reference designators, including the 
format in which they are stored in the Agile PLM database.

Caution Changing the Reference Designator Range Indicator preference after the initial 
implementation of Agile PLM may affect user data. See "Reference Designator Range 
Indicator" on page B-2 for more information.

Read this entire section about "Reference Designator Preferences" before you make any 
updates or changes to these preference settings.

Reference Designators Allow Range Expand Collapse

Permits reference designators to be displayed in the BOM table as a range instead of a 
sequence. For example, the reference designator range R1 through R5 can be displayed as 
either:

Expand setting:

R1, R2, R3, R4, R5

Collapse setting:

R1-R5

Reference Designator Range Indicator

The symbol that appears between lower and upper range values in reference designator 
statements. The default character is hyphen ( - ). If the reference designator number format 
that you want to use includes the hyphen character as part of the format, then you can use 
this setting to select a different character to use as the range indicator. For important 
information about this preference, see "Reference Designator Range Indicator" on 
page B-2 before you make any updates or changes.

Reference Designators Allow Range Expand Collapse
This setting is now editable in this release. By default, the Reference Designators Allow 
Range Expand Collapse preference is set to Collapse, which means it collapses ranges of 
reference designators, for example, RefDes01-03. A setting of Expand forces the sequence to 
list each individual reference designator, separated by commas, for example, RefDes01,02,03.
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Edit Mode - How editing reference designators is affected by the 
Expand/Collapse setting
When a BOM row is in edit mode, the reference designators are always displayed in expanded 
mode, regardless of the RDAREC preference setting. This lets the user select and delete 
individual reference designators.

Regardless of the RDAREC preference setting, the user can always type a reference designator 
range in edit mode. If the user enters R1-R99, when they save their edits, the reference 
designators are displayed according to the RDAREC preference setting. If the Expand setting 
is selected, each individual reference designator is displayed on the BOM table.

Reference Designator Range Indicator
This preference determines which character is used to indicate a range of reference designators. 
The default reference designator range indicator is the hyphen character:

-

When the Reference Designators Allow Range Expand Collapse (RDAREC) preference is set 
to Collapse, this character is used to indicate the "missing" reference designators in the 
sequence. For example, the range R1-R5 indicates that the range consists of the reference 
designators beginning with R1 and ending with R5. Although R2, R3, and R4 are not 
displayed, the range indicator character implies that they are included in the range.

Why Select a Non-default Reference Designator Range Indicator?
If you need to use a reference designator format that includes the hyphen character as part of 
the reference designator number (for example, a segmented reference designator such as 
R3-AB46), then you can use this system preference to select a different character to use as the 
Reference Designator Range Indicator. If you select the colon character ( : ) as the reference 
designator range indicator, and the RDAREC is set to Collapse, then the range of reference 
designators beginning with R3-AB44 and ending with R3-AB48 is displayed as:

R3-AB44:R3-AB48

If the RDAREC is set to Expand, then the same range of reference designators beginning with 
R3-AB44 and ending with R3-AB48 is displayed as:

R3-AB44, R3-AB45, R3-AB46, R3-AB47, R3-AB48

For example, if you select the colon character as the range indicator character and use the 
hyphen character to segment reference designators, and then you subsequently select the 
hyphen character as the range indicator character, then a range indicator value R3-AB47 no 

Note: Whether they are originally entered as individual numbers or as 
ranges, Agile PLM stores reference designators as individual reference 
designator numbers. The RDAREC preference setting determines only the 
manner in which they are displayed on the BOM table (expanded or 
collapsed).

Caution: Changing the reference designator range indicator character may 
affect user data. Updates or changes after the initial Agile PLM 
implementation should be made with extreme caution. Selecting a range 
indicator character that was previously used to segment reference designators 
may cause data mismatch problems.
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longer has the same meaning, as the hyphen now indicates a range rather than part of the 
reference designator value.

Reference Designators with Leading Zeros
The following rules apply to the manner in which reference designators with leading zeros may 
be entered on the BOM table:

The user may enter leading zero reference designators regardless of the Expand/Collapse 
setting.

(See "Reference Designators Allow Range Expand Collapse" on page B-1.)

The number of the numeric characters between reference designator segments in a range 
need not match. For example, the user may enter R0001-R100.

When the number of numeric characters does not match, the first segment's number of 
numeric characters is used to store the reference designator values in the database. For 
example, R0001-R100 is stored as R0001, R0002, .. R0100.

Multi-segmented Reference Designators
The following rules apply to the format of multi-segmented reference designators, that is, when 
the reference designator has a suffix.

Reference designators may be separated into a maximum of three parts:

– Prefix - May be any character that is not designated as the Range Indicator or a 
delimiter.

– Number - Must be numeric (include only characters 0 through 9)

– Suffix - May be any character that is not designated as the range indicator or a 
delimiter AND does not start with "0" (zero).

Only the last number string is considered as the Number.

For example, in reference designator value A10B30D

Prefix = A10B

Number = 30

Suffix = D

Revising Item Descriptions
Agile PLM 9.3 provides several ways to manage and control the modification of the 
Description field of Item objects.

Three basic behaviors:

Item object modification

Important: Regarding revision-controlled Description field modification: 
The item Description field cannot be modified through an MCO because an 
MCO does not create a new item revision. The MCO uses the Description 
field information from the ECO revision or Introductory revision on which it 
is based.
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The end user edits the Description field of the item object. This method is controlled by 
Modify privilege masks for item objects applied to the item Description field.

Revision controlled - all Item objects

The end user must modify the item Description field on the Affected Items table of a 
change order, in the same manner that an item's Revision and Lifecycle attributes are 
revision controlled and, thus, are modified on the Affected Items table of a change order.

This method is controlled by Modify privilege masks for the change order object applied to 
the Item Description field of the Affected Items table. Also, the Item Description field 
must be enabled on the Affected Items table.

Revision controlled - selected Item subclasses

This method is a mixture of the previous two methods: some selected item subclasses 
require revision-controlled modification of the Description field, while other item 
subclasses do not require it.

This method is controlled by using a combination of the previous methods:

– Modify privilege masks for the item subclass applied to the item Description field (for 
the subclasses that do not require revision-controlled description modification, but the 
users may edit the description on the item object itself).

The Item Description field must be enabled on the Affected Items table.

– Modify privilege masks for the change order object applied to the Item Description 
field of the Affected Items table (for the subclasses that do require revision-controlled 
modification).

In addition, the Modify privilege masks for the change order object must use the 
wildcard $AFFECTEDITEMTYPE to determine which subclasses require 
revision-controlled modifications to the specific item subclass Description field.

Setting up the Change Order Object
The Affected Items tab of change order objects (for example, ECOs) includes the following two 
attributes, which must be enabled or disabled appropriately for each Item Description 
modification method:

Old Item Description

This Affected Items attribute is populated with existing Item Description field value when 
the item is added to the change order. This attribute is not editable on the Affected Items 
tab. By default, this attribute is not enabled.

For any item revision method that requires change order revision-controlled modification, 
you must enable this attribute.

Item Description

This is the default Affected Items table item description attribute. With the appropriate 
modify privilege masks for change order objects, this attribute is editable on the Affected 
Items table.

In effect, this is the New Item Description and you may rename it if you want.

Note: Item descriptions are associated with a specific item revision. 
Although the actual modifications are made on the item object itself (a 
change order is not required), the resulting descriptions are revision-specific.
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When both these change order Affected Items table attributes are enabled, the Old Item 
Description field automatically displays the item description of the most recently released item 
(upon which the change order is based). The (New) Item Description field is available for the 
user to enter the desired item description for the pending revision of the item. This scenario 
requires the appropriate change order Modify privilege masks, with the appropriate Applied To 
properties for the (New) Item Description field.

Setting up the Appropriate Modify Privilege Masks for each Method
The following tables illustrate how you should modify the Agile-supplied default privilege 
masks for each method. Use this table as a guideline for setting up the desired method in your 
Agile PLM system. If you are not using the Agile-supplied default roles and privilege masks, 
examine the Example privilege masks and compare them to the actions outlined in the tables.

Item Object Description Field Modification
Goal: Modify the Item Description on the Item Object only.

1. Default Item privilege masks:

a. Modify Preliminary Items (Applies to Introductory and Pending revisions.):

ADD Items.Title Block.Description to the Applied To property.

b. Modify Released Items:

ADD Items.Title Block.Description to the Applied To property.

2. Default Change privilege masks:

a. All default privilege masks with object type Changes:

REMOVE Changes.Affected Items.Description from the Applied To property.

3. Change Order object, Affected Items table Item Description attributes:

a. HIDE (disable) Old Item Description attribute.

b. ENABLE New Item Description attribute and RENAME it to Item Description.

Revision Controlled, All Items
Goal: Modify the Item Type (subclass) description on Change Order only.

1. Default Item privilege masks:

a. Modify Preliminary Items (specific Item Type). (Applies to Introductory and 
Preliminary revisions.)

REMOVE Items.Title Block.Description from the Applied To property.

b. Modify Released Items (specific Item Type)

REMOVE Items.TitleBlock.Description from the Applied To property.

2. Default Change privilege masks:

a. All default privilege masks with object type Changes:

Note: For each Item Type (subclass) to be modified by Change Order only, 
a modify privilege mask for change orders (with criteria for 
$AFFECTEDITEMTYPE) is required.
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ADD Changes.Afftected Items.Item Description to the Applied To property where 
Change.Affected Item.Item Type = (specific Item Type).

Use the criteria:

Change.$AFFECTEDITEMTYPE = (specific Item Type)

3. Change Order object, Affected Items table Item Description attributes:

a. SHOW (enable) Old Item Description and New Item Description.

Goal: Modify the Item description on Item object or on Change Order.

1. Default Item privilege masks:

a. Modify Preliminary Items (specific Item Type). (Applies to Introductory and 
Preliminary revisions.)

ADD Items.Title Block.Description to the Applied To property.

b. Modify Released Items (specific Item Type)

ADD Items.Title Block.Description to the Applied To property.

2. Default Change privilege masks:

a. All default privilege masks with object type Changes:

REMOVE Changes.Affected Items.Item Description from the Applied To property.

3. Change Order object, Affected Items table Item Description attributes:

a. HIDE (disable) Old Item Description attribute.

b. ENABLE New Item Description attribute and RENAME it to Item Description.

Revision Controlled, All Items
Goal: Modify the Item description on Change Order only.

1. Default Item privilege masks:

a. Modify Preliminary Items (applies to Introductory or Pending revisions)

REMOVE Items.Title Block.Description from the Applied To property.

b. Modify Released Items

REMOVE Items.Title Block.Description from the Applied To property.

2. Default Change privilege masks:

a. All default privilege masks with object type Changes:

ADD Changes.Affected Items.Item Description to the Applied To property.

3. Change Order object, Affected Items table Item Description attributes:

a. SHOW (enable) Old Item Description and New Item Description.

Goal: Modify the Item description on Item object or on Change Order.

Note: For each Item Type (subclass) to be modified on the item subclass, a 
modify privilege mask (with criteria for Title Block.Part Type) is required.



Configuring Sites - Distributed Manufacturing

Configuring Product Collaboration in Agile Administrator B-7

1. Default Item privilege masks:

a. Modify Preliminary Items (applies to Introductory or Pending revisions)

ADD Items.Title Block.Description to the Applied To property.

b. Modify Released Items

ADD Items.Title Block.Description to the Applied To property.

2. Default Change privilege masks:

a. All default privilege masks with object type Changes:

ADD Changes.Affected Items.Item Description to the Applied To property.

3. Change Order object, Affected Items table Item Description attributes:

a. SHOW (enable) Old Item Description and New Item Description.

Notes on Configuring Product Collaboration Object Tabs
Only the editable attributes on the BOM tab and the Manufacturers tab can be redlined. 
For more information, see Agile PLM Administrator Guide, "Classes" chapter, section 
about Read-Through Fields.

In the BOM Bulk Change wizard to replace or remove an item from an assembly, when the 
user identifies an item to bulk replace or remove, a table of assemblies where that item is 
used is displayed in the wizard. That table is derived from the item's Where Used tab. That 
is, any attributes that are visible on the item object Where Used tab will also appear in the 
BOM Bulk Change wizard.

For example, if you want the assembly revision to appear in the table in the BOM Bulk Change 
wizard, then you must enable (make visible) the Revision attribute on the Where Used tab of 
item objects. For more information, see Agile PLM Administrator Guide, "Classes" chapter, 
section about Configuring Tabs.

Notes on Configuring Agile PLM Settings that Affect Product 
Collaboration

The Multiple Items Per Manuf Part SmartRule is applied when the user creates an item 
with the Save As feature. That is, if the original item has a manufacturer part and the user 
displays that item and chooses Save As, the SmartRule is applied to the new item. If the 
SmartRule is set to Disallow, the user is presented with an error message and will not be 
allowed to create the new item. If the SmartRule is set to Warning or Allow, no error 
message is displayed and the new item is created.

Configuring Sites - Distributed Manufacturing

When the Agile administrator enables the Agile PLM Sites license, the Agile Site object is 
available and Agile PLM multi-site manufacturing functions become available. Agile PLM 
multi-site manufacturing capabilities are used to assist a company that builds its products in 

Note: For information about implementing and configuring Agile PLM 
multi-site manufacturing, see Agile PLM Administrator Guide. For 
information about using Agile PLM multi-site manufacturing, see Chapter 3, 
"Sites and Distributed Manufacturing."
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multiple locations (distributed manufacturing). Before taking this step, you must determine and 
plan how Agile PLM multi-site manufacturing will be integrated with your ERP system.

Agile PLM multi-site manufacturing helps a company that builds its products in multiple 
locations to do so by enabling parts and documents in those locations that are specific to the 
manufacturing process. In Agile PLM, revisions are global item attributes. If a part is used in 
two manufacturing sites, then it must share the revision level, although the effectivity dates and 
disposition settings can be different.

The Agile PLM multi-site manufacturing features allow you to annotate product data with three 
types of site relationships:

Item object-to-Site relationship

An item can be associated with one or more sites by adding the site object to the sites table 
on the item Sites tab. Item-site relationships are similar, but not identical to ERP item-site 
relationships. You can see if an Agile part is enabled in any sites by viewing its Sites tab.

Parts that are not released in any site have only global item effectivity dates and 
dispositions.

Parts released in sites are can have both site-specific item effectivity dates and 
dispositions and global item effectivity dates and dispositions.

BOM row-to-Site relationship

BOM row-site relationships are unique to Agile PLM. A child part can relate to its parent 
with no site relationship or through one or more specific sites. Each BOM row has either 
no site relationship or one site relationship. Use multiple rows, one for each site, to 
represent more than one site relationship for the same child part.

A child part that reports to its parent without a specific BOM row-site relationship is 
considered a common part, that is, a part common to all manufacturing sites.

A child part that reports to its parent with a BOM row-site relationship is a 
site-specific part, that is, a part that is specific to the related manufacturing site.

AML table row-to-Site relationship

On the Manufacturers tab of a part, you can specify site-specific AMLs (Approved 
Manufacturer List). Rows on the part manufacturer table can be common (specify no site) 
or a site-specific (associated with a site listed on the Sites tab of the part). BOM row-site 
relationships and AML row-site relationships are independent of one another.

A manufacturer part without a specific AML row-to-site relationship is a common 
manufacturer part and can be used at any manufacturing site.

A manufacturer part with an AML row-to-site relationship is a site-specific 
manufacturer part, which permits the manufacturer part to be used at the specified 
manufacturing site.

Other important Agile PLM sites and ERP sites differences to keep in mind:

Caution: Agile PLM multi-site manufacturing functionality is built 
differently than ERP sites. Agile PLM Site objects and ERP sites are similar, 
but they are not identical. You should work with an Oracle Consulting - Agile 
PLM practice representative to plan your Agile PLM to ERP integration 
before you enable the Agile PLM Sites license. The type of information that 
you want to track in Agile PLM and how you choose record that information 
in Agile PLM may depend on how product information is stored in your ERP 
system.
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In many ERP systems, a part can appear in different sites and have independent revisions. 
Agile PLM considers all revision to be a global attribute of the part, therefore, site-based 
revisions are not supported in Agile PLM. To accommodate this need, simply prefix or 
suffix the part number with a unique string, for example SJC-P1000 and NYC-P100. These 
are unique parts which have global revision, but because these parts are not used in other 
sites their revisions appear to be site-specific.

The item-site relationship and the BOM row-site relationship are independent of one 
another in that you can add a part to a BOM as a site-specific BOM row without first 
adding the site to the part. Unlike typical ERP systems, Agile PLM does not require that a 
part must first be released in a site before it can be added to a site-specific BOM row.

When adding a row to a BOM where the parent has Sites that are not on the child, Agile 
PLM prompts the user to add the Sites to the child. This occurs only on the initial add of 
the BOM row - either in authoring mode (direct editing of a part) or in redlining mode 
(modifying a part through change redline). The user can choose only to Copy the sites onto 
the child to add the row to the BOM. Choosing Close will not add the BOM row. If 
additional Sites are subsequently added to the parent, then the newly added Sties are not 
automatically copied to the child. If Sites are removed from the child, then no check is 
made on whether there is inconsistency between Sites on the parent and the child.

The SmartRule Child Released First is enforced by the Release Audit when a part is 
released. When a parent part is released, this rule checks the BOM components for Site 
association and whether the BOM components are also released. The Release Audit 
verifies whether the item has been released by a Change or Manufacturer Change after a 
Site was added. To correctly pass this SmartRule, the Item must be released after adding a 
Site.

What are Change Controlled Attributes?
Important terms and concepts:

Change-Controlled Attributes

This term is used to describe attributes which can be Change Controlled (Redlined on a 
change order or manufacturer change order) and which are configured in Agile 
Administrator to be Change-Controlled.

Rebasing

Rebasing is the process of rationalizing values when there are multiple pending changes to 
an item. For example, if two ECOs are redlining the same BOM, then Agile PLM must 
update, or rebase, the second ECO when the first ECO is released.

Pending Change

When discussing Agile PLM, pending change refers to a change which has not reached the 
first released status of its workflow.

Change

When discussing Change Controlled attributes, a change means either a change order 
(ECO) or a manufacturer change order (MCO).

Using the Agile PLM Change Controlled Attributes feature enables you to control how item 
attributes are modified. In the Agile Administrator Data Settings node, setting an item attribute 
Change controlled property to Yes means that the attribute can only be modified by using a 
either a change (ECO) or a manufacturer change order (MCO) and redline editing the attribute 
on the change object Affected Items tab, Title Block redline tab.
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The Title Block redline attribute modifications are controlled by the change approval process. 
The proposed new attribute values are not in use until the change is released. If the change is 
canceled, then the proposed new values are discarded and are not used.

Change-Controlled attributes are not displayed in the item object by revision. When the user 
selects a different revision in the Rev drop-down list, revision controlled attributes (for 
example, Description) appear in the item display as appropriate for each revision. A 
Changed-Controlled attribute displays the latest value for that attribute, regardless of which 
Rev is selected.

To view and compare historical values of item attributes, Agile PLM 9.3 provides the Item 
Attribute History report. This report enables you to view attribute changes that took place at 
each revision. Both revision controlled attributes and Change-Controlled attributes can be 
included in the report. See also "Item Attribute History Report" on page 9-15.

Change-Controlled attributes include Title Block, Page 2 and Page 3 attributes. For each 
attribute you want to be under Change Control, set the Change controlled attribute property to 
Yes. When items are added to a change order (ECO) or manufacturer change order (MCO), the 
Affected Items tab of the change includes a Title Block redline tab in Web Client.

Configuring Change Controlled Attributes
To configure an item attribute to be Change Controlled:

1. Login to Java Client Agile Administrator and navigate to the object tab you want to 
configure.

2. On the Attributes tab, double-click the attribute you want.

3. Set Change controlled to Yes and then click Save.

Attributes that can be defined as Change Controlled are:

Title Block attributes that are not revision-controlled. Revision-controlled attributes 
display N/A in the Change controlled column of the Attributes table.

Page Two attributes, except for the Create User attribute.

Page Three attributes.

Display Type for Lists in Web Client
The Display Type list property setting for Lists and Multilists determines the list edit format in 
Web Client. In Java Client Administrator the Agile administrator chooses whether the object 
list attribute is displayed as a List format or Search format in Web Client. If the selection is List 
mode then the entries display in a drop-down list. If the selection is Search mode then the 
entries display in a search palette.

For detailed information about customizing and configuring lists, see Agile PLM Administrator 
Guide.

Note: The Title Block redline tab is available only in Web Client.

Note: For list attributes that contain more than 250 entries, Web Client 
automatically displays the entries in Search mode.
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CConfiguring Variant Management

This appendix provides information about Agile PLM Administrator settings for Variant 
Management.

Administrative Settings for Variant Management

Privileges for Variant Management User

To change the preference for the internal or external Configurator for Variant Management, you 
must have a Modify privilege mask with the criteria My User and which includes 
users.Preferences.BOM Variant Configuration Preference in the Applied To property.

Additionally, to be able to create the Instance BOM, you require the same privileges that are 
needed to create a BOM, and the Save As privilege for Parts (Models).

To be able to modify a Model Option BOM, the fields Parts.BOM.Max Qty, Parts.BOM.Min 
Qty, Part.BOM.Mut Excl, and Parts.BOM.Optional also must be included in the Modify 
privilege mask Applied To property.

To create Instances on the Instances tab, the field Items.Instances.Item Name must be 
included in the Modify privilege mask Applied To property.

To launch the Instance Manager, the Configure Instance privilege is required, and the Read 
privilege mask must include the field Items.Instances.Item Name in the Applied To property.

In case the Title Block tab of Models or Instances contains a description, to create the Instance 
BOM, the Modify privilege mask must include Items.TitleBlock.Description in the Applied 
To property.

The privileges that enable the Propagate button on the Instances tab are the same privileges 
that enable the use the Add and Remove buttons. To use the Propagate button, you require the 
same privileges.

Note: The information in this section is referring to the Java client 
Administrator only.

Note: You require the 'Administrator' privilege to configure the necessary 
privileges.
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Activating 'Internal Configurator' - Instance Manager

To activate the 'Internal Configurator':

1. Login to the Web client.

2. Click the My Settings button, or open the user profile you want to configure.

3. Select the Preferences tab.

4. In the System Preferences section ensure that the BOM Variant Configuration 
Preference is set to Internal Configurator.

External Configurator - Oracle Generic Configurator User 
Interface

Some basic information about how to use the Oracle Generic Configurator User Interface can 
also be found in this guide.

Activating 'External Configurator' - Generic Configurator User Interface

To activate the 'External Configurator':

1. Login to the Web client.

Important: You must have Read privileges for BOM attributes that are 
used in the Instance Manager. Contact your Agile administrator if you have 
questions about your assigned roles and privileges.

Important: To change the preferences of the client, you require the 
privileges to modify this setting on a user.

Note: To work with the Internal Configurator, each user must have the 
correct preference configured. This is set to Disabled by default.

Note: When creating a Model Option BOM, ensure that when a BOM item 
has the same minimum and maximum quantity value, the Quantity must have 
the same value as well. If Min Qty = Max Qty <> Qty value, then the 
Change Order (ECO), through which this BOM is released, it causes an error 
in the Application Integration Architecture (AIA) queue and will not be sent 
to Oracle E-Business Suite (EBS).

Important: To change the preferences of the client, you require the rights 
to modify this setting on a user.

Note: To work with the External Configurator, each user must have the 
correct preference configured. This is set to Disabled by default.
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2. Click the My Settings button, or open the user which has to be configured.

3. Select the Preferences tab.

4. In the System Preferences section make sure the BOM Variant Configuration Preference 
is set to External Configurator.

Admin Settings for the External Configurator

To provide Agile 9 Model Option BOM data in the external Configurator, settings have to be 
made in the Java client. For detailed information regarding these settings, see Agile PLM 
Integration Pack for Oracle E-Business Suite - Design to Release 2.5 - Implementation Guide 
(http://aia.oraclecorp.com/products/agileplm2billPIP.html).

Event Management in Variant Management
To support a higher flexibility in Variant Management, and also because not all customer use 
cases are covered by the defined validation rules, the user can define its own validation rules 
for a Model Option BOM.

Variant Management Event Types
The Variant Management Event Types are triggered for Models only:

The six Variant Management Event Types:

"Create Variant Instance" on page C-3

"Derive Variant Model Option BOM" on page C-4

"Update Variant Configuration" on page C-4

"Validate Variant Configuration" on page C-5

"Validate Variant Instance Selections" on page C-5

"Validate Variant Model Option BOM" on page C-5

Examples of Variant Management Events
This section provides brief information on how the administrator might tailor Event 
Subscriptions to benefit users in Variant Management. You must read the chapter "Event 
Management" in Agile PLM Administrator Guide. Developers of the (Java and Script) process 
extensions used by the Events framework must read appropriate chapters in Agile PLM SDK 
Developer's Guide.

Create Variant Instance
Purpose

Note: This information is referring to the Java client only. To be able to 
perform these settings you need to have administrative rights.

Note: Once the Variant Management event types are enabled, they replace 
the corresponding default behavior for the affected objects and do not extend 
it.
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This event type retrieves the Instance BOM object from the storage and creates the 
Instance BOM in Agile 9. The entry state of the created Instance on the Instances tab is a 
Part without a BOM. This Instance becomes the root element for the Instance BOM when 
clicking the Create Instance button in the Instance Manager.

The event handler code traverses the logical structure. With this event:

– Parts get created that will replace Models

– All BOM relations get created

Triggered

This event type is triggered once for a specific Instance after the successful processing of 
the Validate Variant Instance Selections and the Derive Variant Model Option BOM event 
types.

Errors

Errors are displayed in a pop-up window.

Derive Variant Model Option BOM
Purpose

This event type creates an Instance BOM object in the storage. This Instance BOM object 
already contains the configurations for the final Instance BOM, without actually creating 
new items or changing the BOM table of an item. The derivation adds the selected parts to 
the BOM, replaces all models by parts (except for the top level model), Option Classes will 
get replaced by their options, and the quantities will be calculated for all parts.

Triggered

This event type is triggered once for a specific Instance when pressing the Create Instance 
button in the Instance Manager, after the successful validation of the Validate Variant 
Instance Selection event type.

Errors

Because the Model Option BOM should be already validated, there should be no errors 
displayed at this stage. In case errors need to be displayed, they are displayed in a pop-up 
window.

Update Variant Configuration
Purpose

This event type checks every line item of the Model Option BOM when launching the 
Instance Manager and in the Instance Manager, for example, check boxes for mandatory 
items are already set, certain quantity fields become read only.

The input data containing the quantity and the status of the check boxes 
(selected/deselected) is passed to the event handler.

With this event:

– Configuration options are added or removed

Note: Items of the logical structure and their relations between each other 
contain only BOM attributes that are necessary for Variant Management, for 
example, minimum/maximum quantity, optional, mutually exclusive. Any 
additional attributes have to be processed and copied in this code.
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– Propagation is processed

Checks for the correct dependencies between child and parent for updated options.

Triggered

This event type is triggered once for every modification of the Configuration Graph for a 
specific Instance, and for preselections (for example, mandatory items) when starting the 
Instance Manager. It is also triggered when pressing the Copy Configuration or Reset 
Configuration button.

Errors

Errors are displayed for each line item in the Instance Manager, at the beginning of each 
line.

Validate Variant Configuration
Purpose

This event type checks if the already created Configuration Graph is still consistent with 
the current Model Option BOM. In case of inconsistencies, the Configuration Graph will 
be updated.

Triggered

This event type is triggered once for a specific Instance when opening the Instance 
Manager for an Instance with Configuration Graph and after the successful processing of 
the Validate Variant Model Option BOM event type. This event type is not triggered for 
preselections (for example, mandatory items) or if no Configuration Graph is available.

This event type is also triggered when pressing the Copy Configuration button.

Errors

Errors are displayed in a pop-up window.

Validate Variant Instance Selections
Purpose

This event type validates the Configuration Graph, for example, to check for min/max 
violations, or if an Option Class has sufficient selected child options.

Triggered(This event type is triggered once for a specific Instance when):

– Clicking Launch Configurator on the Instances tab.

– Modifying a line item (select, deselect, edit quantities) in the Instance Manager.

– Clicking the Validate button in the Instance Manager.

– Clicking the Create Instance button in the Instance Manager.

– Clicking the Reset Configuration button in the Instance Manager.

– Clicking the Copy Configuration button in the Instance Manager.

Errors

Errors are displayed as guide icons for each line item, or when clicking the Validate button 
in a pop-up window.

Validate Variant Model Option BOM
Purpose
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This event type validates the Model Option BOM, for example, to check for min/max 
violations, or if an Option Class has sufficient child options.

Triggered

This event type is triggered once for the top level Model of the Model Option BOM, when 
selecting the Check Model Option BOM menu of the BOM tab of a Model, or when 
clicking the Launch Configurator button on the Instances tab.

Errors

Errors are displayed in a pop-up window, and prevent the Instance Manager to open.
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Activity
A project activity in Agile Product Portfolio Management, such as a program, task, or phase.

Affected Files
Similar to Affected Items, these objects are EC files that are Design Release Candidates.

Agile Configuration Propagation (ACP)
Propagating existing configuration of PLM to the newly installed version of PLM.

Agile Content Service (ACS) 
ACS is an event-driven XML-based publishing service that makes the product record available 
to a wide variety of business applications and users, internally and across the global 
manufacturing network

Agile Destination
A package created by an Agile PLM system in the target PLM using Web Services to import 
from the Attachments tab of the package in the target system.

Agile Integration Services (AIS)
A collection of predefined Web Services in the Agile Integration Framework that enable 
communication between the Agile Application Server and disparate systems

Agile Product Portfolio Management
The Agile PLM project management solution that is integrated with the product information in 
PLM.

AI
Affected Items tab on Change objects in Agile.

Approved Manufacturer Parts List (AML)
List of approved manufacturer parts associated with an item.

Application Programming Interface (API)
A set of routines, protocols, and tools for building software applications. An API expresses a 
software component in terms of its operations, inputs, outputs, and underlying types.

Assembly
A product assembly lists the parts in a product and shows the substances and materials that 
comprise those parts. It is linked to specifications that can restrict how much of a particular 
substance that product assembly may contain
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Automated Transfer Orders (ATO)
Content published by Agile PLM users in real time with a content transfer order (CTO) or set 
up subscribers to automatically create automated transfer orders (ATO) based on a schedule or 
triggered by a workflow status change.

Baseline
A snapshot of a project, usually in its initial stage, used as a reference for future comparison in 
Agile Product Portfolio Management.

Bill of Material (BOM)
A hierarchical representation of a product that is made up of other products.

Bill of Substances (BOS)
A hierarchical list of substances that are contained in the parts and assemblies that make up a 
BOM.

Change Sequence
A series of three-digit numbers (001 through 099) that define the order in which DFCOs 
(Design File Change Orders) have been published for a specific Design or File Folder. Each 
Change Sequence number is associated with one specific DFCO and with the specific file 
folder version number in use when the DFCO is published.

Commodity
A class of goods that is in demand, that is supplied without qualitative differentiation regardless 
of supplier.

Computer-aided Design (CAD)
The use of computer systems to assist in the creation, modification, analysis, or optimization of 
a design. CAD software is used to increase the productivity of the designer, improve the quality 
of design, improve communications through documentation, and to create a database for 
manufacturing. CAD output is often in the form of electronic files for print, machining, or other 
manufacturing operations.

Contract (Price)
This is a subclass of the Published Prices class. Contract prices are prices provided by the 
supplier for a specific item or manufacturer part. This price information applies only for the 
specified duration and can apply to any project.

Co-Sourcing
The process of leveraging product cost across suppliers. 

Deliverable
A unit of work required for a project's success, usually fulfilled by generating a digital file. 
(Word processing documents, spreadsheet documents, PDFs, presentation documents, and so 
on.) Deliverables can also be Agile PLM objects and processes. Also called ’content’ in Agile 
Product Portfolio Management.

Design Change Order (DCO)
A Change Order subclass that is available when the effected File Tab is enabled and provides 
access to all Agile PLM Workflow functions.
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Design File Folder
An EC file folder that is integrated with CAD and PLM files, providing full access to PLM 
Workflow function.

EC Client
A Java-based UI to access, administer and operated the EC solution.

Engineering Collaboration (EC)
An application that provides data and process integration between CAD applications and Agile 
PLM. It allows CAD designers and engineers to capture and control the data representing a 
primary source of the product record.

Engineering Collaboration Order (ECO)
An object that carries with it all the proposed changes to a product and/or its BOM. When 
approved and implemented, the proposed changes become effective.

Extensible Markup Language (XML) 
A markup language that defines a set of rules for encoding documents in a format that is both 
human-readable and machine-readable

File Manager
The File Manager manages files in a repository or vault in the file system and provides a place 
to store and retrieve files locally or remotely. You can install it on the same server as the Agile 
Application Server or on a separate one. You can also install the File in a redundant 
configuration and/or distributed across geographic regions. 

File Transfer Protocol (FTP)
A standard network protocol used to transfer computer files from one host to another host over 
a TCP-based network, such as the Internet.

Fully Qualified File Name
The exact name of a file on a computer that is completely specified such that it is unambiguous 
and cannot be mistaken for any other file on that system.

Fully Qualified Path Name (FQPN)
The full path of a resource, directory or file, stored in a computer. It is composed by the full 
path to the resource and its syntax depends on the operating system.

Gantt Chart
A project management tool that shows project activities and schedule as a bar chart. The chart 
lists project activities in sequence, and presents critical information such as the start and end 
dates of each activity, as well as interdependencies between activities.

Item Master
The product record. It is the entire collection of Items - Parts, Documents, and any other 
user-defined subclasses of the Items class maintained under change control in the Agile system.

Java Message Service (JMS)
The Java Message Service (JMS) API is a Java Message Oriented Middleware (MOM) API for 
sending messages between two or more clients.

Lifecycle Phase
Current state in an object’s workflow.
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LRR
Latest Released Rev - concerning a Part or Document. 

Non Cancelable Non Returnable (NCNR) 
Applies to an item. NCNR can be a Yes or No, depending on the supplier. You can ask for the 
NCNR information in the supplier response. This is one of the critical factors in finding the best 
deal among the supplier responses.

PDX
See Product Definition eXchange (PDX).

PLM
See Product Lifecycle Management (PLM).

Percent allocation or % allocation
The percentage of a resource's time allocated to a specific task or tasks in Agile Product 
Portfolio Management..

Percent complete or % complete
Amount of time and effort expended on a project measured as a percentage of the time and 
effort required to complete the whole project. Used in Agile Product Portfolio Management.

Product Definition eXchange (PDX)
A standard designed for the e-supply chain. This standard is based on the XML format because 
it provides a simple yet powerful and flexible way to encode structured data into a format that 
is both human- and computer-readable. In PLM, PDX packages contain product content, such 
as items.

Product Lifecycle Management (PLM)
The process of taking parts/documents from inception to production to phase-out, and all the 
stages in between.

Protocol
A system of digital rules or agreed-upon format for data exchange within or between devices. It 
determines the type of error checking and data compression used.

Published Price
This is a subclass of the Published Prices class. Published prices are prices provided by the 
suppliers in response to an RFQ and published from the project. The published price 
information can also be used in other projects.

Price
An object that carries with it all the proposed changes to a product and/or its BOM. It can be 
approved and implemented to make the proposed changes effective.

Price Change Order
It is an object that carries with it all the proposed changes to a price. It can be approved and 
implemented to make the proposed changes effective.

Quote History
A subclass of the Quote Histories class. Quote history prices are the stored prices from supplier 
responses that you can use. Any change in the response line of an RFQ is stored in the 
historical response and is usable at any time.
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Request for Information (RFI)
A material declaration that lists the parts in a product assembly and shows the substances and 
materials contained in the part.

Request for Quote (RFQ)
A standard business process whose purpose is to invite suppliers into a bidding process to bid 
on specific products or services.

Request for Proposal (RFP)
A solicitation, often made through a bidding process, by an agency or company interested in 
procuring a commodity, service or valuable asset, to potential suppliers.

Response Line
A response line has information about only one item. The negotiation of price and terms for 
items is dealt with in a response line.

Resource Pool
A group of users who can be bulk assigned as resources for a particular project or task in Agile 
Product Portfolio Management.

RFQ Response
A medium of communication between the user and the supplier. One response from a supplier 
can contain multiple response lines for different items. Price data is added to the project 
automatically when the supplier submits the response.

Schedule Editor
The scheduling engine that handles updates to the project schedule in Agile Product Portfolio 
Management.

Schema
In computer programming, a schema is the organization or structure for a database. The activity 
of data modeling leads to a schema.

Software Development Kit (SDK or "devkit")
A set of software development tools that allows the creation of applications for a certain 
software package, software framework, hardware platform, computer system, video game 
console, operating system, or similar development platform.

Sourcing Project
The entry point of sourcing and product pricing. A sourcing project tracks data required for 
sourcing and pricing, to perform data analysis for effective pricing.

Standard Cost
Applies to an item. This is the market cost of the item. It is site-specific. The standard cost is 
for a unit.

Supplier
A supplier of one or several commodities.

Target Cost
Applies to item. This is the expected cost of the item by you or the supplier. This can be a 
percentage of the standard cost. Target cost is for a unit.
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Timesheet
The time entry system in Agile Product Portfolio Management, used to track actual hours spent 
by resources on project activities and to calculate corresponding labor cost. 

Top Level Assembly (TLA)
The level in a BOM that indicates the ultimate product being manufactured. 

Transfer order
Every time Agile Content Service (ACS) publishes product content, it produces a transfer order 
that keeps track of what, where, and when product content is transferred.

User Productivity Kit (UPK)
The Oracle online help system used in some Oracle products.

Web Service Extensions (WSX)
A Web service engine that enables communication between Agile Product Lifecycle 
Management system and disparate internal and external systems.

XML
See Extensible Markup Language (XML).

XML Schema
Description of a type of XML document, typically expressed in terms of constraints on the 
structure and content of documents of that type, above and beyond the basic syntactical 
constraints imposed by XML rules.
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